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Overview

Overview

Migrating from Deltek FMS™ to Deltek Vision® means that you will be moving the data in your
current FMS database to a new Vision database. Then, you will use Vision to manage that data
and process the accounting, billing, project management, and reporting transactions that are vital
to your business. While this may seem like a large undertaking at first glance, the whole process
can be broken down into a number of very manageable steps—and, of course, the staff at Deltek
is available to guide you and support your efforts throughout the entire process.

These are the major steps in the migration process:

1. Work with a Vision consultant to develop a migration plan for your firm. As part of this
step, you should determine the staff members who need training, what type of training
they need, and when the training should occur.

2. Install Vision.
Install the current version of FMS and unlock the Vision Conversion module.

4. Complete the migration decisions that apply to your conversion situation and record
those decisions in the Vision Conversion module. Complete any other data preparation
tasks that are required.

5. Run the preconversion utilities in the Vision Conversion module and resolve any
problems they reveal.

6. Create a backup copy of your FMS data and submit it to your Vision consultant for the
trial conversion.

7. Load the converted data into your Vision system and test it to make sure the conversion
results are satisfactory.

8. Create a backup copy of your current FMS data and submit it to your Vision consultant
for the final conversion.

9. Load the converted data into your Vision system and begin live processing in Vision.

This list of steps is a general map of the migration process. In practice, some steps may overlap
and each comprises a number of more specific tasks.

About this Guide

The primary purpose of the Deltek FMS to Deltek Vision Migration Guide is to serve as an
information resource for those who are responsible for planning and carrying out the migration of
your current FMS data to the Vision database.

Your key resource for the migration process, however, is your Vision consultant. This guide is not
intended to replace the knowledge and experience that person provides. Rather it is intended to
supplement Vision consulting services and to repeat and reinforce the information you receive
from your consultant.

While this guide at least touches on all of the primary steps listed previously, its main focus is on
the tasks necessary to prepare for, carry out, and verify the results of the conversion of your FMS
data.

= Chapter 1 offers a summary of what the data conversion does and an introduction to the
primary steps in the conversion process.

= Chapters 2 — 6 cover the migration decisions. These chapters are the heart of this guide.
We recommend that you read these chapters to prepare for the migration planning
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session you'll have with your Vision consultant. After the planning session, as you are
making and recording your decisions, refer to these chapters if you need to refresh your
understanding of individual decisions.

= Chapter 7 provides step-by-step instructions for using the Vision Conversion module
dialog boxes to record your migration decisions and for running the preconversion utilities
to verify that your FMS data is prepared for conversion. Because the dialog boxes are not
difficult to use in most cases, you may not need to refer to this chapter often as you are
entering setup data. However, be sure you read the topic on running the preconversion
utilities. That step in the migration process is very important.

= Chapters 8 — 10 describe how to begin using Vision and how to load and test the
converted data.

= The appendixes offer summaries of how major types of FMS data are converted to Vision
data and where you can find that data in Vision. You don’t need to read the appendixes in
order to prepare for the conversion. Use them as a reference tool if you have questions
about where converted data ends up in Vision.

Planning and Management

In our experience, the most important part of the migration process is the planning phase. An
experienced Deltek consultant will act as your project manager and lead you through this phase,
gathering information about your firm and helping you design a migration plan. This consultant
will remain in contact with your firm throughout the migration process, answering questions and
providing training and guidance.

Application Consulting

For many firms, the move to a new software system is the perfect opportunity to re-evaluate their
business practices. With a whole new set of software features available to you, now is the perfect
time to look for more effective ways to process and share information. Our consultants can show
you how to make optimal use of Vision features to streamline your internal procedures and fine-
tune your management practices.

Database Conversion Consulting

Database conversion is the process of taking the accounting and project data that you've
accumulated in FMS, and preparing it for use by Vision. The goal is to eliminate the need to re-
enter data. Our data conversion specialists will help you get your data ready and will then perform
the conversion for you.
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If You Need Assistance

If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of
information and expertise readily available to you.

Customer Services

For over 20 years, Deltek has maintained close relationships with client firms, helping with their
problems, listening to their needs, and getting to know their individual business environments. A
full range of customer services has grown out of this close contact, including the following:

= Extensive self-support options through the Customer Care Connect Web portal.
=  Phone and email support from Customer Care analysts

= Technical services

= Consulting services

=  Custom programming

= Classroom, on-site, and Web-based training

[Ill Find out more about these and other services from the Customer Care Connect site.

Customer Care Connect Site

The Deltek Customer Care Connect site is a support Web portal for Deltek customers who
purchase an Ongoing Support Plan (OSP).

The following are some of the many options you have at the Customer Care Connect site:
= Download the latest versions of your Deltek products
= Search Deltek’s knowledge base

=  Ask questions, exchange ideas, and share knowledge with other Deltek customers
through the Deltek Connect Customer Forums

= Display or download product information, such as release notes, user guides, technical
information, and white papers

=  Submit a support case and check on its progress

= Transfer requested files to a Customer Care analyst

= Use Quick Chat to submit a question to a Customer Care analyst online

=  Subscribe to Deltek communications about your Deltek products and services

= Receive alerts of new Deltek releases and hot fixes

@ If you need assistance using the Customer Care Connect site, the online help available on the site
provides answers for most questions.
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Access Customer Care Connect

To access the Customer Care Connect site, complete the following steps:

1. Go to https://deltek.custhelp.com.

2. Enter your Customer Care Connect Username and Password.
3. Click Log In.
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Chapter 1: The Migration Process

Data Conversion Overview

Conversion Levels

Deltek offers three data conversion levels. These levels differ primarily in the amount of historical
data converted, and as a result, they also differ in pricing.

Conversion Level Description

Basic You can convert only the types of information that reside in the Deltek
Vision Info Centers (projects, clients, vendors, employees,...). You
cannot convert transactions, and you can only convert projects with
activity in the current fiscal year or in the two prior fiscal years.

Standard You can convert both Info Center information and transactions.
However, you can only convert transactions dated in the current fiscal
year and the two prior fiscal years (two full years plus the current year
to date), and you can only convert projects that have activity in those
years. If you have Payroll Plus, you can only convert payroll records
for the current calendar year.

Premium You can convert both Info Center information and transactions. You
have the option to convert all historical data, or you can use cutoff
dates to limit the data that goes to Vision.

When you go through the installation process to unlock the Vision Conversion module in Deltek
FMS, that process automatically configures the module based on the level you purchased.

Selecting a Conversion Level

If you have not already selected and purchased a conversion level, your Vision consultant will
discuss the advantages and disadvantages of each of them with you. The basic tradeoff is
between converting historical data and the time and expense of the conversion.

During the first conversions of Deltek clients from FMS to Vision, we learned that much of the
time the Vision consultants spent “cleaning up” the converted data was a result of data left over
from an earlier conversion from the DOS version of FMS to the Windows version. This data did
not cause problems in FMS for Windows but either caused the conversion to Vision to fail or
made the resulting Vision data unsatisfactory.

Other conversion difficulties are caused by data created as a result of problems in early versions
of FMS for Windows or because of past system failures, particularly those involving the non-SQL
Server version of FMS.

In general, if you reduce the amount of data you convert, you also reduce the number of
conversion problems, and you start with a “cleaner” database as you move forward with Vision.
If You Are Using Stand-Alone Business Management

If you have the Stand-alone Business Management version of FMS (also known as the “Business
Management Only” version) rather than the full version, you can still convert to Vision.
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Be aware, however, that this guide assumes you are converting the full version of FMS, so some
of the decisions and procedures described here are not applicable to your conversion. Your
Vision consultant will help you identify those that do apply.

Data That Isn’'t Converted

The conversion program moves much of your FMS data to Vision. However, because of the many
differences between the two systems, some data is not converted. In many cases, just a few data
items from FMS records aren’t converted, but in a few instances certain categories of data aren't
converted. Here are the more noteworthy examples:

= Time sheets — The Vision Time application is an optional, separately priced Vision
application for entering and processing timesheets. The standard Vision product does not
use time sheets. Because the Time application is optional and because you can't edit
past time sheets in that application, the conversion converts FMS time records to posted
Vision time records but does not convert the time sheet information.

=  Employee expense sheets — The Vision Expense application is an optional, separately
priced Vision application for entering and processing employee expense sheets. The
standard Vision product does not use employee expense sheets. Because the Expense
application is optional and because you can't edit past expense sheets in that application,
the conversion process converts FMS employee expense records to Vision but does not
convert the expense sheet information.

= Invoices and reports — No FMS reports, custom or standard, are available in Vision.
After installing Vision, review the reports and identify those that contain the information
you want.

You have the option to convert the FMS invoice formats, custom or standard, that are
assigned to the projects you are converting, but be aware that the conversion does not result
in identical invoices in Vision. It just provides you a starting point for setting up Vision
invoices. No other FMS billing reports, such as Billing Review reports, are converted.

= Recurring transactions — Recurring AP invoices, purchase orders, and general journal
transactions are not converted.

= Resource Scheduling and Budgeting data — No information entered using the
Resource Scheduling and Budgeting feature set is converted.

= Check reconciliations and charge account reconciliations — Unreconciled checks
and deposits are converted to Vision so you can reconcile them there, but no reconciled
checks or deposits or other check reconciliation information is converted. Vision does not
provide charge account reconciliation, so that FMS information is nhot moved to Vision.

= OQOverhead allocation amounts set up for the Project Profitability report using the
Overhead Allocation Assignment tool — If you are using this tool in FMS, you should
run the Overhead Allocation process in Vision for each year for which converted data
exists.

= AR Collections information — Vision doesn’t provide features equivalent to those in the
AR Collections module in FMS, so most of that data is not converted. Your collection
actions, however, are converted to AR comments and can be reported on in Vision.

If You Have Multiple FMS Companies

If you have multiple companies in FMS, each company you want to convert to Vision goes
through its own migration process. If you purchase the Vision Multicompany feature, your
converted FMS data for all companies are merged into a single database. If you don't purchase
the Multicompany feature, each company’s information goes into a separate database.
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Consolidation and Elimination Companies

While you can do consolidated financial reporting in Vision, it is accomplished in a different way
than it is in FMS. Because of this, the conversion does not convert consolidation accounts.

If you have a consolidation company the sole function of which is to produce consolidated
financial reports, there is no reason to convert that company. However, if you have a
consolidation company that represents an actual financial entity as well as being used for
consolidated reporting, you can convert that company to a Vision company. The detail accounts
set up in that company are converted but the consolidation accounts are not.

If you set up an elimination company in FMS so you could enter adjusting entries to eliminate the
effect of intercompany activity in your consolidated financial reports, there is no point in
converting that company.

Archive Companies

If you have created archive companies and used the Business Management Data Archiving tool
to archive project data in those company databases, you cannot convert those companies or their
data to Vision.

Prepare Vision for the Migration

We recommend that you install or upgrade to the latest version of Vision before beginning the
conversion process, so you can benefit from the latest enhancements to the conversion.

If you want to convert to an earlier version, discuss it with your Vision consultant to make sure
you understand all of the pros and cons of that decision.

Hardware and Software Selection

As part of the planning process, our Technical Services staff will help you choose and configure
any new hardware or software you need in order to run Vision.

We will evaluate your current equipment and determine your needs in the following areas:
= Workstation requirements
=  SQL Server database requirements
= Server requirements
=  Bandwidth requirements
= Licensing requirements

For more detailed information about Vision hardware and software requirements, and technical
specifications for running the software, see the Deltek Vision Technical Installation Guide, which
is available from the Customer Care Connect site at https://deltek.custhelp.com.

Installing Vision

You should install Vision and the demonstration database as soon as you want to access Vision
at your site. You should do this before you send your FMS data to Deltek for conversion so you
can load the Vision database as soon as it is available and begin verifying the conversion results.

For complete instructions and a detailed explanation of the Vision installation process, see the
Deltek Vision Technical Installation Guide, which is available from the Customer Care Connect
site at https://deltek.custhelp.com.
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During the Vision installation process, you will be asked to supply your database server name,
your database name, your database username, and your database password. When you enter
your database name, be sure to enter the name you gave to your newly converted database.

After you have installed Vision, you must log on and activate the modules you have purchased
before you can begin using the application. You will also need to complete some configuration
tasks. See “7: Preparing to Test and Go Live on Deltek Vision” on page 159.

Plan the Migration

Client Implementation Team

Several functional areas are involved when you implement Deltek Vision. The team that plans
and implements the conversion consists of the following roles:

Title 200][C]

Executive Sponsor The executive sponsor is the system champion/cheerleader/enforcer —
responsible for securing commitment from executive management,
department/office management, accounting, marketing, and project
managers.

The executive sponsor reviews the major decisions made about Vision
and ensures that your firm’s needs have been met.

Senior management support is perhaps the single most important
aspect of a successful implementation. Vision is normally chosen
because of a need to standardize processes to benefit from an end-to-
end system. The executive sponsor needs to be involved in identifying
and implementing changes to your internal processes to ensure that
you get full benefit from the comprehensive nature of the Vision
product.

Coordinator The coordinator has overall responsibility for the implementation of
Vision software at your firm. The person in this role deals with issues
relating to policy and procedures. The coordinator ensures that all
groups’ requirements are considered in the implementation decisions.

The primary role of the coordinator is as the high-level liaison between
your firm and Deltek, and among all internal groups using management
information generated by Vision. This individual, usually a senior-level
manager, performs an integrative function, rather than providing
technical expertise on Vision.

Application The application administrator develops a thorough understanding of the
Administrator application through the implementation process with the Client
Implementation Team and Deltek. Thereafter, this person performs the
ongoing day-to-day administration of the system and leads the internal
training effort.

The role of the application administrator is primarily production-
oriented. This individual must have an overall knowledge of Vision
applications and operations (including Info Center maintenance, data
entry, and report production), and a basic understanding of accounting
and project management principles.

The application administrator becomes the Vision resource for your
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Title 200][C]

firm, and advises principals, project managers, marketing, and the
controller as they make decisions about the system. The
responsibilities of this position do not typically include the use of Vision
reports to make management decisions or the development of firm
budgets or project budgets.

To prepare for his or her responsibilities, the application administrator
should participate in administrator training, pilot training, and user
training.

The application administrator serves as your primary contact with
Deltek Customer Care. Daily support questions from those using Vision
should be routed first through the application administrator so that
person can become familiar with the common questions and the
specific needs of the users, and become the initial Vision resource for
your employees.

Information Systems
Representative

The information systems representative is responsible for the day-to-
day technical maintenance of Vision. A working knowledge of Windows
technologies, including SQL Server and Internet Information Server are
preferable.

Project Management
Representative

The project management representative is the liaison between the
coordinator and the project managers. This person ensures that the
needs of project managers are communicated to the coordinator and
considered during installation. The project management representative
works with the Deltek consultant to develop specific training programs
for the project management staff. He or she also participates in the
training programs along with a Deltek consultant.

Accounting Manager

The accounting manager oversees the entry of accounting and project
data into Vision. A large firm might have multiple accounting managers,
each with an area of specialization (for example, billing, accounts
payable, or payroll).

Office/Division
Administrator
(optional)

If your company has multiple offices or divisions, consider including a
second tier of part-time office/division administrators to provide input on
any unique business needs of the individual offices or divisions.

Planning Meeting

To ensure that your migration goes as smoothly as possible, one of our experienced Vision
consultants will meet with you to help you develop a migration plan.

During the planning session, the consultant and your team will do the following:

= Gather information from your senior managers, accounting staff, project managers, and
marketing personnel to assess each group’s Vision requirements.

= Review your current work breakdown structure (WBS) for projects, billing groups, phases,
labor codes, accounts, vendors, clients, and employees to determine if changes would be

beneficial.

= Review the Vision release schedule.
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= Demonstrate the Vision user interface.
= Demonstrate Vision’s new features and reporting capabilities.
= Analyze the differences between Vision and FMS to see how they will affect your firm.

= Discuss how internal procedures might be improved to make the most of the features in
Vision.

= Discuss options for mapping and importing data stored in applications other than FMS.

= Help you create a data entry plan for Vision.

= Review interfaces with other applications and determine how to maintain these interfaces
in Vision.

= Discuss the special responsibilities or roles that your staff must assume during the
migration process.

= Determine whether you need additional hardware or software to run Vision.

= Discuss the steps you should take to prepare your FMS data for conversion.

= Schedule the major phases in the migration process, including data preparation,
conversion, and segment testing.

= Choose the date you will begin processing “live” on Vision.

= Determine whether your firm needs any custom reports or processes to supplement the
standard options available in Vision.

= Plan a training program for your staff.

Prepare FMS for the Migration

Install the Required Version of FMS

To convert to from Deltek FMS to Deltek Vision, you must be using the SQL Server version of
FMS, and you must install the latest version of FMS.

Unlock the Vision Conversion Module

When you purchase Vision and select your conversion level, you receive a new serial number
and activation key that adds the Vision Conversion module to your FMS system.

To unlock the Vision Conversion module, complete the following steps:

1. Log on to your stand-alone computer or, if you're installing on a network file server, log
on to the network as a user with Supervisor or Administrator rights.

2. Run WUP_DATE.EXE. This program file is located in the folder in which you installed
Deltek FMS.

3. When the Update Deltek FMS dialog box opens, click Options.

4. On the expanded dialog box, click Brand.

5. On the Serial Number dialog box, enter the serial number and activation key.
6. Click OK.

If you're running FMS on a network, you need to perform this procedure only once to update the
database on the network file server. Individual workstations automatically receive access to the
Vision Conversion module after the server installation is complete.
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Make and Record the Migration Decisions

Once you've installed the required version of FMS and unlocked the Vision Conversion module,
you're ready to make decisions about how you want your data converted and to record those
decisions using the Vision Conversion module. The next few chapters describe why each of those
decisions is necessary and provide guidelines for making the right decisions for your situation.

Run the Preconversion Utilities

When you have finished using the Vision Conversion module to record the migration decisions
that apply to your conversion and you have completed any additional data preparation tasks, the
next step is to run a set of preconversion utilities to ensure that your migration decisions are
ready for the conversion. Do not submit your FMS data for conversion if you have not run all of
those utilities and resolved as many of the problems as you can.

See “Run the Preconversion Utilities” on page 152 for a description of this important step in the
migration process.

Run FMS Reports

Deltek recommends that you run a set of selected reports just before you send your FMS data to
your Vision consultant for conversion. When you receive the converted data, you can then print
comparable reports in Vision and compare the two sets of reports to verify that the two systems
balance.

For a list of the reports and complete balancing instructions, see “8: Balancing Vision to FMS
Following Data Conversion” on page 164.

Submit a Copy of Your FMS Database for Conversion

A Vision consultant performs the actual data conversions. Normally, he or she does a trial
conversion first so you can review the data in Vision. Once you are happy with the results, the
consultant performs a final conversion of your current FMS data.

Your last task before the conversion is to make a backup copy of your FMS data and send it to
the consultant. See “Create the Backup Copy and Submit It for Conversion” on page 157 for
details.

Convert Your Deltek FMS Database

During the time you have been using Deltek FMS to process data, you have likely accumulated a
huge store of information about your firm's finances, projects, clients, and employees. No doubt
you'll want to transfer this data from FMS into Deltek Vision as quickly and efficiently as possible
so that you can start using Vision to process your firm’s business transactions. The time that
Deltek has your data for conversion can vary from one to four days.

Test Conversion

To ensure the best conversion results, complete a test conversion a few months before the final
conversion. The test conversion does the following:

= Enables you to confirm that the way you have chosen to change your FMS data to fit with
Vision features is optimal

= Enables you to confirm that our conversion program works correctly with your data and
that the resulting database is satisfactory

= Provides you with an experimental database to use for testing and staff training.
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Final Conversion

The final conversion takes place at the time you begin processing “live” on Vision. Picking the
best date to go live takes careful planning. Choose a date that minimizes the impact on your
accounting and payroll processes, your billing cycle, and your reporting schedule.

At least one day before your scheduled conversion, you send your prepared FMS data to Deltek
by either uploading it to the Deltek ftp site or by overnighting it to the Deltek consultant who is
performing the conversion.

Before running the conversion, the consultant reviews key elements of the data. If you request
that Deltek perform some of the preconversion steps, or if there are data problems that you are
unable to resolve on your own, the consultant also takes care of those tasks. He or she then runs
the conversion to create the Vision SQL database.

Data Verification

Following the conversion, the Vision consultant prints key FMS and Vision reports and compares
them to ensure that the data converted correctly. You are encouraged to perform this check
yourself when you receive the converted data.

After verifying the data, the Vision consultant prepares a report indicating any differences found
and emails it to you along with natification that your Vision database is available on the Customer
Care Connect site. You can then download and install the database.

Load and Evaluate the Converted Data

When you receive the test conversion data, you load it into your Deltek Vision database and
evaluate it to make sure you selected the correct conversion options and to confirm that the data
conversion was successful and satisfactory.

Test Plan

In preparation for this step of the migration process, you prepare a detailed testing plan with the
help of your Vision consultant. The plan should include staff assignments for testing individual
modules or processes, procedures for reporting problems, and a schedule for completing the
testing and addressing any issues.

Evaluation
The evaluation of the conversion results should include the following:

= Comparing selected Deltek FMS and Vision reports to confirm that the two systems
balance. (See “8: Balancing Vision to FMS Following Data Conversion” on page 164)

= Verifying Info Center data. (See “Verify Info Center Data” on page 173)

= Performing segment testing. (See “Perform Segment Testing” on page 173)
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Go Live on Deltek Vision

As part of planning your migration to Deltek Vision, you must choose a “go live” date—the date on
which you plan to stop using Deltek FMS and begin processing solely with Vision. The date you
choose depends upon several factors:

= Payroll, billing, and payment cycles
= Staff availability (for example, holidays, other critical assignments)
=  Availability of data needed for cut-over

In preparation for your “go live” date, you must restore the final conversion database and
configure your application and security settings just as you did when you created your test
database.

You may be able to import some configuration and other settings from your test database into
your live database. For example, you can copy security from the test database to the live Vision
database. These steps are billable and need to be arranged in advance with your Vision
consultant.

Because the go live date marks the beginning of “live” processing in Vision, you should not
perform any processing in FMS after that date.
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Chapter 2: Migration Decisions — Conversion
Setup

Before your Deltek FMS data can be converted, you must make a number of key decisions.
These migration decisions instruct the conversion program how to transform your FMS data into
Deltek Vision data.

For the most part, these decisions are necessary because FMS and Vision, while serving the
same general function for professional services companies, are very different in a number of
ways. While they have many data items in common, each also contains information not present in
the other. As a result, some FMS data is not converted at all, and some can only be converted
using the guidance you provide by making the migration decisions described in this and
subsequent chapters.

The migration decision sections have two primary purposes:

= Use them to become generally familiar with the important conversion issues before you
meet with your Vision consultant to discuss your particular conversion in detail.

= Use them after that meeting as needed to refresh your understanding of the migration
decisions and to serve as a guide and checklist for making those decisions.

Each major topic in these chapters discusses a single migration decision or a group of closely
related migration decisions. Each topic provides background information to help you understand
how FMS and Vision compare, why the decision is necessary, and what the key factors are, as
well as guidelines for making the decisions.

What to Do After You Make the Decisions

The purpose of the Vision Conversion module in FMS is to record your migration decisions so the
conversion program can act on them. Once you make a decision or a group of decisions, you can
record them in the Vision Conversion module. You don’t need to wait until you've made all of the
decisions.

That said, however, because some migration decisions depend on others, it is generally
important that you make and record your decisions in the order they are presented in this guide.
That sequence follows the sequence of options on the Maintain menu in the Vision Conversion
module and, within individual dialog boxes, the sequence of tabs from left to right.

Each migration decision topic indicates where to go in the Vision Conversion module to record
that decision. And if you need help working with the dialog boxes, see Chapter 4.

Conversion Type Decision

If you purchased the Basic conversion, you can convert only the types of information that reside
in the Deltek Vision Info Centers (projects, clients, vendors, employees,...).

If you purchased either the Standard or Premium conversion, you have two basic types of data
conversion processes to choose from:

= You can convert only the types of information that reside in the Vision Info Centers.

= You can convert both Info Center information and transaction records (AP invoices, AR
transactions, receipts, and so on).
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Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu. On the General tab, select the option you want under Conversion Type.

If you need help using this tab, see “Vision Conversion Setup Procedures: General Options” on
page 117.

Select the type of conversion you
want.

— ¥ision Conversion Setup

Acpounts WBS Labor Codes Ety

Conversion Type
O Info Center Only

(& Info Center and Transactions

Vision Information
Application Yersion: 5.0 (Build 5.0.255)
Using Vision Payroll

[[JUsing Vision Resource Planning

Default Checkbook: | Checking @

First National Bank

Guidelines

Most companies that purchase the Standard or Premium conversion choose to convert both Info
Center information and transactions. However, some companies are not satisfied with how they
set up Deltek FMS originally and would prefer to convert only their master file information
(employees, clients, projects, and so on) and start fresh with transaction entry in Vision.

If you choose to convert only Info Center data, you are, as far as GL balances and transaction
history are concerned, the same as a new, non-converting Vision client. In that situation, there
are some minimum history loading requirements that you must meet in order for Vision to function
properly. Refer to the chapter on history loading in the Deltek Vision Implementation Guide for
more information.

If you decide to convert only Info Center data, some of the migration decisions do not apply to
your conversion because they affect only the conversion of transactions.

General Vision Decisions

The Vision consultants who will convert your Deltek FMS data to Deltek Vision need to know the
following:

= What version of Vision you will be using at the time of the conversion

=  Whether you will be using Vision Payroll, and if so, whether you will convert Payroll Plus
data to Vision

=  Whether you will be using Vision Planning
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Recording Your Decision in the Vision Conversion Module

To record your decisions in the Vision Conversion module, click Vision Conversion Setup on
the Maintain menu. On the General tab, record your decisions under Vision Information. As long

as it is clear what version of Vision you are using, the exact format of the entry in Application
Version doesn’t matter.

If you need help using this tab, see “Vision Conversion Setup Procedures: General Options” on
page 117.

Enter your version information and
indicate if you're using Vision Payroll
or Resource Planning. If you are using
Vision Payroll, also indicate if you
want to convert Payroll Plus data.

Vision Conversion Setup

General Accounts Labor Codes

Conversion Type
O Info Center Only

(%) Info Center and Transactionfs

Vision Information
Application Version: 5.1 (Build 5.1.251)
Using Vision Payroll

Convert FMS Payroll to Vision Payroll

[[JUsing Vision Resource Planning

Default Checkbook: | Checking! |

First National Bank

Guidelines: Vision Version
To determine the version of Vision that you are using, complete the following steps:
1. Click E Help on the Vision toolbar.

2. Onthe Help menu, click About.

3. On the About dialog box, locate your current version next to Application Version.
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Click here and then click on About
on the Help menu to open the
About dialog box.

MCMC_PS test of changing company - Period Ending 1/6/2008 - v6.0 (Limited Release 1) (- (0| X|
) Dashboz & Searc Options ™ (2) Help'™~
This is your 4 Dashboard earch [ ption 2) Help
current version
of Vision.

)

Lile ¥ Print v (2) Help

Application Yersion: 6.0 (Limited Release 1) (6.0.0.720)
Client Version: 6.0.0,720 (client)

Database Version: 6.0.700

Application Server: CAMQAWSLUNA - Microsoft Windows Server 2003 (Service Pack 2)
SQL/MSDE Server: camdbtst1 - Version 9,00,3054.00 (Enterprise Edition)

Database Name: VisionDemoLunaMCMC - VisionDemolLunaMCMC (camdbtst1)

Report Server: CAMQARPTLUNA (Root Folder: YISION)

Report Server Url: http: [JCAMQARPTLUNASREPORTSERYER

Report Server Yersion:  Microsoft SQL Server Reporting Services Version 9.00,3310.00 (Standard)
Enabled Languages: Endglish {International), English (United States)*

Motice: This software is ‘commercial computer software' as defined in DFARS 252,227-7014 and FAR 12,212 and
software documentation is commercial ‘technical data' as defined in DFARS 252.227-7015 and FAR 12,211, As use,
modification, reproduction, release, performance, display, or disclosure of this commercial software shall be in strict
accordance with the manufacturer's standard commercial license which is attached to and incorporated in the
governing Government contract. Manufacturer is Deltek Systems, Inc., 13880 Dulles Corner Lane, Herndon V& 20171,
© Deltek Systems, Inc. 2008 Unpublished-rights reserved under the copyright laws of the United States,

Visit Deltek Systems, Inc. on the Internet at http:/fwww,deltek.com

\i_.._...QL(...._....i‘ Details>> H Heln

Guidelines: Vision Payroll

If you are going to use Vision Payroll, regardless of whether you are now using or converting
FMS Payroll Plus, select Using Vision Payroll. If this check box is selected, Vision Payroll is
enabled, and payroll-related employee data and other information that wouldn’t otherwise be
converted are converted to Vision.

Guidelines: Deciding to Convert Payroll Data

If you have been using Payroll Plus in FMS and you are going to use Vision Payroll, you have the
option to convert payroll information.

Nearly all Payroll Plus users who are going to use Vision Payroll, do convert at least their current
data. Along with converting existing payroll transactions, the conversion sets up employee taxes
and adjustments for you, tasks that would require a lot of time to do manually in Vision. About the
only reason for not converting is if you're not happy with the way Payroll Plus is set up, and you
determine that it will be easier to start fresh in Vision.
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Guidelines: Vision Planning

If you are going to use Vision Planning, select Using Vision Resource Planning. If this check
box is selected:

=  Employee rate information is used to set up provisional rates in Vision.

= Employee percent of direct hours budgets are converted to utilization ratios in Vision.

Default Checkbook Decision

Before the conversion, you need to specify the Deltek FMS checkbook for the bank account you
want to be used by default for converted AP transactions in Deltek Vision that require a bank
code.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, and select the default checkbook in Default Checkbook on the General tab.

If you need help using this tab, see “Vision Conversion Setup Procedures: General Options” on
page 117.

i— ¥ision Conversion Setup

General Accounts WBS Labor Codes E

Conversion Type
O Infa Center Only

(%) Info Center and Transactions

Vision Information
Application Version: 5.1 {(Build 5.1.251)
Using Vision Payroll
Convert FMS Payrall to Vision Payroll
[JUsing Vision Resource Planning

Default Checkhook: | Checkingl

First National Bank

Select the default checkbook.

Background

Checkbooks set up in FMS are converted to bank codes in Vision. Most AP transactions in Vision
require the assignment of a bank code from which Vision gets the cash account for implicit entries
in cash-related transactions. When the conversion program creates AP transactions in Vision
from FMS transactions, it assigns, by default, the bank code created from the checkbook you
specify in Default Checkbook on the General tab.

Guidelines

Select the checkbook you use most often when paying AP invoices.
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Country in Addresses Decision
You have two options for converting the country portion of addresses in Deltek FMS:

= You can convert the country for an address only if it differs from the FMS company’s
country.

= You can always convert the country for an address.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu. On the General tab, select the option you want under Country in Address. If you
need help, see “Vision Conversion Setup Procedures: General Options” on page 117.

Indicate how you want to convert the
country portion of addresses.

GL Budgets FMS Miscellaneous BM

Country in Address
() Convert Country Only ¥when Different Than Company's Country

) Always Convert Country

vendars

[] Convert Active Vendors Only

[v] Assign Hold Payment Terms to Vendors with Hold Status in FMS

[] Convert Vendor Discount Information

Transactions to Convert

Only Convert AP Invoices, Employee Expense
Sheets, and Purchase Orders Dated On or After | 15172005

[] convert Open AP Invoices and Employee Expense Sheets Only

[C] convert Open Purchase Orders Only

Background

FMS requires an entry in Country for contact, client, vendor, employee, and company addresses.
When printing documents such as checks and government forms, however, FMS only prints the
country if it is different than the country in the FMS company’s primary address. In Vision, if the
address includes a country, it is always printed as part of that address. Because of this difference,
you must indicate how you want the country portion of addresses handled.

Guidelines

If you want... Then select...

The country printed only when it is different than | Convert Country Portion of Address Only
the country in the company’s primary address When Different from Company’s Country.

The country included whenever addresses are Always Convert Country Portion of
printed Address.
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Company Primary Address

The country for the company’s primary address is always converted.

Inactive Vendors Decision

You can convert all of your Deltek FMS vendors, active and inactive, to Deltek Vision vendors, or
you can choose to convert only your active vendors.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu. On the General tab under Vendors, select or clear the Convert Active Vendors
Only check box.

If you need help using this tab, see “Vision Conversion Setup Procedures: General Options” on
page 117.

FMS Miscellaneous BM

Employees GL Budgets

Country in Address
() Convert Country Only ¥when Different Than Company's Country

) Always Convert Country
Vendors
[l Convert Active Yendors Only

[] Gonvert Vendor Discount Information

5sign Hold Payment Terms to Vendors with Hold Status in FMS

Trangiactions to Convert

Only Convert AP Invoices, Employee Expense
Shaets, and Purchase Orders Dated On or After | 15172005

(] conyert Open AP Invoices and Employee Expense Sheets Only
Clcony

rt Open Purchase Orders Only

Check this box if you only want to convert
active FMS vendors to Vision vendors.

Guidelines

If you've accumulated vendors in FMS that you no longer use, select Convert Active Vendors
Only to clean up your vendor list when you move to Vision. If you don’t select Convert Active
Vendors Only, all vendors are converted. In some special cases, inactive vendors are converted
to Vision even when you select Convert Active Vendors Only:

= If any open AP invoices or purchase orders are converted for an inactive vendor, that
vendor is also converted.

=  When you mark an employee as terminated in FMS, the vendor linked to the employee
for employee expense entry is marked as “inactive” in the FMS database. However,
those vendors are always converted to facilitate the conversion of employee expenses.

= Aninactive vendor designated as the vendor to receive payment for a charge account is
always converted.
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If you select Active Vendors Only and later change the active status of a vendor in the Firms
dialog box, it's conversion status changes automatically. However, when you enter a transaction
for an inactive vendor and are prompted to make the vendor active, the conversion status does
not change automatically in that situation.

The Convert Active Vendors Only check box can affect which AP transactions are converted if
you are converting all transactions or transactions dated after a cutoff date. Normally in those
cases, all transactions, open or closed, that satisfy the date requirement, if any, are converted.
However, if you select Convert Active Vendors Only, closed transactions for inactive vendors
are not converted.

Vendor Hold Status Decision

You have two options for handling default payment terms assigned to vendors in Deltek Vision
that have the Hold Payment status in Deltek FMS:

= The conversion can assign the Hold payment terms to those vendors in Vision.

= The conversion can assign their Vision payment terms based on each vendor’s default
payment terms in FMS.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu. On the General tab under Vendors, select or clear the Assign Hold Payment
Terms to Vendors with Hold Status in FMS check box.

If you need help using this tab, see “Vision Conversion Setup Procedures: General Options” on
page 117.

GL Budgets FMS Miscellaneous BM

Employees

Country in Address
(¥) Convert Country Only When Different Than Company's Country

(O Always Convert Country

Yendors

[] Convert Active Vendors Only

[¥] Assign Hold Payment Terms to Yendors with Hold Status in FMS

[ J\convert Vendor Discount Information

Trangactions to Convert

Only Convert AR Invoices, Employee Expense
Shieets, and Purchase Orders Dated On or After | 1/1/2005

[ codvert Open AP Invoices and Employee Expense Sheets Only
[] contert Open Purchase Orders Only

Indicate if you want vendors with the Hold
Payment status to be assigned the Hold
payment terms in Vision.
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If you want payment terms for these vendors to be...

On hold Select the check box.
Determined by their default payment terms in FMS Do not select the check box.
Background

In FMS, if you want a vendor’s invoices assigned the Hold Payment status by default, you can set
the status of the vendor to Hold Payment without changing the vendor’s default payment terms. In
Vision, you accomplish this by assigning Hold as the vendor’s payment terms.

Guidelines

If you select Convert All FMS Vendors with the Hold Payment Status to Have Hold as the
Payment Terms in Vision, the conversion program assigns Hold as the payment terms for these
vendors. If you later want to remove this restriction for a vendor, you can assign different terms in
the Vendors Info Center.

If you don'’t select this check box, the conversion program assigns payment terms in Vision based
on the default payment terms in FMS. If you enter a new invoice for the vendor in Vision, it will not
be on hold by default.

This decision does not affect existing invoices for these vendors. If you convert an invoice that is
on hold in FMS, it will still be on hold in Vision.

Vendor Discount Information Decision

For vendors with Deltek FMS payment terms that offer discounts, you have the option to retain or
discard the discount information when the vendors are converted to Deltek Vision.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu. On the General tab under Vendors, select or clear the Convert Vendor
Discount Information check box.

If you need help using this tab, see “Vision Conversion Setup Procedures: General Options” on
page 117.
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GL Budgets FMS Miscellaneous BM

Employees

Country in Address
(® Convert Country Only When Different Than Company's Country

O Always Convert Country

Vendors

[[] convert Active Vendors Only

[“] Assign Hold Payment Terms to Vendors with Hold Status in FMS

[] Convert Vendor Discount Information

Transactions to Convert

Okly Convert AP Invoices, Employee Expense
Shgets, and Purchase Orders Dated On or After | 1/1/2005

[[] Conyert Open AP Invoices and Employee Expense Sheets Only
[ convirt Open Purchase Orders Only

Indicate if you want to convert vendor
discount information.

Background

In FMS, discounts are set up as part of payment terms and can be changed for individual vendors
and for individual invoices. You can set up discount availability based on a certain number of
days past the invoice date or based on a certain date (day of the month).

In Vision, discounts are handled separately from payment terms and are always based on a
specified number of days past the invoice date. There is no option to set up a discount that can
be taken if payment is made before a certain day of the month.

Guidelines

If you take discounts in FMS Accounts Payable and discount availability is most often based on
paying the invoice a certain number of days after the invoice date, select Convert Vendor
Discount Information. The conversion program will set up the vendors’ discount information in
Vision to match the discount information in the vendors’ default payment terms in FMS.

If discount availability is most often based on a day of the month in FMS, you may not want to
select Convert Vendor Discount Information, because Vision doesn’t support that type of
discount. If you do decide to assign discount information as part of the conversion, Next (pay in
next check processing run) is assigned as the payment terms for vendors with terms based on a
day of the month. In either case, you should review discount information in Vision after the
conversion to make sure that it is correct for all vendors.

Accounts Payable Transactions, Employee Expenses, and
Purchase Orders to Convert Decisions

If you are converting transactions, you must indicate which of your AP transactions, employee
expense sheets, and purchase orders you want to convert to Deltek Vision. You can convert all of
these transactions, or you can restrict the conversion to your most recent transactions or to
transactions with an existing balance.
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Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu. On the General tab, use the check boxes under Transactions to Convert to
indicate if you want to restrict the transactions that are converted. If you need help using this tab,
see “Vision Conversion Setup Procedures: General Options” on page 117.

Employees GL Budgets FMS Miscellaneous BM

Country in Address
(& Convert Country Only When Different Than Company's Country

O Always Convert Country

Vendors
[[] Convert Active Vendors Only

Assign Hold Payment Terms to Vendors with Hold Status in FMS

[[] Convert Vendor Discount Information

Transactions to Convert

Only Convert AP Invoices, Employee Expense
Sheets, and Purchase Orders Dated On or After | 1/1/2005

[[]convert Open AP Invoices and Employee Expense Sheets Only
[[] Convert Open Purchase Orders Only

Use these check boxes to restrict the
conversion based on a cutoff date or
based on the existence of a halance.

Background: General

The conversion converts AP invoices, employee expenses, and purchase orders in Deltek FMS
into AP vouchers, employee expenses, and purchase orders in Vision. Payment information is
also converted.

During the first conversions of Deltek clients from FMS to Vision, we learned that much of the
time the Vision consultants spent “cleaning up” the converted data was a result of data left over
from an earlier conversion from the DOS version of FMS to the Windows version. This data did
not cause problems in FMS for Windows but either caused the conversion to Vision to fail or
made the resulting Vision data unsatisfactory. Other conversion difficulties are caused by data
created as a result of problems in early versions of FMS for Windows or because of past system
failures, particularly those involving the non-SQL Server version of FMS.

Guidelines: General

In general, if you reduce the amount of data you convert, you also reduce the number of
conversion problems, and you start with a “cleaner” database as you move forward with Vision.

Because of this, we recommend that, if possible, you use one of the options to limit the AP
transactions, employee expense sheets, and purchase orders that are converted to Vision. This
recommendation is for all converting FMS clients, but it is particularly crucial that you limit the
data you convert if you are one of the FMS clients that converted from the DOS version of FMS.
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If you don’t convert all of your AP transactions, employee expenses, and purchase orders, you
should keep your FMS system operational in case you need to retrieve historical data.

Guidelines: Selecting Transactions Based on a Cutoff Date

Most converting FMS clients choose to limit the transactions converted based on a cutoff date.
We recommend that, if possible, you only convert transactions dated within the last year or two.

If you purchased the Standard conversion, you have already made this decision. The cutoff date
is set automatically to the first day of the year, two years prior to the current fiscal year, and you
cannot change it. For example, if the date you enter the setup information in the Vision
Conversion module is 11/15/09 and your fiscal year starts on January 1, the cutoff date is set at
1/1/07. You get two full prior years of transactions and all transactions for the current year to date.

The actual date you specify doesn’t matter. The first day of a calendar or fiscal year is a
convenient choice, but it isn’t necessary to pick one of those. And this cutoff date need not be the
same as other cutoff dates you're using for the conversion.

When you use this option, if any of the key dates for a transaction falls on or after the cutoff date,
that transaction is converted. For an invoice, for example, the conversion compares invoice date,
effective date, and payment dates to the cutoff date.

Normally, all transactions, open or closed, that satisfy the date requirement are converted.
However, if you select Convert Active Vendors Only, closed transactions for inactive vendors
are not converted. (If there are open transactions for inactive vendors, both the transactions and
the vendors are converted, even though Convert Active Vendors Only is selected.)

If you specify a cutoff date, manual payments to an account are also included or excluded from
the conversion based on that date.

Guidelines: Selecting Only Open Transactions

The option to convert only open AP transactions and employee expenses isn't used often, but it
provides a way to drastically cut the AP data going to Vision while still sending over those
transactions that you need to deal with in the near term.

If you're only interested in converting purchase orders for which there are still items to be
received, select Convert Open Purchase Orders Only. If you do this, purchase orders marked
as “closed” are not converted.

These two options are not available if you elect to restrict the conversion using a cutoff date.

Migration Briefing: Chart of Accounts Conversion

While defining general ledger accounts in Deltek Vision is similar in many ways to how you do it
in Deltek FMS, there are some key differences that may have a significant effect on how your
FMS chart of accounts is converted to the Vision chart of accounts and what you need to do to
prepare for the conversion of your accounts.

This briefing describes the differences between the FMS and Vision charts of accounts, identifies
the key differences, and explains how the key differences affect the conversion.
For More Information
For more information related to the conversion of the chart of accounts, see:
= “GL Account Number Structure Decision” on page 29

= “GL Expense Account Ranges Decisions” on page 30
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= "FMS Accounts-to-Vision Accounts Mapping Decisions” on page 72

= "Expense Codes-to-Accounts Mapping Decisions” on page 78

FMS Chart of Accounts: The Basics

In FMS, the total number of characters in your account numbers can be as few as 1 or as many
as 15, plus separators. The account number can comprise from one to four account divisions.

Each account is assigned to one of five account types: Asset, Liability, Equity, Income, and
Expense. While you can define the account number ranges making up each account type in any
way you want in FMS, most companies set up their accounts so that all accounts of a particular
type fall into a single range and the account type ranges follow the sequence in the preceding
sentence: asset accounts in the lowest numbered range, liability accounts in the next highest
range, and so on.

You can have summary accounts and consolidation accounts in FMS as well as detail accounts.

Vision Chart of Accounts: The Basics

In Vision, the account numbers can have from 3 to 13 characters, including the separator (called
a delimiter in Vision), if you use one, and a maximum of two divisions.

Like FMS, Vision uses account types. However, it has more types:

= Asset
= Liability
= Net Worth

= Revenue

= Reimbursable

= Reimbursable Consultant
= Direct

= Direct Consultant

= Indirect

= Other

The Other account type is for accounts for below-the-line revenue or expenses, such as rental or
interest income.

As in FMS, the account numbers do not have to be grouped into ranges by account type, though
that is the common practice. And if you do group by account type, the account type ranges can
be in any order.

Vision does not have summary accounts and consolidation accounts, so those types of FMS
accounts are not converted.
Chart of Accounts Conversion: The Basics
To prepare for the conversion of your chart of accounts, you do the following:
1. Specify the structure you want to use for Vision account numbers.

2. Specify the FMS main account number range that corresponds to each Vision expense
account type.

3. Map individual FMS detail account numbers to Vision account numbers.
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In most cases, however, because of differences between the two systems, you must complete
some additional tasks before you can map the accounts.

Key Difference: Expense Accounts

The Vision distinction between a reimbursable expense and a direct expense has important
implications for the conversion of the FMS chart of accounts.

= Areimbursable expense in Vision is an expense that, under the terms of the contract, is
or could be billed as a separate line item on a client invoice. These expenses correspond
to project expenses in FMS that have Yes or Hold in Bill?.

= Adirect expense is a project-related expense that you bill as part of a fixed fee or that
you are unable to bill. In FMS, such expenses would have Fee, WriteOff, or No in Bill?.

In Vision, the expense accounts are crucial for the correct processing of project expenses.
Though Vision has expense codes, they have a different function than they do in FMS; Vision has
no true equivalent to the FMS expense code. When you enter an expense in Vision, it is the
expense account that both identifies the type of expense (airfare, rental car, and so on) and
determines whether it goes into the billing process or not. As a result, two expense accounts are
needed for each type of project-related expense: one account (a reimbursable expense account)
that you use when the expense is to be explicitly billed to the client and another account (a direct
expense account) that you use when the expense is not to be billed or is to be billed as part of
fixed fee billing. In FMS, on the other hand, the same expense account is used in both cases.

Here’s an example. In your FMS chart of accounts, you have a Travel direct expense account,
5121, that is assigned to a Travel expense code. When you enter a project-related travel expense
in FMS, you enter the expense code and project information, and you use Bill? to indicate how or
whether the expense is to be billed. To accomplish the same thing in Vision, you could set up a
Reimbursable Travel expense account, 5121 and a Direct Travel expense account, 6121. When
you enter a project-related travel expense, you would enter it for 5121 if the expense is billable as
a separate charge and for 6121 if it is not billable or is billed as part of a fixed fee billing amount.

Because of this difference, most companies must add the second set of project-related expense
accounts required in Vision to their FMS chart of accounts. While it is not required, most
companies also shift ranges of expense accounts during the account mapping procedure so that
the resulting Vision accounts are numbered in a logical sequence and the new direct expense
account numbers are grouped with other expense accounts in that sequence (after the
reimbursable expense accounts and before the indirect expense accounts, for example).

Another difference is that Vision has separate account types for subcontractor/consultant
expenses, both for reimbursable expenses and direct expenses.

Key Difference: “Other” Accounts

The Other account type is for accounts for below-the-line revenue or expenses, such as rental or
interest income. FMS has no equivalent account type. When you map your FMS accounts to
Vision accounts, you can change the default Vision account type for such an account to the Other
account type.

Key Difference: Account Number Structure

In FMS, account numbers can consist of a main account division and up to three other divisions.
The main account numbers correspond to basic categories of business activity, while the most
common use of the additional divisions is to create general ledger accounts for specific
operational units of the company (branch offices, regions, budget centers,...) or broad categories
of services (architectural, engineering,...). This enables you to print financial reports in FMS not
only for the company as a whole but also for individual operational units or categories of service.
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In Vision, the account number is intended in most cases to represent only a basic category of
business activity, much as the main account does in FMS. If you want to print financial or other
types of reports for operational units or types of services, you do that by defining an
organizational structure outside of the chart of accounts.

So what does this mean for your data migration? If you have single-division account numbers in
FMS, just make sure that the Vision account number length matches your FMS account number
length and review the default account mappings to verify that all of your FMS account numbers
are mapped to the matching Vision account number.

If you have multiple-division account numbers in FMS, the procedure is a bit more complicated.
Most converting Deltek clients who are using multiple-division account numbers do the following:

1. Define a Vision account number structure that matches the main account division in FMS.

2. Map all FMS accounts with the same main account number to an account number in
Vision that matches that main account number.

3. Convert the other FMS account number divisions to organization levels and organization
codes in Vision.

Example: Account Number Structure

Suppose you are using departments in Business Management, and your FMS account number
structure consists of three divisions: Main Account (four characters), Branch (one character), and
Department (two characters). The account number for Professional Services income for the
Architecture department (department 10) of the Chicago office (branch C) is 4111-C-10.

When you map your FMS data to Vision, you do the following:

1. Onthe Account Structure subtab of the Accounts tab in the Vision Conversion Setup
dialog box, you define the Vision account number structure to match your FMS main
account division: a single, four-character division with no delimiter.

2. On the Account Ranges subtab of the Accounts tab in the Vision Conversion Setup
dialog box, you specify FMS main account number ranges for the expense account

types.

3. Onthe WBS tab of the Vision Conversion Setup dialog box, you select Vision
Organizations under Convert FMS Departments As and select Convert FMS Account
Number Structures to Vision Organizational Levels. You also click the Set Up
Organization Codes button to review and, if necessary, make changes to the default
codes, and you click the Set Up Organizations button to assign names to the
organizations the conversion will create.

4. On the FMS Departments — Vision Organizations Mapping dialog box, you map your
departments to organizations.

5. Onthe FMS Accounts — Vision Accounts Mapping dialog box, you map all FMS accounts
to the Vision accounts that match their main account numbers. So account 4111-C-10 is
mapped to 4111 in Vision, as are all other FMS accounts that have the 4111 main
account.

When it converts your data to Vision, the conversion program sets up GL accounts in Vision
based on the account mapping and sets up organization levels and organization codes based on
your account divisions and division codes in FMS. Returning to the example, the conversion
would create Branch and Department organization levels, and among the organization codes
would be a C organization code at the Branch level and a 10 organization code at the Department
level, the two division codes from our example account number.
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If You Don’t Use Departments in Business Management

Some FMS clients have multiple-division account numbers but do not use departments in
Business Management. In that case, you are not given the option to create organization levels in
Vision based on your account number structure, because the conversion program would have no
way of knowing how to assign employees and projects to organizations. (If you use organizations
in Vision, every employee and project must be assigned to an organization.)

If you are in that situation and you want to use organizations in Vision, you must turn on
departmentalization in Business Management Control Information before you convert and assign
each of your employees and billing groups to a department. Before doing this, however, you
should discuss it with your Vision consultant to determine if this is the best approach for your
company.

GL Account Number Structure Decision

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, click the Accounts tab, and use the Account Structure subtab to specify the
structure of your Vision account numbers.

If you need help using this tab, see “Vision Conversion Setup Procedures: Account Structure” on
page 1109.

= Vision Conversion Setup

General i feconts G wes Labor Codes Emplovees 6L Budé

Account Structure Account Ranges ACCOL

Account Format Options
Display Leading Zeros

Account Length: 4

AddiRemove From
O Left

Account Delimiter Position 0 & Right

Account Delimiter

Sample Value 1234

Background

The most important difference between the account number structure options in Deltek FMS and
those in Vision is that FMS accounts can have up to three divisions in addition to the main
account division. These divisions enable you to print financial reports for individual operational
units or categories of service. In Vision, you accomplish this type of reporting by setting up an
organizational structure outside of the chart of accounts. GL accounts in Vision are essentially the
same as main accounts in FMS. Because of these differences, most companies that have
multiple-division account numbers find it necessary to change their account number structure
when they convert to Vision.

For more background information, see “Migration Briefing: Chart of Accounts Conversion” on
page 25.
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Guidelines: If You Have Multiple Account Number Divisions

Most clients with multiple account number divisions drop their extra divisions so that their Vision
account numbers have one division that matches their FMS main account division. Some,
however, also take the opportunity to increase the size of the account number during the switch
to Vision to provide room in their chart of accounts for more accounts.

Guidelines: If You Have One Account Number Division

Most clients with a one-division account number set up the conversion so that their Vision
account numbers match their FMS account numbers. Some, however, take the opportunity to
increase the size of the account number during the switch to Vision to provide room in their chart
of accounts for more accounts.

Guidelines: Using Two-Division Accounts in Vision

You have the option to create two-division account numbers in Vision, but keep in mind that the
reasons for doing so are not the same as they are in FMS. The additional division in Vision
accounts is primarily a way to identify sub-categories for accounts, not to provide enhanced
financial reporting as in FMS. Before you decide to use two divisions in Vision, you should
discuss the option with your Vision consultant.

Guidelines: Shortening Your Account Number

You can also choose to make your Vision account numbers shorter than your FMS account
numbers. Keep in mind that if you decide to decrease the number of characters in your account
numbers, it could mean that the characters that distinguish two account numbers from each other
are discarded. If this happens, the two FMS accounts will be mapped to the same Vision account
by default in the FMS Accounts — Vision Accounts Mapping dialog box.

GL Expense Account Ranges Decisions

By default, FMS accounts are mapped to Vision accounts based on their account type. For
example, all FMS income accounts with the 4111 main account are mapped by default to the
4111 Vision revenue account (assuming you defined the Vision account number structure to
match your FMS main account).

For expense accounts, however, FMS has only the Expense account type, while Vision has five
account types for expense accounts. To provide default mappings for the expense accounts, you
need to specify a range of FMS main account numbers for each type of Vision expense account.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, click the Accounts tab, and use the Account Ranges subtab to specify the range
of FMS main account numbers for each type of Vision expense account. If you need help using
this tab, see “Vision Conversion Setup Procedures: Account Ranges” on page 121.
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i ¥ision Conversion Setup E|E|EJ
General Accounts WHBS Lahor Codes Emplayees GL Budgets FMS Miscellaneous BM
Account Structure Account Ranges Accounting Periods
FMS Expense Ranges: Starting Ending
Reimbursable: 5000 5999
Reimbursable Consultant: | 5111 111
Direct: 8000 8999
Direct Consultant 8111 8111
Indirect: 5000 6999
Save ] [ Cloge
Background

FMS accounts with an account type for which a matching account type exists in Vision are, by
default, mapped to Vision accounts of that type in the FMS Accounts — Vision Accounts Mapping
dialog box. So FMS accounts with an account type of Asset, Liability, Equity (Net Worth in
Vision), and Income (Revenue in Vision) automatically appear on the corresponding tab in the
FMS Accounts — Vision Accounts Mapping dialog box.

However, while FMS expense accounts all have the Expense account type, Vision divides
expense accounts into five separate account types:

= Reimbursable

= Reimbursable Consultant
= Direct

= Direct Consultant

= Indirect

Because of this difference, you need to specify the range of FMS main accounts corresponding to
each Vision expense account type so the corresponding FMS accounts can be displayed on the
correct tab in the mapping dialog box. The only purpose of specifying the expense account type
ranges is to save you work in the FMS Accounts — Vision Accounts Mapping dialog box. The
ranges are not converted and in no way restrict how you number your Vision expense accounts.

Do not worry if a range you specify contains a few expense main accounts that should have
different Vision account types. You can change the default Vision account types in the mapping
dialog box. If an expense range contains a non-expense account, that has no effect on the default
mapping; Vision accounts mapped to FMS non-expense accounts are always assigned the same
account type that they have in FMS.

If an FMS expense account has a main account that does not fall within one of the expense
account ranges, the default Vision account it is mapped to is given the Indirect account type but
you can change that in the FMS Accounts — Vision Accounts Mapping dialog box.
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Your FMS chart of accounts is likely to have accounts that fall into each of the Vision expense
account type ranges. There are two important exceptions, however: the direct expense range
and the direct consultant range. In nearly every case, converting companies must both define a
new range of account numbers for direct and direct consultant expenses and create the accounts
themselves in FMS before mapping accounts.

For more detailed background information related to this migration decision, see “Migration
Briefing: Chart of Accounts Conversion” on page 25.

Guidelines: Reimbursable Expense Account Range

For the range of FMS main accounts for the Reimbursable account type, use the range of your
FMS direct project expense accounts.

Guidelines: Direct Expense Account Range

Because their FMS chart of accounts does not include a range for direct expense accounts
(“direct” as defined in Vision) and because they generally want that range to come immediately
after the range for reimbursable expense accounts, converting companies often find it necessary
to create space in the chart of accounts for the new range.

For example, in your FMS chart of accounts, direct project expense accounts (“direct” as defined
in FMS) fall in the 5000-5999 range and indirect expense accounts in the 6000-6999 range. In
Vision, however, you want to use 5000-5999 for reimbursable expenses and 6000-6999 for direct
accounts. Thus, the indirect accounts need to be moved to the 7000-7999 range to make room
for the direct accounts.

To accomplish such a shift, the most common approach is to do the following:

1. Identify an unused range within the numbering scope of your FMS main account numbers
that is large enough to accommodate the number of new direct expense main accounts
you need to set up.

2. Use the Create Mirror Image for Direct Accounts tool in the Vision Conversion module to
make copies of your existing FMS direct project expense accounts using main account
numbers that fall within the unused range. The existing FMS direct project expense
accounts will become your reimbursable expense accounts in Vision, and the copies will
become your Vision direct expense accounts.

3. On the Account Ranges tab of the Accounts tab in the Vision Conversion Setup dialog
box, specify the range of FMS main accounts that corresponds to each Vision expense
account type.

4. On the Reimbursable tab of the FMS Accounts — Vision Accounts Mapping dialog box,
verify that your original FMS direct project expense accounts are mapped to the correct
Vision reimbursable and reimbursable consultant expense accounts.

5. On the Indirect tab of the FMS Accounts — Vision Accounts Mapping dialog box, click the
Default Accounts/Organizations button, and use the Default Accounts/Organizations
dialog box to increment (increase) the Vision indirect account numbers to make room in
your Vision chart of accounts for the direct expense accounts.

6. On the Direct tab of the FMS Accounts — Vision Accounts Mapping dialog box, click the
Default Accounts/Organizations button, and use the Default Accounts/Organizations
dialog box to decrement (decrease) the default Vision direct and direct consultant
account numbers so that they follow the reimbursable expense accounts in your Vision
chart of accounts.

Thus, in the example, you use the tool to create the new set of expense accounts in the 8000-
8999 range. Then, in the FMS Accounts — Vision Accounts Mapping dialog box, you map the
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5000-5999 FMS expense accounts to the 5000-5999 accounts in Vision, the FMS 6000-6999
indirect expense accounts to the 7000-7999 accounts in Vision, and, finally, the new FMS direct
expense accounts (numbered 8000-8999) to the 6000-6999 accounts in Vision.

When you specify the FMS main account ranges on the Account Ranges tab of the Vision
Conversion Setup dialog box, you must enter valid main account numbers for the beginning and
ending accounts. Thus, before you can enter the main account ranges, you need to create the
FMS accounts that you want to map to Vision direct expense accounts.

These procedures are described in more detail in “FMS Accounts-to-Vision Accounts Mapping
Decisions” on page 72 and in “FMS Accounts — Vision Accounts Mapping Procedures” on page
134.

Guidelines: Consultant Expense Account Ranges

Vision differentiates between reimbursable consultant (subcontractor) expenses and other
reimbursable expenses, so you should specify the range you use for direct project subcontractor
expenses in FMS. Most companies have their subcontractor accounts grouped already, so this
isn’t normally a problem. If yours are not grouped, you may want to specify a range with a single
account number as the beginning and ending account, and then, in the FMS Accounts — Vision
Accounts Mapping dialog box, change the account type to Reimbursable Consultant for the other
accounts that should have that type.

The above discussion applies also to the direct consultant expense account range.

The consultant expense ranges are completely independent of the other three expense ranges.
The reimbursable consultant expense account range can be within the reimbursable expenses
range or it can be an entirely separate range. The same is true for the direct consultant expense
account range.

Accounting Periods Decisions

The conversion program creates fiscal periods in Deltek Vision based on the accounting periods
you have defined in Deltek FMS. Before the conversion, you need to do the following:

= Specify the first fiscal year that you want converted.

= Specify the latest accounting period you want converted. The conversion creates fiscal
periods for this period and all prior periods back through the first fiscal year to be
converted.

= Indicate the Vision fiscal year corresponding to the FMS fiscal year for the latest FMS
period to be converted. Prior fiscal years in Vision are determined by this entry.

Recording Your Decision in the Vision Conversion Module

To record your decisions in the Vision Conversion module, click Vision Conversion Setup on
the Maintain menu, click the Accounts tab, and use the Accounting Periods subtab to specify
accounting periods for Vision.

If you need help using this tab, see “Vision Conversion Setup Procedures: Accounting Periods
Options” on page 122.
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1 ¥ision Conversion Setup Q|§|®
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Account Structure Account Ranges Accounting Periods

General Ledger Beginning Year: 2005
Convert Periods Through: 2008 Movember hd
Wision Fiscal Year for FMS Fiscal Year 2006: 2006

Fiscal Year Conversion

FMS Fiscal Year | Fiscal Year Date Range | Vision Fiscal Year| A
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2005 11720048 - 1203102005 2005
2004 1172004 - 1203172004 2004

[ Save H Close

Background: General Ledger Beginning Year

During the first conversions of Deltek clients from FMS to Vision, we learned that much of the
time the Vision consultants spent “cleaning up” the converted data was a result of data left over
from an earlier conversion from the DOS version of FMS to the Windows version. This data did
not cause problems in FMS for Windows but either caused the conversion to Vision to fail or
made the resulting Vision data unsatisfactory. Other conversion difficulties are caused by data
created as a result of problems in early versions of FMS for Windows or because of past system
failures, particularly those involving the non-SQL Server version of FMS.

Guidelines: General Ledger Beginning Year

In general, if you reduce the amount of data you convert, you also reduce the number of
conversion problems, and you start with a “cleaner” database as you move forward with Vision.
Because of this, we recommend that, if possible, you limit the conversion to a year or two of
general ledger information. This recommendation is for all converting FMS clients, but it is
particularly crucial that you limit the data you convert if you are one of the FMS clients that
converted from the DOS version of FMS.

If you purchased the Basic or Standard conversion, you have already made this decision. The
cutoff is set automatically to the fiscal year two years prior to the current year, and you cannot
change it. For example, if the date you enter the setup information in the Vision Conversion
module is 11/15/09 and your fiscal year starts on January 1, the general ledger beginning year is
set to 2007. (For the Basic conversion, only the accounting periods are set up. No account
balances or transactions go to Vision.)

If you have the Premium conversion, note the following when you choose your beginning year:

= The year you select in General Ledger Beginning Year serves as a cutoff date for the
conversion of accounting periods, account balance information, and general journal
transactions. You will not be able to print financial reports for any periods prior to the first
period of the year you select.

= If you have any past years that, because of account number restructuring or other
reasons, are out of balance, it is important that you select a more recent year to be the
beginning year in Vision.
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= The year you select does not need to match up with other cutoff dates you’re using for
the conversion.

#.] If you don’t convert all of your fiscal years, you should keep your FMS system operational in
case you need to retrieve historical data.

Background: Latest Period to Be Converted

While you can have any number of open fiscal periods in Vision, the most common approach is to
create a new open period when most or all data entry and processing has been completed for the
preceding period. When you create a new period, it becomes the current period and all earlier
periods are automatically considered prior periods.

In FMS, on the other hand, when you near the end of a fiscal year, you set up the next fiscal year
with all of its accounting periods.

Guidelines: Latest Period to Be Converted

Depending on how Vision is set up, the ability to work in prior periods, whether they are closed or
not, may be restricted. For that reason, you should not convert any FMS accounting periods that
are later than the period during which you will go live with Vision. If you did convert the future
periods set up in FMS, the latest of those would be the current period in Vision, while the fiscal
period that was really the current one would be treated as a prior period.

Because of this, for your final conversion you should select the FMS accounting period in which
you will go live with Vision in Convert Periods Through on the Accounting Periods subtab of the
Accounts tab in the Vision Conversion Setup dialog box. Then, in Vision Fiscal Year for FMS
Fiscal Year, enter the Vision fiscal year in which that period will fall.

For trial conversions, always select the current period in Convert Periods Through so that all
existing transactions are converted. If you instead select an earlier period (your most recent
closed period, for example), be aware that your FMS and Vision reports are not likely to balance.

Before you run the preconversion utilities in preparation for submitting your data for the final
conversion (or a subsequent test conversion), check the period in Check Periods Through to
make sure it is still the correct period. If not, change it before running the utilities.

Migration Briefing: Work Breakdown Structure Conversion

The work breakdown structure, whether in Deltek FMS or Deltek Vision, is the hierarchical
structure of activities that need to be carried out to complete a project. The work breakdown
structure is used to categorize, collect, and report on project data.

The conversion of the FMS work breakdown structure components to Vision work breakdown
structure components is one of the most complex and, at the same time, most important parts of
the data migration process.

This briefing describes the fundamental differences between the FMS and Vision work
breakdown structures and explains how those differences affect the conversion.
For More Information

For more information related to the conversion of the work breakdown structure, see these
migration decision topics:

=  “Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39

= “Work Breakdown Structure Decisions: Phases” on page 42
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=  “Work Breakdown Structure Decisions: Departments” on page 45
=  “Work Breakdown Structure Decisions: Labor Codes” on page 49
=  “Work Breakdown Structure Decisions: Staff Types” on page 51

= “Expense Codes-to-Accounts Mapping Decisions” on page 78

FMS Work Breakdown Structure Components

In FMS, these are the standard components of the work breakdown structure:

=  Project
= Billing group
= Phase

=  Department
= Cost type

Below the cost type level, the labor code and staff type components are used for labor and the
expense code component for expenses.

Vision Work Breakdown Structure Components

In Vision, the standard components of the work breakdown structure are
=  Work breakdown structure level 1: WBS1 (default label: Project)
=  Work breakdown structure level 2: WBS2 (default label: Phase)
= Work breakdown structure level 3: WBS3 (default label: Task)

If you need to break down project activity even more, project numbers can have up to three levels
separated by delimiters, and phases and tasks can have two each.

Below the task level, you can further categorize labor using labor codes. And each labor code can
have up to five segments for tracking labor at even more detailed levels. Where FMS uses
expense codes, Vision uses GL expense accounts to identify the particular types of non-labor
expenses charged to projects.

Vision Projects (WBS1)

Vision projects fall into one of three categories, designated by their charge type: regular,
overhead, and promotional. The charge type determines the account number used when entering
transactions for the project and the reports you use to report on the project. In Vision, posting to
the general ledger is essentially project-driven, and in most data entry situations, Vision verifies
that project charge types and transaction accounts are compatible.

Regular projects are revenue-producing projects, to which direct labor, reimbursable expenses,
and direct expenses are charged.

Overhead projects do not produce revenue. Their function is to track indirect costs. Indirect labor
and expenses are charged to overhead projects. Typically, overhead projects are set up for such
overhead categories as vacation, sick leave, holiday, business development, accounting, civic
duty, and general overhead. Overhead projects accumulate transactions for the current fiscal
year, with the total cost associated with them eventually distributed to regular projects through the
Overhead Allocation process. While Vision overhead projects are basically equivalent to FMS
billing groups with the Overhead billing type, Vision, unlike FMS, requires indirect expenses
entered through Accounts Payable or General Ledger to be associated with an overhead project.
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Promotional projects, like FMS billing groups with the Proposal billing type, are used to track labor
and expense associated with acquiring a contract.

During the conversion of your FMS data, either your FMS projects or your FMS project-and-billing
group combinations, depending on the option you choose, are converted to the WBS1 level in
Vision.

Vision Phases and Tasks (WBS2 and WBS3)

Phases and tasks in Vision are sub-projects, much as billing groups are in FMS. They can have
different organizations, billing terms, managers, overhead, revenue, and attributes. Unlike for
FMS billing groups, however, you cannot print separate invoices for phases or tasks.

Phases and tasks are always project-specific, in contrast to the global phases and labor codes in
FMS. Also unlike FMS, when you set up a project in Vision, you have the option to not use the
WBS2 and WBS3 levels if you don’t need those levels to track project activity.

Depending on the options you select for the conversion, FMS billing groups, phases,
departments, or labor codes could be converted to the WBS2 or WBS3 level in Vision.

Vision Labor Codes

Vision labor codes extend the standard work breakdown structure, enabling you to further classify
the work your employees do for budgeting, billing, and reporting purposes. You define labor
codes globally rather than setting them up for individual projects, but you decide on a project-by-
project basis whether or not to use them. If you do use them, all time records entered for the
project must include a labor code as well as a code for each WBS level being used for that
project.

Labor codes in Vision are commonly used to track such things as the departments, project
phases, service types, or staff levels associated with labor charges.

Because a labor code can have up to five levels and a maximum of 14 characters (including
delimiters), you can actually use them to track multiple labor-related items. For example, your
labor code structure might be made up of a one-character department level and a two-character
activity level separated by a period. When an employee entered time incurred by department A
for activity 10, she would enter the A.10 labor code as part of the time record.

Depending on the options you choose for the conversion of your FMS work breakdown structure,
the conversion program may create Vision labor code levels and sub-codes from your phases,
departments, FMS labor codes, or staff types, or from any combination of them.

Vision Expense Accounts

In FMS, a particular type of project expense is identified during data entry and on reports by an
expense code, and each expense code is linked to the appropriate GL expense accounts.

Though Vision has expense codes, they have a different function than they do in FMS; Vision
does not have a true equivalent of the expense code. Instead, you set up GL expense accounts
for each category of expense. When you enter expense transactions, you enter the appropriate
GL account number, which in turn identifies the type of expense, indicates how it affects the
general ledger, and determines whether it goes into the billing process or not.

As part of the conversion preparation, you map each of your FMS expense codes to a set of
Vision GL accounts, and that mapping information is used to convert your FMS expense
transactions.

For more information, see “Migration Briefing: Chart of Accounts Conversion” on page 25, “GL
Expense Account Ranges Decisions” on page 30, and “Expense Codes-to-Accounts Mapping
Decisions” on page 78.
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Data Entry and the WBS Levels

In FMS, all time and expense records include all of the WBS levels, though the option exists to
hide some of those levels for data entry purposes and use default data.

In Vision, the WBS levels used can vary by project. For a given project, however, time and
expense records and other types of transactions must include a code at the lowest level being
used for that project, and revenue and overhead are distributed at that level as well.

Below the standard WBS levels, you have the option, for each project, to use labor codes as well.
If you do, each time record entered must include a labor code along with the required WBS
components. And, as mentioned previously, each expense record must contain the appropriate
GL expense account.

Billing and the WBS Levels

In FMS, you have the option to print separate invoices at either the project level or the billing
group level. How the billing is done is largely controlled by the billing information entered for the
billing groups or set up in the billing rate schedules assigned to billing groups.

In Vision, you can only print separate invoices at the WBS1 level, though the invoices can show
billing information at lower levels of the WBS and even at the labor code and expense account
levels. If required, you can assign each WBS2 and WBS3 code its own billing terms. Conversely,
if you are using a WBS level only for internal reporting purposes and don’t want it to appear on
invoices, you can also use billing terms to do that.

If you need to bill a client for multiple projects on a single invoice, you can use the Vision billing
group feature to group projects for billing.

Reporting and the WBS Levels

In Vision, you can generally summarize (roll up) data on project reports by work breakdown
structure level or by virtually any part of a WBS level.

For reports that show labor detail, you can usually sort and group by labor code level and control
which labor code levels are shown. For those that report on expenses, you can normally select
the types of expenses shown (reimbursable, reimbursable consultant, direct,...).

Converting the FMS WBS Levels

The conversion program converts your FMS work breakdown structure to a Vision work
breakdown structure based on a set of migration decisions that you record in the Vision
Conversion module. Though projects you will set up in Vision after you go live do not all have to
use the same work breakdown structure, the work breakdown structure decisions you make for
the conversion are applied to all converted projects. As a result, all will have the same levels after
the conversion.

Here is a summary of your options. The topics that follow this one provide more detailed
descriptions and guidance.

These FMS work breakdown

structure components... Can be converted to the following in Vision

Projects WBS1 components (either alone or in combination with a
billing group)

Billing groups WBS1 components (in combination with the project) or WBS2
components
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’ These FMS work breakdown
structure components... Can be converted to the following in Vision
Phases WBS2 or WBS3 components, or labor codes
Departments WBS2 or WBS3 components, organizations, labor codes, or

any combination of these three options

Cost types Not converted

Labor codes WBS2 or WBS3 components, labor codes, or both WBS
components and labor codes

Staff types Labor codes, labor categories, or both

Expense codes GL expense accounts

Depending on your decisions, WBS1 components can be either FMS projects alone or a
combination of an FMS project and one of its billing groups. Vision labor codes can represent any
one of the following—phase, department, labor code, or staff type—or any combination of them.

Work Breakdown Structure Decisions: Projects and Billing
Groups

The first decision you need to make about the conversion of your work breakdown structure is
whether Deltek FMS projects alone or project-billing group combinations will be at the highest
work breakdown structure level (WBS1) in Deltek Vision. This is a global decision for the FMS
company you are converting. It applies to all converted projects.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu and use the options under Set Up Vision Projects (WBS1) For on the WBS tab
to indicate which FMS work breakdown structure levels will convert to the WBSL1 level in Vision.

If you need help using this tab, see “Vision Conversion Setup Procedures: WBS Options” on
page 124.

— ¥ision Conversion Setup
General Accounts i wRs Lahar Codes Employees

Set Up vision Projects (WBS1) For

(%) Each FMS Praoject and Billing Group Combination
Qmitthe Billing Group ID for Projects with Only One Billing Group

Insert This Character Between Project ID and Billing Group D

Use Billing Group Title Instead of Project Title for Combined Projects
(") Each FME Project (Billing Groups will be Yision YWBS2)

Convert EMS Departrents As:
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Background

Because of the differences between the FMS and Vision work breakdown structures, you must
decide whether FMS projects alone or project-billing group combinations will be at the highest
work breakdown structure level (WBS1). What you decide affects your options for converting
other FMS work breakdown structure components to Vision.

If you decide to combine project and billing group at the WBSL1 level, a Vision project is created
for each combination of FMS project and billing group. Thus if you convert project 06-005 and its
two billing groups—0001 and 0002—you get two projects in Vision: 06-005.0001 and 06-
005.0002.

If you don’t combine them, WBSL1 is used for the FMS project ID and WBS2 for the billing group
IDs.

If you decide to combine projects and billing groups at the WBS1 level, you also need to decide
whether to do the following:

= Omit the billing group ID from the Vision project ID when the converted FMS project has
only one billing group

= Separate the project ID and billing group ID with a separating character when they are
combined into a Vision project ID

= Use the billing group title rather than the FMS project title for the project title in Vision

For more background information, see “Migration Briefing: Work Breakdown Structure
Conversion” on page 35.

Guidelines: Combining Projects and Billing Groups at the WBS1 Level

The vast majority of Deltek clients who convert from FMS to Vision choose to combine project
and billing group at the WBS1 level, for one or more of these reasons:

=  They print separate invoices for billing groups in FMS and want to be able to continue
that practice.

= They have no projects or very few projects with more than one billing group, so they don't
want to devote a level of the work breakdown structure to billing groups.

=  Some billing groups for a project are assigned to a different client than other billing
groups for the same project or to a different client than the project itself is assigned to.

Also be aware that, by using the Project Base Rollup slider in the report options dialog boxes in
Vision, you can still print reports that roll up data by FMS project ID for those projects that have
been converted as multiple Vision projects.

Using WBS1 for both projects and billing groups also leaves two other work breakdown structure
levels available, giving you the option to convert two of the following as work breakdown structure
levels: phases, departments, or labor codes.

Guidelines: Converting Projects as WBS1 and Billing Groups as WBS2

While it isn’t commonly done, you may want to consider converting billing groups as WBS2 rather
than combining them with projects at WBS1 if both of the following are true:

= Your projects commonly have multiple billing groups but they are not billed using
separate invoices

and

= You don't need both WBS2 and WBS3 for the conversion of phases, departments, and
labor codes
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If you convert billing groups at the WBS2 level, this normally results in one Vision project for each
FMS project converted. However, there are some exceptions you should take into consideration:

= If an FMS project has both proposal and regular billing groups, one Vision project is
created for the proposal billing groups and a second project for the non-proposal billing
groups.

= |f an FMS project has both overhead and regular billing groups, one Vision project is
created for the overhead billing groups and a second project for the non-overhead billing
groups.

= |f billing groups for a project have more than one client, a project is created in Vision for
each billing group client.

= If two billing groups for a project have the same client but have different billing contacts, a
separate project is created for each client-contact combination.

Guidelines: Omitting the Billing Group ID from the Vision Project Number
When the FMS Project Has Only One Billing Group

If you choose to combine projects and billing groups at WBS1, the conversion normally constructs
the Vision project number by combining the FMS project ID and the billing group ID. For example,
project 06-001 and billing group 0001 become project 06-0010001 in Vision. However, for
projects that have only one billing group, you have the option to discard the billing group ID and
just use the FMS project ID as the Vision project number. In this case, the Vision project number
for the previous example would just be 06-001. This approach is recommended if your billing
group IDs do not serve any function other than to distinguish one billing group from another.

To use this option, select Omit the Billing Group ID for Projects with Only One Billing Group
on the WBS tab of the Vision Conversion Setup dialog box.

Guidelines: Using a Separator Between Project ID and Billing Group ID

If you choose to combine projects and billing groups at WBS1, you can specify a separator
character for the Vision project number to separate the FMS project ID from the billing group ID.
In many cases, using a separator makes it easier to distinguish the two parts of the project
number.

If you want the Vision project IDs to include a separator, select Insert This Character Between
Project ID and Billing Group ID on the WBS tab of the Vision Conversion Setup dialog box and
type the character you want to use in the small box to the right.

If you specify a separator, be aware that it is not converted as a delimiter in Vision. Vision
delimiters have special significance. If you specify a single delimiter for project numbers in Vision,
for example, all project numbers must include that delimiter and have the two segments it
creates. The project numbers created during your conversion, on the other hand, whether or not
you use a separator between the project ID and billing group ID, are treated as one-segment
project numbers in Vision. The separator added during the conversion has no special status.

Guidelines: Using Billing Group Titles Rather Than Project Titles for Your
Vision Projects

If you choose to combine projects and billing groups at WBS1, the conversion normally assigns
the project title as both the short name and long name of the project in Vision. However, if your
billing group descriptions provide more relevant information about the Vision projects, you have
the option to use those descriptions instead of the project title.
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If you want to convert billing group descriptions as Vision project names, select Use Billing
Group Title Instead of Project Title for Combined Projects on the WBS tab of the Vision
Conversion Setup dialog box.

If you have long project titles or billing group descriptions, they may be shortened when converted
because of size restrictions for project names in Vision. Project short names are limited to 40
characters.

Work Breakdown Structure Decisions: Phases

Before you convert your data to Deltek Vision, you need to decide if your phases in Deltek FMS
will be converted as work breakdown structure components, as Vision labor codes, or not
converted at all. This is a global decision for the FMS company you are converting. It applies to
all converted projects.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu and use the options under Convert FMS Phases As on the WBS tab to indicate
how you want to convert phases.

If you need help using this tab, see “Vision Conversion Setup Procedures: WBS Options” on
page 124.

Lahor Codes
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g 5roup |0 for Projects with Only One Billing Group O Vision Labor Codes
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Background

Because of the differences between the FMS and Vision work breakdown structures, you must
decide whether FMS phases are converted as part of the work breakdown structure in Vision, as
Vision labor codes, or not converted at all.

The work breakdown structure level at which you can convert phases depends on whether billing
groups are converted to WBS2. If they are, you can convert FMS phases at WBS3. If they aren't,
you can convert phases at WBS2.

For more background information, see “Migration Briefing: Work Breakdown Structure
Conversion” on page 35.
Guidelines: Converting Phases as Part of the Work Breakdown Structure

Most often, Deltek clients convert phases to WBS2 or WBS3, whichever is available, if some or
all of the following are generally true for the projects to be converted:

= Both labor and expenses are tracked at the phase level.

= You have billing groups with phased billing types (Phased Fixed Fee, Phased Percent of
Constructions, Phased Cost Plus to a Maximum,...).

= FMS phase names are generally project-specific rather standard names.
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When considering this option, keep in mind that in Vision all data is entered at the project’s lowest
WBS level. Thus, if you convert phases to WBS2, you must specify a WBS2 component when
you enter a manual AR transaction or apply payments to invoices for any converted project,
whereas in FMS you could do so at the billing group level for those with non-phased billing types.
(For converted transactions that aren’t associated with a phase in FMS, the conversion assigns
ZZZ to the WBS level for phases in Vision.)

If You Have Long Phase IDs

WBS components at the WBS2 or WBS3 level can only be seven characters, but phase IDs in
FMS can have up to ten characters. If you have phase IDs longer than seven characters, you
may need to change some of those IDs. See “Complete Additional Data Preparation Tasks” on
page 150 for details.

Guidelines: Converting Phases as Vision Labor Codes

Consider converting phases as Vision labor codes if some or all of the following are generally true
for the projects you are going to convert:

= You track labor by phase in FMS but assign all expenses to a single phase.
= The projects you are going to convert do not have billing groups with phased billing types.
= FMS phase names are the same for all projects.

If you pick this option, phase assignments for expenses will not be converted, nor will any
classification labels that are assigned to phases.

Once you've selected this option in the Vision Conversion Setup dialog box, you must also open
the FMS Codes — Vision Labor Codes Mapping dialog box, display the default Vision labor code
mapping for each phase on the Phases tab, and make any changes you want to the code or
description. For more on this, see “FMS Codes to Vision Labor Codes Mapping Decisions” on
page 82.

If you also convert departments, staff types, or FMS labor codes as Vision labor codes, the
conversion creates multi-level labor codes in Vision. In that case, you can assign phases to any
level of the Vision labor codes that you want. For more information on specifying the Vision labor
code structure, see “Labor Code Structure Decision” on page 53.

If you are required to bill a client at the phase level but internally you don't want to add a phase
level to your work breakdown structure, you may still be able to choose this option. In some
situations, you can set up the equivalent of phases for billing only in project billing terms.
However, you should discuss this possibility with your Vision consultant before making this
decision.

Guidelines: Not Converting Phases

Even for billing groups with non-phased billing types, phases in FMS normally have a project
management function that converting Deltek clients don’t want to lose. As a result, FMS phases
are almost always converted. If you do not convert phases, your converted FMS transactions will
contain no phase information.

Before you decide not to convert phases, we recommend that you discuss the choice with your
Vision consultant.

Migration Briefing: Vision Organizations

If you are using departments in Business Management, you have the option to convert those
departments into Deltek Vision organizations.

Migration Guide 43



Deltek Kwovmore

Chapter 2: Migration Decisions — Conversion Setup

This briefing summarizes what organizations are, how they are used in Vision, and how they are
created by the Deltek FMS conversion process.

For More Information

For more information related to the conversion of departments into organizations, see these
migration decision topics:

=  "Work Breakdown Structure Decisions: Departments” on page 45
= "Department-to-Organization/WBS Mapping Decisions” on page 71
= "GL Account Number Structure Decision” on page 29

= "FMS Accounts-to-Vision Accounts Mapping Decisions” on page 72

Organizations: The Basics

In Vision, you can set up “organizations” within your firm. Similar to profit centers, these separate
organizations are business units that incur expenses and/or generate revenue and that can be
looked at in terms of profitability.

For example, if your firm does business in more than one region and has several offices in each
region, you could create a separate organization for each region-office combination and then
track and report on information for each of those organizations.

Each transaction that you enter in Vision—each labor charge, expense charge, journal entry, and
so on—is implicitly linked to the organization associated with that transaction. You can then use
organization reporting, an optional feature of Vision, to generate financial statements, project
reports, and other reports for a single organization, a group of organizations, or for all of your
firm’s organizations.

You can also distribute overhead to individual organizations.

If you use organizations in Vision, every work breakdown structure component and every
employee in Vision is assigned to an organization. And every transaction that generates revenue
and expenses is implicitly linked to an organization.

Organization Levels

Organizations can be single-level or multi-level. If you only want to do organization reporting for
offices, set up an organization for each office, a single-level structure. If you want to report on
departments within each office, however, set up a two-level organization structure, one level for
offices and one for departments. You specify a subcode for each office and each department, and
each combination of office and department subcodes becomes an organization code.

For example, if you have an Austin office and a Boston office (subcodes A and B at the Office
level) and Architecture and Engineering departments (subcodes 10 and 20 at the Department
level), you would have these organizations:

= A:10 — Austin-Architecture
= A:20 — Austin-Engineering
= B:10 - Boston-Architecture
= B:20 - Boston-Engineering

The maximum number of characters for a complete organization code (all subcodes plus
delimiters) is 14.
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Organizations and the General Ledger

In FMS, each department normally has its own set of income and expense accounts. When you
print a financial report for a department, that report retrieves the data from the department’s
account balances. In Vision, however, organizations do not directly affect the makeup of your
chart of accounts. Two expense transactions that are associated with different organizations but
are otherwise identical will generate distributions to the same GL accounts. To print a financial
report for an organization, Vision goes to that organization’s transactions rather than directly to
GL account balances.

Organizations and the Conversion

If you are using departments in FMS Business Management, you have the option to convert
those departments to Vision organizations. If you do, the following happens:

= An organization is created for each FMS department.

= If you choose to convert your GL account structure to organization codes, organization
codes or subcodes are created for each non-main account division code.

= Each employee is assigned to the organization mapped to his or her FMS department.

= Each work breakdown structure component (each project, billing group, phase,
department, or labor code, depending on how you convert the work breakdown structure)
is assigned to an organization.

= Each converted transaction (time records, expenses) is linked to an organization.

Work Breakdown Structure Decisions: Departments
If you are using departments in Business Management, you need to decide the following:
=  Which Deltek FMS departments you want to convert

=  Whether the departments will be converted as work breakdown structure components, as
Deltek Vision labor codes, or as organizations

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu and use the options on the WBS tab to indicate how you want to convert
departments.

If you decide to convert departments as organizations or WBS components, you also define the
organizations and WBS components you want to create in Vision for your organizations. Then
you click Mapping on the Maintain menu and FMS Departments — Vision Organizations
Mapping on the submenu, and use the mapping dialog box to map your departments to
organizations or WBS components.

If you need help using these dialog boxes, see “Vision Conversion Setup Procedures: WBS
Options” on page 124 and “FMS Departments-Vision Organizations/WBS Mapping Procedures”
on page 133.
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Indicate if you want to create labor codes, organizations,
or WBS components in Vision based on your
departments in Business Management.

— Vision Conversion Setup
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Set Up Vision Prpjects (WBS1) For
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Omitthe Billing Group ID for Projects with Only One Billing Group

Insert This Character Between Project ID and Billing Group ID :

Use Billing Group Title Instead of Project Title for Combined Projects
(& Each FMS{Project (Billing Groups will be Vision WBS2)

Convert FMS Departments As:
[Jvision Labor Codes
[¥]vision Organizations

Convert FMS Account Number Structures to Vision Organization Levels

[[visionWBS3

[ Set Up Organization Codes... ]

Set Up Organizations...

Click these buttons to define the structure of your
organization codes and specify the subcodes for
each level and to review and make changes to the
default organization codes themselves.

Background

If you are using departments in FMS Business Management, you must decide whether
departments are converted as part of the work breakdown structure in Vision, as Vision labor
codes, as organizations, or as any combination of the three. You can also choose to not convert
departments at all.

This migration decision is hecessary because of some key differences between FMS and Vision:

= In Vision, a project is assigned to one organization, and all income and expense for the
time and expense records entered for the project flow to that organization, even if, for
example, an employee from another organization works on the project. In FMS, you have
more control over the distribution of income and expenses to departments.

= In FMS, you can enter budgets by department, but in Vision, you can’t budget by
organization unless you are using the Vision Planning application. Budgets are entered at
the labor code level and can be rolled up to work breakdown structure levels but can’'t be
summarized by organization.

A related decision is which departments to convert. If you have departments set up in FMS that
you ho longer use, the conversion is an opportunity to remove those departments.

For more background information, see “Migration Briefing: Work Breakdown Structure
Conversion” on page 35 and “Migration Briefing: Vision Organizations” on page 43.

Migration Guide 46



Deltek Kwovmore

Chapter 2: Migration Decisions — Conversion Setup

Guidelines: Converting Departments as Organizations

If you use departments in Business Management and you set up your FMS chart of accounts so
that you could produce financial reports by department, you should convert your departments to
Vision organizations so that you can continue this practice using organization reporting in Vision.

To convert departments to organizations, complete the following steps:

1. Onthe WBS tab in the Vision Conversion Setup dialog box, select Vision
Organizations.

2. If your general ledger account number structure reflects your departmental organization,
also select Convert FMS Account Number Structures to Vision Organization Levels
under Convert FMS Departments As.

3. Click the Set Up Organization Codes button to open the Set Up Vision Organization
Codes dialog box. In that dialog box, specify the structure you want for your organization
codes, review the default codes and labels for each organization level, and make any
changes you want to them.

4. If your organizations have more than one level, click the Set Up Organizations button to
open the Set Up Organizations dialog box. In that dialog box, review the default
organizations in the grid and make any necessary changes to the names and subcodes
shown. You can also delete any of the default organizations or add new ones to the list.

5. Click Mapping on the Maintain menu and FMS Departments — Vision Organizations
on the submenu to open the FMS Departments — Vision Organizations Mapping dialog
box. Review the default mapping of departments to organizations, and make any
necessary changes.

If you decide to convert departments to organizations, you may also want to convert them to
Vision labor codes or to a WBS level. These options are discussed in the following paragraphs.

Guidelines: Converting Departments as Vision Labor Codes

If you want to be able to enter project labor budgets in Vision by department and you aren'’t using
Vision’s Planning application, you can make that possible by converting your departments to
Vision labor codes, in addition to converting them to organizations.

To do this, go to the WBS tab in the Vision Conversion Setup dialog box and select Vision Labor
Codes under Convert FMS Departments As.

If you do this, be aware that it does not affect the normal flow of income and expenses to the
project’s organization. If you want to redirect income and expenses, you'll need to use the cross
charge capability in Vision.

Once you've selected this option in the Vision Conversion Setup dialog box, you must also open
the FMS Codes — Vision Labor Codes Mapping dialog box, display the default Vision labor code
mapping for each department on the Departments tab, and make any changes you want to the
code or description. For more on this, see “FMS Codes to Vision Labor Codes Mapping
Decisions” on page 82.

If you also convert phases, staff types, or FMS labor codes as Vision labor codes, the conversion
creates multi-level labor codes in Vision. In that case, you can assign departments to any level of
the Vision labor codes that you want. For more information on specifying the Vision labor code
structure, see “Labor Code Structure Decision” on page 53.

You can also make it possible to enter organization budgets for a project by converting
departments to a work breakdown structure level, as described in the following paragraphs.
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Guidelines: Converting Departments as Part of the Work Breakdown
Structure

If you want to be able to budget by department and to control the flow of income and expenses to
departments, convert your departments to a work breakdown structure level.

To convert departments to a WBS level, complete the following steps:

1. Onthe WBS tab in the Vision Conversion Setup dialog box, select Vision WBS2 or
Vision WBS3 (whichever is available) under Convert FMS Departments As.

2. If you are also converting departments to organizations, click the Set Up Organization
Codes button to open the Set Up Vision Organization Codes dialog box. In that dialog
box, specify the structure you want for your organization codes, review the default codes
and labels for each organization level, and make any changes you want to them.

3. If you are also converting departments to organizations, click the Set Up Organizations
and WBS button to open the Set Up Organizations and WBS dialog box. In that dialog
box, review the default organizations in the grid and make any necessary changes to the
names and subcodes shown. You can also delete any of the default organizations or add
new ones to the list. In the WBS column, assign the WBS component you want
associated with each of the organizations.

4. If you are only converting departments to a WBS level, click the Set Up WBS button to
open the Set Up WBS dialog box. Enter the WBS components you want to use for
departments, and enter a description for each one.

5. If you are converting departments as both organizations and WBS components, click
Mapping on the Maintain menu and FMS Departments — Vision Organizations on the
submenu to open the FMS Departments — Vision Organizations Mapping dialog box.
Review the mapping of departments to organizations and make any necessary changes.

6. If you are converting departments to WBS components only, click Mapping on the
Maintain menu and FMS Departments — Vision Organizations on the submenu to open
the FMS Departments — Vision WBS Mapping dialog box. Map each department to one of
the WBS components.

When considering this option, keep in mind that in Vision all data is entered at the
project’s lowest WBS level. Thus, if you convert departments to WBS3, for example, all
transactions you subsequently enter in Vision for the converted projects must be entered
at the WBS3 level. (For converted transactions that aren’t associated with a department
in FMS, the conversion assigns ZZZ to the department WBS level in Vision.)

The work breakdown structure level at which you can convert departments depends on how
many levels you're using for the conversion of projects, billing groups, phases, and labor codes.
Departments are always the lowest work breakdown structure level.

Guidelines: Discarding Unused FMS Departments During the Conversion

Many FMS clients have departments set up in FMS that, for one reason or another, they no
longer use, but because they are referenced in transactions, they can’t be deleted in FMS. If that
is your situation and you are converting departments either to organizations or to WBS
components, the conversion is an opportunity to remove those departments.

To discard departments:

= When you define your organizations or WBS components for departments, don’t set one
up for the departments you want to remove. Instead, set up a single organization or WBS
component to be used for all of these unused departments.
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= When you map departments to organizations or to WBS components, map each of the
departments you want to remove to the “unused departments” organization or WBS
component.

The effect of this is to merge all of your unused departments into a single organization or WBS
component. If FMS transactions for those departments are converted, they are all assigned to the
“unused departments” organization and/or WBS component. Do not discard a department if you
want to be able to print departmental financial reports or other reports for it in Vision. When in
doubt, discuss the decision with your Vision consultant.

Guidelines: Not Converting Departments

Though the option is rarely used, you can decide to not convert any of your departments to Vision
in any form if, for some reason, you decide that you don’t need or want that operational structure
in Vision. Before you decide not to convert departments, however, we recommend that you
discuss the choice with your Vision consultant.

Work Breakdown Structure Decisions: Labor Codes
You can convert your Deltek FMS labor codes to the following in Deltek Vision:
= Vision labor codes
= A work breakdown structure level
= Both Vision labor codes and a work breakdown structure level

You also have the option to not convert labor codes in any form.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu and use the options on the WBS tab to indicate how you want to convert labor
codes. If you need help using this tab, see “Vision Conversion Setup Procedures: WBS Options”
on page 124.

Indicate if youwant to convert FMS
labor codes to Vision labor codes, to
WBS components, or to both labor
codes and WBS components. You also
can choose to not convert FMS labor
codes.

Labor Codes Employees

GL Budgets

FMS Miscellaneous B
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(&) Vision WBS52

Billing Group Combination

roup ID for Projects with Only One Billing Group © Vision Labor Codes

er Between Project ID and Billing Group ID : O Do Not Cornvert
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Convert FMS Labor Codes As:
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Background

FMS labor codes and Vision labor codes have the same basic function: to enable you to
categorize labor at whatever level of detail you want. And many Deltek FMS clients just convert
their FMS labor codes into Vision labor codes.

Nevertheless, you need to explicitly choose the conversion option you want because of a key
difference between FMS and Vision labor codes. In FMS, you can use either global labor codes
or labor codes that are specific to a particular billing group, but in Vision, all labor codes are
global. How you convert labor codes, then, depends on how you are using them in FMS.

For more background information, see “Migration Briefing: Work Breakdown Structure
Conversion” on page 35.

Guidelines: Converting FMS Labor Codes as Vision Labor Codes Only

If all or most of your projects use global labor codes in FMS, you should just convert your FMS
labor codes to Vision labor codes. This is the most common approach.

To do this, go to the WBS tab in the Vision Conversion Setup dialog box and select Vision Labor
Codes under Convert FMS Labor Codes As.

Once you've selected this option in the Vision Conversion Setup dialog box, you must also open
the FMS Codes — Vision Labor Codes Mapping dialog box, display the default Vision labor code
mapping for each FMS labor code on the Labor Code tab, and make any changes you want to
the code or description. For more on this, see “FMS Codes to Vision Labor Codes Mapping
Decisions” on page 82.

If you also convert phases, departments, or staff types as Vision labor codes, the conversion
creates multi-level labor codes in Vision. In that case, you can assign FMS labor codes to any
level of the Vision labor codes that you want. For more information on specifying the Vision labor
code structure, see “Labor Code Structure Decision” on page 53.

Guidelines: Converting FMS Labor Codes as a Work Breakdown Structure
Level Only

If the general practice is to use labor codes that are specific to individual billing groups rather than
using global labor codes, the only way to duplicate this in Vision is to convert your labor codes as
a work breakdown structure level.

To do this, go to the WBS tab in the Vision Conversion Setup dialog box and select Vision WBS2
or Vision WBS3 (whichever is available) under Convert FMS Labor Codes As.

When considering this option, keep in mind that in Vision all data is entered at the project’s lowest
WBS level. Thus, if you convert labor codes to WBS3, for example, all transactions you
subsequently enter in Vision for the converted projects must be entered at the WBS3 level. (For
converted transactions that were entered in FMS without a labor code, such as expense records,
the conversion creates a ZZZ component at the WBS level for FMS labor codes and assigns that
component to those transactions.)

Guidelines: Converting FMS Labor Codes as Both Vision Labor Codes and
a Work Breakdown Structure Level

In some cases, a company that normally uses global labor codes uses billing group-specific labor
codes for a few projects to meet the terms of the contracts. In this situation, it is recommended
that you convert FMS labor codes as both Vision labor codes and a work breakdown structure
level.
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To do this, go to the WBS tab in the Vision Conversion Setup dialog box and select Vision WBS2
and Labor Codes (or Vision WBS3 and Labor Codes) under Convert FMS Labor Codes As.

Once you've selected this option in the Vision Conversion Setup dialog box, you must also open
the FMS Codes — Vision Labor Codes Mapping dialog box, display the default Vision labor code
mapping for each labor code on the Labor Code tab, and make any changes you want to the
code or description. For more on this, see “FMS Codes to Vision Labor Codes Mapping
Decisions” on page 82.

Be aware, however, that this doesn’t result in a completely “clean” conversion. After converting
your data, your Vision consultant must remove the labor code work breakdown structure level
from all projects except those using that level to meet contractual requirements.

Guidelines: Not Converting Labor Codes

In FMS, if you don’t want to use labor codes, you can hide that column in the Time Records
dialog box and use the same default labor code for all time records. If you're doing that, there is
no reason to convert labor codes, so you should select Do Not Convert under Convert FMS
Labor Codes As on the WBS tab in the Vision Conversion Setup dialog box.

If you choose to not convert labor codes, the conversion removes the FMS labor codes from all
converted time records, budgets, rate schedules, and so on.

Work Breakdown Structure Decisions: Staff Types
You can convert your Deltek FMS staff types to the following in Deltek Vision:
= Labor categories
= Labor codes

= Both labor categories and labor codes

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu and use the options on the Labor Codes tab to indicate how you want to convert
staff types.

If you need help using this tab, see “Vision Conversion Setup Procedures: Labor Codes Options”
on page Error! Bookmark not defined..

Migration Guide 51



| 4

A Deltek gwumore

Chapter 2: Migration Decisions — Conversion Setup

r— ¥ision Conversion Setup

General Accounts WHE

Employvees

Convert Staff Type As

() Labor Categaries

() Lahor Codes

(® Labor Categories and Labor Codes

Yigion Labor Code Levels

Delimiter: |.

Lahel Length
Lahar Code i)
Staff Type 4

Mﬁﬁwww

Background

When you convert staff types to labor categories, the conversion creates the labor categories in
Vision and assigns employees to the labor category that was created for their assigned staff type.

The primary purpose for labor categories in Vision is for billing. You can set up billing rates for
labor categories and print billing amounts for them on invoices. However, if you are not using the
Vision Planning application, you can’t enter budgets by labor category, and whether or not you're
using Vision Planning, you can’t print reports that show project costs by labor category. When
deciding how to convert our staff types, you need to consider these characteristics of labor
categories carefully.

For more background information, see “Migration Briefing: Work Breakdown Structure
Conversion” on page 35.

Guidelines: Converting Staff Types to Both Labor Categories and Labor
Codes

Convert your staff types to both labor categories and labor codes if both of the following are true
for most of your projects:

= You budget by staff type in FMS and/or you want to be able to report by staff type on
Vision project cost reports.

= You bill by staff type.

Most converting Deltek clients choose this option. To select it, go to the Labor Codes tab in the
Vision Conversion Setup dialog box and select Labor Categories and Labor Codes under
Convert Staff Type As.

Once you've selected this option in the Vision Conversion Setup dialog box, you must also open
the FMS Codes — Vision Labor Codes Mapping dialog box, display the default Vision labor code
mapping for each staff type on the Staff Type tab, and make any changes you want to the code or
description. For more on this, see “FMS Codes to Vision Labor Codes Mapping Decisions” on
page 82.

Also, open the FMS Staff Types — Vision Labor Categories Mapping dialog box, display the
default Vision labor category mapping for each staff type, and make any changes you want to the
code or description. For more on this, see “Staff Type-to-Vision Labor Category Mapping
Decisions” on page 83.
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The default labor category codes are the same as your staff type IDs if those IDs are numeric. If
they aren't, no default code is provided, so you must type in the codes you want. Labor category
codes in Vision must be numeric.

If you also convert phases, departments, or FMS labor codes as Vision labor codes, the
conversion creates multi-level labor codes in Vision. If that case, you can assign staff types to any
level of the Vision labor codes that you want. For more information on specifying the Vision labor
code structure, see “Labor Code Structure Decision” on page 53.

Guidelines: Converting Staff Types as Labor Categories Only
Convert your staff types to labor categories alone if all of the following are true:
= You bill by staff type.
= You don't budget by staff type.
= You don’t want to report by staff type on Vision project cost reports.

To do this, go to the Labor Codes tab in the Vision Conversion Setup dialog box and select Labor
Categories under Convert Staff Type As.

Next, open the FMS Staff Types — Vision Labor Categories Mapping dialog box, display the
default Vision labor category mapping for each staff type, and make any changes you want to the
code or description. For more on this, see “Staff Type-to-Vision Labor Category Mapping
Decisions” on page 83.

The default labor category codes are the same as your staff type IDs if those IDs are numeric. If
they aren’t, no default code is provided, so you must type in the codes you want. Labor category
codes in Vision must be numeric.

Guidelines: Converting Staff Types as Labor Codes Only
Convert your staff types to labor codes alone if all of the following are true:

= You budget by staff type in FMS and/or you want to be able to report by staff type on
Vision project cost reports.

= You don't bill by staff type.

To do this, go to the Labor Codes tab in the Vision Conversion Setup dialog box and select Labor
Codes under Convert Staff Type As.

While this option is recommended if you don’t normally bill by staff type, choosing this option does
not mean you cannot bill in Vision based on your converted FMS staff types. You can bill by labor
code, but it is a more complicated process than when you use labor categories.

Labor Code Structure Decision

If you are converting any Deltek FMS work breakdown structure components to Vision labor
codes, you need to decide the following:

= The delimiter to use between labor code levels (if you are converting two or more FMS
components to Deltek Vision labor codes)

= The label for each labor code level
=  The number of characters in each level

= The order of the levels
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Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu and use the options on the Labor Codes tab to indicate the structure of the Vision
labor codes.

If you need help using this tab, see “Vision Conversion Setup Procedures: Labor Codes Options”
on page Error! Bookmark not defined..

If your Vision labor codes will have more than
one level, specify a delimiter to separate the
levels. If necessary, change the label, length,
and order of the default labor code levels.
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Background

Vision labor codes are used to classify the work your employees do. They are defined globally
rather than for specific projects. You can break up labor codes into as many as five segments,
called “levels,” and give each of those levels a name and a specific length.

Once you've selected FMS work breakdown structure components (phases, departments, labor
codes, or staff types) for conversion to Vision labor codes, FMS displays default labor code
structure information on the Labor Codes tab in the Vision Conversion Setup dialog box. You
can’t change the number of levels, except by selecting or deselecting FMS components for
conversion to labor codes, but you can change other structural characteristics of your labor
codes.

For more background information, see “Migration Briefing: Work Breakdown Structure
Conversion” on page 35.

Guidelines: Specifying a Delimiter

If you are converting more than one FMS work breakdown structure component to Vision labor
codes, the Vision labor codes will have one level (segment) for each component. You can specify
a delimiter to separate the levels and make the labor code easier to “read” in reports and online.

Delimiters must be a character such as a period, comma, colon, or hyphen. It cannot be a letter
or number, and some special characters (single or double quotation marks, for example) are also
not allowed.
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Guidelines: Entering Level Labels and Lengths

The name of the FMS component to be converted is the default label for the corresponding labor
code level (Staff Type for the level to which staff types will be converted, for example). If you
want, you can change any of the labels.

Though most Deltek clients find this unnecessary, you can also change the default lengths of the
levels to be longer or shorter. FMS selects default lengths based on the longest codes defined in
FMS. When you change lengths, you also use the Add/Remove From options to indicate if the
additional characters are to be added to the left or right end of the existing codes. (If you are
shortening the length of a level, these options control whether characters are removed from the
left or right end.)

While shortening codes isn't commonly done, you may have to do that if the default codes coming
from FMS are long. The Vision Conversion Setup dialog box displays default lengths based on
the longest codes, even if they total more than the 14 characters, including delimiters, that Vision
allows. In that case, you may have to reduce the length of one or more of the levels. If you do
that, keep in mind that shortening codes can sometimes create duplicate codes because
characters that previously distinguished one code from another are removed.

Guidelines: Setting the Order of Levels in Labor Codes

Though the sequence of levels within labor codes has no impact on how labor codes function in
reporting or elsewhere in Vision, you can use the up and down arrow buttons next to the grid
under Vision Labor Code Levels to move a level up or down in the sequence, if you prefer to
have the levels in a different order.

To move a level, first click in the row for the level you want to move, and then click the button for
the direction you want to move that row.

Company Timesheet Calendar Decisions

So the conversion can configure Vision for timesheet entry, you must decide what time interval
employee timesheets in Deltek Vision will cover and which labor periods you want the conversion
to set up.

Recording Your Decision in the Vision Conversion Module

To record your decisions in the Vision Conversion module, click Vision Conversion Setup on
the Maintain menu and use the options under Establish Company Timesheet Calendar on the
Employees tab to indicate the timesheet frequency and the range of labor periods you want.

If you need help using this tab, see “Vision Conversion Setup Procedures: Employees Options”
on page 128.
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Specify the time period that employee
timesheets will cover, select the range of dates
for which you want to create labor periods, and
select the status you want assigned to those
periods.
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End Date of the Last Labor Period Created: | 10/8/2006
Status for Each Period Created: QOpen v

Joh Cost and Payroll Frequencies

Job CostFrequency. | Semi-Monthly .

Payroll Frequency: Semi-Monthly h

Background

In Deltek FMS, you specify a default timesheet period but have the option to allow employees to
override the default dates for their timesheets. The options for the default period are Weekly, Pay
Period, and Daily. Selecting the Pay Period option means that an employee’s timesheet period
matches his or her payroll period. As a result of these options, timesheet periods could vary from
employee to employee.

In Vision, all timesheet dates are controlled by the labor periods set up on the Calendar tab of the
Company Timesheet Configuration form, so all timesheets for a given period have the same
dates. The options for timesheet frequency are Monthly, Semi-monthly, Biweekly, and Weekly.

Your selections and entries under Establish Company Timesheet Calendar enable the
conversion program to set up your initial labor periods in Vision.

Guidelines: Selecting a Timesheet Period

If most or all of the timesheets entered in FMS cover a monthly, semi-monthly, biweekly, or
weekly period, you can choose the corresponding option in Timesheet Frequency if you are
happy with that frequency.

If you are using daily timesheets, or if you base timesheet dates on payroll periods and your
employees are assigned the annual, semi-annual, or quarterly payroll periods, Vision has no
comparable options. You'll have to select the Vision option that will work best for your company.

Guidelines: Specifying Labor Periods

The range of dates for labor periods that you specify in the Vision Conversion Setup dialog box
are just used to set up an initial set of labor periods in Vision so they will be there when you begin
live operations. They have no effect on the conversion of other data.

Because of that, most FMS clients choose to have the conversion set up only the one labor
period they will be using immediately after the final conversion. To do that, enter the first date of
the timesheet period in Start Date of the First Labor Period Created and the final date of the
period in End Date of the Last Labor Period Created, and select Open in Status for Each
Period Created.
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An alternative is to have the conversion set up additional future periods, so you don't have to set
any up yourself until later on. To do that, specify the start and end dates of the span of time for
which you want periods created. In this case, you may want to select Closed as the status for the
periods to prevent time entry in the future periods. Once the conversion is completed, though, you
will have to go to the Company Timesheet Configuration form in Vision and open the current
period.

Do not have the conversion create labor periods for which timesheets were completed before the
final conversion date. While the labor detail for those periods is converted, the timesheets
themselves are not, so those past periods would have no function.

Job Cost Frequency and Payroll Frequency Decisions

Indicate how often you want to run the Adjust Salaried Job Cost process in Deltek Vision and how
often you print payroll checks for your employees.

Recording Your Decision in the Vision Conversion Module

To record your decisions in the Vision Conversion module, click Vision Conversion Setup on
the Maintain menu and use the boxes under Job Cost and Payroll Frequencies on the
Employees tab to select the frequencies you want.

If you need help using this tab, see “Vision Conversion Setup Procedures: Employees Options”
on page 128.

Indicate how often you want to run
the Adjust Salaried Job Cost
process in Vision and how often you
print payroll checks for your

— ¥ision Conversion Setup

General Accounts WES LallorCodes || Employees || GLBudgets

Establish Company Timesheet Calendar
Timesheet Frequenc Wieekly
10/2/2006

End Date ofthe Last Lybor Period Created: | 10/8/2006

Start Date of the First (abor Period Created:
Status for Each Period Created

Open

Joh Cost and Payroll Fregquencies

Job CostFrequency: | Semi-Monthly b

Payroll Frequency: Semi-Monthly b

Background: Job Cost Frequency

When an employee charges time to a project, Vision calculates labor costs using the job cost rate
defined for the employee in the Employee Info Center. If the employee is paid hourly, the labor
cost reflects the actual cost of the hours worked. However, if the employee is salaried, the
employee may charge time for which he/she is not paid—that is, overtime. In this case, the labor
charged to the project may exceed the amount actually paid to the employee.

The Adjust Salaried Job Cost process, which has a similar function to the Effective Cost Rate
Calculation tool in Deltek FMS, allows you to create an adjusted hourly job cost rate for each
salaried employee based on the employee's salaried pay rate and the actual hours the employee
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works each pay period. This adjusted rate reflects the actual cost of the employee's labor, and
thereby provides you with more accurate payroll costing for your salaried employees.

The Adjust Salaried Job Cost process uses the job cost frequency in the calculation of the
adjusted hourly job cost rates.

Background: Payroll Frequency

In FMS, you can have multiple payroll cycles, and the cycles can have different frequencies. The
options are Annual, Semi-annual, Quarterly, Monthly, Semi-monthly, Biweekly, and Weekly.

Vision, on the other hand, allows only one company-level payroll cycle. The frequency options for
that cycle are Monthly, Semi-monthly, Biweekly, or Weekly.

Guidelines: Selecting a Payroll Frequency and a Job Cost Frequency

If most or all of your employees are currently paid monthly, semi-monthly, biweekly, or weekly,
choose the corresponding option in Payroll Frequency and maintain your existing payroll
schedule. Payroll processing will have to change for employees who are now paid based on
payroll periods other than the one you select. If you plan to use the Adjust Salaried Job Cost
process in Vision, set the job cost frequency to be the same as your payroll frequency. While it
doesn’t matter what you select if you aren’t going to use the feature, you should set it to match
the payroll frequency so that it is set correctly if you ever decide to begin using it.

General Ledger Budget Decisions

You have the option to convert to Deltek Vision the budgets you set up for GL accounts in Deltek
FMS.

Recording Your Decision in the Vision Conversion Module

To record your decisions in the Vision Conversion module, click Vision Conversion Setup on
the Maintain menu and use the options on the GL Budgets tab to indicate the budgets you want
to convert.

If you need help using this tab, see “Vision Conversion Setup Procedures: GL Budgets Options”
on page 129.
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Check this box if you don't want to convert any
GL budgets.

— Vision Conversion Setup

General Accounts WBS Labor Codes ErTees T oLBudges -

[1Da Not Convert Any GL Budgets

Budget Version Description Do Not Convert? BudgetYear
Budget2005  |2005 Budget W] 2005
Budget2006 2006 Budget O 2006

Background

In both FMS and Vision, you can set up budgets for GL accounts. In FMS, a budget version does
not have to be linked to a particular fiscal year, but in Vision, it does. FMS budgets can contain
budget amounts for accounts from multiple departments, branches, and so on. If you are using
organizations in Vision, then each budget is entered for a specific organization.

Guidelines

If, in FMS, you are systematically creating and reporting on budgets you've set up in the General
Ledger module, you should convert them. Clear Do Not Convert Any GL Budgets, clear Do Not
Convert next to the specific budgets you want to convert, and enter the fiscal year you want
associated with each budget in Vision. (The year must be entered as a 4-digit year.) Select Do
Not Convert for any budgets you don’t need in Vision.

If you are converting departments to Vision organizations and one of your budgets includes

accounts mapped to different organizations, the conversion creates a Vision budget for each
organization represented in the FMS budget. Each organization budget contains the budget
amounts for accounts mapped to that organization.

If you haven't set up GL budgets or you're not now using any of the budgets, leave Do Not
Convert Any GL Budgets selected.

Update Project Teams Decision

When your billing groups are converted, any employees listed on the Staffing tab in the Billing
Groups dialog box in Deltek FMS are added to the Team tab in the Project Info Center in Deltek
Vision at the corresponding WBS level. In addition, you have the option to have the conversion
add other employees and vendors to Team tabs if time or expense records have been entered for
them for a project.
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Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, click the FMS Miscellaneous BM tab in the Vision Conversion Setup dialog box,
and select Update Project Team When Posting Labor or Vouchers.

If you need help using this tab, see “Vision Conversion Setup Procedures: FMS Miscellaneous
Business Management Options” on page 130.

If you want to add employees and vendors to project
Team tabs in Vision based on time and expense
records entered for projects, check this box.

Labor Codes Employees GL Budgets . FMS Miscellaneous BM

[ Update Project Team When Posting Labor or Vouchers
[ Convert Business Management Budgets
[[JEnable Revenue Generation

Time Records Cost Amounts
(%) Effective Cost

O Original Cost

Background: General

On the Team tab of the Project Info Center in Vision, you can assemble lists of employees and
vendors who are working, have worked, or will work on a project, along with their roles and other
related information.

If you have used the Staffing tab in the Billing Groups dialog box in FMS to track the managers
and staff for projects, billing groups, and phases, the conversion program automatically adds
them to the Team tab in the Project Info Center for the appropriate WBS levels.

If you haven't been using the Staffing tab or if the staffing lists have become out of date, you can
also have the conversion update the team information in Vision for all converted projects. If you
select Update Project Team When Posting Labor or Vouchers, any employee for whom a time
record was entered for a project is added to the employee list on the Team tab for the appropriate
WBS levels. In addition, any vendor for which a project expense was entered for a project is
added to the vendor list on the Team tabs. The conversion also selects the corresponding check
boxes on the General tab of the Accounting System Settings form in Vision (Configuration »
Accounting » System Settings on the Vision Applications menu) so the team lists will continue
to be updated as you enter time and expenses in Vision.

Guidelines

While most converting Deltek clients choose to have the conversion update team information
from time and expense records and set the corresponding check box in Vision so that team lists
continue to be updated as you enter time and expenses in Vision, you should consider the
following before deciding to do the same:

= |f what you want from the Team tabs is just a list of every employee who contributed time
to projects and every vendor (supplier and subcontractor) involved in your projects, you
should take advantage of the option to update these lists automatically.

= If your primary purpose for tracking project teams is so that information is readily
available when preparing proposals for new contracts, you are likely to want to exercise
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more control over which employees and vendors appear on the Team tabs. For example,
administrative staff may charge some time to projects but it would not be relevant to
include them as team members on a proposal.

= You may also choose to not select Update Project Team When Posting Labor or
Vouchers if you want to use Team tabs as a way, over the life of a project, to select and
document who is formally assigned to work on the project and who the key vendors are.

Business Management Budget Decision

If you are using the standard Deltek FMS budgeting feature in Business Management, you have
the option to convert your budgets to Deltek Vision budgets. (The only budgets converted are
those for the projects you select for conversion.)

If you are instead using the Resource Scheduling and Budgeting feature set, your budgets and
schedule cannot currently be converted.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, click the FMS Miscellaneous BM tab, and select Convert Business
Management Budgets.

If you need help using this tab, see “Vision Conversion Setup Procedures: FMS Miscellaneous
Business Management Options” on page 130.

If you want to convert project
budgets, check this box.

Labor Codes Employees GL Budgets FMS Miscellaneous BM

Wdate Project Team When Posting Labor or Vouchers
[C] Convert Business Management Budgets
[C]Enable Revenue Generation

Time Records Cost Amounts
(%) Effective Cost

O Original Cost

Background: General

In Vision, you enter labor budgets at the labor code level and expense budgets at the expense
account level, and they tree up from there through the project’'s WBS levels.

Because of this, which FMS budget amounts can be converted and how they are assigned
depends on how you choose to have the conversion create the Vision work breakdown structure

and the Vision labor codes.

Guidelines

Many FMS clients choose to not convert their FMS project budgets. Often they make this decision
because their budgets either aren’t set up the way they would like or they haven't been
maintained and are out of date. In either case, the budgets aren't being used, and the clients
either don't plan to use budgets in Vision or want to start over with budgeting once they begin
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using Vision. If this is your situation, do not select the Convert Business Management Budgets
check box.

If you are happy with your FMS budgets for the most part and want to convert them to Vision
budgets, read the additional background topics that follow. These topics describe how the WBS
conversion affects the conversion of budget information. You may find that because of limitations
imposed by your Vision WBS and labor codes, the converted budgets will no longer serve their
purpose. On the other hand, if it appears the converted budgets will meet your needs, select
Convert Business Management Budgets.

If you have decided on the Vision work breakdown structure you want and have entered the work
breakdown structure information and Vision labor code information in the Vision Conversion
Setup dialog box, you can print the Vision Budget Pre-Conversion Exceptions report to help you
judge how well your budgets will convert. This report analyzes your FMS budgets in light of your
WBS and labor code decisions and identifies possible budget conversion problem areas. To print
the Vision Budget Pre-Conversion Exceptions report, open the Print Standard Reports dialog box
in the Vision Conversion module.

If you're not sure whether the converted budgets will work for you, convert them for the test
conversion and take a look at them. If they aren’t satisfactory, you can clear the Convert Business
Management Budgets check box for the final conversion.

Background: Phase Labor Budgets

The following discussion assumes there are no detail expense budgets for the phase. If there are,
they are subtracted from the phase budget and the difference becomes the labor budget for the
phase. One implication of this is that if higher level budgets include expense budgets but don't
have the complete detail to support them, some labor budgets will be inflated because they
actually reflect some expense budget amounts.

If you budget at the phase level in FMS, the conversion does the following:

= |f you convert departments in FMS as a work breakdown structure level, no labor budgets
will be created in Vision.

= |If phase is converted as a work breakdown structure level (and department is not), each
phase budget is converted as a labor budget assigned to a labor code under that phase.
This labor code in each instance is made up of the generic codes for each labor code
level, as defined in the FMS Codes — Vision Labor Codes Mapping dialog box.

= |f phases are converted as labor codes and they are the only labor code level, each
phase budget is converted as a labor budget assigned to the corresponding Vision labor
code.

= |If phases are converted as labor codes and there are one or more other labor code
levels, each phase budget is converted as a labor budget assigned to a Vision labor code
made up of the phase code and the generic codes for the other levels.

Background: Detail Labor Budgets

If you budget at the detail level (labor code, staff type, or employee) in FMS, labor budgets are
converted and assigned to the appropriate Vision labor codes. Depending on how you budget in
FMS and how you are setting up Vision labor codes, the budgets could be assigned to Vision
labor codes made up of actual codes, generic codes, or a combination of the two:

= |f phases are converted as labor codes and they are the only labor code level, the total of
all detail budgets that roll up to a phase in FMS is converted as the labor budget for the
corresponding Vision labor code. The same is true of departments if they are converted
as the only labor code level.
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= If both phases and departments are converted as labor codes and they are the only labor
code levels, the total of detail budgets that tree up to a phase/department combination in
FMS is converted as the labor budget for the corresponding Vision labor code.

= If phases and/or departments are converted as labor codes and there is also a labor code
level for FMS labor code, staff type, or both, the detail budgets are assigned to Vision
labor codes consisting of actual codes for those levels at which the budget was either
entered or rolled up in FMS and generic codes for other levels.

For example, suppose the Vision labor code includes levels for staff type and FMS labor code,
and the generic code for the FMS labor code level is 00. If a budget exists in FMS for staff type
12, that budget is assigned to Vision labor code 12.00, since the conversion has no way to
associate it with a specific FMS labor code. The same would be true if the Vision labor code
includes levels for staff type and/or FMS labor code and the conversion encounters a budget
entered for an employee.

Background: Department Labor Budgets

The following assumes there are no detail expense budgets for the department. If there are, they
are subtracted from the department budget and the difference becomes the labor budget for the
department.

If you budget at the department level in FMS, the conversion does the following:

= If departments are converted as a WBS level and phases are converted as Vision labor
codes, the Vision labor code for the phase gets the department budgets entered for that
phase in FMS. If phases aren’t converted to Vision labor codes, the department budgets
go to the generic Vision labor code.

= |f departments are converted as a Vision labor code level, each department budget from
FMS is assigned to the Vision labor code for that department. The codes for other Vision
labor code levels will be the generic codes. If department isn’t part of the Vision labor
code, the department budgets go to the generic Vision labor code.

= If both phase and department are converted as WBS levels, department budgets go to
the generic Vision labor code.

= |f both phase and department are converted as Vision labor code levels, the department
budget goes to the phase/department Vision labor code. The codes for other Vision labor
code levels will be the generic codes. If phase is converted as a Vision labor code level
and department isn’'t converted at all, department budgets go to the phase Vision labor
code. If department is converted as a Vision labor code level and phase isn’t converted at
all, department budgets go to the department Vision labor code. If neither phase nor
department is converted at all, department budgets go to the generic Vision labor code.

Background: Cost Type Labor Budgets

The following discussion assumes there are no detail expense budgets for the project. If there
are, they are subtracted from the budget and the difference becomes the labor budget.

If you budget at the cost type level in FMS, the conversion does the following:

= If departments are converted as a WBS level and phases are converted as labor codes,
the phase Vision labor code under the department gets the cost type budgets entered for
that department and phase in FMS. If phase isn't part of the Vision labor code, the cost
type budget goes to the generic Vision labor code under the department.

= If departments are converted as a Vision labor code level, the cost type budget from FMS
is assigned to the Vision labor code for that department under the appropriate phase. Any
other Vision labor code levels will use the generic codes. If department isn’t part of the
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Vision labor code, the cost type budget goes to the generic Vision labor code under the
phase.

= If both phase and department are converted as WBS levels, cost type budgets go to the
generic Vision labor code.

= If both phase and department are converted as Vision labor code levels, the cost type
budget goes to the phase/department Vision labor code. Any other Vision labor code
levels will use the generic codes. If phase is converted as a Vision labor code level and
department isn’t converted at all, cost type budgets go to the phase Vision labor code. If
department is converted as a Vision labor code level and phase isn’'t converted at all,
cost type budgets go to the department Vision labor code. If neither phase nor
department is converted at all, cost type budgets go to the generic Vision labor code.

Background: Expense Budgets

If you budget at any level except the expense code level in FMS, no expense budgets will be
created in Vision. (An expense budget entered for both an expense code and a vendor will be
converted, but one entered just for a vendor will not be converted.)

Each expense code budget amount is converted as an expense budget assigned to an expense
account in Vision:

= If the cost type under which the budget was entered is included in the fee for a fixed fee
billing group and the cost type isn’t marked as a subcontractor cost type, the direct
expense account is assigned the budget.

= If the cost type under which the budget was entered is included in the fee for a fixed fee
billing group and the cost type is marked as a subcontractor cost type, the direct
consultant expense account is assigned the budget.

= |f the cost type under which the budget was entered is not included in the fee for a fixed
fee hilling group or the billing group is not a fixed fee billing group, and the cost type isn’t
marked as a subcontractor cost type, the reimbursable expense account is assigned the
budget.

= |f the cost type under which the budget was entered is not included in the fee for a fixed
fee billing group or the billing group is not a fixed fee billing group, and the cost type is
marked as a subcontractor cost type, the reimbursable consultant account is assigned
the budget.

= |f a project has expense budgets that are for both expense code and vendor, they will be
also be broken down in Vision by vendor within expense account.

= If a project has an expense budget that is for both an expense code and vendor but the
vendor is not going to be converted, the budget is converted to Vision without the vendor
information.

(You establish the link between FMS expense codes and Vision expense accounts using the
FMS Expense Codes — Vision Accounts Mapping dialog box in the Vision Conversion module.)

Revenue Generation Decision

Before you convert, you need to decide, at the company level, if you're going to use the Revenue
Generation feature in Deltek Vision.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, click the FMS Miscellaneous BM tab, and select Enable Revenue Generation.
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If you need help using this tab, see “Vision Conversion Setup Procedures: FMS Miscellaneous
Business Management Options” on page 130.

If you want to use the Revenue Generation feature in
Vision to calculate project revenue, check this box.

Labor Codes Employees GL Budgets FMS Miscellaneous BM

[[]Upgdte Project Team When Posting Labor or Vouchers
] @Onvert Business Management Budgets
[C]Enable Revenue Generation

Time Records Cost Amounts
(%) Effective Cost

O Original Cost

Background: General

In Deltek FMS, revenue is recognized for projects when you print invoices. How project revenue
is calculated is largely controlled by FMS. You can generate work-in-process whenever you want,
but again, you have few options for how WIP is calculated.

In Vision, you have two basic options for project revenue:

= If you use the Revenue Generation feature, you control when revenue is assigned to
projects, and you have a number of possible methods for calculating revenue, including
the option to create custom calculation methods. (Refer to the Vision Concepts Guide
and to the Vision online help for more information about available revenue methods.)

= If you don’t use Revenue Generation, revenue is calculated as job-to-date billings for
projects and is allocated to projects when you print invoices. There is no option to include
WIP.

Guidelines

If, like many FMS clients, you do not currently generate WIP in FMS, do not select Enable
Revenue Generation. In Vision, project revenue will be calculated automatically as job-to-date
billings and assigned to projects when you bill your clients.

If you do generate WIP in FMS, we recommend that you select Enable Revenue Generation to
turn on the Revenue Generation feature in Vision. Vision gives you much more control and
flexibility in allocating revenue to projects than FMS does. However, because none of the
standard revenue methods in Vision exactly matches the WIP calculation in FMS, it is important
that you discuss both the standard options and the options for custom revenue methods with your
Vision consultant to determine the method that best fits your needs. (The conversion assigns
Revenue Method B to all of the converted projects, but you should change that setting following
the conversion.)

Cost Amount for Time Records Decision

When it converts your Deltek FMS time records, the conversion program needs to know whether
you want the cost amounts in the Deltek Vision time records to be effective cost amounts or
original cost amounts. If you are only converting Info Center information, this migration decision
does not apply to your conversion, so you do not need to read this section.
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Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click Vision Conversion Setup on the
Maintain menu, click the FMS Miscellaneous BM tab, and select Effective Cost or Original Cost
under Time Records Cost Amounts. If you need help using this tab, see “Vision Conversion
Setup Procedures: FMS Miscellaneous Business Management Options” on page 130.

Select the type of cost amounts you want to use for
time records in Vision.

Labgr Codes Employees GL Budgets i FMS Miscellaneous BM |

[[JUpdate Projgtt Team When Posting Labar or Vouchers
[ Convert Buginess Management Budgets
[T Enable R¢venue Generation

Time Records Cost Amounts
(%) Effective Cost

(O Original Cost

Background: General

Time records in Vision have only one cost rate, while those in FMS can have both an original cost
rate and an effective cost rate.

If you want to see effective cost rates on project cost reports in Vision, you run the Adjust Salary
Job Cost process first to calculate effective costs. This process is similar in purpose and effect to
the Effective Cost Rate Calculation tool in FMS but with one important difference. While the tool
in FMS updates time record effective cost rates but leaves original costs unchanged, the Adjust
Salary Job Cost process changes the original cost rate to the effective cost rate so you can no
longer report on original cost for those time records. (The Adjust Salary Job Cost process also
changes the general ledger for the postings to direct and indirect labor accounts.)

Guidelines

If you have not been using the Effective Cost Rate Calculation tool to calculate effective cost
rates in FMS, select the Original Cost option.

If you have been calculating effective cost rates in FMS and printing most or all of your
management reports using effective cost, select the Effective Cost option.

If you have been calculating effective cost rates but you report on costs using both the effective
rates and the original rates, discuss this decision with your Vision consultant before selecting one
of the options. A common approach is to pick what you think is the best option, take a look at the
results using the test conversion, and then switch if those results aren't satisfactory.

If you select the Effective Cost option, be sure you run the Effective Cost Rate Calculation tool in
FMS for all of your time records before the final conversion. If you use this tool and you have
Payroll Plus, end all time entry in FMS at the end of a payroll period to ensure that you run the
tool for all time records before the final conversion.
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Chapter 3: Migration Decisions — Projects to
Convert

As part of the conversion preparation, you must indicate which of your existing Deltek FMS
projects you want to convert to Deltek Vision. You can convert all projects or only selected
projects.

Recording Your Decision in the Vision Conversion Module

To record your decision in the Vision Conversion module, click FMS Projects to Convert on the
Maintain menu. In the FMS Projects to Convert dialog box, select Yes under Convert? for the
projects you want to convert to Vision projects.

If you need help using this tab, see “FMS Projects to Convert Procedure” on page 131.

Set the options you want to use to select the
projects to be converted, and then click Select to set
Convert? to Yes or No based on those options.

— FMS Projects to Convert

Select Projects to Convert
O Convert All Projects
& Convert Selected Projects

[“] Prajects with Activity On or After 11112005

[ Active Projects Only

[]Exclude Unbilled Time and Expense as Open ltems

Excluded »
Project ID Title Completed? Inactive? Convert? by Activity
Date
04-002 Design and Construction of TAV Warehouse Yes
04-501 City Park Development: Children Playground Yes
04-398 Lab Testing Yes
05-000 QOverhead Yes
05-001 Exercise Course: City Park Development Yes
05-003 City Park Development: Poollice Rink Complex Yes
05-004 Happy Acres Community Golf Course Yes
05-005 Hilltop Gateway Mall and Amusement Park: Design and Construc Yes
05-006 City Park Development Proposal: Riverside Bicycle Path Yes
05-007 Design and Construction of Eureka Warehouse Yes
05-008 Minot AFB Housing Project Yes
05-009 Ellsworth AFB Facilities Warehouse Project Yes
05-010 Government Independent Research and Development Project Yes
05-011 Government Bidding and Proposal Project Yes
05-013 Yellowstone Madison Junction Campground RY Dump Station Yes
06-000 2006 - Overhead Yes hd
[ Save ] [ Close ]

Background: General

During the first conversions of Deltek clients from FMS to Vision, we learned that much of the
time the Vision consultants spent “cleaning up” the converted data was a result of data left over
from an earlier conversion from the DOS version of FMS to the Windows version. This data did
not cause problems in FMS for Windows but either caused the conversion to Vision to fail or
made the resulting Vision data unsatisfactory.
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Other conversion difficulties are caused by data created as a result of problems in early versions
of FMS for Windows or because of past system failures, particularly those involving the non-SQL
Server version of FMS.

Guidelines: General

In general, if you reduce the amount of data you convert, you also reduce the number of
conversion problems, and you start with a “cleaner” database as you move forward with Vision.

Deltek recommends that you only convert a year or two of project data. This recommendation is if
you convert from the DOS version of FMS.

Background: Excluding Projects from the Conversion

When you use the FMS Projects to Convert dialog box to exclude a project from the conversion, it
has these effects:

= No corresponding project is created in Vision.

= Phases assigned to the project will not be converted to WBS components or Vision labor
codes.

= Labor codes assigned to the project will not be converted to WBS components or Vision
labor codes.

= No transactions (time records, Business Management expense records, AR invoices, AR
receipts) for that project are converted.

= No budgets for the project are converted.
= If you have the AR Collections module, no actions for the project are converted.

Projects with open items—unpaid AR invoices, unpaid AP invoices, open purchase orders, or
unbilled time or expense records (unless you specifically make an exception for unbilled time and
expense, as described later on)—are always converted. They cannot be excluded.

Using the FMS Projects to Convert dialog box, you can select projects for conversion based on
an activity cutoff date, project status (active, inactive, completed), or both.

When you use a cutoff date, the dialog box checks for transactions for each project—AR invoices,
AR receipts, AP invoices, AP payments, GL transactions, project expenses, time records, or
purchase orders—dated on or after the cutoff date. If it finds none for a project (and it finds no
open items dated before the cutoff date), it sets Convert? to No for that project.

To avoid excluding new projects for which no transactions have been entered, Convert? is set to
Yes for such projects if either the project creation date or a billing group start date are on or after
the cutoff date.

If you select Active Projects Only, FMS sets Convert? to No for all projects marked as inactive
or completed, even if they meet the cutoff date requirement (except, again, if a project has open
items). You can also use this option if you aren’t using a cutoff date.

After you click the Select button to update Convert? based on the options you chose, you can
review the list and change the setting for individual projects.

Guidelines: Selecting Projects Based on an Activity Cutoff Date

As mentioned in the general guidelines, we recommend that, if possible, you only select projects
for conversion that have activity (transactions) dated within the last year or two.

If you purchased either the Basic or Standard conversion, you have already made this decision.
In these cases, the cutoff date is set automatically to the first day of the year, two years prior to
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the current fiscal year, and you cannot change it. For example, if the date you select projects for
conversion is 11/15/09 and your fiscal year starts on January 1, the cutoff date is set at 1/1/07.

If you purchased the Premium conversion, you can specify any cutoff date you want. The actual
date you specify doesn’t matter. The first day of a calendar or fiscal year is a convenient choice,
but it isn’t necessary to pick one of those.

Guidelines: Selecting Projects Based on Status

If you have inactive or completed projects that qualify for conversion based on your cutoff date (if
you have one) and you will have no need to include them on reports once you begin using Vision,
select Active Projects Only so that Convert? will be set to No for all of them by default. If you
decide that some of those projects do, in fact, need to be converted, you can change Convert?
back to Yes for them individually.

Guidelines: If You Don’t Use FMS to Bill Your Clients

Some Deltek FMS clients do not use FMS to bill their clients. As a result, time and expenses are
never marked as billed in FMS.

If you decide to convert only selected projects and you are not using FMS to bill your clients, be
sure you select Exclude Unbilled Time and Expense as Open Items before clicking the Select
button.

If you do not select this check box, the unbilled time and expense records will prevent you from
excluding the associated projects from the conversion.

Time and expenses with either WriteOff or No in Bill? are never considered open items when
determining if a project must be converted. The Exclude Unbilled Time and Expense as Open
Items check box only applies to time and expenses with Fee or Yes in Bill?.

Subcontractor Cost Types Decisions

Review your cost types in the Cost Types dialog box and select Subcontractor for any that you
use for subcontractor costs and billing. The conversion uses this cost type setting when
converting expenses to Deltek Vision.

Recording Your Decision in the Vision Conversion Module

To record your decisions, click Cost Types on the Maintain menu in either the Vision Conversion
module or the Business Management module. On the Cost Types dialog box, select
Subcontractor under Class for any expense cost types that are for subcontractor costs and
billing.
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1 Cost Types E][E]@
Class
Cost Type ID: Osen (%) Expense [¥] Subcantractar [ Inactive
Description: Outside Senices O Labar
Default GL Accounts
Income Account: 4116-A-10 Outside Service Incame
Unbilled Income: 4121-A-10 Unhilled Incarme - WP
Unearned Income: 4171-A-10 Unearned Income
Cept Cepartment Description Type Account Description ~
A0 Corporate-Architectural Income 4116-A-10 Cutside Service Incame
A-10 Corporate-Architectural Unbilled Income 4121-A10 Unbilled Income - WP
A0 Corporate-Architectural Unearned Income A171-A10 Unearned Incame
A20 Corporate-Engineering Income 4116-A-20 Outside Service Income
A-20 Corporate-Engineering Unbilled Income 4121-A-20 Unbilled Income - WIP
AZ0 Corporate-Engineering Unearned Incarme 4171-A-20 Unearned Income
A-90 Corporate-Administration Income 4116-A-90 Cutside Service Incame
A-90 Corporate-Administration Unkilled Income 4121-A-90 Unbilled Income - WP
A-90 Corporate-Administration Unearned Income 4171-A-90 Unearned Income .

Background

When project expenses are converted to Vision, the expense codes are replaced by Vision
expense accounts. Those accounts are determined based on how you map expense codes to
accounts in the FMS Expense Codes — Vision Accounts dialog box, and on whether or not the
expense record’s cost type is designated as a subcontractor cost type.

Identifying subcontractor cost types was optional in FMS, but if you don’t do it before converting
to Vision, the conversion may assign the wrong Vision expense account to records for consultant
expenses.

For example, suppose you are converting a subcontractor project expense for civil engineering
services. The expense record in FMS is for the Civil (Civil Engineering) expense code and the
Oserv (Outside Services) cost type. In the FMS Expense Code — Vision Account Mapping dialog
box, you assign 5111 (Outside Services) as the Reimbursable Consultant expense account for
the Civil expense code.

When the conversion program converts the expense record, it checks the Oserv cost type record
to see if Subcontractor is selected:

= If Subcontractor is selected for Oserv, the conversion program recognizes the expense
as a subcontractor expense and replaces the Civil expense code with the correct Vision
account: 5111, the Reimbursable Consultant account you mapped to the expense code.

= |f Subcontractor is not selected for Oserv, the conversion assumes the expense is not a
subcontractor expense and assigns a non-consultant Reimbursable expense account
instead.

Guidelines

For each cost type used to enter expenses for subcontractors or consultants, select
Subcontractor under Class on the Cost Types dialog box.
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Department-to-Organization/WBS Mapping Decisions

If you are converting your Deltek FMS departments to Deltek Vision organizations, the final step
in that process is to map each department to one of the organizations you've defined.

If you are converting departments to a work breakdown structure level and not to organizations,
you map each FMS department to a specific WBS component.

Recording Your Decisions in the Vision Conversion Module

To record your mapping decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Department - Vision Organization Mapping on the submenu. On the
tabs in the FMS Department — Vision Organization Mapping dialog box, review the default
organization mappings and make any changes that are necessary. (If you are converting
departments to a WBS level and not to organizations, the dialog box that opens is the FMS
Department — Vision WBS Mapping dialog box. In that dialog box, review the default WBS
component mappings and make any necessary changes.)

If you need help using this dialog box, see “FMS Departments-Vision Organizations/WBS
Mapping Procedures” on page 133.

- FMS Department - Yision Organization Mapping Elﬁl@

Default Organization: | Corporate-Adrministratin v

Dept Description CQrganization Mame A~
A-10 Carparate-Architectural Corparate-Architecture
A-20 Corporate-Engineering Corporate-Engineering
A-A0 Corporate-Administration Corporate-Administration
B-10 Austin-Architectural Austin-Architecture
B-20 Austin-Engineering Austin-Engineering
B-40 Austin-Administration Austin-Administration

h
Close
Background

For background information on mapping FMS departments to Vision organizations or WBS

components, see these topics:

= “Migration Briefing: Work Breakdown Structure Conversion” on page 35

= “Migration Briefing: Vision Organizations” on page 43

=  “Work Breakdown Structure Decisions: Departments” on page 45
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Guidelines: Mapping Departments to Organizations

When you open the FMS Department — Vision Organization Mapping dialog box, the departments
set up in Business Management are listed. To map them to Vision organizations, use the
Organization Name column to select the organization you want to convert each department to.

If you have departments that you no longer use and, thus, you don’t want to convert them to
separate organizations in Vision, you can map them all to a single “dummy” organization that you
set up for this purpose. (Before you can do this, you must set up the organization from the WBS
tab in the Vision Conversion Setup dialog box. Use the Set Up Organization Codes button and
the Set Up Organizations button to open the dialog boxes you use to define the subcodes and
organizations.)

Guidelines: Selecting a Default Organization

When you map departments to organizations, you must select one of the organizations as a
default organization. Most companies pick a corporate-level administrative organization as the
default organization.

The default organization is used when you map GL accounts to organizations in the FMS
Accounts — Vision Accounts Mapping dialog box. When you click the Default
Accounts/Organizations button in that dialog box, FMS displays default Vision accounts and
organizations for each FMS account. If it cannot determine an organization for an account based
on the FMS account number divisions, it displays this default organization for the account and
highlights it to call your attention to it in case you want to change it.

A common example is when you departmentalize your income statement accounts in FMS but
only use main account numbers for your balance sheet accounts. In that case, the balance sheet
account numbers contain no information that can be used to identify an organization so the
default organization is displayed for those accounts.

For more on mapping accounts, see “FMS Accounts-to-Vision Accounts Mapping Decisions” on
page 72.

Guidelines: Mapping Departments to WBS components

When you open the FMS Department — Vision WBS Mapping dialog box, the departments set up
in Business Management are listed. To map them to codes for the WBS level you're using for
departments, use the WBS Description column to select the WBS component you want to
convert each department to.

If you're converting departments both to organizations and to WBS components, you linked
organizations to WBS components when you defined the organizations, so when you map
departments to organizations, as described earlier, they are automatically mapped to WBS
components as well. There is no separate mapping procedure for the WBS components in that
case.

If you have departments that you no longer use and you don’t want to convert them to separate
WBS components in Vision, you can map them all to a single “dummy” component that you set
up for this purpose. (Before you can do this, you must set up the code from the WBS tab in the
Vision Conversion Setup dialog box. Use the Set Up WBS button to open the dialog box you use
to define the components.)

FMS Accounts-to-Vision Accounts Mapping Decisions

The final step in the process of converting your chart of accounts is to map each Deltek FMS
account number to a Deltek Vision account number. If you are converting departments to
organizations in Vision, you also map each FMS account to a Vision organization.
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Recording Your Decisions in the Vision Conversion Module

To record your mapping decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Accounts - Vision Accounts Mapping on the submenu. On the tabs in
the FMS Accounts — Vision Accounts Mapping dialog box, review the default account mappings
and make any changes that are necessary.

If you need help using this dialog box, see “FMS Accounts — Vision Accounts Mapping
Procedures” on page 134.

— FMS Accounts - Vision Accounts Mapping B@@
Asset Liability Net Worth e ! Reimbursable Direct Indirect Other Charges
FMS Acct # FMS Acct Name FMS Acct Type  Vision Acct # Vigion Acct Name Vision Acct. Type | Organization &

4111-A10 Professional Services Income  |Income 4111 Professional Services Income Revenue A1D

4111-A-20 Professional Services Income  |Income 4111 Professional Services Income Revenue A20

4111-A-90 Professional Services Income  |Income 4111 Professional Services Income Revenue A0

4111-B-10 Professional Services Income  |Income 4111 Professional Services Income Revenue B10

4111-B-20 Professional Services Income  |Income 4111 Professional Services Income Revenue B20

4111-B-90 Professional Services Income  |Income 4111 Professional Services Income Revenue B30

4112-A-10 Reimbursable Income Income 4112 Reimbursable Income Revenue A10

4112-A-20 Reimbursable Income Income 4112 Reimbursable Income Revenue A20

4112-A-90 Reimbursable Income Income 4112 Reimbursable Income Revenue AZD

4112-8-10 Reimbursable Income Income 4112 Reimbursable Income Revenue B10

4112-8-20 Reimbursable Income Income 4112 Reimbursable Income Revenue B20

4112-8-90 Reimbursable Income Income 4112 Reimbursable Income Revenue B30

4113-A10 Subcontractor Income Income 4113 Subcontractor Income Revenue A1D

4113-A-20 Subcontractor Income Income 4113 Subcontractor Income Revenue A20

4113-A-90 Subcontractor Income Income 4113 Subcontractor Income Revenue ASD 2

I: Highlighted — Vision Acct. Type not allowed for this FMS account type ]
DefaniticcnuntiOnEn et nnss Accounts — Could not determine account's organization A

Background: Mapping FMS Accounts to Vision Accounts

For background information on mapping FMS accounts to Vision accounts, see these topics:
= “Migration Briefing: Chart of Accounts Conversion” on page 25
= “GL Account Number Structure Decision” on page 29

= "GL Expense Account Ranges Decisions” on page 30

Guidelines: Reviewing the Default Account Mappings

When you open the FMS Accounts — Vision Accounts Mapping dialog box, your FMS accounts
are listed along with a default mapping to a Vision account number.

If you set up the Vision account structure to match your main account division, most of the default
mappings are likely to be correct for your asset, liability, equity, and revenue accounts.

One possible exception is if you have special accounts in FMS that should have the Other
account type in Vision. This account type is for accounts for below-the-line revenue or expenses,
such as rental or interest income. To change the account type for such an account, go to the tab
in the FMS Accounts — Vision Accounts Mapping dialog box that corresponds to the FMS account
type, locate the FMS account, and change the account type to Other for the Vision account to
which it is mapped.

Because of the need to insert a range for direct expense accounts, the expense account
mappings won't be correct initially. This section provides instructions for resolving this.
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Guidelines: Adding Vision Direct Expense Accounts

If you want your Vision direct expense accounts to fall in a logical location in the account number
sequence, the most complicated account mapping task is adding the new set of direct expense
accounts to your FMS chart of accounts and getting all of the expense accounts mapped to the
appropriate Vision account numbers.

Step 1: Add the direct expense accounts to your FMS chart of accounts.

You need to complete this step before you specify the FMS main account ranges on the Account
Ranges tab of the Vision Conversion Setup dialog box, because you must enter valid main
account numbers for the beginning and ending accounts for each range.

Find a spot in your current chart of accounts where there are enough unused numbers to
accommodate the direct expense accounts. For example, if your highest numbered indirect
expense account is 6999, you could add the direct expense accounts in the 8000 — 8999 or 9000-
9999 range.

To add the accounts, complete the following steps:

= Click Create Mirror Image for Direct Accounts on the Tools menu in the Vision
Conversion module.

- Create Mirror, Image for Direct Accounts @

Copyfrom Range:

Fram: |&111-A-10

EN[EY

To: S171-B-30

Beginning Mirrored Main Account. 2111

Default Divisions to Use
Main Account

Budget Center A
Cepartment 10

EJEY

= Under Copy from Range, specify the range of main accounts to be copied by entering or
selecting an FMS direct project expense account with the lowest main account number in
From and a direct project expense account with the highest main account number in To.

= |n Beginning Mirrored Main Account, enter the lowest main account number you want
to use for the new set of expense accounts. Normally this is the same as the main
account in the account in From with the left-most digit increased to match up with an
unused range. For example, if you are not currently using the 8000 — 8999 range in FMS
and the account in From has the 5111 main account, you could enter 8111 in Beginning
Mirrored Main Account.

= Under Default Divisions to Use, specify division codes you want the tool to use for the
non-main account divisions. You only need to do this for divisions that precede the main
account, and it doesn’t make any difference which codes you select.

= Click Add.

The tool creates one new expense account for each main account included in the range of
accounts you specified. In other words, the tool does not create copies of all of the accounts, just
the copies necessary to create one account for each main account. The first account is assigned
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the main account in Beginning Mirrored Main Account, and the remaining accounts are
assigned main accounts that differ from each other to the same degree that the source accounts

do.

Step 2: Renumber the Vision expense accounts so that they fall into the desired ranges

Open the FMS Accounts — Vision Accounts Mapping dialog box, review the default
expense account mappings, and determine how much the Vision account numbers need
to be increased to move them into the correct account ranges. (Normally, the
reimbursable expense accounts will be mapped correctly, but the direct and indirect
expense accounts will not be.)

Go to the Indirect tab in the FMS Accounts — Vision Accounts Mapping dialog box.

Click the Default Accounts/Organizations button.

i~ Default Accounts / Onganizations @

[ Reset¥ision Accounts to Defaults
[¥]Increment Wision Acct. # by 1000
[1Reset Organizations to Defaults

Select Account Type To Reset
&) Indirect Accounts

O Al Accounts

[]Only Reset Blank Codes

S| cancel

Select Increment Vision Acct # by and enter the number by which you want to increase
the Vision account numbers. For example, to move your indirect expenses accounts now
mapped to the 6000-6999 range to the 7000-7999 range, enter 1000.

Make sure that Indirect Accounts is selected under Select Account Type to Reset,
and click OK.

Go to the Direct tab and repeat this procedure to move your Vision direct expense
account numbers into the correct range. In this case, you may need to decrease the
default Vision account numbers. For example, if you created the direct accounts in FMS
in the 8000-8999 range but want them to be 6000-6999 in Vision, you enter —2000 in
Increment Vision Acct # by.

- Default Accounts / Onganizations @

[ Resetvision Accounts to Defaults
[¥]Increment Wision Acct. # by -2000
[1Reset Organizations to Defaults

Select Account Type To Reset
(%) Direct Accounts

O Al Accounts

[]Only Reset Blank Codes

I cancel

When you finish, click Save on the FMS Accounts — Vision Accounts Mapping dialog box.

Guidelines: Combining Accounts

If you have a multiple-division account number structure in FMS, you map accounts with the
same main account to a single Vision account.
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In addition to this consolidation of accounts based on main account, however, some Deltek
clients also take advantage of the opportunity offered by the conversion to simplify their chart of
accounts and combine other accounts. To do this, go to the tab in the FMS Accounts — Vision
Accounts Mapping dialog box on which the accounts are displayed and enter the same Vision
account for them in the Vision Acct # column.

Finally, there may be instances in which you are using multiple accounts in FMS, and Vision only
allows one account, making it necessary to consolidate accounts.

This table lists some possible examples:

Accounts | For more information...

Work-in-process accounts “Vision Company Accounts Decisions” on page 102

Expense credit distribution accounts “Expense Credit Distribution Accounts Decisions” on
page 104

Billing income accounts “Billing Income Accounts Decisions” on page 106

Guidelines: Adding Accounts

The conversion to Vision requires some accounts that normally don’t exist in FMS charts of
accounts. In those cases, you need to create equivalent FMS accounts and map those accounts
to Vision accounts on the appropriate tabs of the FMS Accounts — Vision Accounts Mapping
dialog box.

This table lists accounts you may need to create and map before converting:

Accounts | For more information...

Consultant accrual credit “Expense Credit Distribution Accounts Decisions” on
page 104

Employee expense credit “Expense Credit Distribution Accounts Decisions” on
page 104

Current year profit and loss “Vision System Accounts Decisions” on page 111

Bonus cost “Payroll Decisions” on page 113

AP discount “AP Discount Account Decision” on page 110

Accounts receivable "Cash Receipt Allocation Decisions” on page 108

Guidelines: Changing Account Descriptions

By default, FMS assigns the description for the main account as the Vision account name when
multiple accounts with the same main account are mapped to a single Vision account. In many
cases, that will be adequate. However, if you find that some Vision account names are not
correct, type the name you want in the Vision Acct Name column in the grid in the FMS
Accounts — Vision Accounts Mapping dialog box.

You may also want to change the names of the reimbursable and direct expense accounts to
differentiate them from each other. For example, if the default name for the two travel expense
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accounts is Travel Expense, you might change them to Reimbursable Travel Expense and
Direct Travel Expense.

Account names for reimbursable expenses are normally printed on client invoices when those
expenses are billed, so you should make sure those hames are appropriate for that use.

Background: Mapping FMS Accounts to Vision Organizations

If you are converting departments to organizations in Vision, you map each FMS account to a
Vision organization at the same time that you map FMS accounts to Vision accounts. The
account-to-organization mappings are used by the conversion program to assign organizations to
converted transactions (AP invoices, vendor checks, time records, and so on). They are not used
once you begin live operations in Vision. The following paragraphs explain why the organization
mapping is necessary.

If you are using organizations in Vision, every transaction is assigned to an organization. When
you create transactions in Vision, the organization assigned to transactions involving income
statement accounts is the one assigned to the lowest level of the work breakdown structure for
that transaction. For transactions involving balance sheet accounts, the default organization is
used unless you've set up Vision to provide organization reporting for balance sheets.

The conversion program, however, does not assign organizations to converted transactions as
described in the previous paragraph because in FMS it is possible to override the normal
assignment of revenue and expenses to departments. So that the financial information in Vision
after the conversion matches the information in FMS before the conversion, the conversion
program instead assigns organizations to the transactions based on the GL accounts affected by
those transactions.

In many cases, the conversion program can determine the correct organization for an account
based on departmental account information in FMS. However, in other cases, it is not so clear.
That is why you need to review the default mappings and change any that are not correct.

Guidelines: Mapping FMS Accounts to Organizations

When you map FMS accounts to Vision accounts and organizations in the FMS Accounts —
Vision Accounts Mapping dialog box, organization mappings are displayed in the Organization
column based on the department to which each account is assigned in FMS Business
Management. The organization that you have linked to a department is mapped to accounts that
are assigned to that department.

In most cases, these default organizations will be correct. However, in the following situations,
FMS cannot identify a department for an account:

= The account is not assigned to a department in FMS. Most often these are balance sheet
accounts or non-departmental income or expense accounts such as those for
depreciation or interest income. Your new direct expense accounts will also not be
assigned to departments.

= The account is assigned as a default account on the GL Accounts tab in the Business
Management Control Information dialog box.

= The account is assigned to more than one department.

Instead of assigning a normal organization in these cases, FMS assigns the default organization
that you specified in the FMS Department — Vision Organization Mapping dialog box and
highlights that organization in the grid to call your attention to it.

You should review all of the account-to-organization mappings, but be sure you examine the
highlighted ones carefully and change those for which the default organization is not the correct
organization for the account. In the case of non-departmentalized balance sheet accounts, the
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default organization may be appropriate. You can also leave the newly created direct expense
accounts mapped to the default organizations, since no Vision transactions affecting the general
ledger will be created for them during the conversion. For income and expense accounts such as
those for depreciation and interest income that appear only in general journal transactions and
thus are not assigned to departments in Business Management, the default organization is more
likely to be incorrect.

Expense Codes-to-Accounts Mapping Decisions

To prepare for the conversion of expense transactions and budgets, you must map each of your
Deltek FMS expense codes to the appropriate Deltek Vision GL expense accounts.

With the exception of the indirect expense accounts (see the note that follows this paragraph),
these expense code mappings only affect the conversion of your FMS expense transactions and
budgets and subsequent reporting on those converted transactions in Vision. They have no other
impact on the configuration or operation of Vision.

The expense codes themselves become units in Vision. If you map an expense code to an
indirect expense account, that account is assigned as the unit’s credit account in Vision. If you
don’t map the expense code to an indirect expense account, the default indirect expense account
is assigned.

Recording Your Decisions in the Vision Conversion Module

To record your mapping decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Expense Codes - Vision Accounts Mapping on the submenu. In the
FMS Expense Codes — Vision Accounts Mapping dialog box, display and review the default
account mappings, make any changes that are necessary, and select Vision accounts for any
blank cells.

If you need help using this dialog box, see “FMS Expense Codes — Vision Accounts Mapping
Procedure” on page 137.

1 FMS Expense Codes - Vision Accounts Mapping E]|E|@

Project Cost Adjustment

() Only make adjusting entries when account is a diffierent account type

() Always create adjusting entries with the new account number

Default Accounts: 5111 5171 6116 8171 7381

Expense Code Degcription Reimb. Consult. Reimbursahle Direct Consult. Direct Indirect Type ~
AirFare AirFare 5141 7361 Other
Blue Blueprints 2171 FEcES| Cither
Ceivil Civil Engineering 2111 6116 73im Consultant
Camputer Carmputer Time 8171 7381 Cther
Copy Herox Copies 5131 7381 Cther
Drill Drilling Equipment 8171 T3 Other
Elec Electrical Engineer 8111 6116 Tim Consultant
File Filing Fee 5171 7381 Other
Histary Historical Expense 2171 FEcES| Cither
Lah Laboratory Tests 2171 73im Cither
Lodging Lodging 5121 7361 Cther
Meals Meals 5121 7361 Other
Mile Vehicle Mileage 5121 7361 Other
FPhone Telephone Charges 5141 T362 Cither
FPhoto Photographs 5132 738 Cither
Rental Rental Equipment 2171 FEcES| Cither B
Miscellaneous
[:é%gu%geu — Wision account is the wrang Npe:|
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Background: Expense Codes

In FMS, expense codes identify types of project-related expenses and are used to group
expenses on reports and invoices. In Vision, types of expenses are identified by GL accounts.
Like FMS, Vision has expense codes, but using them is optional. If you do use them, they have
different roles than they do in FMS:

= Expense codes are only used when entering AP vouchers and disbursements. They do
appear on Transaction List reports, but they are not saved with the posted vouchers and
do not appear on any project or GL reports, or on invoices.

= They can speed AP voucher entry. Instead of having to enter a GL account number for
an expense, you can instead select or enter an expense code, and Vision assigns the
appropriate GL expense account based on that expense code.

= They help you assign the correct type of expense account to expenses—reimbursable,
reimbursable consultant, direct, or direct consultant—and that, in turn, helps ensure that
those expenses are billed correctly.

In FMS, Bill? is set to Yes or Fee for expenses entered for a fixed fee billing group based on
whether or not the cost type for the expense is included in the fee for that billing group. In Vision,
there are no cost types, but you can use Vision expense codes to provide this same function. If
you enter an AP voucher in Vision that includes a project expense and Bill by Default is “on” for
the expense code for that project, that is the equivalent of having Yes in Bill? in FMS. Vision then
assigns the appropriate reimbursable expense account to the expense, and it will be billed
separately rather than as part of the fixed fee amount. On the other hand, if Bill by Default is “off”
for the expense code for that project (the equivalent of Fee in FMS), Vision assigns the
appropriate direct expense account, and the expense will not be billed separately.

Vision uses one other expense code attribute, the expense code type, when determining the
account to assign to an expense. If Type is set to Consultant, Vision assigns either the
reimbursable consultant or direct consultant expense account, and if it is set to Other, it assigns
the non-consultant reimbursable or direct expense account.

When you convert your FMS data, the conversion sets up Vision to require expense codes for
regular projects. It then creates a Vision expense code at the system level for each of the FMS
expense codes that you map to a Vision account. Bill by Default is set to Yes for all expense
codes, and Type is set based on the value of Type in the FMS Expense Codes — Vision
Accounts Mapping dialog box in the Vision Conversion module. Each expense code is also
assigned a reimbursable account, a direct account, an overhead account, and a promotional
account. The reimbursable account and direct account are either consultant or non-consultant
accounts, depending on whether the expense code type is Consultant or Other.

For each Vision project, the conversion sets Bill by Default for each expense code based on the
billing group’s billing type and on how each cost type/expense code combination was handled in
FMS. After the conversion, you should review those settings for each of the Vision projects to
make sure they are correct.

Background: Mapping Expense Codes to Accounts

In Vision, types of expenses are identified by GL accounts rather than by expense codes.
Because of this, the conversion program needs to know which Vision GL accounts to assign to
expense transactions for each expense code when converting the transactions to Vision.

The conversion can't just look at the expense accounts in the FMS expense records—first,
because those may or may not be the account you generally want associated with that type of
expense, and second, in the case when an expense transaction will become a direct expense in
Vision, because the conversion program has no way of knowing which of the new Vision direct
expense accounts to assign. As a result, you need to map each of your expense codes to the
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Vision reimbursable, direct, and indirect account numbers you want associated with the converted
transactions for that expense code, so those transactions can be grouped correctly on project
cost reports and, for unbilled transactions, on invoices.

The expense code mappings do not affect the general ledger. They only affect project cost
reports and, for unbilled transactions, invoices.

For additional background information on expense accounts and on the expense code and
expense transaction conversions, see

= “Migration Briefing: Chart of Accounts Conversion” on page 25

= “GL Expense Account Ranges Decisions” on page 30

= “Expense Codes Conversion” on page 209

= "Business Management Project Expenses Conversion” on page 224

= “Accounts Payable Invoices Conversion” on page 239

Guidelines: Reviewing the Default Expense Code Mappings

When you open the FMS Expense Codes — Vision Accounts Mapping dialog box, your expense
codes are listed. Click the Reset/Default Accounts button to display default account mappings.

FMS bases the default account mappings on the accounts assigned to the expense codes in
FMS. In most cases, the default mappings should be correct, but if you need to change any of
them, you can. All account numbers must have the correct Vision account type.

Because no expense codes are associated with the accounts mapped to the new Vision direct
expense accounts, the two columns for direct expense accounts will be blank. You must supply
those account numbers.

Guidelines: Using Default Accounts Instead of Entering Individual Account
Numbers

If possible, enter the correct account number for each type of expense account for each expense
code. There are some shortcuts you can consider:

= If you are certain that for a given expense code there are no transactions to be converted
that will need a particular type of account, you can leave that account cell blank. For
example, for expense codes with a default cost type for which the Subcontractor check
box is not selected, you can leave the two consultant-related account cells blank.

= For expense codes for which you have no transactions with Fee or No in Bill?, no direct
expense transactions need to be created in Vision. For those expense codes, you can
leave the direct account columns blank.

= If you don’t want to spend time entering all of the expense account numbers and you are

not concerned about accurate information at the expense account level or transaction
detail level on project cost reports and invoices, you can leave all accounts blank that
weren't filled in when you clicked the Reset/Default Accounts button. If you take this
approach, project cost reports involving converted transactions should be accurate in
terms of the broad expense categories—reimbursable expenses, reimbursable consultant
expenses, and so on—but may not be accurate if the report shows totals by expense
account or shows individual transactions.

In all of these cases, should the conversion need one of the missing accounts, it uses the default
account you specify above the grid for that type of account.

As you are considering the shortcuts just discussed, keep in mind that the only expense
transactions that are converted are those for the projects you've selected for conversion.
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Guidelines: Reviewing the Default Expense Code Types

As you are reviewing the default expense code mappings, you should also review the default
values under Type. Make sure that all expense codes that represent consultant expenses have
Consultant in Type. All non-consultant expense codes should have Other in Type.

Background: Project Cost Adjustment Options

Each project expense transaction in FMS that is converted to Vision has both a general ledger
aspect and a project cost aspect. To simplify this discussion, these aspects will be described as a
general ledger transaction and a project cost transaction, though often a single transaction record
contains both aspects. In most cases, the general ledger transaction and the project cost
transaction have the same expense account. However, if the Vision account mapped to the FMS
account for the FMS expense transaction is not the same as the account mapped to the expense
code used in that transaction, they may have different accounts.

The option you select under Project Cost Adjustment tells the conversion program how to
create the project cost transaction in Vision when the account mapped to the FMS account for the
FMS transaction is not the same as the account mapped to the expense code in that transaction:

= |f you select Only make adjusting entries when account is a different account type
and both accounts have the same Vision account type, the project cost transaction uses
the GL account mapped to the account in the FMS transaction.

= |f you select Only make adjusting entries when account is a different account type
and the two accounts have different Vision account types, the account mapped to the
transaction account is still used for the general ledger side of the converted transaction
but the project cost transaction uses the GL account mapped to the expense code. This
is the case for any transactions that qualify as direct expense transactions in Vision
because the new direct expense account never matches the transaction account and
always has a different Vision account type.

= |f you select Always create adjusting entries with the new account number, the
project cost transaction uses the account mapped to the expense code anytime the two
accounts differ.

Guidelines: Selecting a Project Cost Adjustment Option

If you map all of your expense codes to the correct accounts or if you're certain any unmapped
accounts won'’t be needed, select Always create adjusting entries with the new account
number. If you do, all transactions involving a given expense code will be grouped together on
project cost reports even if some of the FMS transactions involve different GL accounts.

Select Only make adjusting entries when account is a different account type in these cases:

= You decide to save data entry time and use default accounts for expense codes that
should be mapped to other accounts. In this case, the only instance in which the project
cost transaction will use a default account is when that default account and the account
mapped to the FMS transaction have different Vision account types.

Or

= Your expense records in FMS didn't always use the default expense accounts assigned
to the expense codes, and you want project cost reports to break down expenses based
on the Vision accounts mapped to those accounts rather than grouping them by the
account mapped to the expense code.
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FMS Codes to Vision Labor Codes Mapping Decisions

If you are converting one or more Deltek FMS work breakdown components (phases,
departments, labor codes, or staff types) to Deltek Vision labor codes, the final step in that
process is to map each FMS code to a Vision labor code.

Recording Your Decisions in the Vision Conversion Module

To record your mapping decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Codes - Vision Labor Codes on the submenu. On the tabs in the FMS
Codes — Vision Labor Codes dialog box, review the default labor code mappings and make any
changes that are necessary.

If you need help using this dialog box, see “FMS Codes to Vision Labor Codes Mapping
Decisions” on page 82.

- FMS Codes - Vision Labor Codes @

Phases Labor Code Staff Type Departments
FMS Code FMS Description Wision Code Wision Description ~
101 Computer Aided Design 101 Computer Aided Design
101 Computer Aided Drafting 101 Computer Aided Design
101 Computer Drafting 101 Computer Aided Design
102 Draft 102 Drafting
102 Drafting 102 Drafting
103 Meetings 103 Meetings
103 Site Meetings 103 Meetings
104 Site Visit 104 Site Visit
104 Site Visits 104 Site Visit
105 Survey 105 Surveying
105 Surveying 105 Surveying
106 Field Work 106 Field Work
106 Field Wk 106 Field Work
110 Surveying 105 Surveying
112 Field Work 106 Field Work 2
Generic ¥ision Labor Code: | 403
sare ) [oies
Background

For background information on mapping FMS codes to Vision labor codes, see these topics:
= “Migration Briefing: Work Breakdown Structure Conversion” on page 35
=  “Work Breakdown Structure Decisions: Phases” on page 42
= “Work Breakdown Structure Decisions: Departments” on page 45
= “Work Breakdown Structure Decisions: Labor Codes” on page 49
= “Work Breakdown Structure Decisions: Staff Types” on page 51

= “Labor Code Structure Decision” on page 53

Guidelines: Mapping Codes to Vision Labor Codes

When you open the FMS Codes — Vision Labor Codes dialog box, the codes you have set up in
Business Management for the FMS work breakdown structure components you are converting to
labor codes are listed. To map them to Vision labor codes, click the Reset/Default Codes button,
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review the default codes displayed on each tab, and use the Vision Code column to make any
necessary mapping changes. You can also change the descriptions of the labor codes in the
Vision Description column.

All codes for a given Vision labor code level must be the same length. If an FMS code is the

same length as that specified for the labor code level, then the default Vision code will be the
same as the FMS code. However, for FMS codes that are shorter or longer than the required
length, the default Vision code will be either lengthened with zeros or shortened by dropping

characters from the FMS code. In those cases, you may want to change the default code.

If any of the FMS codes include characters other than letters and numbers (a hyphen, for
example), those characters are not included in the default Vision labor codes. Vision labor codes
cannot include punctuation marks or other special characters, other than those used as delimiters
between levels.

Guidelines: If You Have Codes You Don’'t Want to Convert

If you have FMS codes (some departments, for example) that you no longer use and, thus, don’t
want to convert to separate labor codes in Vision, you can map them all of them on the same tab
to a single “dummy” Vision code that you set up for that purpose. To do that, type in the Vision
code and description for the first unused FMS code, and then type in the same code for each of
the other unused FMS codes.

Guidelines: Mapping FMS Phases and Labor Codes to Vision Labor Codes

On the Phase and Labor Code tabs, the lists of FMS codes include all phases and labor codes
assigned to the FMS projects that you've selected to be converted. Because you can assign
project-specific phases and labor codes in FMS, some phases or labor codes may exist that have
the same ID but a different description. In that case, there will be a row for each ID-description
pair.

By default, these FMS codes are mapped to the same Vision code. If that is not what you want,
you can map them to different Vision codes.

Guidelines: Selecting Default Codes

When you map codes to Vision labor codes, you must specify a default code for each labor code
level. These default codes are used during conversion of project labor budgets. Every Vision
labor budget record must have a labor code. When the conversion program encounters an FMS
budget record that doesn’t include a code corresponding to one of the Vision labor code levels,
the default code for that level is used in the Vision labor code assigned to the budget record.

If you don’t plan to convert your FMS project budgets, don’t have project budgets, or do your
budgeting using the Resource Scheduling and Budgeting feature set, you can select any codes
you want for these defaults; they won't be used.

If you do have project budgets entered using the standard budgeting feature in the Business
Management module and plan to convert those budgets to Vision, it is recommended that you
select an existing general-use code for each level. If you don’t have such a code in FMS for a
level, you can create one in FMS specifically for this purpose, map it to a Vision code, and select
that code as the default for the level.

Staff Type-to-Vision Labor Category Mapping Decisions

If you are converting Deltek FMS staff types to Deltek Vision labor categories, the final step in
that process is to map each staff type to its corresponding labor category.
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Recording Your Decisions in the Vision Conversion Module

To record your mapping decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Staff Types - Vision Labor Categories Mapping on the submenu. On
the tabs in the FMS Staff Types — Vision Labor Category Mapping dialog box, review the default
labor category mappings and make any changes that are necessary.

If you need help using this dialog box, see “Staff Type-to-Vision Labor Category Mapping
Decisions” on page 83.

i FMS Staff Types - ¥ision Labor Category Mapping. @

FMS Code FM3 Description Yision Code Yision Description -~
10 Principal 10|Principal

11 Seniar Architect 11|Zenior Architect
12 Seniar Engineer 12|Senior Engineer

13 CAD Operator 13| CAD Operatar
14 Draftsman 14|Draftsman

16 Architect 16| Architect

CLER General Clerical 18| General Clerical

ResetiDefault Codes...

Close

Background

Labor categories in Vision must be a number between 1 and 32767. Unlike Vision labor codes,
however, labor categories do not have to be a uniform length. For additional background
information on mapping FMS staff types to Vision labor categories, see these topics:

= “Migration Briefing: Work Breakdown Structure Conversion” on page 35

=  “Work Breakdown Structure Decisions: Staff Types” on page 51

Guidelines: Mapping Staff Types to Labor Categories

When you open the FMS Staff Types — Vision Labor Category Mapping dialog box, the staff types
set up in Business Management are listed. To map them to Vision labor categories, click the
Reset/Default Codes button, review the default codes displayed on each tab, and use the Vision
Code column to make any necessary mapping changes. You can also change the descriptions of
the labor categories in the Vision Description column.

If your staff type IDs are numeric (and in the range from 1 to 32767), the default labor categories
will be the same as the staff type IDs. If your staff type IDs contain characters other than
numbers, you must decide on and enter a numeric labor category for each of them in the Vision
Code column. The numeric sequence of labor categories in Vision controls the order in which
labor charges appear on invoices if you bill by labor category. We recommend assigning labor
category numbers based on billing rate, with the lowest numbers going to labor categories with
the highest rates.

Guidelines: If You Have Staff Types You Don’t Want to Convert

If you have staff types that you no longer use and, thus, don’t want to convert to separate labor
categories in Vision, you can map them all of them to a single “dummy” labor category that you
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set up for that purpose. To do that, type in the labor category and description for the first unused
staff type, and then type in the same labor category for each of the other unused staff types.

If you do this, make sure no employees are assigned these staff types. When you convert staff
types to labor categories, employees are assigned to the labor categories to which their staff type
is mapped. If any employees are assigned the unused staff types mapped to the dummy labor
category, the conversion will assign those employees to the dummy labor category.

Labor Rate Schedule Decisions

If you have Deltek FMS billing rate schedules that include labor rate exceptions by employee or
by staff type, you can convert those to labor rate tables or labor category tables in Deltek Vision.

Recording Your Decisions in the Vision Conversion Module

To record your mapping decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Billing - Vision Billing Terms on the submenu. On the Labor Rate
Schedules tab in the FMS Billing — Vision Billing Terms dialog box, indicate the billing rate
schedules from which you want to convert the labor rate exceptions and how you want them
converted.

If you need help using this dialog box, see “FMS Billing — Vision Billing Terms Mapping
Procedures” on page 142.

Select the default rate table type and other rate
schedule conversion options.

FMS Billing - ¥Yision Billing Terms

Labor Rate Schedules [/ Tax Methods Fee Methods Custom Invoice Formats

Convert Labor Rate Schedule

Rate Schedule Vision Rate Table Type Add Missing Employees? A

(&) Labor Rates (By Employee)
O Labor Categary
() No Labor Rate Detail

05-003

Labor Rate

No

2005_10

Lahor Rate

No

2005CPFF

Labor Rate

No

["]Convert Rate Schedules for Inactive/Completed Projects 2005Gay Labor Rate No
Create Labor Rate Schedule for Default Employee Billing Rates 20055d Labor Rate Mo
[Jinclude Terminated Employees General Lahﬂj;lﬁ'alﬁ Mo

For each of the FMS billing rate schedules, indicate the
Vision rate table type you want to convert it to and
whether you want to add all employees to the schedule
who are not already on the FMS labor rate schedule.
Migration Guide 85



Deltek Kwovmore

Chapter 4: Migration Decisions — Mapping

Background

The billing process for a project is controlled by the billing terms set up for the project. To handle
billing rates, you can choose, as part of the billing terms, to use a table of employee billing rates
(labor rate table) or a table of rates by labor category (labor category table). These tables serve

the same basic purpose as the Labor Rates tab in the Billing Rate Schedules dialog box in FMS.

Depending on how you're using billing rate schedules in FMS, you may be able to convert
employee or staff type labor rate exceptions to Vision labor rate tables or labor category tables.
Those tables will then become part of the billing terms set up for the WBS components to which
the associated billing groups are converted.

The only billing rate schedules you can convert are those assigned to the projects you selected
for conversion.

One difference from FMS is that Vision has no default billing rate for individual employees in the
Employee Info Center. Because of this, the default billing rates for employees in FMS are not
converted. If a project in Vision is getting billing rates from a labor rate table and an employee
who worked on the project is not included in that table, that employee’s billing rate will be 0.00. In
FMS, by contrast, his or her default rate would be used if there was no applicable labor rate
exception in the billing rate schedule.

Guidelines: Selecting Conversion Options for Rate Schedules

If you are converting staff types to Vision labor categories and you have billing rate schedules
that contain labor rate exceptions that consist of just a staff type and a rate, select Labor
Category under Vision Rate Table Type in the grid for those schedules. The conversion will
create labor category tables containing the staff type billing rates.

If you have billing rate schedules with exceptions that consist of just an employee and a rate,
select Labor Rate under Vision Rate Table Type for those schedules. The conversion will
create labor rate tables containing the employee billing rates.

In either of these cases, if you have set up additional rates with effective dates for any of the
converted rate exceptions, additional rows are added to the labor category table or labor rate
table in Vision for each of the effective dates specified in FMS.

If you select Labor Category for a rate schedule, the only exception rows that are converted are
those containing a staff type and a rate and no other data. If a row contains any other information
(an employee, a phase,...), itis not converted and won’t appear in the labor category table. The
same is true when you select Labor Rate. The only exceptions converted are those that contain
an employee and rate only.

Select Do Not Convert under Vision Rate Table Type for billing rate schedules that contain no
exception rows that can be converted (as described previously) and for schedules that you are no
longer using. Also select Do Not Convert for schedules that have a mix of conversion-eligible
rows and rows that won’t convert if you don’t want to convert part of the schedule.

If you choose to not convert a billing rate schedule, the billing terms assigned to the WBS
components created from the billing groups assigned that rate schedule will have No labor billing
selected in Method on the Labor tab of the Billing Terms form. Before you can proceed with billing
in Vision, you must edit the billing terms for those projects to re-enable labor billing.

Guidelines: Adding Missing Employees to Labor Rate Tables

For each rate schedule you convert to a labor rate table, you have the option to add all
employees to that table. Employees for whom no labor rate exception exists in the billing rate
schedule are added to the table with their hourly billing base rate from their FMS employee
record.
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Because it adds all employees to the table, this option is normally only used when a number of
employees working on a job have no labor rate exceptions in the billing rate schedule and instead
are billed out at their hourly base billing rate.

Guidelines: Converting Rate Schedules for Inactive and Completed
Projects

Normally, you probably won’t want to convert billing rate schedules that are currently only
assigned to inactive or completed projects. However, you may want to convert such schedules if
you expect to use them again for new projects (a standard billing rate schedule that you use for
government contracts, for example).

To display them in the grid on the Labor Rate Schedules tab of the FMS Billing — Vision Billing
Terms dialog box, select Convert Rate Schedules for Inactive/Completed Projects.

If they aren’t assigned to a project that you've selected for conversion, these schedules won't
appear in the grid even if you select Convert Rate Schedules for Inactive/Completed Projects.

Guidelines: Creating a Labor Rate Table for Default Employee Billing Rates

Regardless of your situation, you should select Create Labor Rate Schedule for Default
Employee Billing Rates. If you select this box, the conversion creates a default labor rates table
in Vision called FMS Default Employee Billing Rates that contains every employee with his or her
hourly base billing rate.

The conversion assigns the FMS Default Employee Billing Rates table as the rate table in the
billing terms for any project for which the FMS labor billing rates weren’t converted. It also assigns
this table as the rate table for the default billing terms and default reporting terms. The default
billing terms and default reporting terms serve as templates for each new project’s billing terms
and reporting terms. (If you elect to not create this table, the conversion assigns no rate table in
any of these situations.)

This labor rate table isn’t intended to be used in any actual billing terms, and you will probably
want to substitute a more useful labor rate or labor category table for it in all instances in which
the conversion assigns it in Vision, including the default billing and reporting terms. It is primarily
recommended that you create this table so that you have a record in Vision of all employees’
hourly base billing rates from FMS in case you want to add employees and their default rates to
other labor rate tables.

Guidelines: Including Terminated Employees

Only select Include Terminated Employees if you have a large number of seasonal employees
that are terminated at the time of conversion, and you want their billing rates to be preserved in
Vision.

Because this setting has a global effect, you should not select it if you have just a few such
employees. If you do select it, the conversion converts labor rate exceptions for all terminated
employees that exist in billing rate schedules you are converting to labor rate tables. In addition, if
you also set Add Missing Employees? to Yes for a rate schedule, all terminated employees are
added to the resulting labor rate table along with all active employees.

Guidelines: If You Will Be Converting Unbilled Time Records with a Billing
Rate Different than in the Schedule

If you will be converting unbilled time records for which the billing rate no longer matches the
applicable rate in the bhilling rate schedule, they will be billed in Vision using the rate taken from
the billing rate schedule. Billing rates on individual time records are not used in Vision so that
information is not converted.
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If you want those time records to be billed at the original rate, use the Create Rates by Effective
Date button in the Billing Rate Schedules dialog box to set up your earlier rates and the current
rates with the appropriate effective dates. Each set of rates will be converted to Vision, and when
you bill the time, the billing rate used in each case will be the one in effect on the time record
date.

Fee Methods Decisions

If you have non-tax fee methods in any billing rate schedules in Deltek FMS, the conversion
converts them to add-ons in Deltek Vision and assigns them to the billing terms for the
appropriate projects. If you have some fee methods designated as taxes, refer to “Tax Fee
Methods Decisions” on page 92 for information on converting those taxes.

Recording Your Decisions in the Vision Conversion Module

To record your fee method decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Billing - Vision Billing Terms on the submenu. On the Fee Methods
tab in the FMS Billing — Vision Billing Terms dialog box, select the basic conversion method you
want to use and provide the other required information.

If you need help using this dialog box, see “FMS Billing — Vision Billing Terms Mapping
Procedures” on page 142.

Select this option if you want the

Select this option if you want to specify add-on conversion to set up the add-on fees in
fee settings to be assigned to all converted Vision based on the specific fee method
projects that use each fee. settings for each billing group in FMS.

— FMS Billing - Vision Billing Terms

Lahor Rate Schedules Tay Method i Fee Methods ) Custom Invoice Formats
(#) Use These Calculation Settings for Converted Fee Methogs
Code Description Method Rate/Amount Vision Credit Acct. Labor Consultant Expense Fee Unit  Add On A
AdminFee Administration Fee Rate 5.75[4111 O | O | 4]
Benefits Markup for Benefits Rate 20.00]4111 O L O L |
DFE DPE Rate 237014111 .} ] O ] ]
ExpFee Expenses Fee Rate 2.25|4112 || 0 O .} 0
ExpMarkup Expense Mar,lw{Fee Rate 0.00{4112 O O O O O
Fringe Fringe Besefits Rate 2557(4111 O O O | O
GBA Gengfal and Administrative Overhead  |Rate 38.91|4111
GRA@BD le€A @ 80 Percent Rate 0.00{4111
InvFee Invoice Fee Rate 10.00/4111 4]
Oﬂsnyﬁﬁ Off-Site OH-Client Site Rate 65.00[4111 O ] 0 L] a2
(0 Use Calculation Settings from Billing Rate Schedules for Converted Fee Methods
Fee Method Maximums For Fee Methods with Combined Basis
() Don't Convert Fee Method Maximums &) DontUse Combined Basis
O Convert Sum of Fee Method Maximums as Add-On Maximum O Include All Add-ons in Basis

If you choose to specify the Vision settings for each add-
on fee, you can set the method, ratefamount, GL account,
and billing categories that make up the basis for
calculating the add-on amounts.
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Background

In both FMS and Vision, you can set up and bill for add-on fees (a profit fee, for example). These
are called fee methods in FMS, “add-ons” in Vision. Though their functions are the same, there
are several differences between how you set up FMS fee methods and how you set up Vision
add-ons.

In FMS, add-on fees can be calculated as a percentage of the basis, a fixed amount, a portion of
a maximum fee amount based on the manager's estimate of percent complete, a percentage of a
total fee that is based on the percentage of the total billing fee billed on each invoice, or a set
amount per unit. In Vision, you only have two basic options. The add-on can be a fixed amount or
it can be a percentage of the basis.

In FMS, the basis for a fee can be fixed fee billing, total billing group billing, or the billing total for
a cost type. If the billing rate schedule will be used for billing groups with phased billing types, you
also have the option to apply a fee to a single phase. In Vision, you can set up add-ons for any of
a project’'s WBS levels. The basis for an add-on can be the billing total for any combination of the
following: fixed fee billing, labor, reimbursable expenses, consultants, units, and other add-ons.

Both products enable you to set up add-on fees with a combined basis. That is, the basis for the
fee includes other add-on fees. In FMS, you can select any combination of the previously
assigned fee methods to include in the basis. In Vision, however, there is no choice. All
previously assigned add-ons are automatically included if you elect to include add-ons in the
basis.

FMS enables you to specify a maximum amount that can be billed for each fee method. In Vision,
you can only specify a single maximum for all add-ons for the WBS level.

Revenue from add-on fee billing in FMS goes either to income accounts specified in the Fee
Methods dialog box or to the income accounts for each of the cost types that contribute to the fee
basis. In Vision, add-on revenue for a project can go to a company-wide default income account
for add-on billing, to an override account specified for the WBS level as a whole, or to accounts
specified for individual add-ons.

Guidelines: General

If you use fee methods, the first thing to understand is that, because of differences between the
two products, the conversion may not create exactly the add-on fees you need in Vision. If you
use a single fee method in FMS to generate markups on all reimbursable expenses using a
standard rate, for example, that fee should convert cleanly to Vision add-ons. But if you have
some fee methods that apply, say, to just selected reimbursable expenses or that use a
combined basis, it is more likely you will need to make changes to the conversion results before
you begin using Vision.

Guidelines: Selecting a Conversion Method

If, for each fee method, the calculation method, rate, and basis are the same for most or all billing
groups for which the fee method is currently being used, select the Use These Calculations
Settings for Converted Fee Methods on the Fee Methods tab of the FMS Billing — Vision Billing
Terms dialog box and specify in the grid how you want each add-on fee set up in Vision. When
you do this, the conversion sets up each instance of an add-on fee in Vision the same way in all
project billing terms.

On the other hand, if the calculation method, rate, or basis for fee methods vary from billing group
to billing group, select the Use Calculations Settings from Billing Rate Schedules for
Converted Fee Methods and specify how you want to handle the conversions of fee maximums
and combined bases. In this case, the conversion sets up each instance of an add-on fee based
on how the corresponding fee method is set up for the billing group in FMS. (For more information
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on how fee methods are converted in this case, see “Fee Methods Conversion (Non-Tax)” on
page 189.)

Guidelines: Choosing Basis Options

If you select the Use These Calculations Settings for Converted Fee Methods option, you
then specify the basis for those add-on fees that are calculated as a percentage (rate).

These don't match defaults/conversions in specs but | don’t understand why specs are the way
they are, unless they decided to check all possible boxes that could apply and user will need to
go in to each one and fine tune them.

If the fee method applies to... Then select...
Billing summary Fee

Billing group Labor, Consultant, Expense, Fee, and Unit
Labor cost type Labor

Expense cost type with Subcontractor Consultant

selected

Expense cost type with Subcontractor not Expense and/or Units

selected

If you select the Use Calculations Settings from Billing Rate Schedules for Converted Fee
Methods option, the conversion establishes these settings in the Vision billing terms based on
how the basis is defined for each instance of the fee method.

Guidelines: Converting Combined Basis

If you select the Use These Calculations Settings for Converted Fee Methods option and one
of the fee methods uses a combined basis (that is, the basis for the fee method includes the
billing amount of another fee method), you need to decide if you should select the Add On check
box for that fee method.

Always, or nearly always, includes all fee methods that Select Add On for that fee
precede that fee method in the Fee Methods grid in the method.
Billing Rate Schedules dialog box

Often does not include all fee methods that precede that Don't select Add On for that fee
fee method in the Fee Methods grid in the Billing Rate method.
Schedules dialog box

For fee methods that don’t have a combined basis, do not select Add On.

If you select the Use Calculations Settings from Billing Rate Schedules for Converted Fee
Methods option, you have the option to convert or not convert the combined basis. (The option
you select applies to all fee methods that have a combined basis.)
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If the combined basis for your fee methods... | Then select...

Always, or nearly always, include all fee methods that Include All Add Ons in Basis
precede that fee method in the Fee Methods grid in the
Billing Rate Schedules dialog box

Often does not include all fee methods that precede that Don’t Use a Combined Basis
fee method in the Fee Methods grid in the Billing Rate
Schedules dialog box

If the conversion of combined basis information will not give you the results you want, discuss the
situation with your Vision consultant to determine how best to set up Vision to bill the fee.

Guidelines: Converting Fee Maximums

If you decide to specify standard add-on fee settings (the Use These Calculations Settings for
Converted Fee Methods option), any maximum billing amounts you've set up for fee methods
for individual billing groups will not be converted. Once the conversion is completed, you can go
to the billing terms for those projects to which a maximum applies and set them up.

If you decide to have the conversion determine add-on fee settings (the Use Calculations
Settings from Billing Rate Schedules for Converted Fee Methods option), you must indicate
how you want fee method maximums to be handled. (If you don't have any fees with maximums,
it doesn’t matter which option is selected.)

If most billing groups that have fee maximums... Then select...

Have only one fee with a maximum Convert Sum of Fee Maximums
or as Add On Maximum

Have two or more fees with maximums, but combining
the maximums into a single maximum will still give you
the correct billing results

Have two or more fees with maximums and adding the Don’t Convert Fee Maximums
maximums together to get the single Vision maximum will
not give you the correct billing results

If you have FMS fee methods with maximums but you decide not to convert the maximums
because the conversion will not give you the correct results, discuss the situation with your Vision
consultant to determine how best to set up Vision to bill the fee.

Guidelines: Reviewing Add-ons Created by the Conversion

Before you begin billing clients using Vision, you should carefully review all add-ons created in
Vision from FMS fee methods to make sure they are set up correctly. This is particularly true if
you decide to have the conversion create the add-on fees based on the fee method settings in
individual billing rate schedules in FMS. However, even if you specify standard settings for your
add-on fees, you may still need to make changes to individual add-ons if there are projects that
need to bill the fees in a non-standard way. Because of differences between FMS and Vision in
fee basis options and how maximums are handled, it may not be possible to convert some fee
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methods to an add-on that is exactly equivalent. Discuss any complex add-on fee billing with your
Vision consultant to determine the best way to duplicate that billing in Vision.

Tax Fee Methods Decisions

If you have tax fee methods in any billing rate schedules in Deltek FMS, you can have the
conversion convert them to tax codes in Deltek Vision and assign them to the billing terms for the
appropriate projects.

For information on converting non-tax fee methods, refer to “Fee Methods Decisions” on page 88.

Recording Your Decisions in the Vision Conversion Module

To record your tax method decisions in the Vision Conversion module, click Mapping on the
Maintain menu and FMS Billing - Vision Billing Terms on the submenu. On the Tax Methods
tab in the FMS Billing — Vision Billing Terms dialog box, select Convert FMS Tax Methods,
display the default tax code information for the tax methods, and make any changes that are
necessary.

If you need help using this dialog box, see “FMS Billing — Vision Billing Terms Mapping
Procedures” on page 142.

For each tax method, indicate the

types of charges to which it applies. If
Check this box if you want to convert necessary, you can also change rates
the tax methods shown. and GL accounts.

FMS gilling - Yision Billing Terms

Labor Rate Schedules i Tax Methods Fee Metfiods Custom Invaice Farmats
Canvert FMS Tax Methods
Code Description Rate  Vision CreditAcct. Labor Consultant Expense Fee  Unit  AddOn  »
GST Goods and Services Tax 5.0000|2164 O O O O O
PST Provincial Sales Tax 5.0000(2164 4 O O O O
SalesTax State Sales Tax 5.0000|2164 || .| .| .| O
SenviceTax  |Professional Senvices Tax 5.0000(2164 4 | 4 4 O
v
[ ResetDefault Tax Methods.

Background

In FMS, you can set up fee methods designated as taxes and assign those taxes to billing groups
through their billing rate schedules if you need to bill clients for taxes. For each billing group, you
have the same wide variety of options for defining the basis for taxes that you do for add-on fees.

In Vision, you set up tax codes and assign those to billing terms for projects if you want to bill for
taxes. Tax codes can be set up to apply to any combination of labor, consultants, expenses, fees,
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units, and add-ons. In contrast to FMS, however, this is set at a global level, not project by
project.

If you have tax methods in any billing rate schedules in FMS or tax methods you’ve set up in the
Invoice Preparation dialog box for billing groups, you can have the conversion convert those tax
methods to tax codes in Vision and assign them to the billing terms for the appropriate projects.

Guidelines: Deciding to Convert Tax Methods

In general, if you bill clients for taxes, there is no reason to not convert your tax methods. Be
aware, however, that because in Vision the tax code rate and what it applies to is the same for all
projects for which it is used, you will have to create additional tax codes for a type of tax if you
use different rates for different projects or you apply the tax differently for different projects.

One situation in which you may not want to convert tax methods is if there are many taxes for
which you can’t duplicate the FMS tax processing just by converting the tax method. In that case,
you should discuss alternatives with your Vision consultant.

Guidelines: Changing the Default Tax Rate

The default tax rate shown on the Tax Methods tab of the FMS Billing — Vision Billing Terms
dialog box is the rate entered for the tax in the Fee Methods dialog box. If that rate is not the
current tax rate, you should change it to the correct rate.

Guidelines: Selecting the Credit Account

The default credit account shown on the Tax Methods tab is the Vision account you mapped to
the default liability account for the tax specified in the Fee Methods dialog box. In most cases,
you should not need to change this account.

Guidelines: Indicating What the Tax Applies To

Use the check boxes in the grid to indicate the types of charges to which each tax applies. For
example, if the tax in FMS applies only to the Professional Services cost type on cost plus
contracts, you would select Labor and clear the other check boxes.

Because Vision doesn’t have the equivalent of cost types, you may find that you can't duplicate
FMS tax processing exactly in Vision (for instance, if you have a sales tax that only applies to
certain types of expenses but not to others). In that case, discuss alternative approaches with
your Vision consultant.

Keep in mind also that what a tax applies to is the same for all projects for which it is used, you
may have to create additional tax codes in Vision for a type of tax if you apply the tax differently
for different projects.

Custom Invoice Format Decisions

If you are using custom versions of the Crystal Reports files used to print client invoices in Deltek
FMS for the projects you are converting, you have the option to convert some or all of those
custom formats to invoice templates and billing terms in Deltek Vision. The conversion
automatically converts any of the standard FMS invoice formats that are assigned to the projects
you convert. These migration decisions only apply to custom invoice formats.

Recording Your Decisions in the Vision Conversion Module

To use the Vision Conversion module to select the custom invoice formats you want to convert,
click Mapping on the Maintain menu and FMS Billing - Vision Billing Terms on the submenu.

Migration Guide 93



y
Deltek Kwovmore

Chapter 4: Migration Decisions — Mapping

On the Custom Invoice Formats tab in the FMS Billing — Vision Billing Terms dialog box, select
the custom formats you want to convert and indicate the template you want the conversion
process to follow for each format. If you need help using this dialog box, see “FMS Billing — Vision

Billing Terms Mapping Procedures” on page 142.
Select a default option for the
Conversion Method column in the grid.
Pick the conversion method that applies

to the most custom formats listed.

Custom Invoice Formats

— FMS Billing - Yision Billing Terms
Fee Methods

Tax Methods
Customn Invoice Template L

Labor Rate Schedules
Convert Custom Invoice Formaty - - -
@ Use Standard Template FMS Custom Invoice Format Conversion Method = Standard Invoice Template
| —— Ternplate INVTYPE1_USA Standard Template  |InvTypel |
(-\, Do Not Convert INVTYPE4_USA Custom Template Customize

/

|
/
|
/ /
/ |
/ /
|
/
|
/
[

v

/ /
N Y

{

For each custom format listed, indicate if
youwant to convert it using a standard
format as template, convert it using a

custom template, or not convert it.

If you selected Standard Template in Conversion
Method, select the standard format you want to use as

the conversion template.
If you selected Custom Template in Conversion Method,
click the Customize button and, in the Custom Format
Settings dialog box, select the custom options you want.

Background: Invoice Formatting
In FMS, the billing types assigned to billing groups, along with other project and billing group
billing settings, determine what data is available for invoices. The invoice format (the Crystal
Reports billing report file) assigned to each project defines what billing data will appear on the

printed invoice and how that data is formatted. The invoice formats control:

Font size and style
Page breaks and page numbers
Page and group headers and footers

Column positions and headings

=  Graphics
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= Currency symbols
=  Subtotals and totals
= Calculated fields

In FMS, you can use the standard invoice formats for your invoices, or you can create custom
versions of them. Using the Crystal Reports Designer, you can control just about every aspect of
an invoice’s contents and appearance.

In Vision, invoice content and appearance is determined by a combination of settings in Vision
itself. Some are part of the billing terms you set up for a project or for its sublevels in the work
breakdown structure, and some are specified in invoice templates. (An invoice template is
assigned to a project as part of its billing terms.) Vision provides access to invoice settings in
Vision itself, it is easier to make changes to invoices, but you are somewhat more limited in the
options you have. There are some invoicing options in Vision that are not available in FMS.

Background: Conversion of Invoice Formats

The conversion can create billing terms and invoice templates in Vision based on the invoice
formats assigned to the projects you've selected to be converted. However, because the invoice
formatting capabilities of FMS and Vision are so different, the conversion will not result in Vision
invoices that are exact duplicates of your FMS invoices. Conversion is automatic for any of the
standard invoice formats that you've assigned to projects that are converted. For custom invoice
formats, you select those you want to convert on the Custom Invoice Formats tab of the FMS
Billing — Vision Billing Terms dialog box.

Guidelines: General
The conversion of invoice formats provides two important benefits:

= The billing terms and invoice templates created provide you with a reasonable
approximation of your FMS invoices, a starting point from which you can refine your
Vision invoices.

= The invoice-related billing terms and invoice templates are assigned to the converted
projects, so you don’t have to do that yourself in Vision.

For these reasons, you should convert any custom formats that you are still using to print invoices
for the projects you are going to convert. After the test conversion, print invoices for
representative projects, review the results, try out other Vision invoicing options, and evaluate
whether you want to select different conversion options for the final conversion.

Guidelines: Selecting the Custom Invoice Formats to Be Converted

When you go to the Custom Invoice Formats tab of the FMS Billing — Vision Billing Terms
dialog box, all custom invoice formats currently assigned to the projects selected for conversion
are listed in the grid.

If an invoice format is currently being used to print invoices for any projects, you should convert
that invoice format by selecting either Standard Template or Custom Template in Conversion
Method.

If an invoice format is only assigned to projects for which you are no longer printing invoices and
you don't expect to use it in the future, do not convert it. Select Do Not Convert in Conversion
Method. While converting a format that you are no longer using does no real harm, it adds an
unnecessary invoice template to your Vision database.
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Background: Conversion Templates

If you are going to convert a custom invoice format, you have two basic conversion methods:
= Convert based on a “standard template
= Convert based on a “custom template”

For the standard template conversion, the conversion program either selects settings for billing
terms and the invoice template in Vision based on a standard FMS invoice format that you specify
or it uses Vision default settings. If you elect to convert using one of the standard FMS formats (
the most common choice), the invoice template created and assigned to the projects using the
custom format is named the same as the standard format (InvTypel, for example). If you decide
to convert using Vision default settings, no invoice template is created or assigned to the projects.
Instead, default settings are used when printing invoices for those projects in Vision.

For the custom template conversion, you again specify either Vision default settings or a standard
invoice format as the basis for the conversion. However, for this type of conversion, you can use
the Custom Format Settings dialog box to review and make changes to some of the settings
before the conversion takes place.

— Custom, Format Settings |zl@®

Custom Invaice Format. | INYTYPE4_USA Use Defaults Fram: | InvTyped o~

Invaice Template Settings

Template Mame: | INWVTYPE4_LISA Report Font. | Times Mew Roman w
Print in Invoice Header Printin Invoice Footer
] Firm Mame [¥] Project Mame [Jinvoice Box [ Total Mow Due [¥] Footer Line
] Firm Trade Name [ Principal Mame [¥] Invoice Mumber [Jsignature Line [¥] Page Mumbers
[ Firm Address [¥] Project Manager

Billing Terms Invoice Settings

Labor Expense: Print General: Print
SortBy | Bycategory ¥ Expense Detail Project AR
Print [] Expansa Multipliar [ Project Billed-To-Date
[ Timeshest Detail
[[] consultant Detail [ Billed-To-Date Received Total
[ Consultant Multiplier []Billed-To-Date AR Balance Total
[¥] Rates [ Unit Detail
[ Multipliers [ Unit Multiplier

[] ot Multiplier

% |

Each of these settings is described later in this topic.

With the custom template conversion method, the default name of the resulting invoice template
in Vision is the same as that of the custom FMS format, but you can change it in Template Name
in the Custom Format Settings dialog box.

Guidelines: Selecting the Standard Template Conversion Method

Select the standard template conversion for an invoice format if both of the following are true:

= The differences between your custom format and the standard format on which it was
based is not related to any of the custom format settings available in the Custom Format
Settings dialog box.
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= You want the invoice template created in Vision and assigned to the projects that use the
FMS invoice format to have the name of the standard invoice format, not that of the
custom format.

The standard invoice format to select is the one on which you based the custom format when you
created it in Crystal Reports.

For example, suppose you created a custom version of the InvTypel standard format in FMS
because you wanted to specify different fonts for some headings. Since none of the custom
settings available for the conversion enables you to duplicate this difference in Vision, you decide
to convert the custom format using the standard template method and select InvTypel as the
template.

In the preceding example, the invoice template created in Vision would be named InvTypel. Why
convert a custom format so that the invoice template in Vision has the standard invoice format
name rather than the custom name? If you have several custom versions of the standard invoice
format in FMS for which the custom features cannot be converted to Vision or if you have some
projects using the standard version and some using a custom version of it, it gives you the option
to assign a single invoice template in Vision to all of those projects. That way, if you make a
change to that invoice template in Vision, the change will take effect for all of those projects. If
you want to keep the custom format name, however, you can do that using the custom template
conversion.

Guidelines: Selecting the Custom Template Conversion Method
Select the custom template conversion for an invoice format if either of the following are true:

= The differences between your custom format and the standard format on which it was
based is related to one or more of the custom format settings available in the Custom
Format Settings dialog box.

= You want the invoice template created in Vision and assigned to the projects that use the
FMS invoice format to be named the same as the custom invoice format.

In Use Defaults From in the Custom Format Settings dialog box, select the standard invoice
format on which the custom format is based, and then review and, as necessary, change the
default conversion settings. If the only reason you selected the custom template conversion is
because you want the Vision invoice template to be named the same as the custom format, just
select that format in Use Defaults From and click OK without making any other changes. (If you
want it to have a name other than the current custom format name, you can change the default
name in Template Name.)

Guidelines: Selecting Vision Defaults as the Template

Most often Deltek clients, whether they select the standard template conversion or the custom
template conversion, convert their custom invoice formats based on the standard invoice format
they used to create the custom format. However, if you created a custom invoice format from
scratch in Crystal Reports Designer or you modified a standard one so heavily that it makes no
sense to convert it based on that standard format, you can choose Vision default settings as the
template and then refine the invoice format and billing terms settings in Vision after the
conversion.

Even if there is no suitable template for converting your custom format, you should still convert it
so that each of the projects using the format is assignhed the same invoice template in Vision.
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Custom Conversion Settings

The following tables describe how the conversion settings available in the Custom Format
Settings dialog box affect invoice printing in Vision.

Option Description

Template Name

Enter the name you want for the Vision invoice template.

Report Font

Select the font you want to use for all invoice text. The drop-down
list contains all fonts available in Vision.

Select this Print in

Invoice Header option...

Firm Name

Print your company name. Do not select this option if your
invoices print on letterhead or stationery on which your firm’'s
name is already printed.

Firm Trade Name

Print your company’s trade name.

Corresponding option in Vision: Print Firm Byline

Firm Address

Print your company’s address.

Project Name

Print the project name.

Corresponding option in Vision: Print Project Long Name

Principle Name

Print the name of the principal to which the project is assigned.

Project Manager

Print the project manager’'s name.

Invoice Box

Print the word Invoice bordered with a box in the top-left corner of
the invoice. Do not select this option if you want to leave the top-
left corner of the invoice empty or display your logo there.

Invoice Number

Print the invoice number.
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Select this Print in

Invoice Footer option...

Total Now Due Print the Total Now Due amount after the Outstanding Invoices
section of the invoice. This amount represents the amount
currently outstanding from prior invoices plus the Total this
Invoice amount from the current invoice.

If you do not also select Project AR under General: Print, this
amount will not appear on the project’s invoice.

If you are displaying outstanding accounts receivable at the WBS2
or WBS3 levels, the total now due will be listed for each WBS2 or
WBS3 component and not for the total invoice. If you are
displaying outstanding accounts receivable by project, the total
now due will be listed for the entire invoice.

Signature Line Display signature information, such as the name, title and
signature of the person (project manager, for example) who
authorizes the information on the invoice.

Footer Line Print a horizontal line above the footer on all invoice pages.

Page Numbers Print the page number in the bottom-right corner of the page,
starting with the second page.

Select this Labor

option...

Sort By Control the sort order and grouping of labor charges on an invoice.
You have the following sorting options:

= None

= By Name (employee name)

= By Category (labor category)
Selecting None has the same result as selecting By Name.

Corresponding option in Vision: Primary under Labor Sorting in
billing terms

Timesheet Detail Print timesheet detail.

Vision prints detail lines showing employee name, date (if Dates is
selected), hours, rate (if Rates is selected), and the extended
amount.

If you do not show timesheet detail, Vision prints a summary of
total labor. This summary is sorted by labor category if you are
using the By Category sort method.
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’ Select this Labor

option...

Comments

Print comments.

The comments print on an additional line beneath the employee
name. If the same comment is entered on multiple lines for an
employee, the comments are consolidated into one line on the
invoice. Timesheet lines with different comments are displayed as
separate lines on the invoice. Therefore, an employee may appear
several times on the invoice.

This option is only available if Timesheet Detail is selected.

Dates

Print the timesheet dates.

Vision prints the timesheet date following the employee name on
the detail lines. This option is only available if Timesheet Detail is
selected.

Rates

Print the labor rate for each line item on the invoice.

Multipliers

Print the explicit multipliers (multiplier factors 2 and 3) before the
Total Labor line on the invoice.

If you do not select this check box, Vision does not show the
explicit multipliers. Instead, the amount is included implicitly in the
Total Labor line.

Ovt Multiplier

Print the standard or secondary overtime multiplier, the premium
amount prior to markup, and the premium amount after markup
before the Total Labor line on the invoice.

If you do not select this option, Vision displays a line for the
overtime premium and the fully marked up billing amount, without
showing multipliers or premiums.

Select this Expense:

Print option...

Expense Detail

Print all reimbursable expense transaction detail (including
transaction type, description, transaction date, vendor name, and
so on). To show only totals for the account, category, or vendor,
do not select Expense Detail.

Expense Multiplier

Print the reimbursable expense multiplier on the invoices.

If you are using the same multiplier for both your reimbursable and
consultant expenses, the multiplier prints on the total line. If any of
the multipliers differ, due to the use of expense tables, Vision
calculates and prints the transactions according to the multiplier.

Consultant Detail

Print all consultant expense transaction detail (including
transaction type, description, transaction date, vendor name, and
SO on).
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Select this Expense:

Print option...

To show only totals for the account, category, or vendor, do not
select Consultant Detail.

Consultant Multiplier

Print the consultant expense multiplier.

If you are using the same multiplier for both your reimbursable and
consultant expenses, the multiplier prints on the total line. If any of
the multipliers differ, due to the use of expense tables, Vision
calculates and prints the transactions according to the multiplier.

Unit Detall Print unit detail information.
If you select this check box, the level and type of detail for each
unit is based on the settings for each unit in the Unit Info Center.
If you do not select Unit Detalil, all unit billing detail is consolidated
into one line on the invoice.

Unit Multiplier Print the unit multiplier.

Since Vision uses the same multiplier for all of the units, the
multiplier is calculated and displayed on the total line.

Select this General:

Print option...

Project AR

Print a list of outstanding accounts receivable at the project level
of the work breakdown structure in an additional invoice section
called Outstanding Invoices.

Project Billed-To-Date

Print the billed-to-date amounts at the project level of the work
breakdown structure in an additional invoice section called Billings
to Date.

Billed-To-Date Received
Total

Select this option to print the total payments (or amount) that has
been received in each project’s Billings to Date section.

Billed-To-Date AR
Balance Total

Select this option to print the total amount of all outstanding
invoices for the project in the project’s Billings to Date section.
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Chapter 5. Migration Decisions — Additional
Setup

Vision Company Accounts Decisions

Before you convert, specify the Deltek Vision GL accounts you want to use for unbilled revenue,
unbilled services, accounts receivable, and retainage receivable.

Recording Your Decisions in the Vision Conversion Module

To record your company accounts in the Vision Conversion module, click Additional Vision
Setup on the Maintain menu. On the Accounting Company Settings tab in the Additional Vision
Setup dialog box, select the accounts under Company Accounts.

If you need help using this tab, see “Additional Vision Setup Procedures: Accounting Company
Settings Options” on page 148.

- Additional Yision Setup g@@
Accounting Commpany Settings Payroll
[¥] Adjust Cash Receipt AR Accounts Billing / AR Accounts
3 P ; Billing Income Accounts Receivahle
ommparty Accounts = =
= Fee 4111 T 113 T
Uninvoiced Revenue Account 411
) ) = Labor am 1131
Unhilled Serices Account 114 — —
) = Consultant | 4113 1133
Accounts Receivable Account 1131 — —
_ — Expense 112 1132
Retainage Receivable Account 1136 = =
Unit 4112 1132
Expense Credit Distribution Addron Ll 13
Labor Credit Account 7221 Taxes 1138
Miscellaneous Expense Credit Account Tam Interest 1134
Reproduction Expense Credit Account 7333

Consultant Accrual Expense Credit Account 2112 HLP ISR SEEE 7834

Emplovee Expense Credit Account 2128 Wision System Accounts
Employee Advance Credit Account 1138 CurrentYear Profitand Loss 3311
Prior Year Retained Earnings 32

Save ] [ Close ]

Background: Unbilled Revenue and Unbilled Services

In Deltek FMS, you track work-in-process in two sets of accounts. Unbilled income, representing
work completed but not yet billed, is posted to an unbilled income asset account and to unbilled
income accounts. Unearned income (negative WIP), representing work that has not been done
but for which you have billed the client, is tracked in an unearned income liability account and in
unearned income accounts.

In Vision, WIP is tracked in just two accounts, an unbilled services asset account and an unbilled
revenue income account. If you enable Revenue Generation, these accounts are posted to when
you generate invoices and run the Revenue Generation process.

In the Vision Conversion module and in Vision itself, the unbilled revenue account is specified in a
box labeled Uninvoiced Revenue.

To view these accounts in Vision, click Configuration » Accounting » Company Settings on
the Vision Applications menu, and click the Revenue tab.
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Guidelines: Unbilled Revenue and Unbilled Services
First, complete these steps:

=  Map all of your FMS income accounts for unbilled income and unearned income to a
single Vision income account.

=  Map your FMS unbilled income asset account to a Vision asset account.

= Use a general journal transaction to move the account balance from the unearned
income liability account to the unbilled income asset account. (This account is not used in
Vision. Vision does not post WIP to a liability account.)

= Map the unearned income liability account to a Vision liability account.

(For more information about mapping accounts, see “FMS Accounts-to-Vision Accounts Mapping
Decisions” on page 72.)

Then do the following on the Accounting Company Settings tab in the Additional Vision Setup
dialog box:

= For the unbilled revenue account in Vision, select the Vision account to which you
mapped your FMS income accounts for unbilled income and unearned income.

= For the unbilled services account in Vision, select the Vision account to which you
mapped your FMS asset account for unbilled income.

Background: Accounts Receivable and Retainage Receivable

Most companies, whether using FMS or Vision, set up a single accounts receivable account and,
if they have contracts that involve retainage, a single retainage receivable account to receive the
debit entry when they bill clients.

In Vision, you specify a default accounts receivable account on the Accounts tab of the
Accounting Company Settings form, and that AR account is automatically linked to each of the
billing income accounts and related report columns on the Invoice Mapping Accounts tab and A/R
Mapping Accounts tabs of the Accounts Receivable Configuration form. If you want to use more
than one AR account (when you bill for consultant reimbursable expenses, for example), you can
set that up by linking a different account for the appropriate billing income accounts on the
Accounts Receivable Configuration form.

You also use the Accounts Receivable Configuration form to specify the retainage receivable
account you want associated with billing income accounts.

To view the default AR account in Vision, click Configuration » Accounting » Company
Settings on the Vision Applications menu, and click the Accounts tab. To view the AR and
retainage account mapping information, click Configuration » Accounting » Accounts
Receivable.

Guidelines: Accounts Receivable and Retainage Receivable

Under Company Accounts on the Accounting Company Settings tab in the Additional Vision
Setup dialog box, specify the Vision accounts to which you mapped your FMS AR and retainage
receivable accounts. The conversion then sets up the AR account as the Vision default and links
it and the retainage receivable account to each of the billing income accounts you specify. (See
“Billing Income Accounts Decisions” on page 106.)
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Expense Credit Distribution Accounts Decisions

Before you convert, specify the Deltek Vision GL accounts to receive the implicit credit entries for
time records, miscellaneous expense transactions, reproduction expense transactions, consultant
accrual expense transactions, employee expense transactions, and employee expense
advances.

Recording Your Decisions in the Vision Conversion Module

To record your expense credit distribution accounts decisions in the Vision Conversion module,
click Additional Vision Setup on the Maintain menu. On the Accounting Company Settings tab
in the Additional Vision Setup dialog box, select the accounts under Expense Credit
Distribution.

If you need help using this tab, see “Additional Vision Setup Procedures: Accounting Company
Settings Options” on page 148.

(- Additional ¥ision Setup Q@@
Accounting Company Settings Payrall
[¥] Adiust Cash Receipt AR Accounts Billing I AR Accounts
8 7 : Billing Income Accounts Receivable
ormparty Accounts = =
- = Fee 4111 1131
Uninvoiced Revenue Account M — —
= Labar 4111 113
Unbilled Serdces Account 1141
] = Consultant 1113 1133
Accounts Receivable Account 131 = =
_ = Expense 4112 1132
Retainage Receivable Account 1138 = =
Lnit 4112 1132
Add-an 4111 F| (1121 T
Expense Credit Distribution
Labor Credit Account 7271 TEEES 1136
Miscellaneous Expense Credit Account 7361 Interest 1134
Reproduction Expense Credit Account 7333

Consultant Accrual Expense CreditAccount | 2112 £ ISR e 7934

Emplovee Expense Credit Account 228 “ision Systemn Accounts
Ernployee Advance Credit Account 1138 Current Year Profit and Loss 3
Prior Year Retained Earnings 3312
Save Close

Background: Labor Credit Account

In Deltek FMS, a time record entered for a project normally results in a debit to a direct labor
expense account and a credit to a salaries payable liability account. Then, when the employee is
paid, the transaction debits salaries payable and credits cash. In the case where the employee
works more than their normal hours and you haven't calculated effective cost rates for the time,
the difference between the original cost (total hours x hourly cost rate) and the employee’s pay is
credited to the PR-TR Differences expense account.

In Vision, it is recommended that the account used to receive the implicit credit entry for a time
record (the labor credit account) be an indirect expense account rather than a liability account
such as salaries payable. When the employee is paid, the transaction debits this expense
account and credits cash. If the employee worked more than his or her assigned hours, the
difference remains in the labor credit account as a credit balance. Thus, the labor credit account
in Vision serves much the same purpose as the PR-TR Differences account in FMS.

To view the labor credit account in Vision, click Configuration » Accounting » Company
Settings on the Vision Applications menu, and click the Posting tab.
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Guidelines: Labor Credit Account

If you are going to use Vision Payroll, it is strongly recommended that you use the Vision account
to which you mapped the FMS PR-TR Differences expense account as the labor credit account
(also referred to as the “job cost variance account” in Vision).

If you are using a payroll service and you will make journal entries in Vision to update account
balances for payroll, you can use the account mapped to the PR-TR Differences account or you
can use the account mapped to the FMS salaries payable account. If you use the PR-TR
Differences account as the labor credit account, you make the debit entry to that account only. If
you use a salaries payable account as the labor credit account, you must also make a journal
entry to the account mapped to the PR-TR Differences account if the payroll amount does not
match the labor costs for the time records.

One result of using an expense account instead of a liability account for the credit entry for labor
expense is that if you don’t pay employees before the end of the accounting period, your balance
sheet will understate salaries payable. To avoid that, you can make a journal entry to salaries
payable before printing financial reports and then reverse it in the next period.

Background: Other Expense Credit Accounts

In addition to the labor credit account, you also specify accounts to receive implicit credit entries
for several other types of transactions:

Transaction type Description

Miscellaneous expense | Distribution of miscellaneous indirect expenses (postage,
shipping, phone charges, CAD, etc.) to projects

Print and reproductions Distribution of printing and copying expense to projects

Consultant accrual Generation of accrued consultant expenses
Employee expense Entry of employee-incurred business expenses
Employee repayment Repayment of unused employee expense advance

To view these accounts in Vision, click Configuration » Accounting » Company Settings on
the Vision Applications menu, and click the Posting tab.

Guidelines: Other Expense Credit Accounts

Follow these guidelines when selecting these credit accounts. (If you have questions about what
accounts to select, contact your Vision consultant.) If you use more than one main account for
any of these types of transactions in FMS, be sure you map all of the accounts for that type of
transaction to a single Vision account.

In... Enter...
Miscellaneous Expense Credit The Vision account to which the indirect expense
Account accounts used in FMS for miscellaneous indirect

expenses were mapped.

Reproduction Expense Credit The Vision account to which the indirect expense
Account accounts used in FMS for reproductions is mapped.
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In... Enter...
Consultant Accrual Expense The Vision account to which the FMS liability account for
Credit consultant accruals is mapped.

Since consultant accruals don't exist in FMS, most
converting clients create this account in FMS and then
map it to a Vision account.

Employee Expense Credit The Vision account to which the FMS liability account for
Account employee expenses is mapped.

Because employee expenses are completely separate
from accounts payable in Vision, you should not specify
an AP account here. Instead, create another liability
account in FMS solely for this purpose and then map it
to the account that will be used for employee expenses

in Vision.
Employee Advance Credit The Vision account to which the FMS travel advances
Account asset account used for employee expense advances is
mapped.

Billing Income Accounts Decisions

Before you convert, specify the Deltek Vision GL accounts to which income will be posted when
you bill your clients.

Recording Your Decisions in the Vision Conversion Module

To record your billing income accounts decisions in the Vision Conversion module, click
Additional Vision Setup on the Maintain menu. On the Accounting Company Settings tab in the
Additional Vision Setup dialog box, select the accounts under Billing Income Accounts. If you
need help using this tab, see “Additional Vision Setup Procedures: Accounting Company Settings
Options” on page 148.
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1 Additional ¥ision Setup g@@
Accounting Company Settings Fayroll
[¥] Adjust Cash Receipt AR Accounts Billing / AR Accounts
- a ; Billing Incorne Accounts Receivable
ompany Accounts = =
= Fee 4111 113
Uninvoiced Revenue Account 4121
_ ) — Labaor 111 1131
Unhilled Senices Account 114 — —
_ — Consultant 113 1133
Accounts Receivable Account 1A = =
= Expense 4112 1132
Retainage Receivable Account 1136 — —
Unit 4112 1132
Add- 4111 | (1131 T
Expense Credit Disttibution on
Labar Credit Account 7271 TEFES 1136
Miscellaneous Expense Credit Account 7381 Interest 1134
Reproduction Expense Credit Accournt 7333

Consultant Accrual Expense Credit Account 212 AP Discount Account 7934

Emplovee Expense Credit Account 2125 Vigion System Accounts
Ernployes Advance Credit Account 1138 Current Year Profit and Loss EEN
Frior vear Retained Earnings 3312

gae [ close |
Background

In Deltek FMS, you specify income accounts for each cost type (Professional Services, Outside
Services, Reimbursable Expenses, and so on). These income accounts receive distributions
when you bill for time or expenses entered for the corresponding cost types, even if the time
records, for example, are billed as part of a fixed fee. You can have multiple cost types set up for
a type of charge, in which case you can also have multiple income accounts involved.

In Vision, which does not have the equivalent of cost types, you specify default income accounts
for the following billing categories:

= Fee — Fixed fee billing

= Labor — Billing for time worked (other than fixed fee billing)

= Consultant — Billing for reimbursable consultant expenses

= Expense — Billing for non-consultant reimbursable expenses

= Unit — Billing for goods or services that are billed at a flat rate per item (for example, lab
tests or survey crews)

= Add-on — Billing for add-on fees.

The default accounts are used for all billing terms except those terms for which you override them
on the Add-ons tab or the Misc tab of the Billing Terms form.

To view these default accounts in Vision, click Configuration » Billing » General on the Vision
Applications menu, and click the Accounts tab.
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Guidelines

Use the following guidelines to link Vision income accounts to the Vision billing categories:
For... Assign...

Fee The Vision account to which you mapped professional services income
accounts. If you have billing groups with fixed fee billing that includes more than
direct labor, work with your Vision consultant to determine the best way to set up
billing terms for those projects in Vision.

Labor The Vision account to which you mapped professional services income accounts

Consultant | The Vision account to which you mapped outside services income accounts

Expense The Vision account to which you mapped reimbursable expenses income
accounts

Unit The Vision account to which you mapped reimbursable expenses income
account

Add-on The Vision account to which you mapped the FMS income accounts used for fee
methods.

If the fee method income accounts used in FMS are not all mapped to the same
Vision account, enter the account to which the most often used income accounts
are mapped. This account serves as a default in Vision, but you can select other
accounts for individual projects or even for individual add-ons. (This account is
also assigned to converted fee methods if they are set up to use the income
accounts assigned to cost types. For more information on converting your FMS
fee methods, see “Fee Methods Decision” on page 88.)

If you have more than one labor cost type in FMS and those cost types use different income
accounts, you will have to consolidate them into one Vision income account when you map
accounts. The same is true for any of the other Vision billing categories, with the exception of
add-ons, if you use multiple accounts in FMS for billing charges that fall into that category. (For
more information, see “FMS Accounts-to-Vision Accounts Mapping Decisions” on page 72.)

Cash Receipt Allocation Decisions

If you want receipts you've entered in Deltek FMS to be distributed to billing categories on the
Accounts Receivable Ledger report in Deltek Vision, you need to set up and assign a Vision AR
account for each billing category.

Recording Your Decisions in the Vision Conversion Module

To record your decisions in the Vision Conversion module, click Additional Vision Setup on the
Maintain menu. On the Accounting Company Settings tab in the Additional Vision Setup dialog
box, select the Adjust Cash Receipt AR Accounts check box and enter the AR account
numbers under Billing / AR Accounts.

If you need help using this tab, see “Additional Vision Setup Procedures: Accounting Company
Settings Options” on page 148.
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1 Additional ¥ision Setup g@@
Accounting Company Settings Fayroll
[¥] Adjust Cash Receipt AR Accounts Billing / AR Accounts
3 " " Billing Income  Accounts Receivable
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Accounts Receivable Account 1A = =
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Retainage Receivable Account 1136 — —
Linit 4112 1132
Add-on 4111 | (1131 T
Expense Credit Disttibution
Labar Credit Account 7271 TEFES 1136
Miscellaneous Expense Credit Account 7381 Interest 1134
Reproduction Expense Credit Account 7333

Consultant Accrual Expense Credit Account 212 AP Discount Account 7934

Emplovee Expense Credit Account 2125 Vigion System Accounts
Emploves Advance Credit Account 1138 Current Year Profitand Loss 3311
PriorYear Retained Earings 3312
Save Cloge

Background: Allocating Cash Receipts to Billing Categories

When you print the AR Transaction Record report in FMS, you can specify up to four cost types
or combinations of cost types for which you want the report to show billed and paid amounts.

In Vision, the Accounts Receivable Ledger report is basically the equivalent of the AR
Transaction Records report. On the Accounts Receivable Ledger report, cash receipts are broken
down into these billing categories:

= Fee — Fixed fee billing

= Labor — Billing for time worked (other than fixed fee billing)

= Consultant — Billing for reimbursable consultant expenses

= Expense — Billing for non-consultant reimbursable expenses

= Unit — Billing for goods or services that are billed at a flat rate per item (for example, lab
tests or survey crews)

= Add-on:— Billing for add-on fees.

Vision does not have cost types. Instead, it assigns cash receipts to the appropriate billing
category based on the AR accounts associated with each billing category. That means that each
billing category for which you want separate amounts must be assigned a unique AR account.

While you have the option to set Vision up so that receipts for invoices entered after you begin
using Vision are automatically distributed to the appropriate AR accounts, the converted receipts
that come to Vision from FMS will all be distributed to one AR account unless you take steps
before the conversion to alter that.

Guidelines: Allocating Cash Receipts to Billing Categories

If it isn’t important to you to be able to print billing category allocations on the Accounts
Receivable Ledger report for receipts entered in FMS, don't select Adjust Cash Receipt AR
Accounts on the Accounting Company Settings tab and don'’t enter any AR accounts under
Billing / AR Accounts. Instead, we recommend that you set this up in Vision for reporting on
receipts entered in Vision after the conversion
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However, if you want to be able to print Accounts Receivable Ledger reports in Vision that show
converted FMS receipts correctly categorized by billing category, do the following:

= In FMS, set up an AR account for each of the Vision billing categories you want to track.

= On the FMS Accounts — Vision Accounts Mapping dialog box, map each of those new AR
accounts to the corresponding Vision account.

= On the Accounting Company Settings tab in the Additional Vision Setup dialog box, select
Adjust Cash Receipt AR Accounts.

= Under Billing / AR Accounts, enter the AR account for each category.

You can assign the same account to two or more categories (Fee and Labor, for example). If you
do that, however, the billing income accounts for those categories must also be the same. Be
aware also that if you assign the same accounts to two categories, all amounts for those
categories will show up on the Accounts Receivable Ledger report under the first category and
the other category will always be 0.00.

If you complete these steps, the conversion, when converting receipts, determines the billing
categories that apply to each receipt based on the income accounts affected by the invoice in
FMS and the billing categories you associated with the corresponding Vision accounts under
Billing / AR Accounts. It then distributes the appropriate amounts to the AR accounts you
associated with those billing categories. These adjusting AR entries do not affect GL account
balances. Their only function is to distribute the receipt amounts for the Accounts Receivable
Ledger report.

If a receipt is applied to an invoice that references an income account that you have not
associated with a billing category, the conversion uses the FMS cost type to determine the billing
category and assign the AR account.

Guidelines: If You Have Outstanding AR

If you enter AR accounts for billing categories and you have unpaid invoices at the time of
conversion, you will need to make manual entries to adjust the affected AR account balances
after you enter the receipt in Vision. The Vision receipt is distributed to the new AR accounts
associated with the billing categories, leaving all or part of the original AR amount still outstanding
for the Vision account mapped to the original AR account used for the invoice.

Guidelines: If You Are Using Cash-Basis Accounting

If you plan to use cash-basis accounting in Vision, Vision uses the billing category AR account
assignments to allocate receipts you enter in Vision to the correct income accounts. However,
because these account assignments do not affect the conversion of FMS cash-basis
transactions, you can set them up in Vision (rather than as part of the conversion process) if you
aren’t concerned about distribution of converted receipts on the Accounts Receivable Ledger
report.

AP Discount Account Decision

If you are going to convert vendor discount information (see “Vendor Discount Information
Decision” on page 22), specify the Deltek Vision GL account you want to receive credit entries
when you take discounts on AP invoices. The conversion assigns the account you select to the
Standard discount code in Vision and assigns that discount code to all vendors with FMS
payment terms that include a discount.
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Recording Your Decisions in the Vision Conversion Module

To record your AP discount account in the Vision Conversion module, click Additional Vision
Setup on the Maintain menu. On the Accounting Company Settings tab in the Additional Vision
Setup dialog box, enter the Vision account number in AP Discount Account.

If you need help using this tab, see “Additional Vision Setup Procedures: Accounting Company
Settings Options” on page 148.

i Additional ¥ision Setup Q@@
Accounting Company Settings Payrall
[¥] Adjust Cash Receipt AR Accounts Billing ! AR Accounts
- a ; Billing Incorne Accounts Receivable
ompany Accounts —
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_ — Consultant 113 1133
Accounts Receivable Account 1 = =
= Expense 412 1132
Retainage Receivable Account 1136 — —
Unit 412 1132
Add-on 4111 | (1131 T
Expense Credit Disttibution
Labar Credit Account 7221 TEFES 1136
Miscellaneous Expense Credit Account 7381 Interest 1134
Reproduction Expense Credit Account 7333

Consultant Accrual Expense Credit Account 212 AP Discount Account 7934

Emplovee Expense Credit Account 2125 Vision System Accounts
Emploves Advance Credit Account 1138 Current Year Profitand Loss 3311
Frior Year Retained Earnings 3312
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Background

In Deltek FMS, the GL accounts used for AP discounts earned are normally income accounts.

In Vision, the account for a discount code must be either an indirect expense account or an other
expense account.

Guidelines

If you are using income accounts for discounts in FMS, you must first create an expense account
in FMS for AP discounts in either the indirect or other expense account range and then map that
account to a Vision expense account in the FMS Accounts — Vision Accounts Mapping dialog
box. Once you have done that, enter the Vision expense account number in AP Discount
Account.

If you are already using indirect or other expense accounts for discounts in FMS, enter the Vision
account to which those accounts are mapped in AP Discount Account.

Vision System Accounts Decisions

Before you convert, specify the Deltek Vision GL accounts for current year profit and loss and for
prior year retained earnings.

Recording Your Decisions in the Vision Conversion Module

To record your system accounts decisions in the Vision Conversion module, click Additional
Vision Setup on the Maintain menu. On the Accounting Company Settings tab in the Additional
Vision Setup dialog box, select the accounts under Vision System Accounts.

Migration Guide 111



Deltek Kwovmore

Chapter 5: Migration Decisions — Additional Setup

If you need help using this tab, see “Additional Vision Setup Procedures: Accounting Company
Settings Options” on page 148.

- Additional ¥ision Setup
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Background

In Deltek FMS, you do not need to have separate accounts for current net income and for
retained earnings. You specify your retained earnings main account number, and FMS
determines net income for you when you print financial reports.

In Vision, current year profit and loss and prior year retained earnings are tracked in separate GL
accounts. To view these default accounts in Vision, click Configuration » Accounting »
Company Settings on the Vision Applications menu, and click the Accounts tab.

Guidelines

If you use a single account to track both current net income and retained earnings in FMS, you
first need to create a new equity account in FMS, and then map it and your retained earnings
account to separate Vision net worth accounts. Then, on the Accounting Company Settings tab of
the Additional Vision Setup dialog box, select the retained earnings account in Prior Year
Retained Earnings and the current net income account in Current Year Profit and Loss. (The
FMS retained earnings account should be the one specified in the General Ledger Control
Information dialog box, not one you set up for manual journal entries.)

Though FMS is designed to use a single account to track both current net income and retained
earnings, many companies create a separate account for current net income because historically
that is how charts of accounts have been set up. If you have both accounts, do the following:

1. Map both your current net income account and the retained earnings account to the
same Vision net worth account. (The FMS retained earnings account should be the one
specified in the General Ledger Control Information dialog box, not one you set up for
manual journal entries.)

2. Create a new equity account in FMS, and map it to a Vision net worth account. Do not
map it to the Vision account to which you mapped your current net income account and
your retained earnings account.

3. Onthe Accounting Company Settings tab in the Additional Vision Setup dialog box,
select the Vision account to which you mapped the new equity account in step 2 in
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Current Year Profit and Loss. Select the Vision account to which you mapped your
current net income account and retained earnings account in step 1 in Prior Year
Retained Earnings.

Payroll Decisions

If you are using Deltek FMS Payroll Plus and you are going to convert FMS payroll data to Vision,
indicate what calendar years you want to convert and enter some additional payroll conversion
information.

Recording Your Decisions in the Vision Conversion Module

To record your payroll conversion decisions in the Vision Conversion module, click Additional
Vision Setup on the Maintain menu. On the Payroll tab in the Additional Vision Setup dialog box,
provide the required conversion information.

If you need help using this tab, see “Additional Vision Setup Procedures: Payroll Options” on
page 149.

If you have not selected Convert FMS Payroll to Vision Payroll on the General tab of the Vision
Conversion Setup dialog box, the Payroll tab in the Additional Vision Setup dialog box is not
available.

If you want to convert Payroll Plus data to Vision
Payroll, specify the first year you want to convert
and provide the other required information.

— Additional Vision Setup

Accounting Compahy Settings i Payroll
Beginning Payroll Year to Convert 2007 FMS Adjustment Other Pay Label ~
Current W-2 Year 2007 Emplinc Employee Incentive
Life Ins Life Insurance
CurrentW-2 Quarter. 4
Bonus CostAccount | 7241
Additional Pay Other Pay Label Other Pay Account s
Other Pay 1 Employee Incentive 7261
Other Pay 2 Life Insurance 7252
Other Pay 3
Other Pay 4
Other Pay 5
v
v
[ save ][ close

Guidelines: Selecting the Years to Convert

If you purchased the Basic or Standard conversion and you are going to convert payroll data, you
have already made this decision. In those cases, the cutoff payroll year is set automatically to the
current calendar year and you cannot change it. (For the Basic conversion, this setting is only
used to determine which FMS payroll tax methods to convert.)

If you purchased the Premium conversion and you are going to convert Payroll Plus data,
determine the earliest payroll (calendar) year for which you want to convert payroll records. Only
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payroll transactions dated on or after the first day of the year you select are converted to Vision. It
is recommended that you convert only one or two years to minimize the chance that old FMS
data will complicate the conversion or cause problems in Vision.

January 1 of the year you enter cannot be earlier than the first day of the fiscal year you select in
General Ledger Beginning year on the Accounts tab in the Vision Conversion Setup dialog box.

If you don’t convert all Payroll Plus information, you should keep your FMS system operational in
case you need to retrieve historical payroll data.

Guidelines: Current Form W-2 Year and Quarter

The conversion passes your current Form W-2 year and quarter to Vision. The year and quarter
you enter should be those that will be current the first time you process payroll in Vision.

Before you run the preconversion utilities in preparation for submitting your data for the final
conversion (or a for a second test conversion), return to the Payroll tab of the Additional Vision
Setup dialog box and make sure that the current Form W-2 year and quarter are still correct. If
not, change them before running the utilities. These entries are only used by Vision payroll. They
have no effect on how Payroll Plus data is converted.

Background: Bonus Cost Account

In FMS, you can have multiple payroll adjustments for bonuses (adjustment type BNS), and each
could use a different labor expense account. You also have the option to allocate bonus pay to
time records and distribute the cost to the labor expense accounts associated with the time
records.

In Vision Payroll, you specify a single account to receive the debit posting when you do a Bonus
payroll run. That account must be an indirect expense account (the most common practice), an
“other” expense account, an asset account, or a liability account.

Guidelines: Bonus Cost Account

The most common practice is to make the debit entry for bonus pay to an indirect labor expense
account. If that is the way your FMS system is set up, select the Vision account to which you
mapped that FMS account as the bonus cost account. (If you are using more than one indirect
expense account for bonuses, map all of them to that Vision indirect expense account.)

If you don’t have an appropriate account in FMS (because you are distributing the cost of
bonuses to the labor expense accounts associated with time records, for example), create an
account in FMS for conversion purposes and map it to the Vision account that you want to use for
bonuses in Vision.

Background: Other Pay

In FMS, you can set up any number of TAG and TNP adjustments, but in Vision Payroll you are
limited to five types of “other pay.” Because of this, you must define the types of other pay you
want to use in Vision and then indicate the TAG and TNP adjustments in FMS that correspond to
each type of other pay.

The conversion sets up a master record for each other pay type, and assigns them to employees
based on the TAG and TNP adjustments assigned to the employees in FMS.
Guidelines: Other Pay

If you have only five or fewer TAG and TNP adjustments, you can specify one other pay type for
each one. As the GL account for each type of pay, assign the Vision account mapped to the FMS
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expense account you use for the corresponding adjustment. In the second grid on the Payroll tab,
assign each FMS adjustment to the corresponding other pay type.

If you have more than five TAG and TNP adjustments, you will have to consolidate them by
assigning multiple adjustments to the same other pay type. If you have payroll transactions that
contain adjustments that have been combined, the adjustment amounts are added together when
they are converted.
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Chapter 6: Entering Migration Decisions

Vision Conversion Module

The Vision Conversion module has three primary functions:

= To enable you to record your migration decisions so the conversion process can use
them when converting your data to Vision

= To provide a set of utilities that you can use to verify that your conversion settings are
complete and that your data is ready for a successful conversion

= To make available the FMS reports you need to print to confirm that your Vision data and
FMS data balance

In This Chapter
This chapter provides the following:

= Aninitial set of topics that describe how to use each of the dialog boxes and tabs in the
Vision Conversion module to enter the results of your migration decisions. Along with
step-by-step instructions, these topics also list any prerequisite tasks. Because most of
the Vision Conversion module dialog boxes are simple to use, just refer to these topics if
you have problems.

= A second set of topics that cover final data preparation tasks, explain why and how to run
the preconversion utilities, describe the standard reports available in the module, and
give instructions for creating a backup copy of your FMS data and for submitting it for
conversion.

Data Entry Sequence

Because some migration decisions depend on others, it is generally important that you make and
record your decisions in the order they are presented in this chapter. That sequence follows the
sequence of options on the Maintain menu in the Vision Conversion module and, within individual
dialog boxes, the sequence of tabs from left to right.

Each data entry topic in this chapter indicates the prerequisite tasks you should complete before
beginning the procedures in that topic.
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Vision Conversion Setup Procedures: General Options

Quick Reference

Use the General tab in the Vision Conversion Setup dialog box to record a set of miscellaneous
migration decisions.

- ¥ision Conversion Setup Q|§|®
. General ¢ Accounts WHS Lahor Codes Employees GL Budgets FMS Miscellaneous BM

Canversion Type Country in Address
O Info Centar Only ® Convert Country Only When Different Than Company's Country
(%) Infa Center and Transactions O Always Convert Country
Wisian Infarmation Wendorg
Application Version: 51 (Build 51 251y L] Convert Active Vendors Only
Using vision Payroll [¥] Assign Hold Payment Terms to Vendors with Hold Status in FMS
Convert FMS Payroll to Vision Payroll [] Conwert Vendar Discount Information

[JUsing ¥ision Resource Planning Transactions to Convert

Only Convert AP Invoices, Employee Expense
Sheets, and Purchase Orders Dated On or After | 17172005
Default Checkbook: | Checking1

First Mational Bank

[[J Conwert Open AP Invoices and Employee Expense Sheets Only
O comver Open Purchase Orders Only

Save ] [ Close

Prerequisite Tasks

Normally, the entries on this tab are the first that you make in the Vision Conversion module.
There are no prerequisite data entry tasks.

Procedure

To record migration decisions on the General tab of the Vision Conversion Setup dialog box, do
the following:

Each of the groups of controls on this tab is independent of the others. You can work with them in
any order, and you can save your work without completing all of them.

1. Under Conversion Type, indicate if you are going to convert only information for the
Deltek Vision Info Centers or if you will convert both Info Center information and
transactions (AP invoices, AR transactions, receipts,...). If you purchased the Basic
conversion, Info Center Only is selected and you can’t change that selection.

2. In Application Version under Vision Information, enter the version of Vision you will be
using at the time of the conversion.

3. Use the check boxes under Vision Information to indicate if you will be using Vision

Payroll or Vision Planning. If you are using the Payroll Plus module in FMS, indicate if
you want to convert Payroll Plus data to Vision.

4. In Default Checkbook, enter the Deltek FMS checkbook for the bank account you want
to be used by default for converted AP transactions that require a bank code in Vision.
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10.

11.

12.

13.

Under Country in Address, select Convert Country Only When Different Than
Company’s Country if you only want to convert the country portion of addresses when
the country is different than your company’s country.

Select Always Convert Country if you want all converted addresses to include the
country.

If you only want to convert active vendors, select Convert Active Vendors under
Vendors.

If you want to convert all vendors, inactive as well as active, clear Convert Active
Vendors.

If you want the conversion to assign the Hold payment terms in Vision to vendors with the
Hold Payment status in FMS, select Assign Hold Payment Terms to Vendors with
Hold Status in FMS under Vendors.

If you want the conversion to assign Vision payment terms to those vendors based on
each vendor’s default payment terms in FMS, clear the Assign Holt Payment Terms to
Vendors with Hold Status in FMS check box.

If you want to convert discount information for vendors with payment terms that offer
discounts, select Convert Vendor Discount Information under Vendors.

If you purchased the Premium conversion and want to limit the AP transactions,
employee expenses, and purchase orders that are converted based on a cutoff date,
select Only Convert the AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or After under Transactions to Convert, and enter the cutoff date.

If you don’t want to limit the transactions based on date, you can do either or both of the
following:

= |f you only want to convert AP invoices and employee expense sheets with an unpaid
balance, select Convert Open AP Invoices and Employee Expense Sheets Only.

= |f you only want to convert purchase orders that are not marked as “closed,” select
Convert Open Purchase Orders Only.

If you purchased the Basic conversion, the options under Transactions to Convert don’t
apply to you. If you purchased the Standard conversion, your transactions will be
selected for conversion using the first day of the year, two years prior to the current fiscal
year, as the cutoff date.

Click Save to save your entries.
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Vision Conversion Setup Procedures: Account Structure

Quick Reference

Use the Account Structure subtab on the Accounts tab of the Vision Conversion Setup dialog box
to indicate what the GL account number structure should be in Deltek Vision.

- ¥ision Conversion Setup

General

WBS Lahor Codes Employees GL Budgets FMS Miscellaneous BIM

Account Structure Account Ranges Accounting Periods

Account Farmat Options
Display Leading Zeros

Account Length: 4
AddiRemove From

O Left
Account Delimiter Position 0 & Right

Account Delimiter

Sample Value |1234

gave | [ ciose

Procedure: Vision Accounts That Match FMS Main Accounts

If your Vision accounts will be the same as your Deltek FMS main accounts, do the following on
the Account Structure subtab on the Accounts tab of the Vision Conversion Setup dialog box:

1. Clear the Display Leading Zeros check box.

2. If Account Length does not already contain the number of characters in your FMS main
accounts, enter that number in the box.

3. Click Save to save your account structure information.

Procedure: Vision Accounts That Are Longer Than FMS Main Accounts

If your Vision accounts will have only one division but will contain more characters than your FMS
main accounts, do the following on the Account Structure subtab on the Accounts tab of the
Vision Conversion Setup dialog box:

1. If you want the additional spaces in your Vision accounts filled with zeros, select Display
Leading Zeros. If you don’t want the additional spaces zero-filled, clear Display
Leading Zeros. The new account numbers will be zero-filled at the beginning or at the
end, depending on whether you select Left or Right under Add/Remove From.

2. If you want the additional characters added to the beginning of your FMS main account
numbers, select Left under Add/Remove From. If you want them added to the end,
select Right.

3. In Account Length, enter the number of characters you want in your Vision accounts.
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4. |If you selected Display Leading Zeros, enter 0 in Account Delimiter Position. (Leave
the default delimiter selected in Account Delimiter. The delimiter won’t be used.)

5. Click Save to save your account structure information.

Procedure: Vision Accounts That Are Shorter Than FMS Main Accounts

If your Vision accounts will have only one division but will contain fewer characters than your FMS
main accounts, do the following on the Account Structure subtab on the Accounts tab of the
Vision Conversion Setup dialog box:

1. Clear the Display Leading Zeros check box.

2. If you want to shorten the account numbers by removing characters from the beginning of
your FMS main account numbers, select Left under Add/Remove From. If you want to
remove characters from the end, select Right.

In Account Length, enter the number of characters you want in your Vision accounts.

4. Click Save to save your account structure information.

Procedure: Vision Accounts That Have Two Divisions

If you want your Vision account numbers to have two divisions, do the following on the Account
Structure subtab on the Accounts tab of the Vision Conversion Setup dialog box:

1. Select Display Leading Zeros.

2. In Account Length, enter the number of characters you want in your Vision accounts,
including the delimiter that separates the divisions.

3. In Account Delimiter, select the character (or space) you want to use to separate the
two divisions.

4. In Account Delimiter Position, enter the number that indicates the position of the
delimiter.

o Example: If Account Length contains 7, Account Delimiter contains a period, and
Account Delimiter Position contains 5, the numbers are formatted as: 1234.67.

5. If your Vision account numbers will contain more characters than your FMS main
accounts, indicate under Add/Remove From whether you want the additional characters
added to the beginning of your FMS main account numbers (Left) or to the end (Right).

6. Click Save to save your account structure information.

Changing the Account Structure Decision

If you save the account structure and go on to specify expense account ranges and map FMS
accounts to Vision accounts and then you decide to change the account number length, be sure
you select the correct option under Add/Remove From (if it isn’t already selected) before you
enter the new length. When you're through changing the structure, check the account numbers
on the Account Ranges tab and make any corrections that are necessary.

Related Topics
“Migration Briefing: Chart of Accounts Conversion” on page 25

“GL Account Number Structure Decision” on page 29
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Vision Conversion Setup Procedures: Account Ranges

Quick Reference

Use the Account Ranges subtab on the Accounts tab of the Vision Conversion Setup dialog box
to specify the range of FMS main account numbers that corresponds to each Vision expense
account type.

These ranges are used to provide the default mappings for expense accounts in the FMS
Accounts — Vision Accounts Mapping dialog box.

1 ¥ision Conversion Setup

General Accounts WHS Labor Codes Employees GL Budgets FMS Miscellaneous BM
Account Structure Account Ranges Accounting Periods
FMS Expense Ranges: Starting Ending
Reimbursable: 5000 5999
Reimbursable Cansultant | 5111 5111
Direct: 8000 8999
Direct Consultant 8111 8111
Indirect: 5000 6999
sawe || Ciose

Prerequisite Tasks

Before you specify account ranges, add copies of your current direct project expense accounts to
your FMS chart of accounts, as described in "Guidelines: Adding Vision Direct Expense
Accounts” on page 74.

Procedure

To specify a range of FMS main accounts for each type of expense account in Vision, do the
following on the Account Ranges subtab on the Accounts tab of the Vision Conversion Setup
dialog box:

1. In Starting next to Reimbursable, enter your lowest FMS direct project expense main
account number, and in Ending, enter your highest direct project expense main account
number.

2. In Starting and Ending next to Reimbursable Consultant, enter your lowest and
highest FMS direct project expense main account numbers for consultant charges.

“.] If you only have one FMS main account for direct project consultant expenses, you can
enter the same number in both Starting and Ending.
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3.

6.

In Starting and Ending next to Direct, enter the lowest and highest FMS main account
numbers that will be mapped to Vision direct expense accounts.

“.]  This should be the lowest and highest numbered FMS main accounts that you added
for the conversion by creating copies of your direct project expense accounts. For
example, if you created the duplicate accounts in the 8111 — 8999 range, enter 8111
and 8999.

In Starting and Ending next to Direct Consultant, enter the lowest and highest FMS
main account numbers that will be mapped to Vision direct consultant expense accounts.

“.] If you only have one FMS main account that will be mapped as a Vision direct
consultant expense account, you can enter the same number in both Starting and
Ending.

In Starting and Ending next to indirect, enter your lowest and highest FMS indirect
expense main account numbers.

Click Save to save your account ranges.

Related Topics

“Migration Briefing: Chart of Accounts Conversion” on page 25

“GL Expense Account Ranges Decisions” on page 30

Vision Conversion Setup Procedures: Accounting Periods
Options

Quick Reference

Use the Account Periods subtab on the Accounts tab of the Vision Conversion Setup dialog box
to indicate the following:

The first fiscal year that you want converted
The latest accounting period you want converted

The Deltek Vision fiscal year corresponding to the Deltek FMS fiscal year for the latest
FMS period to be converted
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- ¥ision Conversion Setup

General Accounts WWBS Lahor Codes Employees GL Budgets FMS Miscellaneous BM
Account Structure Account Ranges Accounting Periods
General Ledger Beginning Year: 2005
Convert Periods Thraugh: 2006  Movember L
Wision Fiscal Year for FMS Fiscal Year 2006: 2006

Fiscal Year Conversion

FMS Fiscal Year | Fiscal Year Date Range | Vision Fiscal Year #

2008 1142006 - 1273102008 2006
2005 1102005 - 1253172005 2005
2004 11142004 - 1253172004 2004

Save ] [ Close

Procedure

To specify accounting period conversion information, do the following on the Accounting Periods
subtab on the Accounts tab of the Vision Conversion Setup dialog box:

1. Enter the earliest FMS fiscal year for which you want to convert accounting periods,
account balance information, and general journal transactions.

If you purchased the Basic conversion, accounting periods are set up for you in Vision for
the current fiscal year and the two most recent past fiscal years. No account balances or
transactions are converted.

If you purchased the Standard conversion, general ledger information for the current
fiscal year and the two most recent past fiscal years is converted.

2. In Convert Periods Through, select the latest FMS accounting period for which you
want to convert transactions. For a trial conversion, select your current accounting period.
For the final

3. conversion, select the period in which you will go live with Vision. In Vision Fiscal Year
for FMS Fiscal Year, enter the Vision fiscal year in which the period in Convert Periods
Through will fall.

4. Click Save to save your accounting period conversion information.

Related Topics
“Migration Briefing: Chart of Accounts Conversion” on page 25

“Accounting Periods Decisions” on page 33
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Vision Conversion Setup Procedures: WBS Options

Quick Reference

Use the WBS tab of the Vision Conversion Setup dialog box to indicate how Deltek FMS work
breakdown structure components are to be converted.

f— ¥ision Conversion Setup g‘ﬁ|@

General Accounts ﬂES Lahor Codes Employees GL Budgets FMS Miscellaneous BM
Set Up Vision Projects (WWBS1) Far Convert FMS Phases As:
(%) Each FMS Praject and Billing Group Combination (& vision WeS2

Omit the Billing Group 1D far Projects with Only One Billing Group
Insert This Character Between Praject ID and Billing Group 1D

Use Billing Group Title Instead of Project Title for Combined Projects
() Each FMS Project (Billing Groups will be Yision WBS2) Convert FMS Lahor Codes As:
(®Vision Labor Codes

(Ovigion Labor Codes
() Do Mot Canvert

Convert FMS Departrments As: O Wision WBS3
[ vision Lahar Codes (Ovision WBE3 And Labor Codes
[¥#] wision Organizations (Do Mot Convert

Convert FMS Account Mumber Structures to Yision Qrganization Levels
Yision - FM3WBS Map

[vision wWBS3
WBS1: |Project & Billing Group
[ Set Up Organization Codes... ] WBS2:  Phase
[ Set Up Organizations.. ] WBS3: | *hotused ™

[ Save H Close ]

Procedure: To Select Project and Billing Group Conversion Options

To indicate how you want your projects and billing groups converted, do the following on the WBS
tab of the Vision Conversion Setup dialog box:

1.

If you want to create a Deltek Vision project at WBS1 for each project-billing group
combination in FMS, select Each FMS Project and Billing Group Combination under
Set Up Vision Projects (WBS1) For. Continue with step 2.

If you want to create a Vision project at WBS1 for each FMS project and convert billing
groups at the WBS2 level, select Each FMS Project (Billing Groups Will Be Vision
WBS2) under Set Up Vision Projects (WBS1) For.

If you are combining projects and billing groups at the WBS1 level, select Omit the
Billing Group ID for Projects With Only One Billing Group if, in the case where a
project has only one billing group, you want the FMS project ID alone to be the Vision
project number. (Normally, the Vision project number is a combination of the FMS project
ID and billing group ID.)

If you want a separator in the Vision project number between the FMS project ID and the
billing group ID, select Insert This Character Between Project ID and Billing Group ID
and, in the box to the right of the check box, enter the character you want to use.

If you want to use the billing group title rather than the project title as the project name in
Vision, select Use Billing Group Title Instead of Project Title for Combined Projects.
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Procedure: To Select Department Conversion Options

If you are using departments in Business Management, indicate on the WBS tab of the Vision
Conversion Setup dialog box how you want your departments converted:

1. If you want departments converted as part of Vision labor codes, select Vision Labor
Codes under Convert FMS Departments As.

2. If you want departments converted as Vision organizations, select Vision Organizations
under Convert FMS Departments As.

3. If you selected Vision Organizations in the previous step and your FMS general ledger
account number structure reflects your departmental structure, select Convert FMS
Account Number Structures to Vision Organization Levels. If your FMS accounts
only have one division, the main account, this check box is not available.

4. If you want departments converted as part of the work breakdown structure, select
Vision WBS under Convert FMS Departments As.

5. If you are converting departments as organizations, click the Set Up Organization
Codes button to open the Set Up Vision Organization Codes dialog box.

6. Under Organization Codes Structure, specify the delimiter you want to use to separate
the levels in the organization code and enter the number of characters in each
organization level.

7. In Organization Code Level, select each level in turn and review the default codes and
labels. If necessary, you can change codes and labels. You can also delete any of the
default codes or add new ones to the list.

8. Click Save, and then click Close.

9. If you are converting departments to organizations and your organizations will have more
than one level, click the Set Up Organizations button to open the Set Up Organizations
dialog box.

10. If you are converting departments both to organizations and to a WBS level, click the Set
Up Organizations and WBS button to open the Set Up Organizations and WBS dialog
box.

11. If you are converting departments to a WBS level but not to organizations, click the Set
Up WBS button to open the Set Up WBS dialog box.

12. If you are converting departments to organizations, review the default organizations in the
grid and make any necessary changes to the names and subcodes shown. You can also
delete any of the default organizations or add new ones to the list.

13. If you are also converting departments to a WBS level, use the WBS column to assign
the WBS component you want associated with each organization.

14. If you converting departments to a WBS level but not to organizations, enter the WBS
components you want to use for departments and enter a description for each
component.

15. Click Save, and then click Close.

Procedure: To Select a Phase Conversion Option

To indicate how you want your phases converted, do one of the following under Convert FMS
Phases As on the WBS tab of the Vision Conversion Setup dialog box:

= If you want phases converted as part of the work breakdown structure, select Vision
WBS.
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= If you want phases converted as part of Vision labor codes, select Vision Labor Codes.

= If you don’t want to convert phases, select Do Not Convert.

Procedure: To Select an FMS Labor Code Conversion Option

To indicate how you want your FMS labor codes converted, do one of the following under
Convert FMS Labor Codes As on the WBS tab of the Vision Conversion Setup dialog box:

= If you want to convert FMS labor codes only as part of Vision labor codes, select Vision
Labor Codes.

= If you want to convert FMS labor codes only as part of the work breakdown structure,
select Vision WBS.

= If you want to convert FMS labor codes both as part of Vision labor codes and as part of
the work breakdown structure, select Vision WBS and Labor Codes.

= If you don’t want to convert labor codes, select Do Not Convert.

Related Topics

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
“Work Breakdown Structure Decisions: Phases” on page 42

“Migration Briefing: Vision Organizations” on page 43

“Work Breakdown Structure Decisions: Departments” on page 45

“Work Breakdown Structure Decisions: Labor Codes” on page 49

“Labor Code Structure Decision” on page 53

Quick Reference

Use the Labor Codes tab of the Vision Conversion Setup dialog box to indicate if you want to
convert Deltek FMS staff types to Deltek Vision labor codes or labor categories and to specify the
structure of your Vision labor codes.
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- ¥ision Conversion Setup

General Accounts il Employees GL Budgets FMS Miscellaneous BM

Convert Staff Type As

O Labor Categoties

(O Lahor Codes

(%) Lahor Categories and Lahaor Codes

Yision Lahor Code Levels
Delimiter: | .

Lahel Length

Lahar Code i

Staff Type

=

AddfRemaove From
- O Left

@ Right

SampleValue:| LLLLLSSS

Save ] [ Close

Prerequisite Tasks

Before you use the controls under Vision Labor Code Levels to specify the structure of your
Vision labor codes, be sure you have designated which components of the FMS work breakdown
structure are to be converted as labor codes. You do this for phases, departments, and FMS
labor codes on the WBS tab and for staff types on the Labor Codes tab.

Procedure: To Select Staff Type Conversion Options

To indicate how you want your staff types converted, do the following under Convert Staff Type
As on the Labor Codes tab of the Vision Conversion Setup dialog box:

= If you want staff types converted as Vision labor categories, select Labor Categories.
= If you want staff types converted as part of Vision labor codes, select Labor Codes.

= If you want staff types converted both as labor categories and as part of Vision labor
codes, select Labor Categories and Labor Codes.

Procedure: To Set Up the Vision Labor Code Structure

To set up the structure of your Vision labor codes, do the following under Vision Labor Code
Levels on the Labor Codes tab of the Vision Conversion Setup dialog box:

1. If you elected to convert more than one component of the FMS work breakdown structure
to labor codes, use the Delimiter box to enter the character you want to use to separate
the subcodes in your labor codes. The delimiter can only be special characters such as
period or comma. It cannot be a letter or number, space, or single or double quotation
mark. If you don’t want a delimiter between levels, blank out the Delimiter box.

2. If necessary, change the label for the first level.

If you want to make the subcodes for the first level longer than the default length, indicate
under Add/Remove From whether the additional characters should be added to the
beginning (Left) or the end (Right) of the current subcodes.
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If you want make the first level subcodes shorter than the default length, indicate under
Add/Remove From whether characters should be removed from the beginning (Left) or
the end (Right) of the current subcodes.

3. If you are changing the length of the first level, enter the number of characters you want
for that level under Length.

4. Repeat these steps for each level.

If you want to change the sequence of the levels, click in the grid row for a level you want
to move and then click on the up arrow or down arrow button to move the level up or
down in the sequence. The total length of Vision labor codes cannot be more than 14
characters, including the delimiters. If you use long codes in FMS, the default labor code
structure shown on this tab may be longer than is allowed in Vision. In that case, you'll
need to shorten one or more of the levels.

Related Topics

“Work Breakdown Structure Decisions: Staff Types” on page 51

“Labor Code Structure Decision” on page 53

“Migration Briefing: Work Breakdown Structure Conversion” on page 35
“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Work Breakdown Structure Decisions: Labor Codes” on page 49

Vision Conversion Setup Procedures: Employees Options

Quick Reference

Use the Employees tab of the Vision Conversion Setup dialog box to enter company timesheet
calendar settings and specify job cost and payroll frequencies for Deltek Vision.

[ ¥ision Conversion Setup g‘ﬁ|@

General Accounts WHS Labor Codes GL Budgets FiiS Miscellaneous B

Establish Campany Timesheet Calendar

Timesheet Frequency: Weekly o
Start Date ofthe First Labor Period Created: 100202006

End Date of the Last Labar Period Created: | 1008/2006
Status for Each Period Created: Open b

Joh Cost and Payroll Freguencies
Job CostFrequency: | Semi-Monthly e

Payrall Frequency: Semi-Manthly hd

save | [ ciose
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Procedure

To enter Vision company timesheet calendar information and job cost and payroll frequencies, do

the following on the Employees tab of the Vision Conversion Setup dialog box:

1. InTimesheet Frequency, indicate how often employees complete one timesheet and

start another: monthly, semi-monthly, biweekly, or weekly.
2. In Start Date of the First Labor Period Created and End Date of the Last Labor

Period Created, enter the range of dates for which you want the conversion to create

labor periods in Vision.

3. In Status for Each Period Created, select the status you want the conversion to assign

to the labor periods it creates: Open, Administrator, System Administrator, or Closed.

4. If you plan to use the Adjust Salaried Job Costing feature in Vision, indicate in Job Cost

Frequency how often you will use it.

5. If you aren’t planning to use the Adjust Salaried Job Costing feature, it doesn’t matter
which frequency you select.

6. In Payroll Frequency, indicate how often you will print payroll checks for your
employees.
Related Topics
“Company Timesheet Calendar Decisions” on page 55

“Job Cost Frequency and Payroll Frequency Decisions” on page 57

Vision Conversion Setup Procedures: GL Budgets Options

Quick Reference

Use the GL Budgets tab of the Vision Conversion Setup dialog box to select the GL budget
versions in Deltek FMS that you want to convert to Deltek Vision.

— ¥ision Conversion Setup

General Accounts Lahor Codes Employees FMS Miscellaneous BM

[JDo Mot Convert Any GL Budgets

Budgetversion Description Do Mot Convert? BudgetYear
Budget2005  |2005 Budget O 2005
Budgetz2006  |2008 Budget ] 2008

Save ] [ Close
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Procedure

If you don’t want to convert any GL budgets, select Do Not Convert Any GL Budgets on the GL
Budgets tab of the Vision Conversion Setup dialog box.

If you do want to convert some or all of your GL budgets, do the following:
1. Clear the Do Not Convert Any GL Budgets check box.

2. For each budget version listed in the grid that you don’t want to convert, select Do Not
Convert.

3. For each budget version to be converted, enter the 4-digit fiscal year that you want
associated with the budget in Vision.
Related Topics

“General Ledger Budget Decisions” on page 58

Vision Conversion Setup Procedures: FMS Miscellaneous
Business Management Options

Quick Reference

Use the FMS Miscellaneous BM tab of the Vision Conversion Setup dialog box to specify
miscellaneous Business Management conversion options.

- ¥ision Conversion Setup

General Accounts WES Lahor Codes Employees GL Budgets FMS Miscellaneous BM

Update Project Team ¥hen Posting Labor or Youchers
[[] Convert Business Management Budgets
[CJEnable Revenue Genetation

Time Recards Cost Amounts
(%) Effective Cost
() Original Cost

Save ] [ Close

Procedure

To set miscellaneous Business Management conversion options, do the following on the FMS
Miscellaneous BM tab of the Vision Conversion Setup dialog box:

1. If you want the conversion to add employees and vendors to project Team tabs in Deltek
Vision if time records or project expenses have been entered for those employees and
vendors for the project, select Update Project Team When Posting Labor or
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Vouchers. The conversion also turns on the corresponding options in Vision so team
lists are continuously updated as time and expenses are entered in Vision.

2. If you want to convert your Deltek FMS project budgets to Vision, select Convert
Business Management Budgets. This option is not available if you are using Resource
Scheduling and Budgeting.

3. If you want to use the Revenue Generation feature in Vision for your company, select
Enable Revenue Generation.

4. Under Time Records Cost Amounts, indicate if you want the cost amounts for
converted time records to be effective costs or original costs. If you are only converting
Info Center information, this option has no effect on your conversion.
Related Topics
“Update Project Teams Decision” on page 59
“Business Management Budget Decision” on page 61
“Revenue Generation Decision” on page 64

“Cost Amount for Time Records Decision” on page 65

FMS Projects to Convert Procedure

Quick Reference

Use the FMS Projects to Convert dialog box to specify the Deltek FMS projects that you want to
convert to Deltek Vision projects.

— FMS Projects to Convert @

Select Projects to Convert
O Corvert All Projects
(%) Convert Selected Projects

Projects with Activity On or After 12008

[ Active Projects Only

[ Exclude Unbilled Tirme and Expense as Open tems

Excluded &
Project ID Title Completed? Inactive? Convert? by Activity
Date
04-002 Design and Construction of TAV VWarehouse Yes
04-501 City Park Development. Children Playground Yes
04-999 Lah Testing Yes
05-000 Overhead Yes
05-001 Exercise Course: City Park Development Yes
05-003 City Park Developrment Pooliice Rink Cormplex Yes
05-004 Happy Acres Community Golf Course Yes
05-005 Hilltop Gateway Mall and Amusement Park: Design and Construc Yes
05-006 City Park Development Froposal: Riverside Bicycle Path Yes
05-007 Diesign and Construction of Eureka Warehouse Yes
05-008 Minot AFB Housing Project Yes
05-009 Ellsworth AFB Facilities YWarehouse Project Yes
05-010 Government Independent Research and Development Project Yes
05-011 Government Bidding and Proposal Project Yes
05-013 ellowstone Madison Junction Campground RY Dump Statian Yes
06-000 2006 - Overhead Yes 5
Save ] [ Close
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Procedure
To select the projects you want to convert, do the following:

1. Click FMS Projects to Convert on the Maintain menu in the Vision Conversion module
to open the Projects to Convert dialog box.

If you purchased the Premium conversion and you want to convert all of your projects to
Vision, select Convert All Projects under Select Projects to Convert, and click Save.
You're finished with this task.

If you purchased the Basic or Standard conversion or if you purchased the Premium
conversion but you don’t want to convert all projects, select Convert Selected Projects
and continue with the remaining steps in this procedure.

2. If you only want to convert projects with activity on or after a cutoff date, select Projects
with Activity On or After, and enter the cutoff date. If you purchased the Basic or
Standard conversion, this check box is selected automatically, and you cannot clear it.
The date is set to the first day of the year, two years prior to the current fiscal year. Any
projects that are assigned No in Convert? because of this cutoff date will have Yes in
Excluded by Activity Date.

3. If you only want to convert active projects (those not marked as inactive or completed),
select Active Projects Only.

4. If you don’t want the conversion to consider unbilled time and expense records as open
items when determining projects to be converted, select Exclude Unbilled Time and
Expense as Open Items. If you purchased the Basic or Standard conversion, this check
box is selected automatically, and you cannot clear it.

5. Click the Select button to set Convert? to Yes or No for each of your projects based on
the conversion options selected.

6. If necessary, change the setting in Convert? for individual projects.

%] If you purchased the Premium conversion, you can change Convert? from No to Yes for
any project in the grid. If you purchased the Basic or Standard conversion, you cannot
change Convert? from No to Yes for projects excluded based on the activity cutoff date.

For all conversions, you can change Convert? from Yes to No for any projects except
those that have open items. Those projects must be converted.

9. Click Save to save the list of projects to be converted. You can save your work in this
dialog box at any time, and you can close it and then return later to make changes.

If You Add a Project or Change Its Active Status

If you add a new project in FMS after you have selected the projects you want to convert, that
project is automatically marked to be converted. You don't have to return to the FMS Projects to
Convert dialog box and mark it yourself.

If you selected the Active Projects Only check box when selecting projects to convert and you
later change the Inactive or Completed check box for a project in the Projects dialog box in FMS
to make it active, it is automatically marked to be converted. If, on the other hand, you later make
a project inactive that was previously selected to be converted, it will still be converted unless you
change that decision in the FMS Projects to Convert dialog box. In Vision, it will have the
Dormant status.
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FMS Departments-Vision Organizations/WBS Mapping
Procedures

Quick Reference

If you selected the option to convert Deltek FMS departments to organizations in Deltek Vision,
use the FMS Department — Vision Organization Mapping dialog box to link each of your FMS
departments to a Vision organization.

1 FS Department - ¥ision Organization Mapping

Default Organization: | Corporate-Admministrati v

Dept Description Organization Mame ~
A0 Corparate-Architectural Corporate-Architecture
A-20 Corpaorate-Engineering Cotparate-Engineering
A-90 Corporate-Administration Corporate-Administration
B-10 Austin-Architectural Austin-Architecture
B-20 Austin-Engineering Austin-Engineering
B-40 Austin-Administration Austin-Administration

»

Close

If you selected the option to convert FMS departments to a WBS level and not to organizations,
use the FMS Department — Vision WBS Mapping dialog box to link each of your FMS
departments to a WBS component.

If you chose to convert departments both to organizations and to a WBS level, you map the
departments to organizations, and that in turn links them to the WBS component associated with
the organization. There is no separate mapping procedure for the WBS components in that case.

i FS Department - Yision WBS Mapping

Dept Cescription WBS Description ~
A0 Corparate-Architectural Corporate-Architecture
A:20 Corporate-Engineering Corporate-Engineering
A-80 Corporate-Administration Corparate-Administration
B-10 Austin-Architectural Austin-Architecture
B-20 Austin-Engineering Austin-Engineering
B-90 Austin-Administration Austin-Administration

Close
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Prerequisite Tasks

Before you can map departments to organizations, you must select the option to convert
departments to organizations, and you must define the organizations. You do both on the WBS
tab of the Vision Conversion Setup dialog box.

Before you can map departments to work breakdown structure codes, you must select the option
to convert departments to a WBS level (and not to organizations), and you must define the WBS
components. You do both on the WBS tab of the Vision Conversion Setup dialog box.

Procedure: Mapping Departments to Organizations
To map your FMS departments to Vision organizations, do the following:

1. Click Mapping on the Maintain menu and FMS Department — Vision Organization
Mapping on the submenu to open the FMS Department — Vision Organization Mapping
dialog box.

2. In Default Organization, select the organization to be assigned to accounts during the
mapping of FMS accounts to Vision accounts when a specific organization can't be
determined.

3. In Organization Name for the first department in the grid, select the organization to
which you want to map that department.

4. Repeat the previous step for each department.

Click Save to save the mapping information.

Procedure: Mapping Departments to WBS components
To map your FMS departments to Vision work breakdown codes, do the following:

1. Click Mapping on the Maintain menu and FMS Department — Vision Organization
Mapping on the submenu to open the FMS Department — Vision WBS Mapping dialog
box.

2. In WBS Description for the first department in the grid, select the WBS component to
which you want to map that department.

Repeat the previous step for each department.

4. Click Save to save the mapping information.

Related Topics
“Department-to-Organization/WBS Mapping Decisions” on page 71

FMS Accounts — Vision Accounts Mapping Procedures

Quick Reference

Use the FMS Accounts — Vision Accounts Mapping dialog box to map each Deltek FMS general
ledger account to a Deltek Vision account number.

If you selected the option to convert FMS departments to organizations in Vision, you also use
this dialog box to link each FMS account to a Vision organization.
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— FMS Accounts - ¥ision Accounts Mapping g@@
Azset Liability Met Worth Revenue Reimhursable Direct Indirect Other Charges
FMS Acct # FMS Acct. Mame FMS Acct Type Vision Acct. # Yision Acct Name Wision Acct Type CQrganization ~

#111-A-10 Professional Services Incame  (Income 4111 Professional Services Income Revenue A0

4111-4-20 Professional Services Incame  (Income 4111 Professional Services Income Revenue A20

4111-A-80 Professional Services Income Income 4111 Professional Services Income Revenue ABD

4111-B-10 Professional Services Income Income 4111 Professional Semices Income Revenue B10

4111-B-20 Professional Services Income Income 4111 Professional Semwices Income Revenue Bz0

4111-B-90 Professional Services Incame  (Income 4111 Professional Services Income Revenue Ba0

4112-A-10 Reimbursable Income Income 4112 Reimbursable Incame Revenue A10

4112-4-20 Reimbursable Income Income 4112 Reimbursable Incame Revenue A20

4112-A-30 Reimbursahle Income Income 4112 Reimbursahle Income Revenue ABD

4112-B-10 Reimbursable Income Income 4112 Reimbursable Income Revenue B10

4112-B-20 Reimbursable Income Income 4112 Reimbursable Income Revenue B20

4112-B-90 Reimbursable Income Income 4112 Reimbursable Incame Revenue B30

4113-A-10 Subcontractar Income Income 4113 Subcontractar Income Revenue A10

4113-A-20 Subcontractor Income Income 4113 Subcontractor Income Revenue AZD

4113-A-90 Subcantractor Income Income 4113 Subcontractor Incame Revenue ABD 3

Highlighted — Vision Acct. Type not allowed for this FMS account type
 Default Accounts / Organizations... | |: Accounts — Could not determine account's organization :| 4

Prerequisite Tasks

Before you can map FMS accounts to Vision accounts, you must specify the Vision account
number structure and expense account ranges. You do both on the Accounts tab of the Vision
Conversion Setup dialog box.

If you are going to convert departments to Vision organizations, you should also do the following:

= Select the option to convert departments to organizations and define the organizations on
the WBS tab of the Vision Conversion Setup dialog box.

= Map your departments to organizations in the FMS Department — Vision Organization
Mapping dialog box.
Procedure: Mapping FMS Accounts to Vision Accounts and Organizations

To map your FMS general ledger accounts to Vision accounts and organizations, do the
following:

1. Click Mapping on the Maintain menu and FMS Accounts — Vision Accounts Mapping
on the submenu to open the FMS Accounts — Vision Accounts Mapping dialog box.

2. Onthe Assets tab, review the default account mappings.

3. If any FMS accounts are mapped to the wrong Vision accounts, enter the correct account
numbers in Vision Acct #.

4. If any of the Vision account names are not suitable, enter the names you want in Vision
Acct Name.

5. If any of the Vision accounts should have the Other account type, tab to or click in Vision
Acct Type for that account, and select that account type from the drop-down list in.

6. If you are converting departments to Vision organizations, review the default organization
mappings.

7. If any FMS accounts are mapped to the wrong organizations, enter the correct
organizations in Organization. If FMS is unable to determine the department associated
with an FMS account and thus can’t map a specific organization to the account, it maps
the account to the default organization you specified in the FMS Department — Vision
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Organization Mapping dialog box and highlights that cell in the grid to call your attention
to it.

8. Repeat steps 2 — 7 on each of the tabs. On the tabs for expense accounts, you can
change the account type of any Vision account to any of the expense account types or to
the Other account type.

9. Click Save to save the mapping information. You can save your work on this dialog box
at any time, and you can close it and then return later to make changes.

Procedure: Resetting Vision Accounts to the Default Numbers

If you make changes to the default Vision account numbers and then decide you want to restore
those default numbers, do this on the FMS Accounts — Vision Accounts Mapping dialog box:

1. If you only want to restore the default account numbers for one type of Vision account,
click the tab for that type of account (if it isn’t already the active tab). If you want to
restore the default account numbers for all types of accounts, it doesn’t matter which tab
is active.

2. Click the Default Accounts / Organizations button.

3. On the Default Accounts / Organizations dialog box, select Reset Vision Accounts to
Defaults.

4. Under Select Account Type to Reset, indicate if you want to reset the numbers for the
currently active tab or for all accounts.

5. If you only want the default numbers assigned where there is currently no Vision account
number, select Only Reset Blank Codes.

6. Click OK.

Procedure: Resetting Organizations to the Defaults

If you make changes to the default organization mappings and then decide you want to restore
those defaults, do this in the FMS Accounts — Vision Accounts Mapping dialog box:

1. If you only want to restore the default organizations for one type of Vision account, click
the tab for that type of account (if it isn't already the active tab). If you want to restore the
default organizations for all types of accounts, it doesn’t matter which tab is active.

2. Click the Default Accounts / Organizations button.

3. On the Default Accounts / Organizations dialog box, select Reset Organizations to
Defaults.

4. Under Select Account Type to Reset, indicate if you want to reset the organizations for
the currently active tab or for all accounts.

5. If you only want the default organizations assigned where there is currently no
organization, select Only Reset Blank Codes.

6. Click OK.

Procedure: Changing Vision Account Numbers for an Account Type

If you want to change the Vision account numbers for all accounts of a certain type while
maintaining the same sequence of accounts, use the steps that follow. The most common use of
this procedure is to shift the default Vision accounts to make room in the account sequence for
the direct expense accounts. This task is described in detail in “FMS Accounts-to-Vision Accounts
Mapping Decisions” on page 72.
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1. Ifitisn't already the active tab, click the tab in the FMS Accounts — Vision Accounts
Mapping dialog box for the type of account for which you want to change all account
numbers.

2. Click the Default Accounts / Organizations button.

3. Inthe Default Accounts / Organizations dialog box, select Increment Vision Acct # by,
and enter the amount by which you want to increase (or decrease) the account numbers.
To decrease the account numbers, enter the increment as a negative number (-1000, for
example).

4. Under Select Account Type to Reset, select the option to reset just the accounts on the
active tab.

Make sure the Only Reset Blank Codes check box is not selected.
6. Click OK.

Related Topics

“Migration Briefing: Chart of Accounts Conversion” on page 25
“GL Expense Account Ranges Decisions” on page 30
Migration Briefing: Vision Organizations” on page 43

“Work Breakdown Structure Decisions: Departments” on page 45

FMS Expense Codes — Vision Accounts Mapping Procedure

Quick Reference

Use the FMS Expense Codes — Vision Accounts Mapping dialog box to map Deltek FMS
expense codes to Deltek Vision account numbers. These expense code mappings only affect the
conversion of your FMS expense transactions and budgets and subsequent reporting on those
converted transactions in Vision. They have no other impact on the configuration or operation of
Vision.
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- FMS Expense Codes - Yision Accounts Mapping glil@
Project Cost Adjustment

() Only make adjusting entries when account is a different account type

(%) Always create adjusting entries with the new account number

Default Accounts 111 5171 6116 6171 7381

Expense Code Description Reimb. Consult. Reimbursable Direct Consult. Direct Indirect Type -
AirFare AirFare 5121 7361 Other

Blue Blueprints 8171 I Other

Ciwil Civil Engineering 8111 6116 T3 Caonsultant
Computer Computer Time 8171 Tim Cither

Copy Herox Coples 5131 738 Cither

Corill Crrilling Equiprment 2171 FEcES| Cither

Elec Electrical Engineer 2111 6116 73im Consultant

File Filing Fee 5171 73 Other

History Historical Expense 5171 733 Other

Lab Lahoratory Tests 8171 T3 Other

Lodging Lodging 5131 T361 Cither

Meals Meals 5121 7361 Other

Mile “ehicle Mileage 2121 7361 Cither

Phone Telephone Charges 5141 7362 Cither

Fhota FPhotographs 5132 7381 Cther

Rental Rental Equipment 8171 I Other 3
Miscellaneous
[:é%guigeu — Vigion account is the wrong Wpe:|

Prerequisite Tasks
Before you can map FMS expense codes to Vision accounts, you must do the following:

= Specify the Vision account number structure and expense account ranges. You do both
on the Accounts tab of the Vision Conversion Setup dialog box.

= Map FMS account numbers to Vision account numbers in the FMS Accounts — Vision
Accounts Mapping dialog box.

Procedure: Mapping FMS Expense Codes to Vision Accounts
To map your FMS expense codes to Vision accounts, do the following:

1. Click Mapping on the Maintain menu and FMS Expense Codes — Vision Accounts
Mapping on the submenu to open the FMS Expense Codes — Vision Accounts Mapping
dialog box.

2. Click the Reset/Default Accounts button to display default account mappings in the grid.

3. Under Project Cost Adjustment, select an option for creating project cost transactions
in Vision when the account mapped to the FMS account for the FMS expense transaction
is not the same as the account mapped to the expense code in that transaction. If you're
not sure which option to select, see “Expense Codes-to-Accounts Mapping Decisions” on
page 78 for guidance.

4. In the boxes next to Default Accounts, enter a default Vision account number for each
type of expense. The default accounts are used if the conversion needs an account of a
particular type in order to convert an expense transaction, and you did not map an
account of that type to the expense code.

5. For each expense code in the grid, enter the Vision expense account numbers required
to convert FMS expense transactions for the expense code.
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6. For each expense code in the grid, confirm that Type contains Consultant for all
expense codes that represent consultant expenses and Other for all non-consultant
expense codes.

7. Click Save to save the mapping information. You can save your work on this dialog box
at any time, and you can close it and then return later to make changes.
Related Topics
“Expense Codes-to-Accounts Mapping Decisions” on page 78
“GL Expense Account Ranges Decisions” on page 30
“Accounts Payable Invoices Conversion” on page 239
“Business Management Project Expenses Conversion” on page 224

“Expense Codes Conversion” on page 209

FMS Codes — Vision Labor Codes Mapping Procedure

Quick Reference

Use the FMS Codes — Vision Labor Codes dialog box to map Deltek FMS work breakdown
structure components to Deltek Vision labor codes.

- FMS Codes - Yision Labor, Codes @

Phases Labor Code Staff Type Departments

FMS Code FMS Description Vision Code Yision Description A
101 Camputer Aided Design 101 Computer Alded Design
101 Computer Aided Drafting 101 Camputer Aided Design
101 Computer Drafting 101 Camputer Aided Design
102 Draft 102 Drafting
102 Drafling 102 Crafling
103 Meetings 103 Meetings
103 Site Meetings 103 Meetings
104 Site Visit 104 Site Visit
104 Site Visits 104 Site Visit
108 Survey 105 Surveying
105 Surveying 108 Surveying
106 Field Wark 106 Field WWoark
106 Field ¥l 106 Field YWoarl
110 Surveying 105 Surveying
112 Field Wark 106 Field WWoark a3

Generic Vision Labor Code: | 403

s (ome

Prerequisite Tasks
Before you map FMS codes to Vision labor codes, do the following:

= Onthe WBS tab and the Labor Codes tab of the Vision Conversion Setup dialog box,
select the FMS work breakdown structure components that will be converted to labor
code levels.

= On the Labor Codes tab of the Vision Conversion Setup dialog box, specify the structure
you want for Vision labor codes.

= Inthe Projects to Convert dialog box, select the projects you want to convert to Vision.
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Procedure: Mapping FMS Codes to Vision Labor Codes

To map the FMS codes to Vision labor codes, do the following:

1.

Click Mapping on the Maintain menu and FMS Codes — Vision Labor Codes on the
submenu to open the FMS Codes — Vision Labor Codes dialog box.

Click the Reset/Default Codes button to display default code mappings in the grids. If
any of the FMS codes include characters other than letters and numbers (a hyphen, for
example), those characters are not included in the default Vision labor codes. Vision
labor codes cannot include punctuation marks or other special characters, except as
delimiters between levels.

On the tab for the first labor code level, review the default mappings and make any
changes that are necessary. You can combine multiple FMS codes by mapping them to
the same Vision code, and you can change the Vision codes and descriptions.

o) If you are converting phases or labor codes as labor code levels in Vision, only the
phases and labor codes assigned to the projects you've selected for conversion are
listed in the mapping grids.

In Generic Vision Labor Code, select the Vision code you want the conversion to use
when converting labor budgets if the FMS budget does not have a code corresponding to
this Vision labor code level. If you are not going to convert project budgets, you can enter
any code you want.

Repeat steps 3 and 4 on each of the other tabs.

Click Save to save the mapping information. You can save your work in this dialog box at
any time, and you can close it and then return later to make changes.

Related Topics

“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Work Breakdown Structure Decisions: Labor Codes” on page 49

“Work Breakdown Structure Decisions: Staff Types” on page 51

“Labor Code Structure Decision” on page 53

FMS Staff Types — Vision Labor Categories Mapping Procedure

Quick Reference

If you want to convert your Deltek FMS staff types to Deltek Vision labor categories, use the FMS
Staff Types — Vision Labor Category Mapping dialog box to map staff types to labor categories.
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i FMS Staff Types - Yision Labor, Category Mapping @

FMZ Code

FMS Description

Wigion Code

Vision Description

A

10

Frincipal

10

Frincipal

11

Senior Architect

11

Senior Architect

12

Senior Engineer

12

Senior Engineer

13

CAD Oparatar

CAD Operator

14

Draftsman

Draftsman

16

Architect

Architect

CLER

General Clarical

General Clarical

ResetiDefault Codes...

Close

Prerequisite Tasks

Before you can map FMS staff types to Vision labor categories, you must select either the Labor
Categories option or Labor Categories and Labor Codes options under Convert Staff Type

As on the Labor Codes tab of the Vision Conversion Setup dialog box.

Procedure: Mapping FMS Staff Types to Vision Labor Categories

To map FMS staff types to Vision labor categories, do the following:

1. Click Mapping on the Maintain menu and FMS Staff Types — Vision Labor Categories
Mapping on the submenu to open the FMS Staff Types — Vision Labor Category
Mapping dialog box.

2. Click the Reset/Default Accounts button and click OK in the Reset / Default Labor

Categories dialog box to display default mappings in the grid.

Review the default mappings and make any changes that are necessary.

4. You can combine multiple FMS staff types by mapping them to the same Vision labor
category, and you can change any of the default Vision codes and descriptions
displayed.

“.]  The codes for labor categories must be numbers from 1 to 32767. If you have a staff
type ID that contains characters other than numbers, you must enter a numeric code
for the corresponding labor category.

5. Click Save to save the mapping information. You can save your work in this dialog box at
any time, and you can close it and then return later to make changes.

Related Topics

“Work Breakdown Structure Decisions: Staff Types” on page 51
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FMS Billing — Vision Billing Terms Mapping Procedures: Labor
Rate Schedules Options

Quick Reference

If you want to convert labor rate exceptions from Deltek FMS billing rate schedules to labor rate
tables or labor category tables in Deltek Vision, go to the Labor Rate Schedules tab of the FMS
Billing — Vision Billing Terms dialog box.

— FMS Billing - ¥ision Billing Terms

Labar Rate Schedules Tax Methods Fee hiethods Custom Invoice Formats
Convert Labor Rate Schedule — —
Rate Schedule Vision Rate Tahle Type Add Missing Employees? A
Labor Rates {By Empl

© Labor Rates (By Employee) 05-003 Lahor Rate No
O Labor Category 2005_10 Labor Rat N
€ Mo Labor Rate Detail = anarnate 0
2005CPFF Lahor Rate Mo
[ convert Rate Schedules for Inactive/Completed Projects 2005Gay Labor Rate Mo
Create Labor Rate Schedule for Default Ermplovee Billing Rates 200551 Labor Rate Mo
[Cinclude Terrninated Ermployees General Lahor Rate Mo

b4

Save 1 [ Cloge

Prerequisite Tasks

Before you enter conversion settings for labor rate schedules, use the Projects to Convert dialog
box to select the FMS projects that you want to convert to Vision projects.

Procedure: Selecting Labor Rate Exceptions for Conversion

To select labor rate exceptions in FMS for conversion to labor rate tables or labor category tables
in Vision, do the following:

1. Click Mapping on the Maintain menu and FMS Billing — Vision Billing Terms on the
submenu to open the FMS Billing — Vision Billing Terms dialog box.

2. Under Convert Labor Rate Schedule on the Labor Rate Schedules tab, select the
conversion option that applies to the most billing rate schedules listed in the grid.

3. Your choice becomes the default selection in the Vision Rate Table Type column in the
grid for all of the schedules. Only billing rate schedules assigned to billing groups for
projects selected to be converted are listed in the grid.

4. If you selected some inactive or completed projects to be converted and you also want to
convert the labor rate exceptions for those projects, select Convert Rate Schedules for
Inactive/Completed Projects. When you select this box, any billing rate schedules
assigned to such projects that aren’t already shown in the grid are added to the list so
you can specify if or how you want to convert them.
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o

10.
11.

If you don’t want any labor rate exceptions converted for inactive or completed projects,
leave this box unselected.

If you want the conversion to create the FMS Default Employee Billing Rates table in
Vision, select Create Labor Rate Schedule for Default Employee Billing Rates.

“.] Itis strongly recommended that you elect to create the FMS Default Employee Billing
Rates table.

If you want the conversion to convert labor rate exceptions for terminated employees,
select Include Terminated Employees.

In Vision Rate Table Type for the first billing rate schedule, indicate if you want to
convert labor rate exceptions as a labor rate table, a labor category table, or not convert
them at all.

If you selected Labor Rate in the previous step, select Yes in Add Missing Employees?
if you want the labor rate table to also include all employees for whom no labor rate
exception exists in the billing rate schedule. If you add the missing employees, the labor
rate table uses those employees’ hourly base hilling rates.

Repeat these steps for each billing rate schedule listed.

Click Save to save the mapping information. You can save your work in this dialog box at
any time, and you can close it and then return later to make changes.

Related Topics

“Labor Rate Schedule Decisions” on page 85

FMS Billing — Vision Billing Terms Mapping Procedures: Tax
Methods Options

Quick Reference

If you want to convert tax fee methods from Deltek FMS billing rate schedules to tax codes in
Deltek Vision and assign them to the billing terms for the appropriate projects, go to the Tax
Methods tab of the FMS Billing — Vision Billing Terms dialog box.
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- FMS Billing - ¥ision Billing Terms

Lahar Rate Schedules Tay Methods Fee Methods Custom Invaice Formats
[¥] Canvert FMS Tax Methods
Code Description Rate Yision Credit Acct. Labor  Consultant | Expense Fee Unit ' Add On @
GST Goods and Services Tax 5.0000|2164 [} [} L] ] ]
PST Pravincial Sales Tax £.0000(2164 O O O O O
SalesTax State Sales Tax 5.0000|2164 O O O O O
ServiceTax Professional Services Tax 5.0000|2164 F F .} F F
hd
ResetiDefault Tax Methads
Save 1 [ Close

Prerequisite Tasks

Before selecting tax methods for conversion, you need to map FMS accounts to Vision accounts.

Procedure: Selecting Tax Methods for Conversion
To select FMS tax methods for conversion to codes in Vision, do the following:

1. Click Mapping on the Maintain menu and FMS Billing — Vision Billing Terms on the
submenu to open the FMS Billing — Vision Billing Terms dialog box.

2. On the Tax Methods tab, select Convert FMS Tax Methods.

3. Click the Reset/Default Accounts button to display default conversion settings for the
tax methods that are eligible for conversion. The only tax methods shown and available
for conversion are those that have been assigned to billing groups in FMS using the
Billing Rate Schedules dialog box or the Invoice Preparation dialog box.

4. |If the tax rate in Rate for the first tax method is not the current rate, enter the correct rate.

If the account number in Vision Credit Acct is not correct, enter the correct Vision
account number.

6. Use the check boxes to specify the types of charges to which the tax applies.
Repeat these steps for the remaining tax methods.

Click Save to save the conversion information. You can save your work in this dialog box
at any time, and you can close it and then return later to make changes.

Related Topics

“Tax Fee Methods Decisions” on page 92
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FMS Billing — Vision Billing Terms Mapping Procedures: Fee
Methods Options

Quick Reference

Use the Fee Methods tab of the FMS Billing — Vision Billing Terms dialog box to indicate how you
want to convert fee methods from Deltek FMS billing rate schedules to add-ons in Deltek Vision
and assign them to the billing terms for the appropriate projects.

— FMS Billing - ¥ision Billing Terms

Labor Rate Schedules Tay Methods Fee Methods Custom Invoice Farmats
(@) Use These Calculation Settings for Corverted Fee Methods
Code Description Method | Rate/Amount Wision CreditAcct. Labor Consultant| Expensel Fee Unit | Add On | »
AdminFee Administration Fee Rate 5754111 O O O O O
Benefits Markup far Benefts Rate 20.00(4111 O O O O O
DPE DFE Rate 23.70(4111 O O O O O
ExpFee Expenses Fee Rate 2.25(4112 O | O ] ]
ExpMarkup Expense Markup Fee Rate n.00{4112 F L] F L} L}
Fringe Fringe Benefits Rate 255714111 | | O ] ]
GEA General and Administrative Overhead  [Rale 38914111
GRAGED GEA @80 Percant Rata 0.00(4111
InvFes Invoice Fee Rate 10.00/4111 |
OffSite OH Ot Site OH-Client Site Rate B5.00[4111 O O O O =
() Use Calculation Settings from Billing Rate Schedules for Converted Fea Methads
Fee Method Maximurms For Fee Methods with Combined Basis
(® Don't Convert Fee Method Maximums (%) Dont Use Comhbined Basis
) Convert Sum of Fee Method Maximums as Add-0n Maximum O Include All Add-ons in Basis
Save 1 [ Cloge

Prerequisite Tasks

Before specifying fee method conversion settings, you need to map FMS accounts to Vision
accounts.

Procedure: Specifying Fee Method Conversion Settings

To specify how you want to convert fee methods to add-ons, do the following:

1. Click Mapping on the Maintain menu and FMS Billing — Vision Billing Terms on the
submenu to open the FMS Billing — Vision Billing Terms dialog box.

2. Onthe Fee Methods tab, do one of the following:
If... Then select...

You want to specify add-on fee settings to be Use These Calculation Settings
assigned to all converted projects that use for Converted Fee Methods.
each fee

You want the conversion to set up add-on fees | Use Calculation Settings from
based on the specific fee method settings for Billing Rate Schedules for
each billing group in FMS Converted Fee Methods.
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3. If you selected Use These Calculation Settings for Converted Fee Methods, do the
following

a. If necessary, change the default calculation method, add-on rate or amount, and
the Vision account to receive the credit entry for the first fee method.

b. Use the check boxes to specify the types of charges that will be the basis for the
add-on in Vision.

c. Repeat for the remaining fee methods.

4. |If you selected Use Calculation Settings from Billing Rate Schedules for Converted
Fee Methods, do the following

a. Under Fee Method Maximumes, indicate if you want to convert any maximum
amounts specified for fee methods in FMS.

b. Under For Fee Methods with Combined Basis, indicate if you want to convert
the combined basis for any fee methods that have them in FMS.

5. Click Save to save the conversion information. You can save your work in this dialog box
at any time, and you can close it and then return later to make changes.
Related Topics

“Fee Methods Decisions” on page 88

FMS Billing — Vision Billing Terms Mapping Procedures: Invoice
Formats Options

Quick Reference

If you want to convert custom invoice formats in Deltek FMS to billing terms and invoice
templates in Deltek Vision and assign them to the appropriate projects, go to the Custom Invoice
Formats tab of the FMS Billing — Vision Billing Terms dialog box.

— FMS Billing - ¥ision Billing Terms

Labor Rate Schedules Tay Methods Fee Methods Custom Invoice Formats

Cohvert Custom Invoice Formats
() Use Standard Template

() Use Custom Template

) Do Mot Convert

FMS Custom Invoice Format Conversion Method | Standard Invoice Termplate Custom Invoice Ternplate ~
INYTYPET_LISA Standard Template InvTypel
INYTYPE4_LISA Custam Template Custaomize

Save 1 [ Cloge
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Prerequisite Tasks

Before selecting custom invoice formats for conversion, use the Projects to Convert dialog box to
select the projects to be converted to Vision.

Procedure: Selecting Custom Invoice Formats for Conversion

To select custom invoice formats for conversion to billing terms and invoice templates in Vision,
do the following:

1.

Click Mapping on the Maintain menu and FMS Billing — Vision Billing Terms on the
submenu to open the FMS Billing — Vision Billing Terms dialog box.

Under Convert Custom Invoice Formats on the Custom Invoice Formats tab, select the
conversion method that applies to the most custom formats listed. The option you select
becomes the default selection in Conversion Method for all invoice formats listed in the
grid.

For the first custom invoice format in the grid, select the conversion method in
Conversion Method.

If... Then select...

You want to convert the format using a standard invoice Standard Template
format as the template

You want to convert the format using a custom format as the | Custom Template
template

You don’t want to convert the format Do Not Convert

If you selected Standard Template in the previous step, go to Standard Invoice
Template and select the standard invoice format you want to use as the template.

If you selected Custom Template, click the Customize button in Custom Invoice
Template to open the Custom Format Settings dialog box. On that dialog box, in Use
Defaults From, select the standard invoice format you want to use as the source for the
default settings. Normally, you should select the standard invoice format that you
modified to create the custom invoice format.

Review the default template name, default font, and other default settings, and make any
changes necessary to get the best conversion results for the custom invoice format.

Click OK. You also have the option to base either the standard template conversion or
the custom template conversion on Vision default settings.

Repeat these steps for each custom invoice format.

Click Save to save the conversion information. You can save your work in this dialog box
at any time, and you can close it and then return later to make changes.

Related Topics

“Custom Invoice Format Decisions” on page 93
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Additional Vision Setup Procedures: Accounting Company
Settings Options

Quick Reference

Before you convert, use the Accounting Company Settings tab in the Additional Vision Setup
dialog box to specify Deltek Vision account numbers for key accounts.

- Additional Yision Setup g@@
Accounting Company Settings Payroll
[¥] Adjust Cash Receipt AR Accounts Billing / AR Accounts
3 P ; Billing Income Accounts Receivahle
ommparty Accounts = =
= Fee 4111 T 1131 T
Uninvoiced Revenue Account LAl
= Labar 4111 1 (1131 1
Unhilled Serices Account 114
] = Consultant 1113 1133
Accounts Receivable Account 1131 — —
) = Expense 1112 1132
Retainage Receivable Account 1136 = =
Unit 4112 113z
Expense Credit Distribution Addron Ll 13
Lakor Credit Account 72 Teree 1138
Miscellaneous Expense Credit Account Tam Interest 1134
Reproduction Expense Credit Account 7333

Consultant Accrual Expense Credit Account 2112 HLP ISR SEEE 7834

Emplovee Expense Credit Account 2128 Wision System Accounts
Employee Advance Credit Account 1138 CurrentYear Profitand Loss 3311
Prior Year Retained Earnings 32
Save Close

Prerequisite Tasks

Before specifying account numbers on the Accounting Company Settings tab, you must use the
FMS Accounts — Vision Accounts Mapping dialog box to map FMS GL accounts to Vision GL
accounts.

Procedure: Specifying Key Vision Accounts
To specify key Vision accounts, do the following:

1. Click Additional Vision Setup on the Maintain menu to open the Additional Vision Setup
dialog box

2. Enter the Vision account number in each of the boxes on the Accounting Company
Settings tab. To enter separate AR accounts for billing categories under Billing / AR
Accounts, you must first select the Adjust Cash Receipt AR Accounts check box. For
guidance in selecting accounts, refer to the topics listed under “Related Topics.”

3. Click Save to save the conversion information. You can save your work in this dialog box
at any time, and you can close it and then return later to make changes.
Related Topics
“Vision Company Accounts Decisions” on page 102
“Expense Credit Distribution Accounts Decisions” on page 104
“Billing Income Accounts Decisions” on page 106

“Cash Receipt Allocation Decisions” on page 108
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“AP Discount Account Decision” on page 110

“Vision System Accounts Decisions” on page 111

Additional Vision Setup Procedures: Payroll Options

Quick Reference

If you have Payroll Plus and you want to convert payroll information to Vision Payroll, go to the
Payroll tab of the Additional Vision Setup dialog box.

- Additional ¥ision Setup g@@
Accounting Company Settings Payroll
Beginning Payroll Year to Convert 2007 FMS Adjustment Other Pay Label ~
Current W-2 Year: 2007 Ernplnc Emploves Incertive
Life Ins. Life Insurance
Current¥-2 Quarter: 4
Bonus CostAccount | 7241
Additional Pay Cither Pay Label Other Pay Account ~
Cther Pay 1 Emplovee Incentive 7261
Other Pay 2 Life Insurance 7252
Cther Pay 3
Other Pay 4
Other Pay 5
3
v

Save ][ Close ]

i)

Prerequisite Tasks

Before you enter payroll conversion information, make sure you have done the following:

= Selected Convert FMS Payroll to Vision Payroll on the General tab of the Vision
Conversion Setup dialog box

=  Mapped your FMS GL accounts to Vision GL accounts in the FMS Accounts — Vision
Accounts Mapping dialog box

Procedure: Entering Payroll Conversion Information

To enter payroll conversion information, do the following:

1. Click Additional Vision Setup on the Maintain menu to open the Additional Vision Setup
dialog box.

2. Click the Payroll tab.

3. InBeginning Payroll Year to Convert, enter the earliest payroll year (calendar year) for
which you want to convert payroll records. If you purchased the Standard conversion, the
cutoff payroll year is set automatically to the current calendar year, and you cannot
change it.

4. In Current W-2 Year, enter the year in which you will process payroll in Vision for the first
time.
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5. In Current W-2 Quarter, enter the quarter in which you will process payroll in Vision for
the first time.

6. In Bonus Cost Account, enter the number of the Vision account to receive the debit
posting when you do a bonus payroll run.

7. In Other Pay Label in the first grid, enter a label for each of the types of “other pay” you
will have in Vision. As you enter “other pay” information, you do not have to use every
row in the grid, but you cannot skip a row. In other words, any blank rows must be at the
bottom of the grid.

8. In Other Pay Account in the first grid, enter the Vision GL account to receive the debit
entry for each type of pay.

9. Inthe second grid, assign each TAG and TNP adjustment from Payroll Plus to one of the
“other pay” types in Vision.

10. Click Save to save the conversion information. You can save your work in this dialog box
at any time, and you can close it and then return later to make changes.

Related Topics

“Payroll Decisions” on page 113

Complete Additional Data Preparation Tasks

In addition to recording your migration decisions in the Vision Conversion module, there may be
other steps you need to take to prepare your Deltek FMS data for conversion. Review the topics
below to see if any of the tasks apply to your conversion.

Change Phase IDs

WBS components at the WBS2 or WBS3 level can only be seven characters, but phase IDs in
FMS can have up to ten characters. If you convert phases to a WBS level and the conversion
encounters a phase that is longer than seven characters, it uses only the first seven characters
for the WBS component. Depending on how you have identified your phases, this could result in
loss of important information embedded in your phase IDs. It could also result in duplicate phases
for a project/billing group if you have phase IDs for which the first seven characters are the same.

Because of these potential problems, we recommend doing the following if you are converting
phases to a WBS level and you have phase IDs with more than seven characters:

= Use the Phase List By Client/Project report or the Phase List By Project report to review
the phase IDs for the projects you are converting, or at least for your current projects. If
you find that losing characters at the end of the IDs will make some phase IDs unusable,
change the affected phase IDs. If you use global phases, you may be able to use the
Code Revision tool in the Business Management module to do this more quickly than if
you make the changes in the Billing Groups dialog box.

= When you have recorded your WBS decisions in the Vision Conversion Setup dialog box
in the Vision Conversion module, click Vision Pre-Conversion Utilities on the Maintain
menu in that module and run the Setup Vision Work Breakdown Structure utility. If the
utility doesn’t run successfully, open the log file and make sure the utility didn’t find any
duplicate phases caused by the loss of characters in the IDs. If it did, change the phase
IDs to avoid duplication.
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Change Checkbook IDs

Checkbook IDs in FMS can be up to 15 characters long, but bank codes in Vision are limited to
10 characters. If you have any checkbook IDs that are over 10 characters, you must shorten them
before converting FMS data. Checkbook IDs that are too long will appear on the Pre Vision
Conversion report.

Remove Spaces from Item Codes

If you have the FMS Purchase Order feature set, the item codes, tax methods, shipping methods,
and miscellaneous adjustments used on purchase orders are converted to item categories and
purchasing items. Because Vision does not allow spaces in the IDs for those records, you need to
remove spaces from any item codes and adjustment codes that have them before the data is
converted.

Convert Receiving Records to AP Invoices

If you have received items on a purchase order using the Received Items dialog box in FMS, and
the purchase order has associated project expenses, you must change that receiving record to an
AP invoice before the final conversion. (To do that, select the receiving record in the Invoices
dialog box in the Accounts Payable module.)

You only need to do this for purchase orders with project expenses. Receiving records for
purchase orders that do not have project expenses are converted to Deltek Vision purchase order
receiving records.

Remove Spaces from Payroll Adjustments and Tax Methods

If you have the FMS Payroll Plus module, the payroll adjustments and tax methods are converted
to withholding codes. Because Vision does not allow spaces in the IDs for withholding codes, you
need to remove spaces from any adjustment codes and tax methods that have them before the
data is converted.

Link Expense Codes to Purchase Order Item Codes

If you have the Purchase Order feature set in FMS, it is recommended that you link the item
codes and adjustments (tax methods, shipping methods, or miscellaneous adjustments) used on
purchase orders to FMS expense codes. This enables the conversion to assign the correct GL
accounts during the conversion of Purchase Order data.

If you are not converting Purchase Order data, item codes are not converted to Vision, so this
task is not necessary.

Submit and Approve Time Sheets

Time sheet and time record submission and approval information is not converted. If you have
time sheets in FMS that you want to go through the submission and approval process, you should
do that before converting them to Vision. You won't be able to do it in Vision after the conversion.

Run the Effective Cost Rate Calculation Tool

If you selected the Effective Cost option under Time Records Cost Amounts on the FMS
Miscellaneous FM tab of the Vision Conversion Setup dialog box, be sure you run the Effective
Cost Rate Calculation tool in FMS for all of your time records before the final conversion. If you
use the Effective Cost Rate Calculation tool and you have Payroll Plus, you should end all time
entry in FMS at the end of a payroll period to ensure that you run the tool for all time records
before the final conversion.

Migration Guide 151



Deltek Kwovmore

Chapter 6: Entering Migration Decisions

Apply All Receipts and Credit Memos

Before you submit your data for conversion, apply all payments and credit memos to client
invoices. Retainers need not be applied to invoices, but they must be applied to projects and
billing groups. Retainers cannot be “in process” (that is, applied in the Invoice Preparation dialog
box but awaiting the billing process).For assistance, print the Outstanding Retainer report and the
Unapplied Payments/Credit Memos report. Both are available in the Print Standard Reports
dialog box in the Vision Conversion module as well as in Business Management.

Apply Employee Advances

It is recommended that you apply or otherwise clear as many outstanding employee expense
advances as possible before you submit your data for conversion. This isn’t required, but it will
simplify the process of balancing Vision accounts payable data to the FMS data.

Pay the Balance of Partially Paid Employee Expense Sheets

If you have any partially paid employee expense sheets, you should pay the balance of those
expense sheets in FMS before converting. Because Vision does not allow partial payment of
employee expenses, partial payments made in FMS cannot be converted to Vision.

Complete the Work-in-Process Cycle

Whether or not you decide to use revenue generation in Vision, if you generate work-in-process
in FMS, you need to complete the WIP cycle before you submit your data for conversion by
posting the reversing WIP entry.

If instead of generating WIP in FMS, you enter it using manual journal entries to asset and liability
accounts, you need to enter journal transactions to reverse those account balances.

Post All Transactions

Before you submit your data for final conversion, you must post all transactions. Unposted
transactions cannot be converted to Vision. Posting is only required for the final conversion. You
do not need to post all transactions for trial conversions.

Check General Ledger and Payroll Conversion Dates

If you are preparing to submit your current data for the final conversion (or for a second test
conversion), make sure the following conversion settings are still correct:

= The accounting period in Convert Periods Through on the Accounting Periods subtab
of the Accounting tab in the Vision Conversion Setup dialog box

=  The current Form W-2 year and quarter on the Payroll tab of the Additional Vision Setup
dialog box (if you are converting Payroll Plus data)

If any of these are no longer correct, change them before running the preconversion utilities.

Run the Preconversion Utilities

Quick Reference

When you finish using the Vision Conversion module to record the migration decisions that apply
to your conversion and you complete any additional data preparation tasks, the next step is to run
a set of preconversion utilities to ensure that your migration decisions are ready for the
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conversion. To do that, click Vision Pre-Conversion Utilities on the Maintain menu to open the
Pre-Conversion Utilities dialog box.

Do not submit your data for conversion if you have not run the utilities selected in the Pre-
Conversion Utilities dialog box, resolved as many of the detected problems as you can, and
discussed any unresolved problems with your Vision consultant.

The utilities selected in Run are the only
ones that you run. Your Vision consultant
will run the others.

If a utility does not run successfully, you can click
this button to view or print the log file containing

problem information.

— Pre-Conversion Utilities

Utility Name LastRan On Successful | LastLog Run -~
Check FMS Account Range 1216:2007 2:05:37 PM AT
Check FMS AP 17111900 12:00:00 AM O \
Check FMS AR 1171900 12:00:00 AM O ‘\
Check FM3 GL 17111900 12:00:00 AM O \
Check FMS Time/Expense Records 11171900 12:00:00 AM O \
Check Vision Conversion Setup 12/6/2007 2:05:39 PM H See Log. v
Check Department Conversion Setup 121612007 2:05:40 PM O See Log... v
Check Vision Chart of Accounts Mapping 12/6/2007 2:05:40 PM v
Check Expense Code Accounts Mapping 12/6/2007 2:05:40 PM F See Log...
Check Vision Labhor Codes 121672007 2:05:41 PM H See Log. v
Check Vision Labor Categories 121612007 2:05:41 PM O See Log... v
Add Missing Phases 17171900 12:00:00 AM D
Setup FMS AR Receipts Detail GL 17111900 12:00:00 AM O
Setup Vision Work Breakdown Structure 1111900 12:00:00 AM O
Copy System data into Company cache 12/6/2007 2:05:41 PM J v 3
[ Back Up Data ] I Close

Click this button to run the utilities. —/

When your data is ready for conversion, click
this button to create a backup copy of your
data to submit to your Vision consultant.

Which Utilities You Run

The utilities you need to run are already selected for you in the Pre-Conversion Ultilities dialog
box. Each of them has a check mark in Run. All you need to do is click Run Selected Utilities.

Your Vision consultant will run the other utilities listed in the Pre-Conversion Utilities dialog box as
part of the conversion process.

When to Run the Utilities

Run the preconversion utilities after you finish recording your migration decision using the dialog
boxes in the Vision Conversion module and before you create a copy of your data for conversion.
What the Utilities Do

The preconversion utilities check your migration decisions to make sure they are ready for the
conversion. If they detect problems, the utilities, in some cases, correct the problem. In others,
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they notify you of the problem using a log file entry, and it is up to you to correct it. Some of the
utilities also prepare conversion data to be copied to Vision when the conversion takes place.

When a utility runs without detecting any problems, the Successful box next to it in the Pre-
Conversion Utilities dialog box is selected. If it does detect problems, Successful is not selected
and the See Log button is available so you can open the relevant log file to review the problem
information.

If the Utilities Detect Data Problems
If any of the utilities do not run successfully, do the following:

1. Review the log files that the failed utilities create to identify what types of problems were
found and which records are involved.

2. For data problems that you can resolve yourself in FMS, make the necessary corrections
and rerun the utilities.

3. Discuss any problems you can't resolve with your Vision consultant before submitting
your data for conversion.

Do not submit your data for conversion if you have not run the utilities, resolved as many of the
detected problems as you can, and discussed any unresolved problems with your Vision
consultant.

Viewing the Log Files

To view the log file for a utility that did not run successfully, click the See Log button for the utility
in the grid in the Pre-Conversion Utilities dialog box. The log file opens in a Windows Notepad
window S0 you can view it or print it.

Once you close the Pre-Conversion Utilities dialog box, you can no longer view the log files using
the See Log buttons unless you rerun the utilities. However, the log files are stored in the folder
in which FMS is installed, so you can open them yourself in Notepad or any word processor.

The log file names all begin with the internal ID of the company, followed by “VC,” and they all
end with “.log.” (The internal ID for the sample company is 1, and that for your first actual
company is normally 2.) The log file for the Check Department Conversion Setup utility, for
example, might be 2VCCHECKDEPTCONVERSION.log. The company name is part of the
header information at the beginning of each log file, so you can check there to confirm that you
have opened the file for the correct company.

Creating a Backup of Your Data to Submit for Conversion

When you have run all utilities successfully or you have resolved as many problems as you can,
and you are ready to submit a copy of your data to your Vision consultant to be converted, create
a backup copy of the database.

To create the backup copy, you can do either of the following:

=  Open the Pre-Conversion Utility dialog box and click the Back Up Data button. This
creates a backup file named Vision_Conversion_<company name>.bak in the backup
folder set up for your SQL database.

= Create a backup copy using your normal backup procedure.
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Print FMS Reports

Quick Reference

Following both the test conversion and final conversion of your Deltek FMS data to Deltek Vision,
the Vision consultant who performs the conversions prints and compares sets of reports from
each system to confirm that your systems balance.

If you would like to repeat the confirmation process yourself when you receive your converted and
tested data from Deltek, you can do so. Refer to “8: Balancing Vision to FMS Following Data
Conversion” on page 164.

All of the FMS reports you need, with the exception of the Payroll Plus reports, can be printed
from the Print Standard Reports dialog box in the Vision Conversion module.

- Print Standard Reports El@@

Reparts Repaotting Period
AP Aging A As OF 1013152007
AR Aging A
Charge Account Aging
(L Trial Balance
Cutstanding Retainer i =
PO Direct Expense Aging Elller
PreVision Conversion
Project Profitability - Combined Cost
Purchase Order List B Report Options
Unapplied Payments / Credit Memos . ' = N
“izion Budget Pre-Conversion Exceptions plion o& SploniSat
[ surmany Only
h
[ Print Options... ] [ Report Writer... ]
|

When to Print the FMS Reports

If, when you receive the converted Vision data, you are going to go through the process to
confirm that Vision balances to FMS, it is important that you print the FMS balancing reports at
the point that your data is ready to be submitted for conversion. The reports need to be printed
from the exact set of data that is converted to Vision. If processing continues in FMS and you
print the reports at a later time, it is unlikely that the data on the FMS and Vision reports will
balance.

Standard FMS Reports

These standard reports from the Accounts Payable, Business Management, and General Ledger
modules are also available in the Vision Conversion module:

= AP Aging
= AR Aging
= Charge Account Aging

= GL Trial Balance
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=  Qutstanding Retainer
= PO Direct Expense Aging
= Unapplied Payment/Credit Memos

Special Versions of Standard FMS Reports

Two reports available in the Vision Conversion module are special versions of standard reports
created for this conversion:

=  Project Profitability — Combined Cost
=  Purchase Order List B

These reports are only available in the Vision Conversion module. When you print reports to use
when balancing Vision to FMS, be sure you print these reports and not the standard reports on
which they were based.

Other Vision Conversion Reports

The Vision Conversion module also provides two additional reports to assist you in converting to
Vision:
= Pre Vision Conversion — This report checks for selected conditions in your FMS data
that may require corrective action either before you convert or in Vision after the
conversion. In some cases, it calls your attention to data that cannot be converted. You
can print this report at any time. If you're not sure about how to respond to the
information on the report, discuss it with your Vision consultant.

= Vision Budget Pre-Conversion Exceptions — This report analyzes your FMS budgets
in light of your Vision work breakdown structure and labor code decisions and identifies
possible budget conversion problem areas. Be sure you enter your Vision WBS and labor
code decisions on the Vision Conversion Setup dialog box before you print this report.

Quick Reference

Click the Print Options button in the Print Standard Reports dialog box to open the Print Options
dialog box. You can also open the Print Options dialog box from other Deltek FMS dialog boxes
such as the Invoices and Billing Reports dialog box.

Default Print Options for Billing Reports and Standard Reports

Each user can define default printers or file output. To do that, click User Preferences on the
Tools menu in any Deltek FMS module and do the following in the Preferences dialog box: Use
the options under Reset to Default Options in the Preferences dialog box to indicate when you
want Deltek FMS to reset the print options to your defaults if you change them at the time you
print reports:

Selecting a Printer

You can pick from any of the printers you have defined in Windows. Selecting a printer in Deltek
FMS doesn’t change the default printer for Windows or for other software you use.

If you need to find out about or change the properties of the printer you've selected, you do that in
Windows. Click the Start button, click Settings, and click Printers.
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Opening the File When You Print

If you print a report to a file, you can choose to open the application associated with the file
automatically. Check the Auto-open external application after export to file check box to do
this. For example, if you print the report to Microsoft Word using the Standard toolbar button,
Deltek FMS exports the file and opens it in your Microsoft Word application automatically.
Otherwise, Deltek FMS prints the report to the location specified in File without opening the
associated application.

Override Set Margins When You Print

You can override the set page margins when you print, such as for when you print checks,
invoices, and government reporting forms. To do this, in the Print Options dialog box check
Override Margins. In the associated text boxes, enter your new margins.

If you check this box, you need to enter a margin in each text box even if you only want to
override the top margin, for example. Otherwise, if you enter a top margin and leave the other
margins at the set default 0.000, Deltek FMS prints according to the margins set in the Print
Options dialog box.

Paper Size and Orientation

All Deltek FMS reports are designed to print on 8 2" x 11” paper. By default, the reports will
automatically print in portrait or landscape orientation, whichever the report requires. You can
override the normal paper size or orientation by changing the printer properties in Windows.

Paper Source

Each Crystal Reports report file is saved with a paper source specified. However, you have the
option to override that and use a paper source you specify. To do that, select the printer, check
the Override Crystal Report’s Defined Paper Source, and then pick the paper source for the
printer from the Source drop-down list.

Because the available paper sources vary from one printer to another, you must select the paper
source each time you select a different printer (unless you want to use the default source defined
in Crystal Reports).

Create the Backup Copy and Submit It for Conversion

When you have run all preconversion utilities successfully or you have resolved as many
problems as you can, and you are ready to submit a copy of your data to your Vision consultant
to be converted, create a backup copy of the database.

To create the backup copy, you can do either of the following:

=  Open the Pre-Conversion Utility dialog box and click the Back Up Data button. This
creates a backup file named Vision_Conversion_<company name>.bak in the backup
folder set up for your SQL database.

= Create a backup copy using your normal backup procedure.
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Submit the File Containing the Converted Data

After you create the backup copy of your FMS data, do the following to submit it for conversion:

Use a file compression utility to create a ZIP file containing the backup. (If the compressed file
size is over one gigabyte, contact your Vision consultant directly to discuss alternate file transfer

methods.)

1. Log on to the Customer Care Connect site at https://deltek.custhelp.com.

2. Onthe Support Home tab, under Support Resources, click Transfer Files to Support.

3. In Select a Product, select Deltek FMS.

4. Click Browse, navigate to the ZIP file containing your backup, and select that file.

5. In Comments, enter a short note that includes your Vision consultant’'s name and your
firm’s name (for example, “Attention John Smith: ABC Company’'s FMS database for
migration”).

6. Click Send File. When the file has been uploaded to Deltek, it will be listed under Your
Files with Support has your File in Status.

7. Send your Vision consultant an email message to alert them that the backup file is

available.
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Chapter 7. Preparing to Test and Go Live on
Deltek Vision

Load the Converted Data into Your Vision Database

When Deltek notifies you that your converted data is ready, complete the following steps:
1. Retrieve the file containing the converted data from the Customer Care Connect site.
2. Restore the backup file to your Vision database.

3. Contact Deltek Customer Care if you have any questions or problems retrieving or
restoring the database.

Retrieve the File Containing the Converted Data

When you receive notification that the file containing your converted data is available,
complete the following steps:

1. Log on to the Deltek Customer Care Connect site at https://deltek.custhelp.com.

2. Onthe Support Home tab, under Support Resources, click Transfer Files to Support.
The new file will be listed under Your Files with Your file is ready to download under
Status.

3. To download the file, click Your file is ready to download under Status, and save the
file.

Restore the Converted Vision Database
After you retrieve the file containing the converted data, restore that file to your Vision database.

The exact steps for restoring the converted database depend on which version of SQL Server
you are using. If you are not familiar with the procedure for your version, contact Deltek Customer
Care for assistance.

Notes on Restoring Converted Data

= Restore the test conversion data as a new database. Don't restore it over your Vision
Demo database, for example.

= Restore the final conversion data as a new database. Don't restore it over your test
database. That way, you have the test database available to refer to during the
configuration process.

= If you have more than one test conversion, you can restore the second set of test data
over the first if you wish.

= When you use the Weblink for Deltek Vision utility to enter configuration information for a
new database and connect it to Vision, you can save time by copying the settings. Rather
than clicking New, select the Vision Demo database or another existing database in
Current Database, click Copy, and enter the name of your new database in Database
Name.
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Configure Vision

Deltek Vision configuration is the process of specifying default settings that control and optimize
how Vision will operate. Each Vision database has its own set of configuration settings. If, as
recommended, you create new databases for both your test conversion data and your final
conversion data, you will need to configure each of those databases. The conversion process
provides some configuration settings based on your FMS data, but most will initially be the Vision
default settings.

Configuration Planning

As part of the planning process, a Vision consultant will discuss the configuration options with you
and help you determine the settings that best fit the needs of your firm. Later, as you are trying
out the test conversion data, you can also try out different configuration settings.

Before You Go Live on Vision

Ideally, when you submit your current data for the final conversion, you know just how you want
Vision configured. When you receive and load the final converted database, you enter those
configuration settings in that database before you begin live operations with it.

If your test database contains the configuration settings you want, use it as a reference tool as
you duplicate the settings in your live database. In some cases, the Vision consultant can copy
configuration settings from your test database to your live one. Be sure to notify the consultant
ahead of time if you want this done, so he or she can advise and assist you. Be aware also that
this is a billable service.

Some Initial Configuration Procedures

The remaining topics in this chapter provide instructions for logging on to a Vision database the
first time and descriptions of these initial configuration tasks:

= Activating Vision modules
=  Setting up system security and employee access to Vision
= Setting up server side emalil

= Setting up the process server

Log In to Vision

Procedure

After you have installed Deltek Vision and connected to your database, you are ready to log in to
Vision.

1. Go to your firm’s designated Vision site.

Either click the Deltek Vision link, or wait while the application is loaded.
When the Deltek Vision login form opens, enter ADMIN in User ID.
Leave Password blank.

Use the Database drop-down list to select your database.

Click Login.

o gk~ w DN
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Activate Vision Modules

When you log in to Deltek Vision for the first time, you must activate the modules you have
purchased.

The conversion process will activate some modules, but you should verify that all the modules
you purchased are available in your Vision database.

To activate Vision modules or confirm that they are already activated, do the following:

1. Click Configuration » Module Activation on the Vision Applications menu to open the
Module Activation dialog box.

2. Enter the appropriate password in Password for each module you want to activate.
When you enter a password, Vision automatically enters license information in License.

3. Click OK.

4. Click @ in the upper-right corner of the Vision window to log out of Vision.

Log back in to Vision. The appropriate modules should now be activated.

Set Up Security

Vision Security and the Conversion

Your Deltek FMS user names and passwords are not converted to Deltek Vision. When you
install Vision, the following security information is set up automatically in the database so you can
log in to Vision:

= One user ID: ADMIN (with no password)

= One role: Default

Set Up Employee Roles

Before your employees begin using Vision, you must set up roles for each of them in Vision. You
can then use these roles to define each employee’s security access to the various Vision
applications and forms, and to set each employee’s access to lookup and reporting options. You
can also set up passwords, if desired.

[:ﬂl For detailed information on setting up security for Vision, refer to the Deltek Vision
Implementation Guide or to the Vision help system.

Copy Security from the Test Database to the Live Database

Once you set up security in your test conversion database, you may choose to have the security
information copied to your live database when the final conversion is done. Before you load your
live Vision database, make sure that a copy of your test security setup is saved. Be sure to notify
your Vision consultant if you want this done, so he or she can advise and assist you.

Set Up Server Side Email

You can use Deltek Vision’s email functionality to send reports to principals, project managers,
and other interested personnel at your firm. Before you can use Vision’s internal email features,
you must configure your server side email information.
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Server Side Email Setup Procedure
To configure server side email, do the following:

1. Click Configuration » General » System Settings on the Vision Applications menu to
open the General System Settings form.

Click the Email tab.

3. Enter information in the fields on this tab, as described in the following table:

Field Description

Email Server Enter the name of the email server.
Port Enter the server port number to use for email.
Default Sender Enter the email address for the default sender of

system-wide email.

Default Help Desk Enter the email address for your centralized Help Desk
mailbox. You can choose to send email directly to
Deltek, or you can set up an internal mailbox to receive
and respond to questions from your staff.

Username (optional) Enter a username, if applicable.

Password (optional) Enter a password, if applicable.

Send Test Email to Click this button to test the ability to send emails to the
Default Help Desk email address entered in Default Help Desk.

4. Click E Save to save your entries.

Set Up the Process Server

The Vision Process Server enables you to submit jobs to a process queue and schedule them for
processing. Deltek Vision users can submit reports, transaction postings, batch billings, and other
Vision processes to a process queue in order to keep their workstation free for other jobs.

Before you can begin using process queues in Vision, you must set up your process server
options.

Process Server Setup Procedure

To set up process server options, do the following:

1. Click Configuration » General » System Settings on the Vision Applications menu to
open the General System Settings form.

2. Click the Servers tab.

3. Enter data in the fields on this tab. To add a blank row to a grid, click the Insert grid
option. To delete a row from a grid, select the row and click the Delete grid option.
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Retain job history for
x days

Field/Control Description

Select this option if you want Vision to save history for
completed processes in the queue. The default for this field is
to retain process history.

If you are not retaining process history, Vision deletes
process entries from the queue after they have completed
running, have failed, or have been cancelled. If the process
entry has an alert pending, Vision deletes the process entry
after the submitter has been notified.

If you are retaining process history, Vision deletes process
entries from the queue after the specified number of days. If
the job has an alert pending, Vision deletes the process entry
after the specified number of days and only after the
submitter has been notified.

Retain errors for x
days

This option allows you to set a limit on the number of days
that the server retains error reports for successful runs.

If you enter an error retention period of O days, Vision saves
all error reports indefinitely.

Process Queues:
Name

Required. Enter a name by which to identify this process
queue. The queue name should be descriptive. This name
appears wherever process queue information is displayed
and may be selected.

Process Queues:
Dedicated Server

If you want to dedicate a queue to a specific server, select
the server from the drop-down list. Only that process server
will run jobs on that queue.

This is useful if you want a particular machine to run jobs of a
particular type. For example, you may want all large jobs to
run on the most powerful machine.

Process Queues:
Max

Enter the maximum number of jobs that will run concurrently
in this queue, regardless of how many jobs are actually in the
queue. Enter zero for no limit.

Process Queues:
Priority

Enter the priority for the process queue. Zero (0) is the
highest priority. The priority level you enter is used to
determine user access (by role) to the process queue.

Process Queues:
Status

Displays the status of the queue, either Running or Stopped.
Status is determined by whether you click the Pause or
Continue grid option.

Application Servers:
Server Name

Enter an application server name. These servers are used to
run application processes, such as transaction posting.

PR
4. Click Save to save your entries.
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Chapter 8: Balancing Vision to FMS Following
Data Conversion

Following both the test conversion and final conversion of your Deltek FMS data to Deltek Vision,
the Vision consultant that performs the conversions prints and compares sets of reports from
each system to confirm that your systems balance.

If you would like to repeat the confirmation process yourself when you receive your converted and
tested data from Deltek, this document provides instructions for printing and reviewing the key
FMS and Vision reports.

FMS Reports

All of the FMS reports you need, with the exception of the Payroll Plus reports, can be printed
from the Print Standard Reports dialog box in the Vision Conversion module:

= AP Aging

= AR Aging

= Charge Account Aging

= GL Trial Balance

= PO Direct Expense Aging

=  Project Profitability — Combined Cost
=  Purchase Order List B

“.] The last two reports are special versions of standard reports that were created for this
conversion. They are only available in the Vision Conversion module. Be sure you print these
reports and not the standard reports on which they were based.

It is important that you print these reports at the time that you create the backup copy of your
FMS data to submit for conversion. You need to print them from the exact set of data that you
submit for conversion. If processing continues in FMS and you print the reports at a later time,
you won't be able to confirm that the two systems balance.

Balancing General Ledger Data

In FMS

In Deltek FMS, print the GL Trial Balance report in FMS for the first period of the current fiscal
year through the current period of the current year.

In Vision

Print the Trial Balance report in Deltek Vision for the first period of the current fiscal year through
the current period of the current year. (Click Reporting » General Ledger on the Vision
Applications menu.)

To simplify the balancing process, sort the report by account group rather than account number.
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To Balance

If the beginning balance and ending balance totals are 0.00 in the Vision Trial Balance report, the
systems should balance. As additional confirmation, compare beginning and ending balances for
the FMS account types with the balances for the corresponding Vision account groups.

Balancing Accounts Receivable Data

In FMS

In Deltek FMS, print the AR Aging report through the last accounting period converted. Select the
Effective Date option under Age Invoices Using, and select Client under Summarize By.

AR Aging A Options g|
Age Invaices Using Summarize By
@ Effactive Date ) Nonhe (Show Detaily
(O Invaice Date ) Billing Graup Invaice
O Due Date O Project Invaice
) Project
@ Client
8 [ cancel
In Vision

In Deltek Vision, print the AR Aged report through the last accounting period converted. (Click
Reporting » Accounts Receivable on the Vision Applications menu.)

= On the Options tab in the AR Aged Options dialog box, select Print all Invoices with
Retainage.

¥ AR Aged Options

General | Options | Sorting/Grouping | Calummnz | Graph E
Client Info o display o

|N-:ne |'| ]

Print Imvaice Detail
|:| Print Lask Receipt by Project |:|
[ Print Final Average Age [ a

[ Print Final Receipt Date I

II Print all Invoices with Retainage

]

jprjude invoices over

= On the Sorting/Grouping tab, set up the report to sort by Primary Client Number.
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) AR Aged Options

General | Options | Sorting/Grouping | Columng | Graph |3

Sort SorkfGroup By {
b | Il | Primary Client Mumber Prinia
Project Mumber P
e =

= On the Columns tab for the report, select Select next to Retainage to include the
retainage column on the report.

) AR Aged Options

General | Optiohiz | Sorting/Grouping | Calummnz | Graph L,P

S

- S Move to top g

Select Colurnn Mame {)

Ags 10 \
Inkerest $

b | ' | Retainage {

Unassigned Receipts }

o Inwoice Comment /_)

To Balance

The FMS AR Aging report total includes retainage while the Vision AR Aged report total does not,
even when the Retainage column is shown. To confirm that the two systems balance, first add
the total for the Retainage column on the Vision report to the report total, and then compare that
amount to the report total for the FMS AR Aging report.

Balancing Accounts Payable Data

In FMS
In Deltek FMS, do the following:

= Print the AP Aging report through the last accounting period converted. In the Options
dialog box, select Effective Date in Date Option. Use the filter below:

i Filters

Filter 1D: | [N

Mame: | InvType | ] Assign to All Compatible Reparts

2 Ty Append
and {Invoice Type Mot Equal To Canceled Sheef) m

Expression:

[ Save H Close

= Print a second AP Aging report through the last accounting period converted. As before,
select Effective Date in Date Option. Use the filter below:
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- Filters

Filter ID: | Ermplny
Mame:  |Emplny [] Assign to All Campatible Reparts
Expression
{Irvoice Type Equal To Employee Expense Append
aor Invoice Type Equal To Canceled Sheety
v
e [ ]

= Print the Charge Account Aging report through the last accounting period converted. In
the Options dialog box, select Effective Date in Date Option.

= If you own the Purchase Order feature set, print the PO Direct Expense Aging report
through the last accounting period converted.
In Vision
In Deltek Vision, do the following:

=  Print the Voucher Schedule report through the last accounting period converted. (Click
Reporting » Vendor on the Vision Applications menu.) Do not select any options or filter
the report.

=  Print the Employee Ledger report through the last accounting period converted. (Click
Reporting » Employee on the Vision Applications menu.) Make sure that Unpaid
Expense Reports is selected on the General tab of the Options dialog box.

) Employee Ledger Options

General | Sorting/Grouping | Columng | Graph | Laygf
>

ReportMame | Employee Ledger i
Options E
Report Type | Summary Report [
StartPeriod | =]
EndPeriod | =

Print Final Totals

Il Unpaid Expense Reports

] Page Breaks For Each Emploves

To Balance

To confirm that the two systems balance, add the report totals from the FMS AP Aging report
printed in step 1 above, the Charge Account Aging report, and the PO Direct Expense Aging
report. That sum should match the report total for the Vision Voucher Schedule.

Note that if you have outstanding prepayments (advances) to employees in FMS, those will be
included on the AP Aging report but will not be reflected in the Voucher Schedule report in Vision,
causing the amounts to differ. In that case, you must calculate the total amount of the
prepayments and adjust the FMS amount accordingly.
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Compare the report total from the FMS AP Aging report to the report total on the Vision Employee
Ledger report. The two should be the same.

Balancing Project Cost Data

In FMS

From the Print Standard Reports dialog box in the Vision Conversion module in Deltek FMS, print
the Project Profitability — Combined Cost report through the last accounting period converted.
(The beginning date of the reporting period does not matter since you will print the report to show
project to-date information.) Be sure you print this report from the Vision Conversion module. The
standard Project Profitability report available in the Business Management module will not give
the correct results

So that the report only includes the projects to be converted, create and use this filter when you
print the report.

i Filters - ||E|rz‘

Filter IO | ConvPraj

Mame: |Projects to Be Converted | [ Assign to All Compatible Reports

Expression

7 oo )

In addition to the above filter, use these reporting options.

In addition to the above filter, select these reporting options in the Project Profitability — Combined
Cost Options dialog box.

{1 Project Profitability - Combined Cost Options

General Overhead

Show Lahaor Costs Include
@ Project To-Date @ Effective Cost Only
() Calendar Year To-Date

(O Accounting Year To-Date

() Reporting Period Only

Qriginal Cast Onb
Summatize By SicioinalceEiony

©) Mone (Show Dstail) Calculate Costto Tie to Wision Office Eamings Report
O Billing Group Include Expenses Based On

) Project (%) Expense Date

@ Client (0 Original Transaction Effective Date

() Expense GL Effective Date
Source of WP
(O Generated WP Transactions
(WP Posted to GL

() Unbilled Labar and Expense
() Do Mot Show

e

Migration Guide 168



- Deltek e

Chapter 8: Balancing Vision to FMS Following Data Conversion

= Under Show in the options dialog box, select Project to-Date.
= Under Summarize By, select Client.
= Under Source of WIP, select Do Not Show.

= Under Labor Costs Include, select Effective Cost Only or Original Cost Only. Choose
the option that matches the option you selected on the FMS Miscellaneous BM tab of the
Vision Conversion Setup dialog box under Time Records Cost Amounts.

= Select Calculate Cost to Tie to Vision Office Earnings Report. (Selecting this box
ensures that rounding will be handled the same as it is in the Vision Office Earnings
report.)

= Under Include Expenses Based On, select Expense Date.
Options on the Overhead tab don’t matter. Only the Labor & Expense Cost column on the report
is used to balance to Vision.
In Vision

In Deltek Vision, print the Office Earnings report through the last accounting period converted.
(Click Reporting » Project on the Vision Applications menu.)

= Under Options on the General tab of the Office Earnings Options dialog box, select Cost
in Report At, and select Job-to-Date and Final Totals under Print.

) Office Earnings Options

General | Activity | Budget | Sorting/Grouping | Columnz | Grap
Repart Mame Office Earnings]

Base Rollup (Click and drag arrows ko roll up information)

Project Base Rollup #/1 234567,

Phase Base Rollup *#[1 2 3|+
Task Base Rollup (1 2 3|+
Report At | Cost -

Prink

/| Current Period Unposted Labor
/| ¥ear-to-Date /| Overhead

/| Job-to-Date /| Estimate Overhead

/| Final Totals Committed Purchase Order Exp

= On the Activity tab of the Options dialog box, clear all check boxes under Activity Basis.
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’ ) Office Earnings Options

General |Ac t_l,l| Budget| Sorting/Grouping | Columng | G}

Activity Basis
[ iy Show Projects with Activity

[] only Show Phases with Ackiviky

[ iy Show Tasks with Activity

Activity Perind i

-

= On the Sorting/Grouping tab of the options dialog box, select Sort for Primary Client
Number.

i) Dffice Earnings Options

General | Activil_l,l| Budget | Sarting G rouping | Colurinz | Graph | Layout|
>
Sort SartfiGraup By Label J}
b | vl | Primary Client Murber Primaty Client Muriber ‘ij\J
Project Mumber Project Mumber <\
Phase Number Phase Mumber /,J—“2
e W{WMWM

= When you select data for the report, use this filter expression to exclude completed
projects from the report: "Completed Equals N.”

“ ] Vision does not have a way to mark projects as completed. However, during the conversion,
a custom field is added to the Vision database for projects, and this field is set to Y for
projects marked as completed in FMS. The filter uses this custom field to exclude those
projects from the Office Earnings report.

To Balance

To confirm that the two systems balance, if the first client shown on the Office Earnings report
from Vision is blank, subtract the job-to-date amount under Spent for that client from the total job-
to-date amount for the report under Spent. (If the spent-to-date amount for the blank client is
negative, you would increase the total spent-to-date amount by the Z99 spent-to-date amount.)

The data for the blank client is from project 299, a “dummy” project created by the conversion
process. This project is used whenever the conversion program encounters an FMS transaction
with a GL account that requires a regular project.

After adjusting the Office Earnings job-to-date Spent total as described above, compare the
resulting amount to the total amount under Labor & Expense Cost on the Project Profitability —
Combined Cost report from FMS. The two should match.

Balancing Payroll Data: Summary Check

If you have the Deltek FMS Payroll Plus module and you converted Payroll Plus data to Vision,
you can do a quick check of the payroll data conversion using the instructions below.
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In FMS

Print Form 940 and Form W-3 for the current calendar year.

In Vision

In Deltek Vision, print the Form 940 Worksheet for the current calendar year. (Click Reporting »
Payroll on the Vision Applications menu.) Be sure to fill in the amount in Wage Base in the Form
940 Worksheet Options dialog box.

Also print the Form W-3 Worksheet for the current calendar year. (Click Human Resources »
Payroll » Form W-2 Processing on the Vision Applications menu. Then click E Print on the
Form W-2 Processing form toolbar and click Print W-3 Worksheet on the menu.)

To Balance

Make sure that the amounts on Form 940 from FMS match the corresponding amounts on the
Form 940 Worksheet from Vision and that the Form W-3 amounts from the two systems match.

Balancing Payroll Data Detailed Check

If you have the Deltek FMS Payroll Plus module and you converted Payroll Plus data to Vision,
you can use the instructions in this topic to confirm that the converted payroll data in Deltek
Vision ties to the data in FMS.

In FMS

Print Form W-2 for the current year for all employees.

In Vision

Generate and print Form W-2 for the current year for all employees. (Click Human Resources »
Payroll » Form W-2 Processing on the Vision Applications menu.)

To Balance

Make sure the Form W-2 amounts from the two systems agree.

Alternative

For an even more detailed check, you can print and compare the Employee Payroll History report
in FMS and the Employee Payroll List in Vision. (Click Reporting » Payroll on the Vision
Applications menu.)

Balancing Purchase Order Data

If you have the Deltek FMS Purchase Order feature set, you can use the instructions below to
confirm that the converted purchase order data in Deltek Vision ties to the data in FMS.

In FMS

From the Print Standard Reports dialog box in the Vision Conversion module in FMS, print the
Purchase Order List B report. Be sure you print this report from the Vision Conversion module.
The standard Purchase Order List available in the Accounts Payable module will not give the
correct results.
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’ When you print the report
= Be sure the reporting period is broad enough to include all POs.

= Use the filter below:

i Filters

Filter ID: | i afalegilql;

Mame: |YisionCony | ] Assign to All Compatible Reparts

Expression:

(Project ID Equal To " Append
ar PO Type Equal To Commitrment) m
and (PO Status Equal To Open) =

CE

Close

When you set up the first filter condition, you leave the final component of the condition blank so
that Standard purchase orders assigned to projects are not selected.

The purpose of the filter is to ensure that the FMS report and the Vision report include the same
set of purchase orders. The conversion program converts POs that have been charged to
projects as AP invoices because Vision doesn’t allow POs to be assigned to projects. However,
commitment POs in FMS, which are charged to projects, are converted as open POs because
they do not affect the general ledger. The filter adjusts the content of the FMS report to reflect
these conversion results.

In Vision

In Vision, print the Open Purchase Orders report for the same reporting period you used for the
FMS report. (Click Reporting » Purchasing on the Vision Applications menu.)

To Balance

Compare the report total for Purchase Order List B and the report total for Open Units on the
Open Purchase Orders report. The two should match.
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Chapter 9: Verifying Data and Performing
Segment Testing

Verify Info Center Data

After the conversion utility is run, Deltek recommends that you verify the data in your Deltek
Vision Info Centers to ensure that records were converted properly. Check several records in
each Info Center, reviewing record contents directly in the Vision form. Verify that the data is
accurate and complete.

o ) When your Deltek FMS database is converted to Vision, many data items that did not have an
equivalent in Vision are added to an FMS tab in Vision. Classification label information is
preserved on a Classification tab. These are custom tabs created by the conversion process. If
you want, you can change the tab names and the names of the fields on the tabs.

Perform Segment Testing

After you have verified that the conversion of Deltek FMS data to Deltek Vision data was
successful, you are ready to begin segment testing—one of the most crucial parts of the
migration process.

What Is Segment Testing?

Segment testing involves actually using each area of Vision to process your converted data
before going ahead with the final conversion. This gives your firm an opportunity to evaluate the
results of your migration decisions and the data conversion. It can also enable others in your firm
who will be using Vision to begin becoming familiar with the system.

Segment testing includes both data testing and process testing to help you answer the following
key questions:

= Data testing: Was the conversion setup done correctly? Are you happy with how the data
converted?

= Process testing: Can you recreate all of the major process cycles (billing, payment
processing, reporting, and so on) in Vision?
Segment Test Period

Typically the segment testing period lasts for a few weeks, but at some large firms it can span
several months.

Segment Test Plan

In preparation for segment testing, we will help you create a test plan and work with your staff as
they put Vision through its paces. Besides ensuring that Vision does what it's supposed to do, the
test period gives your staff an opportunity to become comfortable with the Vision environment.

We can help you design a test plan that covers every important area of Vision. At a minimum, you
should do the following:

= Test security and configuration settings by creating users and roles, setting and
modifying various configuration options, and creating custom tabs, fields, and labels.
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Test Info Center records by adding, modifying, and deleting data and/or records within
each Info Center.

Test the transaction entry process by entering sample data in Vision for each type of
transaction (for example, timesheets, expenses, invoices).

Test the posting process by posting sample transaction entries and analyzing the results.

Test revenue recognition by completing a test run and reviewing the results for projects
that have data posted to them.

Test overhead allocation by completing a test run and reviewing the results for projects
that have data posted to them.

Test report generation by running various reports and analyzing the data in the reports.

Test interactive billing by processing various transactions using sample projects.

In general, processing in Vision should yield the same results as processing in FMS. You should
investigate and resolve any significant discrepancies before your firm begins processing live on

Vision.

Back Up Your Vision Test Database

Before you begin segment testing in Vision, we recommend that you create a backup of your test
database. This gives you the option to restore your data at any time during the testing process, if
that becomes necessary.
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Appendix A: How Info Center Information Is
Converted

System Manager Control Information Conversion

If you selected Use SMTP Server When Sending System-Generated E-mail in the System
Manager Control Information dialog box, the SMTP server name, default email address, and
Always Send System-Generated E-mail from the Default E-mail Address setting are
converted.

If you selected Use Outlook Profile When Sending System-Generated E-mail, no System
Manager control information is converted.

Reviewing the Converted Data

To view the converted data in Deltek Vision, click Configuration » General, System Settings on
the Vision Applications menu, and click the Email tab in the General System Settings form.

Company Information Conversion

Much of the basic information you specify in the Companies dialog box in Deltek FMS is
converted to Deltek Vision data.

Related Migration Decisions

“Country in Addresses Decision” on page 19.

Reviewing the Converted Data

To view the converted data in Vision, do the following:

If you want to view... Then do the following from the Vision Applications menu...
Company name, trade Click Configuration » General » Company Settings, and click the
name General tab.
Primary address Click Configuration » General » Company Settings, and click the
General tab.
Federal EIN Click Accounting » Accounts Payable » Form 1099 Processing.
Or

Click Human Resources » Payroll » Form W-2 Processing.

Phone Click Accounting » Accounts Payable » Form 1099 Processing.

Accounting method Click Configuration » Accounting » System Settings, and click
the General tab.

If You Have Multiple FMS Companies

If you have multiple companies in FMS, each company you want to convert to Vision goes
through its own migration process. If you purchase the Vision Multicompany feature, your
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converted FMS data for all companies are merged into a single database. If you don't purchase
the Multicompany feature, each company’s information goes into a separate database

Consolidation and Elimination Companies

While you can do consolidated financial reporting in Vision, it is accomplished in a different way
than it is in FMS. Because of this, the conversion does not convert consolidation accounts.

If you have a consolidation company the sole function of which is to produce consolidated
financial reports, there is no reason to convert that company. However, if you have a
consolidation company that represents an actual financial entity as well as being used for
consolidated reporting, you can convert that company to a Vision company. The detail accounts
set up in that company are converted but the consolidation accounts are not.

If you set up an elimination company so you could enter adjusting entries to eliminate the effect of
intercompany activity in your consolidated financial reports, there is no point in converting that
company.

Archive Companies

You cannot convert archive companies that you created for archiving project data.

Company Name, Trade Name

The company name is converted as the firm name, and the trade name is converted as the
byline.

Addresses

If you don’t have the Purchase Order feature set in FMS, only the primary company address is
converted. The entry in Province/State is not converted if it is not a state in the U.S.

If you have Purchase Order, the conversion creates ship-to and bill-to codes for all company
addresses on the Ship and Bill tabs of the Purchasing and Inventory Company Settings form in
Vision. A PRIMARY ship-to code and bill-to code are set up for the company’s Primary address. If
the Shipping or Billing/Payment address is different than the Primary, SHIPPING or BILLING
ship-to and bill-to codes are also created.

Federal EIN

The company'’s federal EIN is converted as the payer’s federal identification number for Form
1099 processing. If you have Vision Payroll, it is also converted as the employer’s identification
number for Form W-2 processing.

Phone
The company phone number is converted as part of the company information used for Form 1099
processing.

Accounting Method

If Accrual and Cash is selected under Accounting Method, the conversion selects the Cash-
basis reporting check box under Allow for Reporting on the Accounting System Settings form
in Vision.
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FAS Asset Accounting Database and Company

If you are using the link to the Sage FAS asset accounting system, the information related to that
link on the Connection tab of the Companies dialog box is not converted. Vision provides a link to
Sage FAS, but the way data is imported in Vision is different so this information isn’t needed.

Alchemy Path and Security Information
Vision provides its own document management feature and has no link to the Alchemy document
management system, so the information on the Alchemy tab is not converted.

Archive Companies

Because you cannot convert archive companies, the links between a company and its related
archive companies shown on the Archive Companies tab are not converted either.

Not Converted

The following are not converted:
= Main tab
= Connection tab
= Alchemy tab

=  Archive Companies tab

Checkbooks Conversion

Deltek FMS checkbooks, both active and inactive, are converted as Deltek Vision bank codes.

Related Migration Decisions

“FMS Accounts-to-Vision Accounts Mapping Decisions” on page 72.

Reviewing the Converted Data

To view the converted data in Vision, click Configuration » Accounting » Banks on the Vision
Applications menu. The basic converted checkbook information is on the Bank Codes tab, and
the direct deposit information is on the NACHA File Format tab.

Checkbook ID

Checkbook IDs in FMS can be up to 15 characters long, but bank codes in Vision are limited to
10 characters. If you have any checkbook IDs that are over 10 characters, you must shorten them
before converting FMS data. Checkbook IDs that are too long will appear on the Pre Vision
Conversion report.

GL Account

The account assigned to the bank code in Vision is the Vision GL account to which the FMS GL
account assigned to the checkbook is mapped in the FMS Accounts — Vision Accounts Mapping
dialog box.

The organization for the bank code is the organization assigned to this GL account when you
map accounts in the FMS Accounts — Vision Accounts Mapping dialog box.
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Payment Terms Conversion

Deltek Vision does not have a master set of payment terms as Deltek FMS does. However, some
information from FMS payment terms are converted on a vendor-by-vendor basis.

Vision does not apply payment terms to client payments, so default payment terms for clients are
not converted.

Related Migration Decisions
“Vendor Hold Status Decision” on page 21.
“Vendor Discount Information Decision” on page 22.

“AP Discount Account Decision” on page 110.

Reviewing the Converted Data

To view the converted data in Vision, click Info Center » Vendors on the Vision Applications
menu, and click the Accounting tab.

To see discount code information, click Configuration » Accounting » Company AP on the
Vision Applications menu, and click the Discount Codes tab.

Due Days and Due Dates

If a vendor is assigned default FMS payment terms with due days specified, that number of days
is assigned as the payment terms for the vendor in Vision.

If a vendor is assigned FMS payment terms with a due date (a day of the month) specified, Next
(pay outstanding vouchers in the next check processing run) is assigned as the payment terms in
Vision.

Discounts

If you have vendors in FMS that are assigned payment terms that provide for a discount and you
select Convert Vendor Discount Information on the General tab of the Vision Conversion
Setup dialog box, the discount rate and discount days are converted for those vendors. The
Vision account you enter in AP Discount Account on the Accounting Company Settings tab of
the Additional Vision Setup dialog box is assigned to the Standard discount code in Vision, and
that discount code is in turn assigned to all of the vendors that offer a discount.

Vendors with Hold Status

If you have vendors in FMS that have the Hold Payment status and you select Assign Hold
Payment Terms to Vendors with Hold Status in FMS on the General tab of the Vision
Conversion Setup dialog box, those vendors are assigned Hold as the payment terms in Vision,
rather than payment terms based on their default terms in FMS.

Vendors with Pay When Paid Status

If you have vendors in FMS that have the Pay When Paid status, those vendors are assigned
PWP as the payment terms in Vision, rather than payment terms based on their default terms in
FMS.
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Contacts Conversion

Deltek FMS contacts are converted as Deltek Vision contacts.

Related Migration Decisions

“Country in Addresses Decision” on page 19.

Reviewing the Converted Data

To view the converted data in Vision, click Info Center » Contacts on the Vision Applications
menu. Most contact information appears on the General tab. Information converted as custom
fields appear on the FMS tab.

Last Name

Because a last name is required in Vision, the value in Name in FMS is entered in Last for any
contacts with no last name specified in FMS.

Employer’s Firm
The contact’'s company name and type in Vision are the FMS contact’'s employer’s firm name and
firm type.

If a contact has no employer’s firm specified or the firm is not designated as either a client or
vendor, Client is assigned as the type.

A contact whose employer firm is both a client and a vendor in FMS is actually converted twice.
One of the contacts in Vision has Client in the type box and the other has Vendor.

Addresses

If a contact’s work address is the same as the employer’s firm’s primary address or the same as
the contact’s home address, it is not converted. If it is different from those two addresses, the
work address information is converted as custom fields.

If a contact’s alternate work address is the same as his or her work address, it is not converted. If
it is different, the alternate work address information is converted as custom fields.

Whether or not the country portion of contact addresses is converted depends on which option is
selected under Country in Address on the General tab of the Vision Conversion Setup dialog
box.

If the contact’s address is not in the United States, the entry in Province/State in FMS is
shortened to 10 characters, if necessary, and added to the state code table in Vision.

Inactive Contacts

Based on the Inactive check box in FMS, Status for each converted contact is set to Active or
Inactive.

Business Management Control Information Conversion

Most of the options and data in the Business Management Control Information dialog box in
Deltek FMS are not converted to Deltek Vision, though in some cases individual settings affect
how other data is converted. This topic discusses the items that are converted or are involved in
the conversion.
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Related Migration Decisions

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Work Breakdown Structure Decisions: Labor Codes” on page 49

“Work Breakdown Structure Decisions: Staff Types” on page 51

Reviewing the Converted Data

To view the converted Business Management Control Information data in Vision, do the following:

If you want to view... Then do the following from the Vision Applications menu...

Comments required for Click Configuration » Time & Expense » Company Timesheet,
time records option and click the Setup tab.

Invoice number options | Click Configuration » Billing » General, and click the General tab.

Option to allow entry of Click Configuration » Time & Expense » Company Timesheet,

overtime hours and click the Setup tab.

Labels Click Configuration » General » System Settings, and click the
Labels tab.

Time sheet approval Click Configuration » Time & Expense » Company Timesheet,

option and click the Setup tab.

Comments Required for Time Records

If Time Records is selected under Comments Are Required For on the Defaults tab of the
Business Management Control Information dialog box, the conversion selects Require
comments when hours are entered on the Company Timesheet Configuration form in Vision.
(That check box in Vision provides the default for new projects but you can override it at the
lowest WBS level for individual projects.)

For projects converted to Vision, whether they are set up to require comments for time records is
based on whether comments were required for the billing group in FMS.

Track Time and Expense by Department

Though the Track Time and Expense by Department check box is not converted, it determines
whether the department conversion options are available to you or not.

If you selected the Use Department Assigned on Record option under Department Options so
that labor expense and revenue in FMS could follow the employee rather than the project, and
you want that to continue in Vision, you must convert departments as a WBS level. Otherwise,
the organization to which labor and expense and revenue flow is always determined by the
project in Vision.

Use Separate GL Accounts for Principals and Contract Employees

If Principals is selected under Use Separate GL Accounts, the conversion creates a “Principal”
employee type in Vision. To that employee type, it assigns direct and indirect labor expense
accounts. Those accounts are the Vision accounts mapped to the Direct Principal and Indirect
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Principal accounts specified on the GL Accounts tab of the Business Management Control
Information dialog box in FMS.

If Contract Employee is selected under Use Separate GL Accounts, the conversion creates a
“Contract” employee type in Vision and assigns labor expense accounts as described above for
principals.

A third employee type, “Employee,” is assigned the Vision accounts mapped to the FMS Direct
Employee and Indirect Employee expense accounts.

Each converted employee is then assigned an employee type. Those designated as a principal in
FMS are assigned the Principal type. Those with one of the Contract pay types are assigned the
Contract employee type. All others are assigned the Employee type.

Track Billing Fee History

If Track Billing Fee History is selected on the Project Control tab, billing fee history for your
billing groups is converted to Vision as custom data assigned to the corresponding project.

Invoice Number Tracking

If Track by Project or Billing Group under Invoice Numbers on the Project Control tab is not
selected, the invoice number option in Vision is set to Company Wide, and the number in Next
Invoice Number is assigned as the next invoice number in Vision.

If Track by Project or Billing Group is selected, the invoice numbering options for individual
projects and billing groups are converted.

Pay Types Allowed to Have Overtime Hours

If none of the check boxes under Pay Types Allowed to Have Overtime Hours on the Other
Defaults subtab of the Defaults tab is selected, the Allow users to enter overtime check box on
the Setup tab of the Company Timesheet Configuration form in Vision will not be selected
following the conversion.

If one or more of the boxes are selected, the conversion program selects Allow users to enter
overtime in Vision.

User-Defined Labels

Most of your user-defined labels on the User Labels tab can be converted to Vision labels. Which
ones are actually converted and how they are used depends on your decisions about the work
breakdown structure in Vision and about converting departments, labor codes, and staff types.

For example, if you convert staff types to labor codes in Vision, the Staff Type label is used as
the labor code level associated with staff types. If you don’t convert staff types to labor codes,
then the Staff Type label has no function in Vision and isn’t converted.

User-defined labels for “Firm,” “Cost Type,” “Expense Code,” and “Fee Method” are never
converted, nor are any of the billing type labels.

Minimum Bill Hours and Work Hours Increment

If you specified a minimum hour increment for entry of both work hours and bill hours on the Time
& Expense: Control subtab of the Time & Expense Entry tab in the Business Management
Control Information dialog box, the conversion selects Limit timesheet entry to on the Setup tab
on the Company Timesheet Configuration form in Vision and selects the appropriate hour
increment. If your increment in FMS is not a tenth, quarter, half, or whole hour (the only options in
Vision), the conversion selects the increment that is closest to your FMS increment.
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If you are only using one of the hours increments (only the billing hours increment, for example),
this setting is not selected in Vision, since the Vision setting affects both work and bill hours.

Use Start/End Times on Timesheets

If you specified a minimum hour increment for entry of both work hours and bill hours on the Time
& Expense: Control subtab of the Time & Expense Entry tab in the Business Management
Control Information dialog box, and you selected Use Start/End Times on Timesheets on that
tab, the Enable start/end time feature check box is selected on the Setup tab on the Company
Timesheet Configuration form in Vision.

If you are not using both minimum hour increments, the Enable start/end time feature check
box is left unselected, regardless of whether Use Start/End Times on Timesheets is selected or
not in FMS.

Use Time Sheet Approval

If Use Time Sheet Approval is selected on the Time Approvals subtab of the Time & Expense
Entry tab, the conversion program selects Require timesheets to be approved before posting
on the Setup tab of the Company Timesheet Configuration form.

Time record approval settings on the Time Approvals subtab are not converted.

Not Converted

All information entered in the Business Management Control Information dialog box but not
discussed above is not converted to Vision.

Company Holidays Conversion

The conversion adds a holiday to the holiday calendar in Deltek Vision for every holiday date
specified in the Company Holidays dialog box in Deltek FMS.

Reviewing the Converted Data

To view the converted data in Vision, click Configuration » General » Holiday Calendar on the
Vision Applications menu.

Global Comments Conversion

The conversion creates a global comment for time entry in Deltek Vision for each Deltek FMS
global comment that is designated as available for time records. Those set up only for expense
records are not converted.

If a global comment in FMS is longer than 255 characters, the Vision global comment will contain
only the first 255 characters.
Reviewing the Converted Data

To view the converted data in Vision, click Configuration » Time & Expense » Company
Timesheet on the Vision Applications menu, and click the Global Comments tab.

Time-Off Codes Conversion

Time-off codes in Deltek FMS are converted to benefit accrual codes in Deltek Vision. In some
cases, an accrual schedule may also be created in Vision.
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Reviewing the Converted Data

To view the converted time-off code information in Vision, do the following:

If you want to view... Then do the following from the Vision Applications menu...

Benefit accruals Click Configuration » Accounting » Time Analysis and click the
Benefit Accrual Setup tab.

Accrual schedules Click Configuration » Accounting » Accrual Schedule.

Time Analysis headings | Click Configuration » Accounting » Time Analysis, and click the
and setup information Time Analysis Headings and Time Analysis Setup tabs.

Time-Off Codes and Description
Time-off codes and descriptions are converted as benefit accrual codes and descriptions.

Be aware that this is true of time-off codes for company holidays even though holidays are not
normally handled as an accrued benefit. If you want, you can delete the benefit accrual codes for
holidays after the conversion.

In addition, the conversion creates an overhead project in Vision for each converted time-off code
and then adds a row for each of those projects on the Time Analysis Setup tab of the Time
Analysis and Benefit Accrual form. (If a project with the same ID as a time-off code already exists,
a new project is not created. Instead, the resulting benefit accrual in Vision is linked to the
existing project.)

Warn if Entry Exceeds Available Hours

If a time-off code has Entering Time Records selected under Warn if Entry Exceeds Available
Hours When, the conversion sets Check Hours Entered Against Earned for the benefit accrual
code:

= If the Allow Entry option is selected in FMS, Check Hours Entered Against Earned is
set to Warning.

= If the Don’t Allow Entry option is selected in FMS, Check Hours Entered Against
Earned is set to Error.

If Entering Time Records is not selected under Warn if Entry Exceeds Available Hours When,
then Check Hours Entered Against Earned is set to None. This Vision feature is only available if
you have Vision Time and Expense.

The other options under Warn if Entry Exceeds Available Hours When are not converted to
Vision.

Maximum Hours

The maximum number of hours for a time-off code is converted as the maximum accrual for the
corresponding benefit accrual.

Accumulation Based on Years of Service

If Base Accumulation Rate on Years of Service is selected and Type under Accumulation
Method is Each Pay Period, an accrual schedule is created in Vision. The Years of Service
entries in FMS are used to determine the starting and ending months for each row of the accrual
schedule. The value in Hours Per Year in Vision is calculated from the entry in Rate per Pay
Period and the number of pay periods per year for the employees assigned the time-off code.
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If a time-off code is assigned to employees with different numbers of pay periods per year,
multiple accrual schedules are created in Vision for that time-off code.

When the conversion creates an accrual schedule, it assigns it as the default accrual schedule for
the corresponding benefit accrual. If multiple accrual schedules were created, for the reason
described above, the conversion does not assign a default accrual schedule to the benefit
accrual. Instead, it assigns the appropriate schedules to the individual employees.

Default GL Account

The default employer expense account under Employee for a time-off code in FMS becomes a
part of the setup information for the Time Analysis report in Vision.

The Vision account that is mapped to the default employer expense account for the FMS time-off
code is assigned to the corresponding overhead project row on the Time Analysis Setup tab on
Time Analysis and Benefit Accrual form as the expense account to be used for time entered for
the overhead project.

Employees Conversion

The conversion creates employee records in Deltek Vision for all employees set up in Deltek
FMS.

If you have any employees for whom you've entered normal AP invoices, the conversion creates
a vendor record for them in the Vendors Info Center as well as creating the employee record. (For
more information, see “Vendors Conversion” on page 214.)

Related Migration Decisions

“Country in Addresses Decision” on page 19

“Work Breakdown Structure Decisions: Staff Types” on page 51
“Job Cost Frequency and Payroll Frequency Decisions” on page 57

“Work Breakdown Structure Decisions: Departments” on page 45

Reviewing the Converted Data

To view most of the converted employee information in Vision, click Info Center » Employees
and go to these tabs:

= General

= Personal

=  Accounting
= Time

= Expense

To view benefit accrual hours taken and available, click Human Resources » Benefit Hours »
Adjustments.

Name

The name in Legal Name is converted as the employee’s name in Vision. If the name in Name is
different than the first and last name in Legal Name, it is converted as the preferred name in
Vision.
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Staff Type

If you choose to convert staff types as labor categories, each employee is assigned the labor
category created from his or her default staff type.

If you choose to convert staff types as Vision labor codes and do not convert FMS labor codes as
Vision labor codes, each employee is assigned the labor code created from his or her default staff

type.

If both staff types and FMS labor codes are converted as Vision labor codes, no labor code is
assigned to employees.

Pay Type

Employees whose FMS pay type is Salaried or Salaried-Fluctuating are assigned the Salary job
cost type in Vision. All other FMS pay types are converted to the Hourly job cost type.

If you have the Vision Payroll module, the conversion sets the pay rate type in Vision to match the
job cost type.

Payroll Period

Employee payroll periods are not converted. In Vision, the payroll frequency, timesheet
frequency, and job cost frequency are set at the company level. Before converting data, you set
these frequencies on the Employees tab of the Vision Conversion Setup dialog box.

Hours per Period

An employee’s normal number of hours per pay period in FMS is converted to hours per day in
Vision.

Pay Period Salary and Hourly Cost Rate

For employees with the Salary job cost type in Vision, the pay period salary is converted as the
job cost rate if the job cost frequency is the same as the employee’s pay period in FMS. If they
are different, the job cost rate is calculated by dividing the employee’s annual salary in FMS by
the number of pay periods in the year based on the job cost frequency.

For hourly employees, the hourly cost rate in FMS is converted as the job cost rate.

If you have Vision Payroll, the job cost rate is also assigned as the pay rate. And if you have
Vision Planning, the job cost rate is assigned as the provisional cost rate.

Overtime Cost Multiplier
Overtime cost multipliers in FMS become job cost overtime percentages in Vision.

If you have Vision Payroll, they also become pay rate overtime percentages. And if you have
Vision Planning, overtime cost multipliers are converted as provisional cost overtime
percentages.

Hourly Base Billing Rate
The hourly base billing rate in FMS is converted as a custom field.

If you select Create Labor Rate Schedule for Default Employee Billing Rates on the Labor
Rate Schedules tab of the FMS Billing — Vision Billing Terms dialog box, the conversion also
creates an FMS Default Employee Billing Rates labor rate table in Vision that contains all
employee hourly base billing rates. For more information on this table, see “Labor Rate Schedule
Decisions” on page 85.
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If you have Vision Planning, hourly base billing rates are also assigned as provisional billing
rates.

Department

If you convert FMS departments to Vision organizations, each employee is assigned to the Vision
organization to which the employee’s department is converted.

Percent of Direct Hours Budget

The entry in % Direct Hours Budget in FMS is converted to the target ratio in Vision. If you have
Vision Planning, it is also converted to the utilization ratio.

Addresses, Email, Phone,...

All of the information on the Communication tab of the Employees dialog box in FMS is converted
either to equivalent data items in Vision or to custom fields on the FMS tab.

The employee’s home address in FMS is converted to the employee address that appears on the
Personal tab of the Employee Info Center in Vision. Work address is only converted if it is
different than both the company primary address and the employee’s home address. If it is
converted, it is as custom fields on the FMS tab. Similarly, the alternate work address is
converted only if it is different than the work address.

Classification Labels

Employee classification labels are converted as custom fields and appear on a Classification tab.

Time-Off Codes

Time-off codes are converted to benefit accrual codes in Vision. (See “Time-Off Codes” on page
182 for detalils.)

When employee information is converted, the benefit accrual codes created from the time-off
codes assigned to an employee are assigned to that employee in Vision on the Accounting tab of
the Employee Info Center.

Time-Off Codes: Rate

If an accrual schedule was created when a time-off code was converted, that schedule is
assigned along with the benefit accrual code. If no schedule was created and the accumulation
type of the time-off code in FMS is Each Pay Period, the pay period rate is converted to hours
per year based on the number of the employee’s FMS pay periods that occur in a year.

Time-Off Codes: Maximum Hours

Has Maximum and Maximum for an employee’s benefit code are set during conversion based
on whether the maximum for the time-off code for the employee in FMS was the same as the
maximum set in the Time-Off Codes dialog box. If the employee’s maximum matches the time-off
code maximum, Has Maximum is set to System. If they are different, Has Maximum is set to
Yes and Maximum is set to the employee’s maximum amount. If the employee’s maximum is O,
Has Maximum is set to No.

Time-Off Codes: Available Hours

The number of available hours for a time-off code in FMS is used to determine the year-to-date
earned and taken hours for the benefit accrual in Vision.
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The conversion calculates the number of hours used for the time-off code for the current year by
reading through the employee’s time records. That number goes in YTD Taken on the Benefit
Hours Adjustments form in Vision. To that number, it adds the number of hours in Available
Hours for the time-off code in FMS and assigns that sum to YTD Earned on the Benefit Hours
Adjustments form.

Time-Off Codes: Alternate Start Date

The alternate start date for an employee’s time-off code is converted to Change Date for the
corresponding benefit accrual in Vision. If there is no alternate start date for the time-off code, the
employee’s start date is assigned.

“ ] Because the alternate start date in FMS and the change date in Vision have somewhat different
functions, this date is likely to be incorrect for many employees. Following the conversion, you
should review employee change dates and enter corrected dates when necessary.

Personnel Management: Employee Data

All of the information on the Employee Data subtab of the Personnel Management tab in the
Employees dialog box in FMS is converted either to equivalent data items in Vision or to custom
fields on the FMS tab.

Personnel Management: Reviews

All of the information on the Reviews subtab of the Personnel Management tab in the Employees
dialog box in FMS is converted to custom fields on the FMS tab in the Employee Info Center. In
addition, the most recent date under Next Review is assigned to Raise Date.

Payroll Adjustments, Taxes, Direct Deposit, and GL Accounts Information

If you have Vision Payroll, see “Employee Payroll Information Conversion” on page 261 for
information about the conversion of payroll adjustments, payroll taxes, payroll direct deposit
information, and GL accounts for payroll.

Employee Expenses: General

The following items on the General subtab of the Employee Expenses tab are converted to
custom fields on the FMS tab in the Employee Info Center: credit limit, payment limit,
Subcontractor check box, reference, float days, and the department to which indirect expenses
are to be assigned. No other information from this subtab is converted.

Employee Expenses: Classification Labels

Employee expense classification labels are converted as custom fields and appear on the
Classification tab.

If the conversion also created a vendor in Vision for the employee, these labels also appear on a
Classification tab in the Vendor Info Center.

Employee Expenses: Form 1099

The following items on the Form 1099 subtab of the Employee Expenses tab are converted to
custom fields on the FMS tab in the Employee Info Center: Requires Form 1099 check box, tax
ID, Other Name under Recipient Name Box, and all 1099 payments information. No other
information from this subtab is converted.
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Employee Expenses: Direct Deposit

Most employee expense direct deposit account information is converted to Vision and appears in
the direct deposit grid on the Accounting tab of the Employee Info Center. (This grid also contains
any accounts used for payroll direct deposit.)

Only eight of the nine digits in bank routing numbers are converted; Vision calculates the final
check digit value. The account used for deposit of employee expense reimbursements is always
converted to Vision with 100.00 in Expense Repayments Percent.

Employees Set Up for Employee Expense Entry

If you have employees you've set up for employee expense entry in FMS, the conversion not only
converts those employees to Vision employees, but it also creates a Vision vendor for each them.
This occurs whether or not any of an employee’s employee expense sheets or AP invoices are
actually converted. Because there is no firm information in FMS for these employees, the
conversion sets up the vendor data using employee information only. The employee ID, name,
and addresses are converted to vendor number, vendor name, and vendor addresses.

Deltek recommends that you review each of these vendor records carefully in Vision after the
conversion to make sure, first of all, that you need the vendor record at all and, if you do need it,
that the vendor is set up the way you want.

Finance Charges Conversion

If a Deltek FMS finance charge method is assigned to a billing group on the Billing Info tab of the
Billing Groups dialog box, a monthly charge is calculated from the annual charge rate, and the
monthly rate and the minimum overdue days from that finance charge method are converted as
part of the billing terms for the converted billing group in Deltek Vision. The finance charge
method itself is not converted.

Reviewing the Converted Data

To view the converted data in Vision, click Billing » Billing Terms on the Vision Applications
menu. Select the Vision project for which you want to view the finance charge information, and go
to the Misc tab.

Annual Charge Rate

The conversion calculates a monthly charge rate from the rate in Annual Charge Rate. The
monthly rate then goes to Interest on the Misc tab in the Billing Terms form.

When applying a finance charge, FMS calculates a daily rate and then determines the finance
charges based on the days overdue. Vision, however, just applies the rate in Interest to the full
overdue amount. It does not take into account how many days overdue the amount is. If you bill
monthly in Vision, the finance charge calculated during billing using the converted rate will be the
overdue amount multiplied by the monthly rate in Interest. If you do not bill on a monthly cycle or
if you want to charge more than a monthly rate, you can change the rate in Vision after the
conversion.

Minimum Overdue Days

The number of days in Minimum Overdue Days goes to Grace period on the Misc tab in the
Billing Terms form.
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Not Converted

No finance charge information, other than the annual charge rate and the minimum overdue days,
is converted.

Fee Methods Conversion (Non-Tax)

Non-tax fee methods assigned to billing groups through their billing rate schedules in Deltek FMS
are converted to add-on fees in the billing terms for the converted billing groups in Deltek Vision.

The fee methods themselves are not converted, only the specific instances of them in billing rate

schedules.

Depending on the choice you make on the Fee Methods tab in the FMS Billing — Vision Billing
Terms dialog box, the add-on fee information in Vision is a standard set of data for each fee that
you specify in the FMS Billing — Vision Billing Terms dialog box or is based on the fee information
in each billing group’s billing rate schedule.

Related Migration Decisions

“Tax Fee Methods Decisions” on page 92.

Reviewing the Converted Data

To view the converted data in Vision, click Billing » Billing Terms on the Vision Applications
menu, and select the project.

If you converted billing groups as the WBS1 level, click the Add-ons tab. If you converted billing
groups as WBS2, click the icon in the upper-left corner of the Billing Terms form to reveal the
work breakdown structure for the project, click the billing group, and then click the Add-ons tab

Work Breakdown Structure

Fee methods that are not set up for specific phases are converted to add-on fees for the billing
group work breakdown structure level in Vision.

If phases are converted as a work breakdown structure level, fee methods that are set up for
specific phases for billing groups with either the Phased Cost Plus to a Maximum billing type or
the Phased Specified Fee billing type are converted to add-on fees for the phase work breakdown
structure level in Vision.

A fee method assigned to a phase in FMS is converted to an add-on fee with a 0.00 amount for
the billing group work breakdown structure level if phases are not converted as a work breakdown
structure level or if the phase’s billing group does not have the Phased Cost Plus to a Maximum
billing type or the Phased Specified Fee hilling type.

Amount or Percent

You have two options for calculating add-on fees in Vision: as a rate (percentage of basis) or as
an amount.

If the fee method in FMS has either Rate or Fixed Amount in Calculation in the Billing Rate
Schedules dialog box, the percentage or amount for that fee method is assigned to the add-on
fee in Vision.

If the fee method has either % of Maximum or % of Contract, the conversion calculates an
amount for the Vision add-on fee using the percentage and the maximum or contract amount for
the fee method.
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If the fee method has Amount per Unit, the conversion sets up the add-on fee with 0.00 in
Amount in Vision.

Basis

In Vision, the basis to which the add-on fee is applied is any combination of the following: labor,
expenses, consultants, fees, units, and all add-on fees.

If, as part of the conversion setup, you specify a standard set of fee calculation information for
each fee method, you indicate the components of the basis as part of that process.

If, instead, you decide that the add-on calculation information is to be derived from individual
billing rate schedules, the conversion determines the components of the basis based on what the
fee method is assigned to in FMS (billing summary, billing group, expense cost type,...). For fee
methods with a combined basis in FMS, all other add-on fees for the billing group or phase are
included in the basis if you select the Include All Add Ons in Basis option on the Fee Methods
tab of the FMS Billing — Vision Billing Terms dialog box. If you instead select Don’t Use a
Combined Basis, fee methods with a combined basis in FMS will not have a combined basis
once they are converted to Vision add-ons.

GL Accounts

If you are converting fee methods using standard sets of calculation information, you enter the
Vision income account you want to use for each add-on fee on the Fee Methods page of the FMS
Billing — Vision Billing Terms dialog box.

If you are converting fee methods based on information in billing rate schedules, the Vision
account mapped to the default income account for the fee method as specified in the Fee
Methods dialog box is used. (If the fee method is set up so that income goes to GL accounts for
cost types, Account is left blank for the add-on fee.)

Add-on Maximums

As part of the billing terms in Vision, you can specify a maximum amount for all add-on fees for a
billing group or phase. If you select Convert Sum of Fee Method Maximums as Add-On
Maximum on the Fee Methods tab of the FMS Billing — Vision Billing Terms dialog box, the
conversion program calculates the sum of all fee method maximums and assigns that amount as
the add-on maximum in Vision. (Note that this is not done for billing groups with billing types,
such as Cost Plus to a Maximum, that involve a maximum.)

Tax Fee Methods Conversion

Deltek FMS fee methods designated as taxes and assigned to projects selected for conversion
are converted to Deltek Vision tax codes. Those tax codes are then assigned in the billing terms
for the corresponding Vision projects.

Related Migration Decisions

“Tax Fee Methods Decisions” on page 92.

Reviewing the Converted Data

To view the tax codes created from the FMS tax methods, click Configuration » Accounting »
Taxes on the Vision Applications menu.

To view the tax codes assigned to projects, select the project in the Project Info Center, click
Billing Terms to open the Billing Terms form, and go to the Misc tab.
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Fee Method ID and Description

The fee method ID and description become the code and description for the Vision tax code.

Rate

The rate in Fee Rate in the Fee Methods dialog box is the default rate for the Vision tax code.
However, you can change that rate in the FMS Billing — Vision Billing Terms dialog box, if
necessary.

GL Accounts

On the Tax Methods tab of the FMS Billing — Vision Billing Terms dialog box, the Vision GL
account that is mapped to the fee method’s default liability account is entered as both the credit
account and debit account for the tax code. If necessary, you can change one or both of the
accounts.

What the Tax Applies To
A tax can apply to any combination of the following:
= Labor billing
=  Consultant billing
=  Expense hilling
= Fee billing
= Unit billing
= Add-on fee billing

For each tax that will be converted, you specify the types of billing it applies to on the Tax
Methods tab of the FMS Billing — Vision Billing Terms dialog box before your data is converted.

If a Billing Group Has More Than Three Tax Methods

In Vision, a WBS component cannot be assigned more than three tax codes. The conversion
program assigns the tax codes created from the first three tax methods listed on the Fee Methods
tab in the Billing Rate Schedule in FMS. If there are other taxes assigned in that schedule, they
are not assigned to the Vision project.

Billing Rate Schedules Conversion

From the Deltek FMS billing rate schedules assigned to billing groups that are converted, you can
convert the following:

= Labor rate exceptions for employees or staff types

= Fee and tax methods
Expense rate exceptions on the Expense Rates tab of the Billing Rate Schedules dialog box
aren’t converted.
Labor Rate Exceptions

The entries you make on the Labor Rate Schedules tab of the FMS Billing — Vision Billing Terms
dialog box control if and how labor rate exceptions are converted.
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If you are converting staff types to Deltek Vision labor categories and you have billing rate
schedules that contain labor rate exceptions that consist of just a staff type and a rate, you have
the option to convert the staff type exceptions from those schedules to labor category tables
containing the staff type billing rates. (Labor rate exceptions in the schedule that contain anything
other than, or in addition to, staff type and rate are not converted.)

o) If you map two staff types to the same labor category and a billing rate schedule includes rates
for both of those staff types, the conversion program assigns the rate for the first staff type to
the labor category in the labor category table. The rate for the second staff type is not
converted.

If you have billing rate schedules with exceptions that consist of just an employee and a rate, you
have the option to convert the employee exceptions from those schedules to labor rate tables
containing the employee billing rates. (Labor rate exceptions that contain anything other than, or
in addition to, employee and rate are not converted.)

Fees and Taxes

For a description of the conversion of fee methods and tax methods in billing rate schedules, refer
to these topics:

“Fee Methods Conversion (Non-Tax)” on page 189

“Tax Fee Methods Conversion” on page 190

Related Migration Decisions
“Labor Rate Schedule Decisions” on page 85
“Work Breakdown Structure Decisions: Staff Types” on page 51

“Staff Type-to-Vision Labor Category Mapping Decisions” on page 83.

Reviewing the Converted Data

To view the labor rate tables created in Vision, click Billing » Billing Rate Tables » Labor Rates
on the Vision Applications menu.

To view the labor category tables created in Vision, click Billing » Billing Rate Tables » Labor
Categories on the Vision Applications menu.

Schedule ID and Description

The billing rate schedule ID is not converted, but the ID of the schedule assigned to a billing
group is converted to a custom field as part of the billing group conversion.

The schedule description becomes the table name for the labor rate table or labor category table
created from the schedule.

Effective Dates

If you convert a billing rate schedule that has rates defined by effective date, the Enable
effective dates for labor billing rates is selected on the Miscellaneous tab of the Billing Setup
form in Vision (Configuration » Billing » General). In the labor rate table or labor category table,
the conversion creates a separate row for each employee/effective date combination or each
labor category/effective date combination.
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Billing Group Rate Schedule Assignments

When a billing rate schedule is converted, the billing terms for the projects/billing groups to which
the schedule is assigned are updated:

= |f the schedule is converted to a labor rate table, the Labor Method is set to Rate table
and the labor rate table is assigned in Rate Table.

= If the schedule is converted to a labor category table, the Labor Method is set to By
category and the labor category table is assigned in Rate Table.

If you don’t convert a schedule, the billing terms for the billing groups using that schedule in FMS
are either assigned the default labor rate table, if it exists, or are assigned no labor method and
rate table.

Expense Rates

Expense rate exceptions aren’t converted. However, if Assign the Following Multiplier to All
Expenses is selected for a billing rate schedule, that multiplier is entered in Multiplier for
expense, consultant, and unit terms on the Exp/Con/Unit tab of the Billing Terms form.

Clients Conversion

FMS firms designated as clients are converted to clients in Vision. Firms that are not designated
as either a client or a vendor are also converted to clients in Vision.

Related Migration Decisions

“Country in Addresses Decision” on page 19

Reviewing the Converted Data

To view the client information in Vision, click Info Center » Clients on the Vision Applications
menu.

Addresses, Email, Phone...

Most of the information on the Communication tab of the Firms dialog box in FMS is converted
either to equivalent data items in Vision or to custom fields on the FMS tab.

Whether or not the country portion of firm addresses is converted depends on which option you
selected under Country in Address on the General tab of the Vision Conversion Setup dialog
box.

If the firm’s address is not in the United States, the entry in Province/State is FMS is shortened
to 10 characters, if necessary, and added to the state code table in Vision.

Vendor ID
If a client firm is also a vendor, the conversion does the following:
= Creates both a client and a vendor in Vision

= Selects the Vendor check box on the General tab of the Clients Info Center and enters
the vendor to which the client is linked

= Enters the client in Linked Client on the General tab of the Vendors Info Center
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Contacts

Both current and past contacts for an FMS client firm are converted to Vision contacts and
assigned to the client. Past contacts have the Inactive status in Vision. (For more on how FMS
contacts are converted, see “Contacts Conversion” on page 179).

Because contacts can’t be designated as the primary, billing/shipping, or shipping contact for
clients in Vision, that information is preserved in custom fields on the FMS tab.

Classification Labels

Firm and client classification labels are converted as custom fields and appear on a Classification
tab.

Client Information: Main Subtab

Information in Credit Limit and Reference on the Main subtab of the Client Information tab are
converted to custom fields on the FMS tab. No other information from that subtab is converted.

Client Information: Collection Notifications Subtab

No information from the Collection Notification subtab of the Client Information tab is converted.

Inactive Clients

An inactive client firm in FMS is converted to a “dormant” client in Vision.

Projects Conversion

The Deltek FMS projects you select for conversion in the Projects to Convert dialog box are
converted to Deltek Vision projects (WBS1).

If you also elect to convert billing groups at the first work breakdown structure level, a Vision
project is created for each project-billing group combination.

If you convert billing groups at the second work breakdown structure level, one Vision project is
created for each FMS project, and each billing group for a project is converted to the WBS2 level
under the project.

Converting Billing Groups to WBS2: Exceptions

If you convert billing groups at the WBS2 level, this normally results in one Vision project for each
FMS project converted. However, there are some exceptions:

= If an FMS project has both proposal and regular billing groups, one Vision project is
created for the proposal billing groups and a second project for the non-proposal billing
groups.

= If an FMS project has both overhead and regular billing groups, one Vision project is
created for the overhead billing groups and a second project for the non-overhead billing
groups.

= If billing groups for a project have more than one client, a project is created in Vision for
each billing group client.

= |f two billing groups for a project have the same client but have different billing contacts, a
separate project is created for each client-contact combination.
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Related Migration Decisions

“

Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
“Custom Invoice Format Decisions” on page 93

“Country in Addresses Decision” on page 19

Reviewing the Converted Data

To view the converted project information in Vision, click Info Center » Projects on the Vision
Applications menu.

Project Work Breakdown Structure

This topic only discusses the conversion of information you enter in the Projects dialog box in
FMS. For descriptions of how the components of the project work breakdown structure are
converted, see the following:

= “Billing Groups Conversion” on page 197
= “Phases Conversion” on page 203

= “Departments Conversion” on page 205
= “Staff Types Conversion” on page 207

= “Labor Codes Conversion” on page 208

= “Expense Codes Conversion” on page 209

Project ID and Title

If, as is most common, you combine FMS projects and billing groups at WBS1 in Vision, the
project number in Vision is by default a combination of the project ID and the billing group ID.
However, you can choose, on the WBS tab of the Vision Conversion Setup dialog box, to drop
the billing group ID from the Vision project number when the FMS project has only one billing
group. If you select Omit the Billing Group ID for Projects with Only One Billing Group check
box, the conversion uses only the FMS project ID as the Vision project number.

If you don’t combine projects and billing groups at WBS1, the FMS project ID becomes the
project number in Vision.

o) Exceptions: If you convert billing groups at the WBS2 level and the conversion creates more
than one Vision project for an FMS project because of the billing types of the billing groups or
because the billing groups do not all have the same client, the project numbers may consist of
the FMS project ID and additional information to distinguish the Vision projects.

For example, if two projects are created because the FMS project included both phased and
non-phased billing groups, the project numbers are the FMS project ID for the Vision project to
which the non-phased billing groups are converted and the project ID followed by :Phased for
the project to which the phased billing groups are converted.

If you combine projects and billing groups at WBS1, the project title is used for both the short and
long name for the Vision project unless you select the Use Billing Group Title Instead of
Project Title for Combined Projects check box on the WBS tab of the Vision Conversion
Setup dialog box. In that case, the billing group title is used instead. Truncation of either of these
tittes may occur in Vision because of field length restrictions.
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Both the project title and billing group title are also converted to custom fields on the FMS tab.

Inactive or Completed Projects

Inactive or completed projects that you select for conversion normally have the Dormant status in
Vision. However, if the converted project has an outstanding AR balance, its status is set to
Active.

The inactivation date and completion status are converted to custom fields on the FMS tab. The
completion date appears in Actual under Completion Dates on the Dates & Costs tab of the
Project Info Center.

Client
The project’s client assignment isn’t converted to Vision.

If projects and billing groups are combined at the WBS1 level, the billing group’s client becomes
both the project’s primary client and its billing client in Vision.

If billing groups are converted at the WBS2 level, each billing group’s client becomes the primary
and billing client for the corresponding WBS2 code, and the first billing group’s client becomes the
primary and billing client for the project.

Invoice Address

If projects and billing groups are combined at the WBS1 level, the project’s invoice address isn’t
converted, and the billing group’s invoice address appears in Client Address on the General tab
of the Project Info Center and in Billing Address on the Accounting tab.

If you convert billing groups at the WBS2 level, the project’s invoice address becomes the client
address and billing address for the Vision project.

Principal and Project Manager

If you've assigned a principal to an FMS project, the principal is converted to Principal-in-
Charge on the General tab of the Project Info Center.

The project manager specified in the Projects dialog box is converted to Project Manager on the
General tab of the Project Info Center if you convert billing groups at the WBS2 level. If you
combine projects and billing groups at the WBSL1 level, the billing group manager is converted to
Project Manager for the project.

Classification Labels

Project classification labels are converted as custom fields and appear on a Classification tab.

Billing Reports

Invoices and billing-related reports in Vision are not printed using Crystal Reports files, so the
billing report assignments on the Billing Reports tab are not converted.

However, if you are using one of the standard Crystal Reports formats for invoices, some of the
settings from that format are converted to settings in the project’s billing terms and invoice
template in Vision. If you are using a custom invoice format for a project, you have the option to
do the same for that format. See “Custom Invoice Format Decisions” on page 93 for more
information.
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“.] Because the way in which billing is accomplished in Vision is different than in FMS, the
conversion of invoice formats does not result in invoices that match those in FMS. After the test
conversion, it is important that you print trial invoices and, as necessary, work with the billing
options in Vision to get the invoices formatted the way you want.

Invoice Numbering

Whether the invoice numbering information on the Billing Reports tab of the Projects dialog box is
used in Vision depends on how you handle invoice numbers in FMS.

Track by Project or Billing
Group is selected on the Project
Control tab of the Business
Management Control Information
dialog box

Track by Project is
selected on the Billing
Reports tab of the
Projects dialog box

The project’s next invoice

number is converted to Next
Invoice Number on the Misc
tab of the Billing Terms form.

Track by Project or Billing
Group is selected on the Project
Control tab of the Business
Management Control Information
dialog box

Track by Billing Group
is selected on the Billing
Reports tab of the
Projects dialog box

And

You are combining
projects and billing
groups at the WBS1
level

The billing group’s next
invoice number is converted
to Next Invoice Number on
the Misc tab of the Billing
Terms form.

Track by Project or Billing
Group is selected on the Project
Control tab of the Business
Management Control Information
dialog box

Track by Billing Group
is selected on the Billing
Reports tab of the
Projects dialog box

And

You are converting
billing groups at the
WBS2 level

The highest of the billing
groups’ next invoice numbers
is converted to Next Invoice
Number on the Misc tab of
the Billing Terms form.

Track by Project or Billing
Group is not selected on the
Project Control tab of the Business
Management Control Information
dialog box

The next invoice number from
the Project Control tab of the
Business Management
Control Information dialog
box becomes the next invoice
number used company-wide
in Vision.

Billing Groups Conversion

The Deltek FMS projects you select for conversion in the Projects to Convert dialog box are
converted to Deltek Vision projects at the first work breakdown structure level (WBS1). You have
two options for converting the billing groups for those projects:
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= If you also elect to convert billing groups at the WBSL1 level, a Vision project is created for
each project-billing group combination.

= If you convert billing groups at the second work breakdown structure level (WBS2), one
Vision project is created for each FMS project, and each billing group for a project is
converted to the WBS2 level under the project.

Converting Billing Groups to WBS2: Exceptions

If you convert billing groups at the WBS2 level, this normally results in one Vision project for each
FMS project converted. However, there are some exceptions:

= If an FMS project has both proposal and regular billing groups, one Vision project is
created for the proposal billing groups and a second project for the non-proposal billing
groups.

= |f an FMS project has both overhead and regular billing groups, one Vision project is
created for the overhead billing groups and a second project for the non-overhead billing
groups.

= |f billing groups for a project have more than one client, a project is created in Vision for
each billing group client.

= If two billing groups for a project have the same client but have different billing contacts, a
separate project is created for each client-contact combination.
Related Migration Decisions
“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
“Update Project Teams Decision” on page 59
“Labor Rate Schedule Decisions” on page 85
“Fee Methods Decisions” on page 88
“Tax Fee Methods Decisions” on page 92
“Custom Invoice Format Decisions” on page 93

“Country in Addresses Decision” on page 19

Reviewing the Converted Data

To view the converted billing group information in Vision, click Info Center » Projects on the
Vision Applications menu. To see some billing-related information, you will also need to open the
Billing Terms form.

Work Breakdown Structure

This topic only discusses the conversion of information you enter in the Billing Groups dialog box.
For descriptions of how the other components of the project work breakdown structure are
converted, see the following:

= “Projects Conversion” on page 194

= “Phases Conversion” on page 203

= “Departments Conversion” on page 205
= “Staff Types Conversion” on page 207

= “Labor Codes Conversion” on page 208
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= “Expense Codes Conversion” on page 209

Billing Group ID

If, as is most common, you combine FMS projects and billing groups at the WBS1 level in Vision,
the project number in Vision is a combination of the project ID and the billing group ID. If you
don’t combine them, the FMS project ID becomes the project number in Vision, and the billing
group ID becomes the WBS2 identifier.

If you elect to combine projects and billing groups at the WBSL1 level, you can choose, on the
WBS tab of the Vision Conversion Setup dialog box, to drop the billing group ID from the Vision
project number when the FMS project has only one billing group. If you select Omit the Billing
Group ID for Projects with Only One Billing Group check box, the conversion uses only the
FMS project ID as the Vision project number.

Billing Group Title

If you combine projects and billing groups at WBS1, the project title is used for both the short and
long name for the Vision project unless you select Use Billing Group Title Instead of Project
Title for Combined Projects on the WBS tab of the Vision Conversion Setup dialog box. In that
case, the billing group title is used instead.

If you convert billing groups at the WBS2 level, the billing group title is used for the short and long
names at the WBS2 level. (If a billing group has no title in FMS, the billing group ID is used for the
names in Vision.)

Truncation of all tittes may occur in Vision because of field length restrictions.

Both the project title and billing group title are also converted to custom fields on the FMS tab.

Inactive Billing Groups

Inactive billing groups normally have the Dormant status in Vision. However, if the converted
billing group has an outstanding AR balance, its status is set to Active.

The inactivation date is converted to a custom field on the FMS tab.

Billing Type
The FMS billing type itself is converted to a custom field on the FMS tab.

The conversion uses the billing type to determine the Vision project’s charge type (Regular,
Overhead, or Promotional), and it uses the billing type, along with the billing rate schedule and
invoice format, to determine how to set up billing terms for the project.

o) The conversion of billing information in FMS to billing terms in Vision saves you work in
preparing to print invoices in Vision. However, because the way you set up and control the
billing process in Vision is so different from how you do it in FMS, the conversion is not perfect
and does not result in Vision invoices that are identical to your FMS invoices. After the
conversion, be sure you review the billing terms and invoice formats carefully for your active
projects and make any changes that are necessary to get the results you want.

Phased Billing Types and Sublevel Billing Terms

When you convert a billing group with the Phased Fixed Fee, Phased Percent of Construction, or
Phased Cost Plus billing type, the conversion does not set up sublevel billing terms at the phase
level of the work breakdown structure in Vision, because it can set up billing by phase using the
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Enable Posting by Billing Phase check box and the Billing Phases grid on the Fees tab of the
Billing Terms form.

For billing groups with the Phased Specified Fee or Phase Cost Plus to a Maximum billing type,
however, the conversion does set up sublevel billing terms. In the case of Phase Specified Fee,
the required fee method is Current unit or fee, but when you use that method, Vision does not
give you access to the Billing Phases grid, so you can't enter phase fee amounts. Sublevel
terms are necessary for Phased Cost Plus to a Maximum billing groups because the Billing
Phases grid has no column for entering a billing limit.

Department

If you convert departments in FMS to Vision organizations, the department assigned to a billing
group in FMS determines the organization assigned to the corresponding WBS level in Vision
and, in some cases, to other WBS levels:

= If projects and billing groups are combined at the WBS1 level, the organization you map
to the billing group’s department becomes the project’s organization.

= |f billing groups are converted at the WBS2 level, the organization you map to each billing
group’s department becomes the organization for the corresponding WBS2 component in
Vision. The project’s organization, in that case, is the one mapped to the first billing
group’s department.

= If you convert phases at a WBS level, the WBS component corresponding to an FMS
phase is assigned the organization you mapped to the department for that phase’s billing

group.
= If you convert labor codes at a WBS level, the WBS component corresponding to an FMS

labor code is assigned the organization you mapped to the department for that labor
code’s billing group.

= |f you also convert departments at a WBS level, the WBS component corresponding to
an FMS department is always the organization you mapped to that department.

If you are using departments but don’t convert them to organizations, the information linking a
billing group to a department is not converted.

Fixed Department Allocation

In FMS, you can set up a billing group so that specified departments are allocated predetermined
percentages of income and expenses regardless of the actual costs and charges each generates
based on the departments entered in time and expense records. Vision, however, does not
provide this option, so fixed department allocations you've set up for your billing groups are not
converted.

Billing Fee and Fee History

If projects and billing groups are combined at the WBS1 level, the billing group’s billing fee is
converted to Compensation on the Budget & Revenue tab for the project. If billing groups are
converted at the WBS2 level, the billing fee is converted to Compensation for that WBS2
component, and Compensation for the project becomes the sum of the compensation amounts
for its billing groups. In either case, the billing fee is also converted to Fee on the Fees tab of the
Billing Terms form for billing groups with a fixed fee billing type.

If Track Billing Fee History is selected on the Project Control tab of the Business Management
Control Information dialog box, a billing group’s billing fee history is converted to a custom grid on
the FMS tab.
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Phases

How a billing group’s phases are converted depends on the option you choose under Convert
Phases As on the WBS tab of the Vision Conversion Setup dialog box. For more information, see
“Phases Conversion” on page 203.

Comments Required for Time Records

The conversion sets the value of Require Comments for Hours on the Time & Expense tab of
the Project Info Center in Vision based on the corresponding settings in FMS:

= If the Time Records check box under Comments Required For for all billing groups in
FMS agrees with the global setting in the Business Management Control Information
dialog box, Require Comments for Hours is set to Company for all converted projects.

= If this setting is different from that in the Business Management Control Information
dialog box for one or more billing groups, then Require Comments for Hours is set to
Yes or No for each converted project based on the billing group setting.

Client

If projects and billing groups are combined at the WBS1 level, the billing group’s client becomes
both the project’s primary client and its billing client in Vision.

If billing groups are converted at the WBS2 level, each billing group’s client becomes the primary
and billing client for the corresponding WBS2 component, and the first billing group’s client
becomes the primary and billing client for the project.

Invoice Address

If projects and billing groups are combined at the WBS1 level, the project’s invoice address isn’t
converted, and the billing group’s invoice address appears in Client Address on the General tab
of the Project Info Center and in Billing Address on the Accounting tab.

If you convert billing groups at the WBS2 level, the project’s invoice address becomes the client
address and billing address for both the project and for the WBS2 components.

Contact

If projects and billing groups are combined at the WBS1 level, the project’s contact isn’t
converted, and the billing group’s contact appears in Primary Contact on the General tab of the
Project Info Center and in Billing Contact on the Accounting tab.

If you convert billing groups at the WBS2 level, the project’s billing contact becomes the primary
contact and billing contact for both the project and for the WBS2 components.

Billing Rate Schedule

The schedule ID for the billing rate schedule assigned to a billing group appears as a custom field
on the FMS tab in Vision. The information in the billing rate schedule is used to set up billing
terms in Vision. For more on billing rate schedule conversion, see “Billing Rate Schedules
Conversion” on page 191.

Retainage

If the billing group is set up with a retainage withholding percentage, the percentage is converted
to Percent for retainage on the Misc tab of the Billing Terms form, and the maximum amount is
converted to Limit.
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Percent Complete Calculation

The percent complete calculation method affects both the calculation of WIP and fee billing in
FMS. However, these are handled differently in Vision, so the method is only converted to a
custom field on the FMS tab.

Finance Charges

The finance charge method assignment is not converted. However, if a method is assigned to a
billing group, a monthly charge rate and the minimum overdue days for that finance charge
method are converted as part of the billing terms for the converted billing group in Vision. For
more information, see “Finance Charges Conversion” on page 188.

Contract Information

The information on the Contract Info tab of the Billing Groups dialog box is converted as follows:

This FMS data item... Is converted to the following...
Proposal Number Custom field on the FMS tab
Contract Number Custom field on the FMS tab
Contract Date Contract under Initial Dates on the Dates & Costs tab
Work Start Date Start under Initial Dates on the Dates & Costs tab
Expected Finish Date Estimated under Completion Dates on the Dates & Costs tab
Title/Description Custom field on the FMS tab
May also be converted to Long Name and Short Name

Classification Labels

Billing group classification labels are converted as custom fields and appear on a Classification
tab.

GL Accounts

If you do not use departments in Business Management, you assign a number of GL accounts to
individual billing groups. Vision does not support this type of direct linking of GL accounts to a
WBS level, so the billing group account assignments aren’t converted.

Billing Messages

Project, billing group, and phase billing messages are converted as custom fields and appear on
the FMS tabs for the corresponding work breakdown structure levels in Vision.

When sublevel billing terms are created for phases in Vision, any phase billing messages in FMS
are converted to Description on the General tab of the Billing Terms form. If you don’t convert
phases to a work breakdown structure level, phase-level billing messages are not converted.

Alerts

No information from the Alerts tab of the Billing Groups dialog box is converted.
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Staffing Information

Project and billing group manager and staff assignments from the Staffing tab of the Billing
Groups dialog box are converted to rows in the Employees grid on the Team tab of the Project
Info Center at the appropriate WBS levels. If you made an entry in Responsibility in FMS for a
staff member, that entry is converted to Role in Vision. Staff type assignments on the Staffing tab
are not converted.

Managers designated on the Staffing tab in FMS are also converted to Project Manager at the
appropriate WBS levels.

In addition, if you select Update Project Team When Posting Labor or Vouchers on the FMS
Miscellaneous BM tab of the Vision Conversion Setup dialog box, the conversion adds other
employees and vendors to Team tabs for a project if time or expense records have been entered
for them for that project.

Labor Codes

For a description of how labor codes are converted, see “Labor Codes Conversion” on page 208.

Government Contracting Information

No information from the Gov. Contract tab of the Billing Groups dialog box is converted.

Phases Conversion
When you convert FMS phases set up for the billing groups you are converting, you can:

= Convert the phases as a work breakdown structure level (WBS2 or WBS3, depending on
the other WBS options you select).

= Convert the phases as Deltek Vision labor codes.

= Choose to not convert phases at all.

Related Migration Decisions
“Work Breakdown Structure Decisions: Phases” on page 42
“Labor Code Structure Decision” on page 53

“FMS Codes to Vision Labor Codes Mapping Decisions” on page 82

Reviewing the Converted Data
To view the converted phase information in Vision if you convert phases to a WBS level, click

Info Center » Projects on the Vision Applications menu, select a project, and then click IEI in
the upper left corner of the form to expand the sublevels of the project until the phases are
displayed.

To see some billing information for phases, you must also open the Billing Terms form. For
phased billing types, you can review the billing phases on the Fees tab of that form. For Phased
Specified Fee and Phased Cost Plus to a Maximum Billing Types, sublevel billing terms are
created at the phase level of the work breakdown structure.

If you convert phases as labor codes, you can review the codes by clicking Configuration »
Accounting » Labor Codes on the Vision Applications menu.
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If You Convert Phases as Labor Codes

If you convert phases as Vision labor codes or as one level of your Vision labor codes, these are
the results:

= None of the phase information entered in the Billing Groups dialog box is converted.

= The phase IDs and descriptions are converted to Vision labor codes and descriptions as
you specify in the FMS Codes — Vision Labor Codes dialog box.

= Phases for converted time records are reflected in the Vision labor codes assigned to
those records.

= Converted expenses have no phase information associated with them in Vision.

Nearly all converting FMS clients convert phases at a WBS level. The remainder of this topic
deals only with that scenario.

Work Breakdown Structure

This topic only discusses the conversion of the phase information you enter in the Billing Groups
dialog box. For descriptions of how the other components of the project work breakdown structure
are converted, see the following:

= “Projects Conversion” on page 194

= “Billing Groups Conversion” on page 197
= “Departments Conversion” on page 205
= “Staff Types Conversion” on page 207

= “Labor Codes Conversion” on page 208

= “Expense Codes Conversion” on page 209

Phase ID

The FMS phase ID becomes the WBS component at the phase WBS level in Vision. Be aware
that if the FMS phase ID has more than seven characters, not counting spaces, the rightmost
characters are dropped when the ID is converted. If you have phase IDs longer than seven
characters, we recommend that you review and, if necessary, change those IDs in FMS before
converting data.

For more information, see “Complete Additional Data Preparation Tasks” on page 150.

Phase Description

The FMS phase descriptions becomes both the short and long name for the Vision phase.

Inactive Phases

Inactive phases have the Dormant status in Vision.

Billing Fee

Billing fees entered for phases in the Billing Groups dialog box in FMS are converted to
Compensation on the Budget & Revenue tab of the Project Info Center at the phase level of the
WBS

For billing groups with the Phased Fixed Fee billing type, the phase billing fee is also converted to
the Fee column in the Billing Phases grid on the Fees tab of the Billing Terms form. For those
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with the Phased Specified Fee billing type, it is converted to Fee on the Fees tab for the sublevel
terms for the phase WBS level. Phase billing fees for other billing types aren’t converted.

% of WIP

The percent of WIP to recognize as income for a phase is not used in Vision. It is converted to a
custom field on the FMS tab. To view it, select the phase in the project’s work breakdown
structure.

Classification Labels

Phase classification labels are converted as custom fields and appear on the Classification tab
when you select the phase in the project’s work breakdown structure.

Billing Messages

Project, billing group, and phase billing messages are converted as custom fields and appear on
the FMS tabs for the corresponding work breakdown structure levels in Vision.

When sublevel billing terms are created for phases in Vision, any phase billing messages in FMS
are converted to Description on the General tab of the Billing Terms form. If you don’t convert
phases to a work breakdown structure level, phase-level billing messages are not converted.

Staffing Information

Project, billing group, and phase manager and staff assignments from the Staffing tab of the
Billing Groups dialog box are converted to rows in the Employees grid on the Team tab of the
Project Info Center at the appropriate WBS levels. If you made an entry in Responsibility in FMS
for a staff member, that entry is converted to Role in Vision. Staff type assignments on the
Staffing tab are not converted.

Managers designated on the Staffing tab in FMS are also converted to Project Manager at the
appropriate WBS levels.

In addition, if you select Update Project Team When Posting Labor or Vouchers on the FMS
Miscellaneous BM tab of the Vision Conversion Setup dialog box, the conversion adds other
employees and vendors to Team tabs for a project if time or expense records have been entered
for them for that project.

Labor Codes

For a description of how the labor codes assigned to a phase are converted, see “Labor Codes
Conversion” on page 208.

Departments Conversion

If you are using departments in Business Management, you have three options for converting
those departments to Deltek Vision:

= You can convert the departments as a work breakdown structure level (WBS2 or WBS3,
depending on the other WBS options you select).

= You can convert the departments as Vision organizations.
= You can convert the departments as Vision labor codes.

You can choose any combination of these options.
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Related Migration Decisions

“Work Breakdown Structure Decisions: Departments” on page 45
“Department-to-Organization/WBS Mapping Decisions” on page 71
“Labor Code Structure Decision” on page 53

“FMS Codes to Vision Labor Codes Mapping Decisions” on page 82
“Migration Briefing: Work Breakdown Structure Conversion” on page 35

“Migration Briefing: Vision Organizations” on page 43

Reviewing the Converted Data

To view the converted department information in Vision if you convert departments to a WBS
level, click Info Center » Projects on the Vision Applications menu, select a project, and then

click IEI in the upper left corner of the form to expand the sublevels of the project until the
departments are displayed.

If you convert departments as organizations, you can review the organizations by clicking
Configuration » Organization » Codes on the Vision Applications menu.

If you convert departments as labor codes, you can review the codes by clicking Configuration »
Accounting » Labor Codes on the Vision Applications menu.

Department ID

If you convert departments to organizations and you don’t convert the GL account structure to
organization levels, the department ID becomes the default subcode for the department.
However, you can change it during the conversion setup process. If you do choose to convert the
GL account structure, the department ID isn’t used.

If you convert departments to a WBS level, the department ID becomes the default for the
department WBS component in Vision. However, you can change it during the conversion setup
process. All departments are added as available WBS components for each of the converted
projects.

If you convert departments to Vision labor codes, the department IDs are converted to Vision
labor codes as you specify in the FMS Codes — Vision Labor Codes dialog box.

Department Description

If you convert departments to organizations and you don’t convert the GL account structure to
organization levels, the department description becomes both the default code label and the
default organization name. However, you can change either of those during the conversion setup
process. If you do choose to convert the GL account structure, the department description is only
used as the default organization name.

If you convert FMS departments to a WBS level, the department description becomes both the
short and long name for the Vision department in the WBS.

If you convert departments to Vision labor codes, the department descriptions are converted to
Vision labor code descriptions as you specify in the FMS Codes — Vision Labor Codes dialog box.
Manager

The department manager is not converted.
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Inactive Departments

If you convert departments to organizations, all departments, inactive as well as active, appear in
the FMS Department — Vision Organization Mapping dialog box. However, by mapping your
inactive departments to one dummy organization, you can essentially remove them from Vision.
For more on this, see “Department-to-Organization/WBS Mapping Decisions” on page 71.

If you convert departments to a WBS level, inactive departments have the Dormant status in
Vision.
GL Accounts

The GL account assignments for departments in FMS are not converted.

Staff Types Conversion

You have three options for converting FMS staff types to Vision. You can convert staff types to:
= Vision labor categories
= Vision labor codes

= Both labor categories and labor codes

Related Migration Decisions

“Work Breakdown Structure Decisions: Staff Types” on page 51
“Labor Code Structure Decision” on page 53

“FMS Codes to Vision Labor Codes Mapping Decisions” on page 82

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data

If you convert staff types as labor categories, you can review the labor categories by clicking
Configuration » Accounting » System Settings on the Vision Applications menu and going to
the Labor Categories tab. To see the labor categories assigned to individual employees, click
Info Center » Employees on the Vision Applications menu and go to the Accounting tab.

If you convert staff types as labor codes, you can review the codes by clicking Configuration »
Accounting » Labor Codes on the Vision Applications menu. To see the labor codes assigned
to individual employees (if any), click Info Center » Employees on the Vision Applications menu
and go to the Time tab.

Staff Type ID and Description

If you convert staff types to labor categories, you map each staff type to a labor category number
and description in the FMS Staff Types — Vision Labor Category Mapping dialog box.

If you convert staff types to Vision labor codes, the staff type IDs are converted to Vision labor
codes and labels as you specify in the FMS Codes — Vision Labor Codes dialog box.

No other staff type information is converted.

Employee Staff Types

If you choose to convert staff types as labor categories, each employee is assigned the labor
category mapped to his or her default staff type.
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If you choose to convert staff types as Vision labor codes and do not convert FMS labor codes as
Vision labor codes, each employee is assigned the labor code created from his or her default staff

type.

If both staff types and FMS labor codes are converted as Vision labor codes, no Vision labor
codes are assigned to employees.

Labor Codes Conversion
You can convert FMS labor codes to:
= Deltek Vision labor codes
=  AWBS level
=  Both labor codes and a WBS level

Only the labor codes assigned to billing groups for projects that are converted will themselves be
converted.

You also have the option to not convert FMS labor codes. In that case, the labor code information
is dropped from converted time records, project budgets, and billing rate schedules.

Related Migration Decisions

“Work Breakdown Structure Decisions: Labor Codes” on page 51

“Labor Code Structure Decision” on page 53

“FMS Codes to Vision Labor Codes Mapping Decisions” on page 82

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data

If you convert FMS labor codes as Vision labor codes, you can review the codes by clicking
Configuration » Accounting » Labor Codes on the Vision Applications menu.

To view the converted FMS labor codes in Vision if you convert them to a WBS level, click Info

Center » Projects on the Vision Applications menu, select a project, and then click IEI in the
upper left corner of the form to expand the sublevels of the project until the converted labor codes
are displayed.

Labor Code ID and Description

If you convert FMS labor codes to Vision labor codes, they are converted to Vision labor codes
and labels as you specify in the FMS Codes — Vision Labor Codes dialog box.

If you convert labor codes to a WBS level, the labor code ID becomes the identifier for the
corresponding WBS component in Vision. All labor codes are added as available WBS
components for each of the converted projects.

No other FMS labor code information is converted.

Labor Codes in Time Records, Budgets, and Billing Rate Schedules

For information on the conversion of FMS labor codes in time records and project budgets, see
the following:

= "Time Records Conversion” on page 221
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= "Project Budgets Conversion” on page 210

Labor rate exceptions for labor codes in billing rate schedules are not converted.

Expense Codes Conversion
Deltek FMS expense codes have three roles in the conversion:

= You map each expense code to Deltek Vision GL accounts, and that mapping information
is used to convert expense records.

= The expense codes are converted as units in Vision.

= The expense codes are converted as Vision expense codes.

Related Migration Decisions
“Expense Codes-to-Accounts Mapping Decisions” on page 78

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data

To view the units created from FMS expense codes, click Info Center » Units on the Vision
Applications menu, and open the ExpenseCodes unit table. All units for converted expense codes
are in that unit table.

To view the Vision expense codes and related settings, do the following from the Vision
Applications menu:

1. Click Configuration » Accounting » System AP, and go to the Accounts Payable tab
for general configuration settings and to the Expense Codes tab for the expense codes
themselves.

2. Click Info Center » Projects and go to the Accounting tab to see the project-specific Bill
by Default settings and assigned expense code override table.

3. Click Configuration » Accounting » Expense Code Override to see any expense code
override tables created by the conversion.
Converted Expense Transactions
For a description of how expense transactions are converted, see the following:
= “Business Management Project Expenses Conversion” on page 224.

= "Accounts Payable Invoices Conversion” on page 239

Expense Code ID and Description

The expense code ID becomes the unit number and the expense code description becomes the
unit name. They also become the Vision expense code and description.

Unit Cost, Unit Markup, and Multiplier

The expense code’s unit cost becomes the cost per unit in Vision units.

The unit cost, unit markup, and multiplier in FMS are used to calculate the billing rate for the unit:

Vision unit billing rate = (unit cost + unit markup) x multiplier
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Unit Description

The expense code’s unit description, if one is specified, becomes the Vision unit’s singular label
and plural label. If the expense code has no unit description, the expense code description is
used for both unit labels.

Default Cost Type

The expense code’s default cost type is not converted. However, if the unit’s billing rate
(described earlier) is greater than 0, the Vision account mapped to the default cost type’s income
account becomes the unit’s revenue posting account. (If the unit does not have a billing rate
greater than 0, the conversion does not assign a revenue posting account.)

While the conversion doesn’t use the default cost types when setting up Vision expense codes,
the cost type/expense code combinations actually entered in FMS expense transactions for a
billing group are used to determine how Bill by Default is set for the expense codes for the
corresponding Vision project.

GL Accounts

The account assignments listed on the GL Accounts tab of the Expense Codes dialog box in FMS
are not converted. However, the expense code mappings to Vision accounts are used to set the
unit’s regular account (the reimbursable expense account mapped to the expense code),
overhead account (the indirect expense account), and the credit account (the indirect expense
account). In the absence of explicit account mappings, the default account of the appropriate type
is used.

The account mappings, along with the value in Type, are also used to determine the
reimbursable, direct, overhead, and promotional accounts for the Vision expense codes.

Project Budgets Conversion

If you are using the standard budgeting feature in Deltek FMS Business Management, one of
your migration decisions is whether or not to convert the budgets. If you elect to convert budgets,
all budgets for the projects selected for conversion are converted to budgets in Deltek Vision.
Related Migration Decisions

“Business Management Budget Decision” on page 61

Reviewing the Converted Data

To view converted project budgets, click Accounting » Budgeting » Project Budgeting on the
Vision Applications menu and select the project.

How Budgets Are Assigned

For a description of how the conversion determines the WBS components, labor codes, vendors,
and expense accounts to which it assigns budget amounts, see “Business Management Budget
Decision” on page 61.

Labor Hours, Cost, and Billing Budget Amounts

Hours budgets in FMS are converted to the budgeted hours shown on the Project Budget
Worksheet form for both labor cost and labor billing in Vision.
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FMS labor cost budget amounts are converted to the budget amounts on the Labor Burden tab of
the Project Budget Worksheet form.

FMS labor billing budget amounts are converted to the budget amounts on the Labor Billing tab of
the Project Budget Worksheet form.

In addition, the hours, cost, and billing budgets are used to calculate the cost and billing rates
shown in the Rate columns on both the Labor Burden and Labor Billing tabs: Rate = Amount /
Hours. (If there is no hours budget, Rate is set to zero.)

Expense Units, Cost, and Billing Budget Amounts

FMS expense cost budget amounts are converted to the budget amounts on the Expense Costs
tab of the Project Budget Worksheet form.

FMS expense billing budget amounts are converted to the budget amounts on the Expense
Billing tab of the Project Budget Worksheet form.

Phase Schedules

If you've entered phase schedule information in the Budgets dialog box in FMS, the conversion
uses those dates to set start and end dates for budgeted items. If they are available, the
conversion assigns the expected start and finish dates for a phase to the budget records related
to that phase. If there is no expected start date or there is no expected finish date, the actual start
date or actual finish date is assigned.

Accounts Payable Control Information Conversion

Very little of the information from the Accounts Payable Control Information dialog box in Deltek
FMS is converted or is involved in the conversion process. No items other than those discussed
below are converted or used.

Reviewing the Converted Data

To view converted payment terms, click Configuration » Accounting » Company AP on the
Vision Applications menu.

To view the order days derived from the default payment terms, click Configuration »
Purchasing & Inventory » Company Settings on the Vision Applications menu.

To view default shipping expense accounts for purchasing, click Configuration » Purchasing &
Inventory » Company Settings on the Vision Applications menu and go to the Accounts tab.

Default Payment Terms

If the FMS default terms calculate a due date as some number of days after the invoice date, that
number of days is converted to Default Payment Terms in the Company AP Configuration form.

If the FMS default terms result in a due date that is a specified day of the month, the conversion
sets Default Payment Terms to Next (that is, pay during the next AP check run).

If you have the Purchase Order feature set in FMS, the default payment terms are also used to
set the default value in Order Days in the Company Purchasing Configuration form. If the FMS
default terms calculates a due date as some number of days after the invoice date, Order Days
is set to that number of days. If there are no terms or the terms have a day of the month as a due
date, Order Days is set to 30.
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Default Shipping Method

If you have the Purchase Order feature set in FMS, the default shipping method specified on the
Defaults tab of the Accounts Payable Control Information dialog box is used to determine the
default GL accounts for shipping expenses on the Accounts tab in the Company Purchasing
Configuration form in Vision.

If the shipping method is linked to an expense code in the Shipping Methods dialog box in FMS,
the Vision reimbursable expense account you mapped to the expense code is used as the
shipping reimbursable account, and the Vision direct expense account you mapped to the
expense code is used as the shipping direct account. If the shipping method is not linked to an
expense code, the conversion does not set these account numbers.

The Vision account you mapped to the default non-project debit account for the shipping method
is used as the shipping indirect account.

Accounts Payable Liability Accounts

If Always Use Primary GL Accounts Assigned to Vendor is not selected on the Control tab,
the Vision account mapped to the Accounts Payable — Vendor account on the GL Accounts tab is
assigned to the Trade liability code on the Liability Codes tab of the Company AP Configuration
form in Vision. The Vision account mapped to the Accounts Payable — Subcontractor account in
FMS is assigned to the Consultant liability code on the Liability Codes tab.

If Always Use Primary GL Accounts Assigned to Vendor is selected, the accounts assigned
to the Trade and Consultant liability codes are determined based on Vendor GL account
assignments.

Item Codes Conversion

If you have the Purchase Order feature set in Deltek FMS, item codes that have been used in
purchase orders that will be converted are converted to purchasing items in Deltek Vision.
Shipping methods, tax methods, and miscellaneous adjustments used in purchase orders are
also converted to purchasing items.

In addition, the conversion creates item categories in Vision for each of the item codes, shipping
methods, tax methods, and miscellaneous adjustments used in FMS purchase orders.

If you do not have the Purchase Order feature set, no FMS item codes, shipping methods, tax
methods, and miscellaneous adjustments are converted.

“.]  Shipping methods, tax methods, and miscellaneous adjustments used in purchase orders are
also converted to purchasing items. To simplify the following description, the term “item code”
refers to shipping methods, tax methods, and miscellaneous adjustments as well as to item
codes.

Related Migration Decisions

“Accounts Payable Transactions, Employee Expenses, and Purchase Orders to Convert
Decisions” on page 23

Reviewing the Converted Data

To view the purchasing items in Vision, click Configuration » Purchasing & Inventory » ltems
Master on the Vision Applications menu.
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To view the item categories at the system level in Vision, click Configuration » Purchasing &
Inventory » System Settings on the Vision Applications menu.

To view the company-level item category information in Vision, click Configuration »
Purchasing & Inventory » Company Settings on the Vision Applications menu and go to the
Item Categories tab.

Item Code and Description

For item categories, FMS item codes and descriptions are converted to the category identifier and
description.

For purchasing items, they are converted to the item identifier and description.

GL Accounts

The GL accounts associated with company-level item categories and with purchasing items are
determined as follows:

= If the FMS item code is linked to an expense code, the Vision reimbursable and direct
expense accounts to which that expense code is mapped in the FMS Expense Codes —
Vision Accounts Mapping dialog box are assigned as the reimbursable and direct
expense accounts for the item category created from that FMS item code. If the item
code is not linked to an expense code, the default reimbursable and direct expense
accounts from the FMS Expense Codes — Vision Accounts Mapping dialog box are used.

= |f the Vision account mapped to the FMS item code’s non-project debit account is in the
range for indirect expense accounts, it is assigned as the indirect expense account for
the item category. If that Vision account does not fall into the range for indirect expense
accounts, the default indirect expense account from the FMS Expense Codes — Vision
Accounts Mapping dialog box is used.

= |f the account type of the Vision account mapped to the FMS item code’s non-project
debit account is Asset, Liability, or Net Worth, it is assigned as the balance sheet account
for the item category. If that Vision account does not have one of these account types,
the conversion does not assign a balance sheet account.

Unit Description

The item code unit description is converted to the unit of measure for the corresponding
purchasing unit in Vision.

Item code unit descriptions are also added to the system-level list of units of measure on the U/M
tab of the Purchasing & Inventory System Settings form.

Notes

Any notes entered for an FMS item code are converted to the Internal Notes box on the Items
Master form in Vision.

Iltem Category Type

If the FMS item code is linked to an expense code and that expense code’s default cost type has
the Subcontractor check box selected, the type for the item category created from the item code
is set to Services. In all other cases, the item category type is set to Materials & Supplies.
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Purchasing Item Vendor Information

On the Vendors tab of the Purchasing Items form, the conversion fills in the vendor purchasing
data for each converted item code. This data includes the last unit cost paid for the item and the
date of that PO, the total quantity purchased from the vendor, and the total amount of those
purchases.

Only vendors that are converted are included, and the quantity and dollar amount of purchases
reflect only the POs actually converted to Vision.

Vendors Conversion

Deltek FMS firms designated as vendors are converted to vendors in Deltek Vision.

Related Migration Decisions

“Inactive Vendors Decision” on page 20

“Vendor Hold Status Decision” on page 21

“Vendor Discount Information Decision” on page 22

“Country in Addresses Decision” on page 19

Reviewing the Converted Data

To view the vendor information in Vision, click Info Center » Vendors on the Vision Applications
menu.

Firm-Vendor ID

In most cases, the firm ID is converted as the vendor number. However, if the ID in Firm-Vendor
ID in the Firms dialog box is different than the firm ID, it is used as the Vision vendor number
instead of the firm ID.

Addresses, Email, Phone...

Most of the information on the Communication tab of the Firms dialog box in FMS is converted
either to equivalent data items in Vision or to custom fields on the FMS tab.

Whether or not the country portion of firm addresses is converted depends on which option you
selected under Country in Address on the General tab of the Vision Conversion Setup dialog
box.

If the firm’s address is not in the United States, the entry in Province/State is FMS is shortened
to 10 characters, if necessary, and added to the state code table in Vision.

Client ID
If a vendor firm is also a client, the conversion does the following:

= Creates both a client and a vendor in Vision

= Selects the Vendor check box on the General tab of the Clients Info Center and enters
the vendor to which the client is linked

= Enters the client in Linked Client on the General tab of the Vendors Info Center.
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Contacts

Both current and past contacts for an FMS client firm are converted to Vision contacts and
assigned to the vendor. Past contacts have the Inactive status in Vision. (For more on how FMS
contacts are converted, see “Contacts Conversion” on page 179).

Because contacts can’t be designated as the primary, billing/shipping, or shipping contact for
vendors in Vision, that information is preserved in custom fields on the FMS tab.

Classification Labels

Firm and vendor classification labels are converted as custom fields and appear on a
Classification tab.

Vendor Information: Main Subtab

If the payment address for the vendor is Work or Alternate Work, a corresponding address is
created in Vision labeled “Payment Address.”

Payment terms are converted as described in “Payment Terms Conversion” on page 178.

Type (vendor type) in Vision is set based on the Subcontractor check box in FMS. If
Subcontractor is selected, Type is set to the Consultant vendor type that is linked to the
vendor’s AP liability account. If Subcontractor isn’t selected, Type is set to the Trade vendor
type linked to the vendor’s AP liability account.

Reference in FMS is converted to Account Number in Vision.

For vendors with the Hold or Pay When Paid status, the status value may be used to set their
payment terms in Vision. For details, see “Payment Terms Conversion” on page 178. Otherwise,
Status is not converted.

The vendor’s organization in Vision is the organization mapped to the FMS department in
Department under Assign Indirect Expenses To.

Other data on the Main subtab are either converted as custom fields on the FMS tab or not
converted.

Vendor Information: Form 1099 Subtab

If Requires Form 1099 is selected in FMS, the 1099 Required check box on the Accounting tab
in the Vendor Info Center is selected. The entry in Tax ID in FMS goes to Federal ID on the
Accounting tab.

The only 1099 amount that is converted to Vision is the amount for Box 7 for Form 1099 — MISC.
The current year’s amount goes to Paid This Year on the Accounting tab, and the previous
year's amount goes to Paid Last Year. (The current and past years are determined by the
current computer date for the computer running the conversion.)

Vendor Information: GL Accounts Subtab

The vendor GL account assignments are not converted to Vision. However, in some cases, the
AP liability accounts assigned to vendors are used to set up liability codes in Vision, assign GL
accounts to those codes, and link the liability codes to vendor types.

If Always Use Primary GL Accounts Assigned to Vendor is selected on the Control tab in the
Accounts Payable Control Information dialog box, the conversion assigns the first vendor’s
Accounts Payable — Vendor liability account to the Trade liability code on the Liability Codes tab
of the Company AP Configuration form in Vision. It also assigns the Vision account mapped to
that vendor’s Accounts Payable — Subcontractor account to the Consultant liability code.

Migration Guide 215



Deltek Kwovmore

Appendix A: How Info Center Information Is Converted

If some vendors have these two types of accounts mapped to different Vision accounts, the
conversion creates an additional liability code for each unique Vision account number. It also
creates a corresponding vendor type for each one and links the liability code to the vendor type.

The Vision account mapped to the Accounts Payable — Vendor account on the GL Accounts tab
is assigned to the Trade liability code on the Liability Codes tab of the Company AP Configuration
form in Vision. The Vision account mapped to the Accounts Payable — Subcontractor account in
FMS is assigned to the Consultant liability code on the Liability Codes tab.

If Always Use Primary GL Accounts Assigned to Vendor is not selected, the accounts
assigned to the Trade and Consultant liability codes are the Vision accounts mapped to the two
AP liability accounts specified in the Accounts Payable Control Information dialog box.

Vendor Information: Item Code Assignments Subtab

If the vendor has any item code assignments with Default selected, the conversion uses the first
such assignment row to set Regular Account and OH Account for the vendor in Vision.

= If you are not using departments in Business Management or if you are using
departments but the vendor has no department specified for indirect expenses, the Vision
account mapped to the debit account for the row goes to OH Account.

= If you are using departments and the vendor is associated with a department, the Vision
account mapped to the FMS account for the item code for that department goes to OH
Account.

= The Vision direct expense account mapped to the expense code for the assignment row
goes to Regular Account.

No other item code assignment information is converted or used in the conversion process.

Vendor Information: Payment Direct Deposit Subtab

Vision only allows one bank account for vendor direct deposit payment, so only the first bank
account in the grid in FMS is converted. Routing Number goes to Bank ID, and the account
number and account type go to corresponding Vision fields. The bank name is converted to a
custom field on the FMS tab.

Inactive Vendors

An inactive vendor firm in FMS is converted to a dormant vendor in Vision.

Employees Converted to Vendors

If you have employees you've set up for employee expense entry in FMS, the conversion not only
converts those employees to Vision employees, but it also creates a Vision vendor for each them.
This occurs whether or not any of an employee’s employee expense sheets or AP invoices are
actually converted. Because there is no firm information in FMS for these employees, the
conversion sets up the vendor data using employee information only. The employee ID, name,
and addresses are converted to vendor number, vendor name, and vendor addresses.

We recommend that you review each of these vendor records carefully in Vision after the
conversion to make sure, first of all, that you need the vendor record at all and, if you do need it,
that the vendor is set up the way you want.

General Ledger Control Information Conversion

The only information from the General Ledger Control Information dialog box that is involved in
the conversion is the retained earnings account. No other data is converted.
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Related Migration Decisions

“Vision System Accounts Decisions” on page 111

Reviewing the Converted Data

To view the Deltek Vision prior year retained earnings account, click Configuration »
Accounting » Company Settings on the Vision Applications menu, and go to the Accounts tab.
Retained Earnings Account

When you open the Additional Vision Setup dialog box in the Vision Conversion module, the
Vision account you mapped to your Deltek FMS retained earnings main account is entered by
default in Prior Year Retained Earnings. Unless you specify a different account, the conversion
then assigns that account as the prior year retained earnings account on the Accounts tab of the
Accounting Company Settings form.

Chart of Accounts Conversion

General ledger accounts in Deltek FMS are converted to GL accounts in Deltek Vision based on
the conversion setup information you enter on the Accounts tab of the Vision Conversion Setup
dialog box and in the FMS Accounts — Vision Accounts Mapping dialog box.

Related Migration Decisions

GL Account Number Structure Decision on page 29

GL Expense Account Ranges Decisions on page 30

FMS Accounts-to-Vision Accounts Mapping Decisions on page 72

Migration Briefing: Chart of Accounts Conversion on page 25

Reviewing the Converted Data

To view the converted accounts in Vision, click Info Center » Accounts » Chart of Accounts on
the Vision Applications menu.

Account Number Structure

You define the structure of your Vision account numbers before the conversion using the Account
Structure subtab of the Accounts tab in the Vision Conversion Setup dialog box.

Basically, only FMS main accounts are converted to Vision. If you have a multiple-division
account number structure in FMS, you normally map all accounts with the same main account to
one Vision account. In Vision, you use organizations to replace the financial reporting function of
the other account divisions in FMS.

Account Number and Description

The FMS main account numbers and descriptions provide the default Vision account numbers
and account names, but you can change those in the FMS Accounts — Vision Accounts Mapping
dialog box when you map accounts.

Account Type

The FMS account types are not converted directly, but for many accounts, the Vision account
type will match the FMS account type.
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= For asset, liability, equity, and revenue accounts, the FMS account type is the default
account type for the Vision account to which each account is mapped. However, you
have the option in the FMS Accounts — Vision Accounts Mapping dialog box to change
the Vision account type to Other.

= For expense accounts, the default account types for Vision accounts are determined by
the account ranges you specify on the Account Ranges subtab of the Accounts tab in the
Vision Conversion Setup dialog box. In the FMS Accounts — Vision Accounts Mapping
dialog box, you can change the Vision account type to any other expense account type or
to the Other account type.

Posting Type

The posting type (Detail, Summary, or Consolidation) is not converted. Because Vision does not
have summary or consolidation accounts, only detail accounts are converted.

Posting Status

Open accounts are assigned the Active status in Vision, and closed accounts the Dormant status.
If multiple FMS accounts are mapped to a single Vision account and at least one of the FMS
accounts is open to posting, the Vision account is given the Active status.

Allocation Method

Allocation methods aren’t converted.

Notes

Any notes you've entered for an account in FMS are converted to a custom field on the FMS tab
in the Chart of Accounts Info Center in Vision.

Accounting Periods and Account Balances Conversion

The conversion creates fiscal periods in Deltek Vision based on the account periods set up in
Deltek FMS and on the conversion settings you specify on the Accounting Periods subtab on the
Accounts tab of the Vision Conversion Setup dialog box. Periods are only created in Vision for the
FMS fiscal year you specified in General Ledger Beginning Year and for later years through the
accounting period you selected in Convert Periods Through.

Related Migration Decisions

“Accounting Periods Decisions” on page 33

Reviewing the Converted Data

To view the converted accounting periods in Vision, click Utilities » Period Setup on the Vision
Applications menu.

Fiscal Year

The conversion links FMS fiscal years to Vision fiscal years based on your entry in Vision Fiscal
Year for FMS Fiscal Year on the Accounting Periods subtab on the Accounts tab of the Vision
Conversion Setup dialog box. The fiscal year specified in the Accounting Periods dialog box in
FMS is not itself converted to Vision.
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Period Start and End Dates

Each FMS period start date for the fiscal years to be converted becomes the start date of the
corresponding Vision period, and each FMS end date becomes an end date in Vision.

The start date of the first period of each FMS fiscal year is also converted to the fiscal year start
date in Vision, and the end date of the last period of each fiscal year is converted to the fiscal
year end date in Vision.

Number of Periods Per Year

The conversion sets the value in Periods Per Year in the Period Setup form in Vision based on
the number of periods in the FMS fiscal year in which the current Vision period falls. (The current
Vision period is the period you selected in Convert Periods Through on the Accounting Periods
subtab of the Accounts tab in the Vision Conversion Setup dialog box.)

Source Journal Closure Information

The source journal closure information on the Source Journals tab of the Accounting Periods
dialog box is not converted.

General Ledger Account Budgets Conversion

If, on the GL Budgets tab of the Vision Conversion Setup dialog box, you elected to convert one
or more Deltek FMS GL budget versions, the conversion program creates account budgets in
Deltek Vision based on the FMS account budgets.

Related Migration Decisions

“General Ledger Budget Decisions” on page 58

Reviewing the Converted Data

To view the converted budgets in Vision, click Accounting » Budgeting » General Ledger on
the Vision Applications menu.

If You Convert Departments to Organizations

If you are not converting departments to Vision organizations, the conversion creates one budget
in Vision for each budget version in FMS.

If you are converting departments to organizations, this will also be the case if all of the accounts
in the FMS budget version are mapped to the same organization (in other words, if the FMS
budget version was a departmental budget). However, if the FMS budget version contains
budgets for accounts that are mapped to different organizations, the conversion creates one
Vision budget for each combination of budget version and organization. Each FMS account
budget is then assigned to the budget for its organization. This is necessary because Vision
budgets are specific to one organization (if you are using organizations).

Budget Version

If multiple organizations aren't involved, the entry in Budget Version in FMS is converted to
Budget Name in Vision.

If the conversion must create multiple budgets in order to assign account budgets to the correct
organizations, as discussed earlier, the Vision budget name is a combination of the FMS budget
version and as much of the organization code as possible.
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Budget Period Range

The budget period range in Vision is set based on the periods for which budgets exist in the FMS
budget version.

Accounts and Amounts

If organizations are not involved or all of the accounts in the budget version are mapped to the
same organization, the conversion creates a set of period budget amounts in Vision for each
Vision account to which FMS accounts in the budget version are mapped. The budget amount for
a period is the sum of that period’s budget amounts for all of the FMS accounts mapped to that
Vision account.

If organizations are involved, the FMS budget amounts are combined to get Vision budget
amounts only if they are mapped to the same Vision account and to the same organization.

Accounts with zero-dollar budget amounts for all periods aren’t included in the Vision budget.

Migration Guide 220



y
Delte Know more.
Do more™

Appendix B: How Transactions Are Converted

Appendix B: How Transactions Are Converted

Time Records Conversion

Time records in Deltek FMS are converted to posted time records in Deltek Vision.

FMS information related to time sheets rather than to individual time records is not converted. No
data is converted into the optional Vision Time and Expense application.

Related Migration Decisions

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Work Breakdown Structure Decisions: Labor Codes” on page 49

“Work Breakdown Structure Decisions: Staff Types” on page 51

“Labor Code Structure Decision” on page 53

“FMS Codes to Vision Labor Codes Mapping Decisions” on page 82

“Staff Type-to-Vision Labor Category Mapping Decisions” on page 83

“Cost Amount for Time Records Decision” on page 65

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data
To view the converted time records in Vision, do any of the following:

= Click Accounting » Project Review on the Vision Applications menu, and select the
projects for which you want to view labor information.

= Click Reporting » Project on the Vision Applications menu, and print the Labor Detail
report.

= Click Reporting » Employee on the Vision Applications menu, and print the Employee
Labor Detail report.

You can also review information related to the converted records in the following:

Reports | Forms and Applications

Project Detall Billing application (unbilled time only)
Labor Summary Payroll application (unpaid time only)
Office Earnings

Project Progress

Project Summary

Project Earnings

Time Analysis

Unbilled Detail and Aging
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Which Records Are Converted

Which time records are converted depends on the projects selected for conversion and the cutoff
accounting period:

= The only time records converted are those entered for the projects you've selected for
conversion. Time records for other projects are not converted.

=  Only time records dated in or before the accounting period selected in Convert Periods
Through on the Accounting Periods subtab on the Accounts tab in the Vision Conversion
Setup dialog box are converted.

Time Submission and Approval
Time sheet and time record submission and approval information is not converted.

You can turn on these features in Vision following the conversion. Be aware, however, that
submission and approval in Vision occurs before time sheets are posted, and all FMS time
records are posted when converted. If you have time sheets in FMS that you want to go through
the submission and approval process, you should do that before converting them to Vision. You
won't be able to do it in Vision after the conversion.

Project and Billing Group

Projects and billing groups in FMS time records are converted to the appropriate WBS
components in the Vision time records, based on the work breakdown structure decisions you
made on the WBS tab of the Vision Conversion Setup dialog box.

If you selected Update Project Team When Posting Labor or Vouchers on the FMS
Miscellaneous BM tab of the Vision Conversion Setup dialog box, the conversion also adds any
employees for whom time records were entered for a project or billing group to the list of
employees on the Team tab in the Project Info Center for the appropriate WBS levels.

Phase

If you elected to convert phases, the phases in FMS time records become either a WBS
component or part of the labor code in the Vision time records, depending on the work breakdown
structure decisions you made on the WBS tab and Labor Codes tab of the Vision Conversion
Setup dialog box.

Department

If you are using departments in Business Management and you elected to convert departments,
the departments in FMS time records are converted based on the conversion decisions you made
on the WBS tab of the Vision Conversion Setup dialog box:

If departments are

converted as...

A WBS level The time record department becomes a WBS component at that level

Organizations An organization is assigned to the time record based on the mapping of
FMS GL accounts to organizations in the FMS Accounts — Vision
Accounts Mapping dialog box

Vision labor codes The time record department becomes a part of the Vision labor code in
the time record
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Cost Type

Cost types are not converted to Vision.

Labor Codes

If you are converting FMS labor codes, the labor codes in FMS time records are converted based
on the conversion decisions you made on the WBS tab and Labor Codes tab of the Vision
Conversion Setup dialog box:

If FMS labor codes

are converted as...

A WBS level The time record labor code becomes a WBS component at that level

Vision labor codes The time record labor code becomes a part of the Vision labor code in
the time record

Staff Types

The staff types in FMS time records are converted based on the conversion decisions you made
on the Labor Codes tab of the Vision Conversion Setup dialog box:

If staff types are Then the time record staff type becomes...

converted as...

Labor categories The labor category assigned to the Vision time record

Vision labor codes A part of the Vision labor code in the time record

Date

Time record dates are converted to time record dates in Vision.

Regular, Overtime, and Bill Hours

Regular and overtime hours are converted to regular and overtime hours in Vision. In Vision,
changes to bill hours are made by entering a billing adjustment in Vision Billing. When the bill
hours for an FMS time record do not match the regular and overtime hours, the conversion
creates the necessary adjustment in Vision Billing.

Billing Status

Your entry in Bill? For a time record is converted to Vision as follows:

This billing status in FMS... Is converted to this Vision status...
Fee Bill

Yes Bill

Hold Hold

Writeoff Writeoff
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This billing status in FMS... Is converted to this Vision status...

No Bill (In addition, billing is suppressed, and the billing
amount is set to 0.00.)

Time records that were billed in FMS are marked as such in Vision.

Comments

Comments entered for FMS time records are converted to Vision time record comments.

Cost Rate

The cost rates for converted time records in Vision are either the FMS time record hourly cost
rates (original cost) or effective cost rates, depending on the option you chose under Time
Records Cost Amounts on the FMS Miscellaneous BM tab in the Vision Conversion Setup
dialog box.

Overtime Multiplier
Overtime multipliers in Vision are percentages, so FMS multipliers are converted to percentages.
For example, an overtime multiplier of 1.5000 is converted to 150 in Vision.

GL Transactions

The GL transactions associated with time records in FMS are converted to Vision as summarized
transactions. For all time records dated in an accounting period, the conversion creates one set of
GL entries that summarize amounts by Vision account and organization (if you are using
organizations in Vision). In other words, for a given period, there will be a single entry for each
combination of Vision GL account and organization that is linked to time records for that period.

For time records dated prior to the first day of the fiscal year you specified in General Ledger
Beginning Year, the time records may be converted, depending on your conversion options, but
no GL transactions are created for them in Vision. Instead, their effect on the general ledger will
be reflected in the initial account balances that the conversion establishes in Vision.

The organizations for which Vision transactions are created are based on your mappings of FMS
GL accounts to Vision organizations in the FMS Accounts — Vision Accounts Mapping dialog box.

Business Management Project Expenses Conversion

Expense records entered in Business Management are converted to unit transactions in Deltek
Vision.

Related Migration Decisions

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39

“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Expense Codes-to-Accounts Mapping Decisions” on page 78

“Migration Briefing: Work Breakdown Structure Conversion” on page 35
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Reviewing the Converted Data

To view the converted unit transactions created from expense sheets entered in Business
Management, do any of the following:

= Click Accounting » Project Review on the Vision Applications menu, and select the
projects for which you want to view labor information.

= Click Reporting » Project on the Vision Applications menu, and print the Expense
Summary or Expense Detail report.

You can also review information related to the converted records in the following:

Reports Forms and Applications

Project Detall Billing application (unbilled expenses only)
Office Earnings
Project Progress
Project Summary
Project Earnings

Consultant Ledger

Which Records Are Converted

Which expense records are converted depends on the projects selected for conversion and the
cutoff accounting period:

= The only expense records converted are those entered for the projects you've selected
for conversion. Expense records for other projects are not converted.

=  Only expense records from expense sheets dated in or before the accounting period
selected in Convert Periods Through on the Accounting Periods subtab on the
Accounts tab in the Vision Conversion Setup dialog box are converted.
Expense Sheet Information
The only information from the header area of the Project Expenses dialog box in Deltek FMS that
is converted is the transaction date.
Expense Code
FMS expense codes are converted to units in Vision. The conversion replaces the expense code
in an expense record with the corresponding unit when it creates the unit transaction.
Project and Billing Group

Projects and billing groups in FMS time records are converted to the appropriate WBS
components in the Vision unit transactions, based on the work breakdown structure decisions you
made on the WBS tab of the Vision Conversion Setup dialog box.

Phase

If you elected to convert phases as a WBS level, the phases in FMS expense records become a
WBS component.
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If you decided to convert phases as part of labor codes or to not convert phases at all, the unit
transactions do not reference a phase.

Department

If you are using departments in Business Management and you elected to convert departments,
the departments in expense records are converted based on the conversion decisions you made
on the WBS tab of the Vision Conversion Setup dialog box:

If departments are

converted as...

A WBS level The expense record department becomes a WBS component at
that level
Organizations An organization is assigned to the unit transaction record based on

the mapping of FMS GL accounts to organizations in the FMS
Accounts — Vision Accounts Mapping dialog box

Vision labor codes only | The unit transactions won't reference a department.

Cost Type

Cost types are not converted to Vision.

Units

The units for the expense record becomes the quantity for the unit transaction.

Unit Cost

The FMS unit cost is converted to the unit cost rate in Vision.

Billing Status

Your entry in Bill? For an expense record is converted to Vision as follows:

This billing Is converted to this Vision status...
status in FMS...
Fee Bill
Yes Bill
Hold Hold
Writeoff Write-off
No Bill
In addition, billing is suppressed, and the billing amount is set to 0.00.

Expense records that were billed in FMS are marked as such in Vision.
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Bill Units, Markup, and Multiplier

In Vision, changes to the number of units to be billed are made by entering a billing adjustment in
Vision Billing. When the bill units for an FMS expense record do not match the units for the Vision
unit transaction, the conversion creates the necessary adjustment in Vision Billing.

The markup and multiplier for an expense in FMS are not converted. However, they are used to
calculate the billing rate for the unit transaction: (FMS Unit Cost + FMS Unit Markup) x FMS
Multiplier.

Unit Description

The unit description for an expense record becomes the description for the unit transaction in
Vision.

Comments

Comments entered for FMS expense records are not converted.

GL Transactions

The GL transactions associated with an expense record entered in Business Management are
converted using the Vision accounts that you mapped to the FMS accounts affected by the FMS
expense record.

For an expense record with an effective date prior to the first day of the fiscal year you specified
in General Ledger Beginning Year, the expense record may be converted, depending on your
conversion options, but no GL transaction is created for it in Vision. Instead, its effect on the
general ledger will be reflected in the initial account balances that the conversion establishes in
Vision.

o) For project cost purposes, a different Vision account may be used than that affecting the
general ledger, depending on the project cost adjustment option you selected in the FMS
Expense Codes — Vision Accounts Mapping dialog box. For more on this, see “Expense
Codes-to-Accounts Mapping Decisions” on page 78.

Accounts Receivable Invoices Conversion

AR invoices in Deltek FMS are converted to invoices in Deltek Vision.

Related Migration Decisions

There are no related migration decisions.

Reviewing the Converted Data
To view the converted invoices in Vision, do any of the following:
= Click Accounting » Accounts Receivable » Invoice Review on the Vision Applications
menu, and click View Detail above the grid to drill down to the detail.

= Click Accounting » Project Review on the Vision Applications menu, and select the
projects for which you want to view AR information.

= Click Reporting » Accounts Receivable on the Vision Applications menu, and print the
Accounts Receivable Ledger report.
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You can also review information related to the converted records in the following:
= Invoice Register report
= Aged Accounts Receivable report

= Office Earnings report

Which Records Are Converted
Which AR invoices are converted depends on the conversion options you selected:
= AR invoices for a project are only converted if you selected that project for conversion.

= No AR invoices are converted that have an effective date after the ending date of the
accounting period you select in Convert Periods Through on the Accounting Periods
subtab in the Accounts tab of the Vision Conversion Setup dialog box.

In addition, cancelled AR transactions aren’t converted if the invoice and effective dates of the
original transaction are the same as the corresponding dates for the cancellation transaction. If
the cancellation transaction has different dates, both the original and cancellation transaction are
converted.

Transaction Number

The FMS transaction number is not converted.

Transaction Type
The transaction type isn’'t converted, but the conversion uses it to set other data:

= |f the FMS AR transaction is a debit memo, it is created as an invoice transaction in
Vision, but "D” is added at the end of the invoice number to identify it as a debit memo.

= An FMS retainage invoice is also converted to an invoice transaction but with a subtype
of "R” to identify it as retainage.

Client

The client isn’t converted. In Vision, the invoice is linked to the client through the project.

Work Breakdown Structure

The conversion sets the WBS components for the Vision invoice based on the work breakdown
structure conversion options you selected in the Vision Conversion Setup dialog box.

If projects and billing groups are converted as combined WBS1 components and you are only
using WBS1 for your converted projects, one Vision invoice transaction is created for each FMS
AR transaction.

If projects are converted at the WBS1 level and billing groups as the WBS2 level and you are only
using those two levels for your converted projects, one Vision invoice transaction is created but
with multiple WBS2 components.

If your work breakdown structure includes a WBS level in addition to those taken up by project
and billing group (a phase level, for example), the conversion creates a Vision invoice transaction
for each phase affected by the FMS transaction. Thus, if the invoice in FMS is for a phased billing
type and includes distributions to four phases, the conversion creates four invoice transactions,
one for each project/billing group/phase combination, all with the same invoice number. On the
other hand, if you have a WBS level for phase but the FMS invoice isn’t for a phased billing type,
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the conversion assigns a generic phase code (ZZZ) to the phase level for the Vision invoice. The
same basic approach is used if you convert departments or labor codes to a WBS level.

Conversely, if the FMS transaction is broken down by phase but you did not convert phases to a
WBS level, the phase-level breakdown is lost when the transaction is converted.

Invoice Number

The FMS invoice number is converted unchanged except for the addition of leading zeros.

Invoice Date and Effective Date
The FMS invoice date becomes the Vision invoice date and transaction date.

The conversion uses the FMS effective date to assign the Vision invoice to the correct accounting
period.

Invoice Amount

The invoice amount itself is not converted to Vision, but the individual distributions in the grid that
make up that amount are converted to the corresponding invoice section distribution amounts.

Retainage Amount

The retainage amount, if any, is not converted.

Assign To

For most line items for the Vision invoice, the value in Assign To and related columns in the grid
in the AR Invoices dialog box in FMS determine the invoice section.

If Assign To is... Then Invoice Section is...
Billing Summary Type Fee
Billing Group Add-on, Tax, or Interest, depending on

whether the distribution row contains a non-tax
fee method, tax fee method, or finance charge
method

Cost Type and the distribution row also Add-on, Tax, or Interest
contains a non-tax fee method, tax fee
method, or finance charge method

Cost Type and the cost type is a labor cost | Labor
type

Cost Type and the cost type is an expense | Consultant
cost type with Subcontractor selected

Cost Type and the cost type is an expense | Expense
cost type with Subcontractor not selected

Cost Type

Cost types are not converted, but the conversion uses them to determine other conversion data.
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Phase

For a description of how the phase for a distribution is converted, see “Work Breakdown
Structure” earlier in this topic.

Department

If you convert departments to organizations in Vision, the organization mapped to the FMS
account in the FMS Accounts — Vision Accounts Mapping dialog box is assigned to each GL entry
in Vision. Because of this mapping, if an AR transaction in FMS has distributions to specific
departments, the GL entries for the invoice transaction in Vision should preserve the
departmentalization of income for financial reporting.

Fee Method

If a distribution in FMS references a non-tax fee method, it is converted as an Add-on distribution
in Vision.

If a distribution in FMS references a tax fee method, it is converted as a Tax distribution in Vision
for the equivalent Vision tax code.

Finance Charge

If a distribution in FMS references a finance charge method, it is converted as an Interest
distribution in Vision.

Line Item Amount

Each FMS distribution amount is assigned to the corresponding distribution in the Vision invoice
transaction.

Payment Terms

Payment terms are not converted.

GL Transactions

GL entries are created in Vision for each invoice section distribution. The Vision accounts are
those mapped to the FMS accounts in the FMS AR transaction.

Notes

Any notes entered for the AR transaction in FMS are converted to the Description 1 field in
Vision.

Project Receipts Conversion

Project receipts in Deltek FMS are converted to cash receipts in Deltek Vision. A cash receipt line
item is created in Vision for each line item to which the receipt is applied on the Invoices tab of
the Project Receipts and Credits dialog box in FMS.

Credit memos, discounts, write-offs, uncollectibles, and refunds are also converted.

Related Migration Decisions

"Cash Receipt Allocation Decisions” on page 108
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Reviewing the Converted Data
To view the converted receipts in Vision, do any of the following:
= Click Accounting » Accounts Receivable » Invoice Review on the Vision Applications
menu, and click View Detail above the grid to drill down to the detail.

= Click Accounting » Project Review on the Vision Applications menu, and select the
projects for which you want to view AR receipt information.

= Click Reporting » Accounting on the Vision Applications menu, and print the Cash
Receipts report or the Cash Journal report.

You can also review information related to the converted records in the following reports:
= Accounts Receivable Ledger
= Aged Accounts Receivable report

= Office Earnings report

Which Records Are Converted
Which project receipts are converted depends on the conversion options you selected:

= Receipts for a project are only converted if you selected that project for conversion. If a
receipt is applied both to a converted project and to one not converted, only the portion of
the receipt applied to the converted project would be converted.

= No receipts are converted that have an effective date after the ending date of the
accounting period you select in Convert Periods Through on the Accounting Periods
subtab in the Accounts tab of the Vision Conversion Setup dialog box.
Receipt Number

The receipt number is not converted.

Receipt Type

The receipt type isn’t converted, but the conversion does use it to determine how to convert the
transaction.

Checkbook

The checkbook for the receipt becomes the bank code to which that checkbook was converted.

Deposit Number

The FMS deposit number becomes the reference number for the receipt in Vision.

Receipt Date

The FMS receipt date becomes the cash receipt date in Vision. The conversion also uses it to link
the receipt to the correct accounting period.

Client

The client isn’t converted. In Vision, the cash receipt is linked to the client through the project.
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Reference

The reference text in FMS is converted to the Description 1 field in Vision.

Payment Type

The payment type in FMS is converted to the Description 2 field in Vision, along with the check
number.

Check Number

The check number in FMS is converted to the Description 2 field in Vision, along with the
payment type.

Receipt Amount

The receipt amount itself is not converted, only the individual amounts applied to invoices.

Work Breakdown Structure

The conversion sets the WBS components for the Vision cash receipt based on the FMS project
and billing group for the invoice to which you applied the receipt and on the work breakdown
structure conversion options you selected in the Vision Conversion Setup dialog box.

One exception to this is an unapplied retainer. If a receipt is a retainer with an amount that is not
yet applied to an invoice, the WBS components are assigned to the cash receipt for the unapplied
amount based on the project and billing group specified on the Retainer tab of the Project
Receipts and Credits dialog box in FMS.

Invoice Number

Each FMS invoice number to which the project receipt is applied becomes an invoice number in
Vision to which the cash receipt is applied. (In the case of a debit memo, a “D” is added to the
end of the FMS invoice number.)

The other invoice information shown in the FMS grid (type, date,...) is not converted.

Amount Applied

The amount paid for each line item in the Project Receipts and Credits dialog box in FMS is the
amount for the corresponding cash receipt line item in Vision.

GL Transactions

GL entries are created in Vision using the Vision accounts you mapped to the FMS accounts for
the FMS receipt.

Organization

If you convert departments to organizations in Vision, the organization mapped to the FMS
account in the FMS Accounts — Vision Accounts Mapping dialog box is assigned to each GL entry
in Vision.

Payment Detail

Because Vision does not break down receipt information to that level of detail, no information
from the Payment Detail tab of the Project Receipts and Credits dialog box is converted.
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However, if you set up the conversion to allocate cash receipts by billing category for the
Accounts Receivable Ledger report, the conversion creates adjusting entries to distribute
payments to the AR accounts you associated with the billing categories in the Additional Vision
Setup dialog box. (These adjusting entries do not affect GL balances, only reporting.)

Credit Memos

Because Vision doesn’t have credit memo processing, credit memos entered in FMS are
converted as negative AR invoices. The conversion also creates receipt records for both the
amount applied to the original invoice and the amount needed to “pay” the negative invoice.

The negative invoices created from credit memos appear on Vision reports, such as the Accounts
Receivable Ledger report, that show individual invoice information. The invoice number is that of
the invoice to which the FMS credit memo was applied, followed by “CM.”

Discounts, Uncollectibles, and Write-offs of Overpayments

When discounts, uncollectibles, or write-offs of overpayments are involved, the conversion
creates a cash receipt line item for the full amount of the invoice, and then it creates another line
item for the discount, write-off, or uncollectible, which results in a debit entry to the Vision account
mapped to the FMS account used to track that discount taken, uncollectible, or write-off. If that
account is an indirect account, the transaction is applied to the miscellaneous overhead project
(ZzZ) in Vision. If it is a revenue account, reimbursable expense account, or direct expense
account, it is applied to the miscellaneous regular project (Z99).

Refunds

For a refund to a client, the conversion creates a cash receipt line item for the overpayment
amount and applies it to a current project for the client. It then creates a second line item for the
refund of that amount that essentially reverses the cash receipt.

Miscellaneous Receipts Conversion

Non-project cash receipts entered in Deltek FMS using the Miscellaneous Receipts dialog box
are converted to cash receipt transactions in Deltek Vision.

Related Migration Decisions

There are no related migration decisions.

Reviewing the Converted Data

To view the converted miscellaneous receipts in Vision, click Reporting » Accounting on the
Vision Applications menu, and print the Cash Receipts report.

Which Records Are Converted

All miscellaneous receipts dated on or before the ending date of the accounting period you
entered in Convert Periods Through on the Accounting Periods subtab of the Accounts tab in
the Vision Conversion Setup dialog box are converted to Vision. Receipts dated after that period
are not converted.

Receipt Number

The FMS receipt number is not converted.
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Checkbook

The checkbook linked to the receipt is replaced in Vision by the bank code to which that
checkbook was converted.

Deposit Number

The FMS deposit number becomes the reference number for the receipt in Vision.

Receipt Date

The receipt date is converted to the Vision receipt date.

Reference

The reference text for the receipt in FMS is converted to the Description 1 field in Vision.

Payment Type

The payment type and check number in FMS are converted to the Description 2 field in Vision.

Check Number

The check number and payment type in FMS are converted to the Description 2 field in Vision.

Receipt Amount

The receipt amount itself is not converted to Vision.

Accounts and Amounts

The Vision GL accounts for the cash receipt transaction in Vision are those you mapped to the
accounts in the FMS miscellaneous receipt. The amount for each FMS account goes to the Vision
account to which it was mapped.

Project (in Vision)

If the Vision GL account is a revenue, reimbursable expense, or direct expense account, the
project for the entry is the miscellaneous regular project (299). If the Vision account is not one of
these types, the project is the miscellaneous overhead project (Z22).

Organization

If you are using organizations in Vision, the organization mapped to the FMS account in the FMS
Accounts — Vision Accounts Mapping dialog box is assigned to each entry.

Employee Expenses Conversion

Employee expense sheets in Deltek FMS are converted to employee expense transactions in
Deltek Vision.

Related Migration Decisions

Accounts Payable Transactions, Employee Expenses, and Purchase Orders to Convert
Decisions” on page 23

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
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“Work Breakdown Structure Decisions: Phases” on page 42
“Work Breakdown Structure Decisions: Departments” on page 45
“Expense Codes-to-Accounts Mapping Decisions” on page 78
“Default Checkbook Decision” on page 18

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data
To view the converted employee expense information in Vision, do either of the following:

= Click Reporting » Employee on the Vision Applications menu, and print the Employee
Ledger report.

= Click Reporting » Project on the Vision Applications menu, and print the Expense Detalil
report.

You can also review information related to the converted records in the following:

Reports | Forms and Applications

Project Detall Project Review

Expense Summary Billing application (unbilled expenses only)
Office Earnings
Project Progress
Project Summary

Project Earnings

Consultant Ledger

Which Records Are Converted
Which employee expenses are converted depends on the conversion options you select:

= If you select Only Convert AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or After on the General tab of the Vision Conversion Setup dialog box,
only employee expenses with an entry date, effective date, or payment date on or after
the date you specify are converted.

= If you select Convert Open AP Invoices and Employee Expense Sheets Only on the
General tab of the Vision Conversion Setup dialog box, only employee expenses with a
remaining balance are converted.

= No employee expenses are converted that have an effective date after the ending date of
the accounting period you select in Convert Periods Through on the Accounting
Periods subtab in the Accounts tab of the Vision Conversion Setup dialog box

In addition, cancelled employee expense sheets aren’t converted.

®.] Ifa project is converted but some employee expenses entered for that project are not converted,
the conversion does not create an employee expense transaction or any GL transactions but
does bring over project cost information to Vision.
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Credit Purchases

If an employee expense paid using a company charge account has not been reconciled in FMS at
the time of conversion or it has been reconciled but no AP invoice created, the conversion
converts the employee expense as described in this topic, and it also creates an AP voucher in
Vision with the credit card company as the vendor. (If a cancelled or cancellation employee
expense sheet has unreconciled charges, the employee expense sheet isn’t converted, but an AP
voucher for the credit card company is created in Vision.)

For charged employee expenses that have been fully reconciled in FMS and an AP invoice
created, the expense is converted but no additional AP voucher is created.

Expense Sheet Number

The FMS expense sheet number becomes the voucher number for the employee expense
transaction in Vision and the reference number for the individual line items.

Employee

The employee specified for the employee expense sheet in FMS is converted to the employee
associated with the Vision employee expense transaction.

Entry Date and Effective Date

The FMS entry date becomes both the report date for the Vision employee expense transaction
and the transaction date for each of the line items. The effective date is used to associate the
employee expense transaction and each line item in the voucher with the corresponding Vision
accounting period. The dates entered for individual expenses are not converted.

Reference

The reference for the employee expense sheet becomes the report name for the employee
expense transaction.

Bank Code

In preparation for the conversion, you select a default checkbook on the General tab of the Vision
Conversion Setup dialog box. The bank code that the conversion creates from that checkbook is
assigned to all employee expense transactions in Vision.

Individual Expenses

Only the following from the Employee Expenses tab of the Employee Expenses dialog box are
converted or used in the conversion:

This FMS data item... | Is...

Amount Converted to the amount for the project cost transaction related to
the line item.

Payment Type Not converted. However, the payment type is reflected in how the

employee expense affects the general ledger.

Project? Not converted. However, if Project? Is No, the Vision transaction is
assigned to the miscellaneous overhead project.
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GL Transactions

The GL transactions associated with an employee expense sheet are converted using the Vision
accounts that you mapped to the FMS accounts affected by the transaction.

An employee expense sheet with an effective date prior to the first day of the fiscal year you
specified in General Ledger Beginning Year may be converted, depending on your conversion
options, but no GL transaction is created for it in Vision. Instead, its effect on the general ledger
will be reflected in the initial account balances that the conversion establishes in Vision.

o) For project cost purposes, a different Vision expense account may be used than the one
affecting the general ledger, depending on the project cost adjustment option you selected in
the FMS Expense Codes — Vision Accounts Mapping dialog box. For more on this, see
“Expense Codes-to-Accounts Mapping Decisions” on page 78.

Expense Code

FMS expense codes in project expenses related to employee expenses are replaced by expense
accounts. For project cost and billing purposes, the conversion replaces the expense code with
one of the Vision accounts you mapped to it in the FMS Expense Codes — Vision Accounts
Mapping dialog box:

Then the account for the expenseiis...

Bill? Is Yes or Hold and the cost type isa | The reimbursable consultant expense account

subcontractor cost type mapped to the expense code.
Bill? Is Yes or Hold and the cost type is The reimbursable expense account mapped to
not a subcontractor cost type the expense code.

Bill? Is Fee, Writeoff, or No and the cost | The direct consultant expense account mapped
type is a subcontractor cost type to the expense code.

Bill? Is Fee, Writeoff, or No and the cost The direct expense account mapped to the
type is a not subcontractor cost type expense code.

For employee expenses that are not project-related, the default indirect expense account from the
FMS Expense Code — Vision Accounts Mapping dialog box is assigned.

Project and Billing Group

Projects and billing groups in FMS expense records are converted to the appropriate WBS
components in the Vision expense transactions, based on the work breakdown structure
decisions you made on the WBS tab of the Vision Conversion Setup dialog box.

Personal expenses and company expenses that aren’t project-related in FMS are assigned to the
miscellaneous overhead project (ZZ2).

It is possible to convert an expense but not convert the project for which the expense was
entered. If that occurs, the expense is assigned to the miscellaneous overhead project or the
miscellaneous regular project (Z299), whichever is appropriate.

Phase

If you elected to convert phases as a WBS level, the phases in FMS expense records become a
WBS component. If you decided to convert phases as part of labor codes or to not convert
phases at all, the expense records in Vision will not reference a phase.
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Department

If you are using departments in Business Management and you elected to convert departments,
the departments in expense records are converted based on the conversion decisions you made
on the WBS tab of the Vision Conversion Setup dialog box:

If departments are

converted as...

A WBS level The expense record department becomes a WBS component at
that level
Organizations An organization is assigned to the expense record based on the

mapping of FMS GL accounts to organizations in the FMS
Accounts — Vision Accounts Mapping dialog box

Vision labor codes only The expense records won't reference a department.

Cost Type

Cost types are not converted to Vision.

Units and Unit Cost

These values aren’t themselves converted, but the total cost of the expense that is calculated
from them is converted to the expense cost amount in Vision.

Billing Status

Your entry in Bill? For an expense record is converted to Vision as follows:

This billing status | Is converted to this Vision status...

in FMS...
Fee Bill
Yes Bill
Hold Hold
Writeoff Write-off
No Bill
In addition, billing is suppressed, and the billing amount is set to 0.00.

Expense records that were billed in FMS are marked as such in Vision.

Bill Units, Markup, and Multiplier

The bill units, markup, and multiplier for an expense in FMS are not converted. However, the total
billable amount (total charge) calculated from them becomes the billing extension amount for the
expense in Vision.
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Comments

Comments entered for FMS expense records are not converted.

Payments

Any payment or advance applied to an employee expense sheet in FMS is converted to an
employee expense payment in Vision as long as the date of the payment is on or before the
ending date of the accounting period you specified in Convert Periods Through on the
Accounting Periods subtab of the Accounts tab in the Vision Conversion Setup dialog box.

If a payment or credit has been applied in FMS to an employee expense sheet that is not fully
paid at the time of conversion, the application of the payment or credit is reversed, and an
equivalent advance created in Vision.

Voided checks are not converted.

Refunded advances are converted as negative advances.

Accounts Payable Invoices Conversion

AP invoices, debit memos, and credit memos in Deltek FMS are converted to AP vouchers in
Deltek Vision.

Related Migration Decisions

Accounts Payable Transactions, Employee Expenses, and Purchase Orders to Convert
Decisions” on page 23

“Default Checkbook Decision” on page 18

“Inactive Vendors Decision” on page 20

“Vendor Hold Status Decision” on page 21

“Vendor Discount Information Decision” on page 22

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39
“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Expense Codes-to-Accounts Mapping Decisions” on page 78

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data
To view the converted AP transactions in Vision, do either of the following:

= Click Accounting » Accounts Payable » Vendor Review on the Vision Applications
menu.

= Click Reporting » Vendor on the Vision Applications menu, and print the Voucher
Ledger report.

To view information for the project expenses related to the invoices, click Reporting » Project on
the Vision Applications menu, and print the Expense Detail report.

You can also review information related to the converted records in the following:
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Reports Forms and Applications
Project Detall Project Review
Expense Summary Billing application (unbilled expenses only)

Vendor Summary
Office Earnings
Project Progress
Project Summary
Project Earnings
Consultant Ledger

Voucher Schedule

Which Records Are Converted
Which AP transactions are converted depends on the conversion options you select:

= If you select Only Convert AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or After on the General tab of the Vision Conversion Setup dialog box,
only AP transactions with an invoice date, effective date, or payment date on or after the
date you specify are converted.

= If you select Convert Open AP Invoices and Employee Expense Sheets Only on the
General tab of the Vision Conversion Setup dialog box, only AP transactions with a
remaining balance are converted.

= If you select Convert Active Vendors Only on the General tab of the Vision Conversion
Setup dialog box, AP transactions entered for vendors that are now inactive are not
converted unless they have a balance. If they have a balance, they and the vendor are
converted automatically.

= No transactions are converted that have an effective date after the ending date of the
accounting period you select in Convert Periods Through on the Accounting Periods
subtab in the Accounts tab of the Vision Conversion Setup dialog box

In addition, deleted, canceled, and cancellation AP transactions aren’t converted.

“.] Ifa project is converted but some AP transactions entered for that project are not converted, the
conversion does not create a voucher or any GL transactions but does bring over project cost
information to Vision.

AP Transaction Number

The AP transaction number in FMS becomes the voucher number in Vision. For linked retainage
invoices, an “R” is added to the end of the original transaction number.

Vendor

The vendor specified for the AP transaction in FMS is converted to the Vision voucher’s vendor.

If you selected Update Project Team When Posting Labor or Vouchers on the FMS
Miscellaneous BM tab of the Vision Conversion Setup dialog box, the conversion also adds any
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vendors for whom AP transactions were entered for a project or billing group to the list of vendors
on the Team tab in the Project Info Center for the appropriate WBS levels.

Invoice Date and Effective Date

The FMS invoice date becomes the invoice date for the Vision voucher.

The effective date becomes the transaction date in Vision. The conversion also uses it to
associate the voucher and each line item in the voucher with the corresponding Vision accounting
period.

AP Transaction Type

The transaction type is not converted, but it is used by the conversion to determine how to set up
the Vision voucher. Invoices, debit memos, and retainage invoices are converted to regular
vouchers, while credit memos are converted to negative vouchers.

Invoice Number

The invoice number for the AP transaction in FMS is converted to the Vision voucher’s invoice
number. For linked retainage invoices, an “R” is added to the end of the original invoice number.
Invoice Amount

The FMS invoice amount isn't converted. Vision calculates a voucher total amount from the line
item amounts rather than storing a voucher amount.

Reference

The reference for the AP transaction becomes the description of each of the voucher line items.

Form 1099, Retainage, and Discount Information

The Form 1099 information, retainage amount, and non-discountable amount in FMS for an
invoice are not converted.

Bank Code

In preparation for the conversion, you select a default checkbook on the General tab of the Vision
Conversion Setup dialog box. The bank code that the conversion creates from that checkbook is
assigned to all AP vouchers.

Voucher Address

If the vendor has a payment address in FMS, it is set up as a Vision address called “Payment
Address.” If it exists, it is assigned as the voucher address. If the vendor does not have a
payment address, the billing address is used.

ltem Code Information

Only the following from the ltems Received tab of the Invoices dialog box are converted or used
in the conversion:

This FMS data item... | Is...
Amount Converted to the amount for the project cost transaction related to
the line item.
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This FMS data item... | Is...

Balance Converted to the transaction amount for the project cost transaction
related to the line item.

Project? Not converted. However, if Project? Is No, the Vision transaction is
assigned to the miscellaneous overhead project.

Expense code Not converted. However, the expense code mapping is used in
determining the account for the project cost transaction related to
the line item.

Adjustments Information

For each adjustment on the Adjustments/Totals tab of the Invoices dialog box that isn’t allocated
to an item row, the conversion creates a voucher line item in Vision.

GL Transactions

The GL transactions associated with an AP transaction are converted using the Vision accounts
that you mapped to the FMS accounts affected by the transaction.

The AP liability code for the transaction is the liability code linked to the Vision account that you
mapped to the AP liability account for the AP transaction. (For a retainage transaction, the liability
code related to the FMS retainage payable account is assigned.)

An invoice with an effective date prior to the first day of the fiscal year you specified in General
Ledger Beginning Year may be converted, depending on your conversion options, but no GL
transaction is created for it in Vision. Instead, its effect on the general ledger will be reflected in
the initial account balances that the conversion establishes in Vision.

o) For project cost purposes, a different Vision expense account may be used than the one
affecting the general ledger, depending on the project cost adjustment option you selected in
the FMS Expense Codes — Vision Accounts Mapping dialog box. For more on this, see
“Expense Codes-to-Accounts Mapping Decisions” on page 78.

Payment Terms

For AP transactions in FMS that are not on hold or marked as pay when paid, the conversion sets
Payment Date to Date and the FMS due date.

For AP transactions in FMS that have Hold Payment selected, the conversion sets Payment
Date to Hold. In this case, no due date is specified.

For AP transactions in FMS that have Pay When Paid selected, the conversion sets Payment
Date to PWP. In this case, no due date is specified.

No other payment terms information is converted.

Expense Code

FMS expense codes in project expenses related to AP transactions are replaced by expense
accounts. For project cost and billing purposes, the conversion replaces the expense code with
one of the Vision accounts you mapped to it in the FMS Expense Codes — Vision Accounts
Mapping dialog box:
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Then the account for the expenseiis...

Bill? Is Yes or Hold and the cost type is a The reimbursable consultant expense account
subcontractor cost type mapped to the expense code.

Bill? Is Yes or Hold and the cost type is not | The reimbursable expense account mapped to

a subcontractor cost type the expense code.

Bill? Is Fee, Writeoff, or No and the cost The direct consultant expense account
type is a subcontractor cost type mapped to the expense code.

Bill? Is Fee, Writeoff, or No and the cost The direct expense account mapped to the
type is a not subcontractor cost type expense code.

Project and Billing Group

Projects and billing groups in FMS expense records are converted to the appropriate WBS
components in the Vision expense transactions, based on the work breakdown structure
decisions you made on the WBS tab of the Vision Conversion Setup dialog box. Expenses that
aren’t project-related in FMS are assigned to the miscellaneous overhead project (ZZZ2). It is
possible to convert an expense but not convert the project for which the expense was entered. If
that occurs, the expense is assigned to the miscellaneous overhead project or the miscellaneous
regular project (299), whichever is appropriate.

Phase

If you elected to convert phases as a WBS level, the phases in FMS expense records become a
WBS component. If you decided to convert phases as part of labor codes or to not convert
phases at all, the expense records in Vision will not reference a phase.

Department

If you are using departments in Business Management and you elected to convert departments,
the departments in expense records are converted based on the conversion decisions you made
on the WBS tab of the Vision Conversion Setup dialog box.

If departments are

converted as...

A WBS level The expense record department becomes a WBS component at that
level.
Organizations An organization is assigned to the expense record based on the

mapping of FMS GL accounts to organizations in the FMS Accounts
— Vision Accounts Mapping dialog box.

Vision labor codes only | The expense records won't reference a department.

Cost Type

Cost types are not converted to Vision.
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Units and Unit Cost

These values aren’t themselves converted, but the total cost of the expense that is calculated
from them is converted to the expense cost amount in Vision.

Billing Status

Your entry in Bill? For an expense record is converted to Vision as follows:

This billing status in Is converted to this Vision status...

FMS...

Fee Bill

Yes Bill

Hold Hold

Writeoff Write-off

No Bill In addition, billing is suppressed, and the billing amount is set to
0.00.

Expense records that were billed in FMS are marked as such in Vision.

Bill Units, Markup, and Multiplier

The bill units, markup, and multiplier for an expense in FMS are not converted. However, the total
billable amount (total charge) calculated from them becomes the billing extension amount for the
expense in Vision.

Comments

Comments entered for FMS expense records are not converted.

Accounts Payable Payments Conversion

Payments of AP invoices, either through a normal check run or through manual payments, and
cash payments (payments to accounts) in Deltek FMS are converted to AP payments and cash
disbursement records in Deltek Vision. Separate payment line items are created in Vision for
each invoice item paid.

Related Migration Decisions

Accounts Payable Transactions, Employee Expenses, and Purchase Orders to Convert
Decisions” on page 23

“Inactive Vendors Decision” on page 20
“Vendor Hold Status Decision” on page 21

“Vendor Discount Information Decision” on page 22

Reviewing the Converted Data

To view converted AP payment information in Vision, do either of the following:
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Click Accounting » Accounts Payable » Vendor Review on the Vision Applications
menu.

Click Reporting » Vendor on the Vision Applications menu, and print the Voucher
Ledger report.

You can also review information related to the converted records in the following:

Reports | Forms and Applications

Project Detall Project Review

Expense Summary Billing application (unbilled expenses only)
Vendor Summary
Office Earnings
Project Progress
Project Summary
Project Earnings
Consultant Ledger

Voucher Schedule

Which Records Are Converted

Which payments are converted depends on the conversion options you select for AP invoices:

If you select Only Convert AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or After on the General tab of the Vision Conversion Setup dialog box,
only AP transactions with an invoice date, effective date, or payment date on or after the
date you specify are converted. Any payments for the converted transactions are also
converted.

If you select Convert Open AP Invoices and Employee Expense Sheets Only on the
General tab of the Vision Conversion Setup dialog box, only AP transactions with a
remaining balance are converted. Any payments applied to these open invoices are also
converted.

If you select Convert Active Vendors Only on the General tab of the Vision Conversion
Setup dialog box, AP transactions entered for vendors that are now inactive are not
converted unless they have a balance. If they have a balance, the transactions and the
vendor are converted automatically. Any payments for the converted transactions are
also converted.

If you select Only Convert AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or After on the General tab of the Vision Conversion Setup dialog box,
manual payments to accounts (both payments and cash transfers) dated before the cutoff
date are not converted to Vision.

No payments are converted that are dated after the ending date of the accounting period
you select in Convert Periods Through on the Accounting Periods subtab in the
Accounts tab of the Vision Conversion Setup dialog box.

Voided checks are not converted.
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o) Since a payment can apply to multiple invoices, it is possible that not all invoices paid will be
converted. In that case, only the portion of the payment for the converted invoices is converted.

Charge Payment to a Vendor

If a vendor invoice is paid using a company charge account and the charge transaction has not
been reconciled in FMS at the time of conversion or it has been reconciled but no AP invoice
created for the credit card company, the conversion creates the necessary payment records in
Vision for the charge payment, and it also creates an AP voucher in Vision with the credit card
company as the vendor. The voucher number and invoice number for this voucher is “REC_"
followed by the charge tracking number.

For a charge payment that has been fully reconciled in FMS and for which an AP invoice has
been created for the credit card company, the payment to the original vendor is converted but no
additional AP voucher is created.

Refunds

Refunds are converted as negative payments.

Prepayments

Prepayments applied to converted invoices are converted as normal payments, with the date they
were applied serving as the check date.

Unapplied prepayments are converted as Vision prepayments. The result in Vision is a negative
voucher for the amount of the prepayment and GL entries to the Vision accounts mapped to the
FMS accounts for the FMS prepayment transaction.

Discounts

If a discount is taken on an invoice, the conversion creates additional payment line items as
necessary to apply the discount. Discounts are assigned to the miscellaneous overhead project
(2z2z).

Check Date

The conversion uses the FMS check date to associate the payment with the corresponding Vision
accounting period.

Check Number

The FMS check number or charge tracking number is converted to the payment reference
number. For direct deposit payments, a “D” is added to the beginning of the advice number to
avoid the possibility of duplicate payment reference numbers.

Invoice Number

The number of the FMS invoice being paid is used as the payment voucher number in Vision.

Vendor

The vendor paid in FMS is the vendor associated with the payment in Vision.

Payment Amount

The FMS payment amount for each invoice line item is converted to the Vision payment amount.
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Bank Code

The bank code assigned to a cash payment is the one to which the FMS checkbook for the
payment was converted. For a charge payment, the bank code created from the default
checkbook you specified on the General tab of the Vision Conversion Setup dialog box is
assigned.

GL Transactions

The GL transactions associated with a payment are converted using the Vision accounts that you
mapped to the FMS accounts affected by the payment.

A payment dated prior to the first day of the fiscal year you specified in General Ledger
Beginning Year may be converted, depending on your conversion options, but no GL transaction
is created for it in Vision. Instead, its effect on the general ledger will be reflected in the initial
account balances that the conversion establishes in Vision.

Organizations

If you are using departments in Business Management and you elected to convert departments to
Vision organizations, the organizations to which a payment is assigned are the organizations you
mapped to the FMS accounts affected by the payment in the FMS Accounts — Vision Accounts
Mapping dialog box.

Unreconciled Checks and Deposits Conversion

The conversion moves unreconciled checks and deposits from Deltek FMS to Deltek Vision.
Reconciled checks and deposits are not converted.

This conversion enables you to reconcile to your bank statement after you begin using Vision, but
you won't be able to view any additional FMS check history.
Related Migration Decisions

There are no related migration decisions.

Reviewing the Converted Data

To review the converted check and deposit information, click Accounting » Bank Reconciliation
on the Vision Applications menu, select a bank, and enter a statement date. In the Bank
Statement Reconciliation form, use the Deposits and Checks tabs to view the unreconciled items.

You can use the E Print option at the top of the form to print the Bank Reconciliation report.

If you haven't yet saved the reconciliation in Vision, click E Save at the top of the form
before printing the Bank Reconciliation report. If you don’t save it first, the report will show no
checks or deposits.

Records That Will Be Converted

All unreconciled checks and deposits are converted, regardless of date. Cutoff dates that
normally apply to transaction conversion do not apply in this case.

No reconciled checks and deposits are converted.
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Voided Checks, Spoiled Checks, Stub Overruns

Unreconciled voided checks, spoiled checks, and check stub overruns are not converted to
Vision.

Voiding Converted Checks

You cannot void an FMS check in Vision.

Checkbook

The FMS checkbook for a check or deposit is replaced by the corresponding bank code in Vision.

Check Number, Payee, Amount

The check number, payee, and amount for checks are converted to Vision without change.

Deposit Number, Received From, Amount

The deposit number, the person or company from whom the check was received, and the deposit
amount are converted to Vision without change. (For deposits containing more than one payment,
the record has Multiple Receipts as the deposit description instead of a specific payer.)

Check and Deposit Types

The FMS check and deposit types used on the Check Register report (Payroll, PR Direct Deposit,
Computer,...) are converted to an equivalent Vision check or deposit type. Vision has fewer
types, so in many cases multiple FMS types are converted to the same Vision type.

General Ledger Transactions Conversion

General ledger transactions in Deltek FMS are converted to Deltek Vision for user-defined source
journals and for certain system-assigned source journals. The conversion creates the remaining
GL transactions during the conversion of the source transactions (AP invoices, AR invoices,
receipts,...).

Related Migration Decisions

“Accounting Periods Decisions” on page 33

“Work Breakdown Structure Decisions: Projects and Billing Groups” on page 39

“Work Breakdown Structure Decisions: Phases” on page 42

“Work Breakdown Structure Decisions: Departments” on page 45

“Expense Codes-to-Accounts Mapping Decisions” on page 78

“Migration Briefing: Work Breakdown Structure Conversion” on page 35

Reviewing the Converted Data

To view converted GL transaction information in Vision, click Reporting » General Ledger on the
Vision Applications menu, and print the Account Analysis report.

To view information for the project expenses related to the GL transactions, click Reporting »
Project on the Vision Applications menu, and print the Expense Detail report.

You can also review information related to the converted records in these reports:
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= |ncome Statement
= Balance Sheet

= Trial Balance

Which Records Are Converted

The conversion directly converts to Vision all GL transactions for user-defined source journals
and transactions for these system-assigned source journals:

= WIP

= TimeOff
= ChkRec
= ChgRec
=  ACTax
= OPR

= OGL

= OAR

= OAP

= GL Dist
= Conwvt

=  ReAd

No transactions for these source journals are converted that have an effective date after the
ending date of the accounting period you select in Convert Periods Through on the Accounting
Periods subtab in the Accounts tab of the Vision Conversion Setup dialog box

The conversion may also convert transactions for the PR source journal:

= If you aren’t converting payroll data, the conversion converts all transactions for the PR
source journal.

= If you are converting payroll data and you are using Payroll Plus, the conversion converts
any transaction for the PR source journal that is dated before the year you entered in
Beginning Payroll Year to Convert on the Payroll tab of the Additional Vision Setup
dialog box.

Other GL transactions (those for AP transactions, for example) are created in Vision when the
source transactions are converted.

o) If a project is converted but a GL transaction with expenses entered for that project is not
converted, the conversion does not create a GL transaction but does bring over project cost
information to Vision.

Reference

The reference text for the FMS transaction is converted to the transaction description in Vision.

Entry Date and Effective Date

The FMS entry date is converted to the transaction date in Vision.
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The effective date is used to assign each transaction to the correct accounting period in Vision.

Accrual and/or Cash Options

Accrual-basis amounts, cash-basis amounts, or both are converted for a transactions based on
whether the Accrual, Cash, or Accrual and Cast option was selected for it in FMS.

Account

The accounts in the Vision transaction are those you mapped to the FMS accounts in the original
transaction.

Debit and Credit Amounts

The debit and credit amounts are converted to transactions amounts for the corresponding Vision
accounts.

Bank Code

When a transaction involves a cash account, the bank code that the conversion creates from the
checkbook linked to that FMS account is assigned to the entry.

Expense Code

FMS expense codes in project expenses related to GL transactions are replaced by expense
accounts. For project cost and billing purposes, the conversion replaces the expense code with
one of the Vision accounts you mapped to it in the FMS Expense Codes — Vision Accounts
Mapping dialog box:

If... Then the account for the expenseiis...

Bill? Is Yes or Hold and the cost type is | The reimbursable consultant expense account
a subcontractor cost type mapped to the expense code.

Bill? Is Yes or Hold and the cost type is | The reimbursable expense account mapped to the

not a subcontractor cost type expense code.

Bill? Is Fee, Writeoff, or No and the The direct consultant expense account mapped to
cost type is a subcontractor cost type the expense code.

Bill? Is Fee, Writeoff, or No and the The direct expense account mapped to the

cost type is a not subcontractor cost type | expense code.

“.]  For project cost purposes, a different Vision expense account may be used than the one
affecting the general ledger, depending on the project cost adjustment option you selected in the
FMS Expense Codes — Vision Accounts Mapping dialog box. For more on this, see “Expense
Codes-to-Accounts Mapping Decisions” on page 78.

Project and Billing Group

Projects and billing groups in FMS expense records are converted to the appropriate WBS
components in the Vision expense transactions, based on the work breakdown structure
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decisions you made on the WBS tab of the Vision Conversion Setup dialog box. Expenses that
aren’t project-related in FMS are assigned to the miscellaneous overhead project.

It is possible to convert an expense but not convert the project for which the expense was
entered. If that occurs, the expense is assigned to the miscellaneous overhead project or the
miscellaneous regular project, whichever is appropriate.

Phase

If you elected to convert phases as a WBS level, the phases in FMS expense records become a
WBS component. If you decided to convert phases as part of labor codes or not to convert
phases at all, the expense records in Vision will not reference a phase.

Department

If you are using departments in Business Management and you elected to convert departments,
the departments in expense records are converted based on the conversion decisions you made
on the WBS tab of the Vision Conversion Setup dialog box:

If departments are converted

as...

A WBS level The expense record department becomes a WBS
component at that level.

Organizations An organization is assigned to the expense record
based on the mapping of FMS GL accounts to
organizations in the FMS Accounts — Vision Accounts
Mapping dialog box.

Vision labor codes only The expense records won't reference a department.

Cost Type

Cost types are not converted to Vision.

Units and Unit Cost

These values aren’t themselves converted, but the total cost of the expense that is calculated
from them is converted to the expense cost amount in Vision.

Billing Status

Your entry in Bill? For an expense record is converted to Vision as follows:

Fee Bill

Yes Bill

Hold Hold
Writeoff Write-off
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> This billing status in FMS... Is converted to this Vision status...

No Bill  In addition, billing is suppressed, and the billing
amount is set to 0.00.

Expense records that were billed in FMS are marked as such in Vision.

Bill Units, Markup, and Multiplier

The bill units, markup, and multiplier for an expense in FMS are not converted. However, the total
billable amount (total charge) calculated from them becomes the billing extension amount for the
expense in Vision.

Comments

Comments entered for FMS expense records are not converted.

Accounts Receivable Collection Actions Conversion

If you have the Accounts Receivable Collections module, the conversion converts the collection
actions for converted projects to AR comments in Deltek Vision.

Reviewing the Converted Data

To view the AR comments, do either of the following:

= Click Accounting » Accounts Receivable » Invoice Review on the Vision Applications
menu, select the client, select the project in the Aged Accounts Receivable grid, and

click ﬂ Comments in the title bar of the grid.

= Click Reporting » Accounts Receivable on the Vision Applications menu, and print the
AR Comments report.

Which Records Are Converted

Only actions for converted projects are converted to Vision.

Client
The client for which the action was entered in FMS is assigned the corresponding AR comment in
Vision.

Date

The action date becomes the comment date.

Recipient

The action recipient’s ID is included in the comment text in Vision.

Invoice

The invoice number for which the action was entered in FMS is assigned the corresponding AR
comment in Vision.
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Project

The project for which the action was entered in FMS is assigned the corresponding AR comment
in Vision.

Action Type

The action type is included in the comment text in Vision.

Notes

The notes are converted to the comment text in Vision.

User Name (Vision)

Each comment in Vision includes the user name of the person who entered the comment. For the
converted actions, the conversion is putting a sequential number in this field to make the set of
key data for each comment unique, a requirement in Vision.
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Appendix C: How Payroll Information Is
Converted

Payroll Control Information Conversion

The only information from the Payroll Control Information dialog box in Deltek FMS Payroll Plus
that is involved in the conversion to Deltek Vision is the default payroll checkbook on the Defaults
tab and the employee advance account on the GL Accounts tab.

The default checkbook setting is converted to the bank code used in Vision Payroll to make credit
entries directly to a cash account.

The employee advance account is assigned as the credit account for the withholding code
created for payroll advances.

Related Migration Decisions

“General Vision Decisions” on page 15

“Payroll Decisions” on page 113

Reviewing the Converted Data

To view the bank code in Vision, click Configuration » Payroll » General on the Vision
Applications menu. The bank code is on the General tab.

To view the Advances withholding code in Vision, click Configuration » Payroll » Withholding
Codes on the Vision Applications menu.

Payroll Tax Methods Conversion

Deltek FMS tax methods that are employee-paid are converted to Deltek Vision withholding
codes. Employer-paid tax methods, with some exceptions, are converted to contribution codes.
Related Migration Decisions

“General Vision Decisions” on page 15

“Payroll Decisions” on page 113

Reviewing the Converted Data

To view the withholding codes in Vision, click Configuration » Payroll » Withholding Codes on
the Vision Applications menu.

To view the contribution codes, click Configuration » Payroll » Contribution Codes on the
Vision Applications menu.

Tax Methods That Are Converted

With a few exceptions, tax methods that appear in payroll records dated in or after the year you
specified in Beginning Payroll Year to Convert on the Payroll tab of the Additional Vision Setup
dialog box are converted to Vision. Employee-paid taxes become Vision withholding codes, and
employer-paid taxes (FUTA and SUTA, for example) become contribution codes.

The exceptions are tax methods for employer FICA and employer Medicare. These are not
converted, regardless of when they were last used in FMS.
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Tax Type

The tax type in FMS determines type, method, and locale for the withholding code in Vision.
These settings, in turn, determine whether the withholding code is linked to a Vision system tax
table and how it is handled on reports and government forms.

System Tax Methods

System-assigned FMS tax methods (those for federal income tax, state income tax, and so on)
that were used in converted payroll checks are set up in Vision with Federal, State, FICA-HI, or
FICA-OASDI in Type. Method is set to System, so the taxes will be calculated using the system
tax formulas and tables.

For federal income tax, Locale is FE, and for state income tax codes, it is the appropriate state
code. This links the income tax withholding codes to the correct system tax calculation tables.

Non-System Tax Methods

When the conversion creates a withholding code or contribution code for a non-system FMS tax
method, even if that tax method is a copy of one of the FMS system tax methods, it sets it up with
either the Percentage or the Amount calculation method.

If... Then the method assigned is...

Tax Is a Percent of Gross Wages + or — Assigned Percentage.

Adjustments is selected on the Flat Tax Rates tab in Th . he arid h bi
the Tax Methods dialog box in FMS e percentage from the grid on that tab Is

assigned as the tax rate in Vision.

Use Withholding Tax Amount Plus % of Excess is Amount.
selected on the W/H Tax Plus % tab in the Tax Methods

dialog box, and the number of brackets is 1 The amount from the grid on that tab is

assigned as the tax amount in Vision.

In all other cases involving non-system tax methods, the Amount method is assigned, the amount
is set to 0.00, and the withholding code or contribution code is set up as inactive. This is done
because the conversion can’t determine for sure how the tax should be calculated. If you want to
use those codes in Vision, you will have to set them up the way you want them before you print
payroll checks in Vision.

Local Tax Methods

For tax methods with the Local Income Tax type in FMS, the conversion also creates a new
locale in Vision and assigns it to the withholding code. The entry in ID for Reporting from the Tax
Methods dialog box is converted as the locale.

Inactive Tax Methods

Inactive tax methods are converted to withholding codes or contribution codes that are also
marked as inactive.

Default Liability Account

The Vision account mapped to the default liability account for an FMS tax method is assigned as
the credit account for the Vision withholding code or contribution code.
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Default Employer Expense Account

The Vision account mapped to the default employer expense account for an employer-paid tax
method is assigned as the debit account for the Vision contribution code.

Work Breakdown Structure

All withholding codes created by the conversion are assigned to the miscellaneous overhead
project (ZZ2).

Maximum

If the FMS tax method is set up with a maximum amount that is evaluated using gross wages plus
or minus adjustments, that amount is used as the wage basis. If the maximum is evaluated based
on accumulation, it is used as the overall limit amount in Vision.

FICA Expense Account

To set the account on the FICA tab of the Payroll Setup form in Vision, the conversion uses the
Vision account mapped to the default expense account for the first FMS tax method with the
OASDI Employer tax type.

Tax Treatment for Payroll Adjustments

The settings in the Deduct Before Calc Tax? Column of the grid on the Tax Treatment tab in the
Payroll Adjustments dialog box in FMS are used to set Exclude 401(k) amounts and Exclude
cafeteria plan amounts check boxes for Vision withholding codes created from FMS tax
methods.

Note also that if an FMS payroll adjustment is converted to a type of other pay in Vision and that
adjustment has Yes in Deduct Before Calc Tax? For a tax method, the withholding code created
in Vision for that tax method will have the check box selected for that other pay type under
Deduct before calculating withholding.

Payroll Adjustments Conversion

The following types of Deltek FMS payroll adjustments are converted to Deltek Vision withholding
codes:

= NTD (Non-taxable deduction)
= CAF (Cafeteria deduction)

= ATD (After-tax deduction)

= TNP (Taxable — not paid)

= ATA (After-tax addition)

The ATA adjustments are converted as negative deductions. TNP and TAG (Taxable addition to
gross) adjustments are converted to other pay types in Vision. ECT (Employer contributions)
adjustments are converted to contribution codes in Vision. BNS (Bonus) adjustments aren’t
converted.

Related Migration Decisions
“General Vision Decisions” on page 15

“Payroll Decisions” on page 113
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Reviewing the Converted Data

= To view the withholding codes in Vision, click Configuration » Payroll » Withholding
Codes on the Vision Applications menu.

= To view the contribution codes in Vision, click Configuration » Payroll » Contribution
Codes on the Vision Applications menu.

= To view the other types of pay, click Configuration » Payroll » General on the Vision
Applications menu, and go to the Other Pay Setup tab.

Payroll Adjustments That Are Converted

If you are converting both Info Center data and transactions, payroll adjustments that appear in
payroll records dated in or after the year you specified in Beginning Payroll Year to Convert on
the Payroll tab of the Additional Vision Setup dialog box are converted to Vision. In addition, any
payroll adjustment assigned to an employee and set up to be used indefinitely is converted even
if it has not been used in a converted payroll record.

If you are converting Info Center data only, all active payroll adjustments are converted.

Adjustment Type

The FMS adjustment types that represent deductions are assigned a withholding type in Vision:
= CAF adjustments are assigned the Cafeteria type.
= NTD adjustments are assigned the 401(k) type.
= ATA, ATD, and TNP adjustments are assigned the Other type.

Inactive Payroll Adjustments

If Inactive is selected for the FMS adjustment, the conversion checks Inactivate when
processing payroll for the Vision withholding code or contribution code.

Assign to New Employee

If Assign to New Employees is selected for the FMS adjustment, the conversion checks Default
withholding for new employees for the Vision withholding code (Default contribution for new
employees for a contribution code).

No other information from the Options tab in the Payroll Adjustments dialog box is converted.

Calculation Method: Non-ECT Adjustments

For FMS adjustments using the Lump Sum Amount calculation method, the Amount method is
assigned to the withholding code in Vision.

FMS adjustments with the following calculation methods are assigned the Percentage method in
Vision, but because Vision doesn’t support these calculations, the withholding codes are marked
as inactive:

* Rate($) x Pay Period Days
= Rate($) x Work Days

*= Rate($) x Total Work Hours
*= Rate($) x Regular Hours

= Rate($) x Overtime Hours
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= Rate($) x Units

FMS adjustments with a calculation method that applies a rate as a percentage are assigned the
Percentage method in Vision, and the withholding codes are active.

The conversion also uses the FMS adjustment type and calculation method to determine how to
set these check boxes for the withholding code:

= Exclude 401(k) amounts
= Exclude cafeteria plan amounts

The conversion does not select any of the Other Pay check boxes under Deduct before
calculating withholding for withholding codes created from payroll adjustments because that is
seldom appropriate. However, after conversion you should review the payroll adjustments and
make sure none of your other pay types should be excluded.

If Calculate on Bonus Pay is selected in FMS, Default withholding amount to zero for bonus
payroll is not selected in Vision. The reverse is true if Calculate on Bonus Pay is selected in FMS.

Calculation Method: ECT Adjustments

If Employer Matching Adjustment is selected for the ECT adjustment on the Options tab, the
Calculation Method tab is disabled and the settings on the Employer Matching tab are used
instead.

If Employer Matching Adjustment is not selected for the ECT adjustment, the conversion does
the following:

= For ECT adjustments using the Lump Sum Amount calculation method, Fixed amount is
selected in Method for the contribution code in Vision.

= For all other FMS calculation methods, Percent of Employee wages is selected in
Method in Vision.

In either case, the entry in Rate appears in Amount/percent in Vision.

The conversion also uses the FMS adjustment type and calculation method to determine how to
set these check boxes for the contribution code:

= Exclude 401(k) amounts
= Exclude cafeteria plan amounts

The conversion does not select any of the Other Pay check boxes under Deduct before
calculating contribution for contribution codes created from payroll adjustments because that is
seldom appropriate. However, after conversion you should review the payroll contributions and
make sure none of your other pay types should be excluded.

If Calculate on Bonus Pay is selected in FMS, Default contribution amount to zero for bonus
payroll is not selected in Vision. The reverse is true if Calculate on Bonus Pay is selected in FMS.

Employer Matching

No information from the Employer Matching tab in the Payroll Adjustments dialog box is
converted for non-ECT adjustments.

For ECT adjustments for which Employer Matching Adjustment is selected on the Options tab,
the following conversions occur:

= The withholding code created for the adjustment in Linked Adjustment appears in
Withholding in the Payroll Contribution Setup form in Vision.

= The rate in Employer Contribution Rate moves to Amount/percent in Vision.
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= The value in Matching Rate Cap appears in Matching rate cap in Vision.

= If Linked Adjustment’s Basis is selected under Employer Matching Calculation
Methods, Method in Vision is set to Lesser of Employee withholding or wages.

= IfLinked Adjustment’s Contribution is selected under Employer Matching
Calculation Methods, Method in Vision is set to Percent of Employee withholding.

Maximums and Minimums

In Vision, Wage base, Overall limit, and the Reset limit at time of W-2 initialization check box
are used to establish withholding code maximums. If Set Maximum is selected for an FMS
adjustment, the conversion establishes those settings as follows:

= |f Use Period Totals is set to Annual Totals, the conversion selects Reset limit at time
of W-2 initialization for the withholding code.

= If Use Period Totals is set to something other than Annual Totals, the conversion
creates a withholding code with Inactivate when processing payroll selected and 0.00
in Wage base and Overall limit. Vision gives you the option to reset totals annually or let
them continue, but it doesn’t support this for other periods. You'll need to adjust the
amounts yourself for such withholding codes.

= [f Use Accumulation and Compensation is selected for the FMS adjustment,
Accumulation Maximum converts to Overall limit, and Compensation Maximum
converts to Wage base.

= If Hours is selected under Evaluate Maximum Using, the conversion creates a
withholding code with Inactivate when processing payroll selected and 0.00 in Wage
base and Overall limit. You'll need to adjust the amounts yourself for such withholding
codes.

= |f Dollars and Accumulation are selected under Evaluate Maximum Using, the
conversion converts Maximum Amount to Overall limit.

= [f Dollars and anything other than Accumulation are selected under Evaluate
Maximum Using, the conversion converts Maximum Amount to Wage base.

= If you've linked two adjustments in FMS using Linked Adjustment under Link to Use
Accumulation Maximum to handle Roth IRAs, the conversion links the corresponding
withholding codes in Vision using the Link to calculate Overall Limit column on the
Payroll Withholding Setup form.

= The Include Bonus Amount setting for maximums in FMS is not converted.

No information for minimums is converted. Vision doesn’t support withholding code minimums.

Tax Treatment
No information from the Tax Treatment tab in the Payroll Adjustments dialog box is converted.

However, the settings in the Deduct Before Calc Tax? Column of the grid are used to set
Exclude 401(k) amounts and Exclude cafeteria plan amounts check boxes for withholding
codes created from FMS tax methods.

Note also that if an FMS payroll adjustment is converted to a type of other pay in Vision and that
adjustment has Yes in Deduct Before Calc Tax? For a tax method, the withholding code created
in Vision for that tax method will have the check box selected for that other pay type under
Deduct before calculating withholding.
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Government Reporting

For non-ECT adjustments, the line labels for Form W-2 are converted to Box to include on W2
in Vision. Both 12D and 12AA becomes Box 12 D... in Vision, and 12BB becomes Box 12 E....

No other information from the Government Reporting tab in the Payroll Adjustments dialog box is
converted.

GL Accounts: Default Adjustment Account

The Vision account mapped to the default adjustment account for a payroll adjustment is
assigned as the credit account for the Vision withholding code.

Vision requires the credit accounts to be asset, liability, or expense accounts. If the Vision
account does not fall into one of these ranges, the withholding code is marked as inactive, and
you'll need to change the account before you can use the code.

If the account is an expense account, the withholding code is assigned to the miscellaneous
overhead project (ZZZ2).

GL Accounts: Default Employer Expense Account

For ECT adjustments only, the account in Employer Expense on the GL Accounts tab is
converted as the debit account assigned to the contribution code in Vision.

Adjustments Converted to Other Pay

TAG and TNP adjustments are converted to types of other pay based on your entries on the
Payroll tab in the Additional Vision Setup dialog box. They are all assigned to the miscellaneous
overhead project (ZZ22).

None of the payroll adjustment information for these types of adjustments is used to set up the
other pay types in Vision.

Bonuses

Vision does not process bonuses using a withholding code or other pay type, so BNS payroll
adjustments are not converted. In Vision, bonuses are generated when you do a payroll run with
Bonus selected in Run Type on the Payroll Processing form.

Bonus cost in Vision goes to a single GL account, the account you specified on the Payroll tab in
the Additional Vision Setup dialog box.

“.] In Vision, you can’t pay a bonus amount on a regular payroll check. Because of this, if the
conversion encounters that situation when converting FMS payroll record, it increases the
regular pay amount by the amount of the bonus.

Advances

If you convert payroll records for a payroll advance, repayment of an advance, or an advance
draw, the conversion creates an Advances withholding code in Vision. The credit account for the
withholding code is the Vision account mapped to the employee advance account specified on
the GL Accounts tab of the Payroll Control Information dialog box in FMS. Withholding type is
Other and method is Amount.
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Employee Payroll Information Conversion

If you have elected to convert Deltek FMS Payroll Plus data to Deltek Vision Payroll, the
conversion sets up withholding codes or contribution codes for adjustments and taxes, other pay
amounts, and payroll direct deposit accounts for employees in Vision based on the corresponding
employee information in FMS.

Related Migration Decisions
“General Vision Decisions” on page 15

“Payroll Decisions” on page 113

Reviewing the Converted Data

To view employee withholding codes, contribution codes, and other pay information in Vision,
click Info Center » Employees on the Vision Applications menu and go to the Payroll tab. To see
direct deposit information, go to the Accounting tab.

Payroll Adjustments

Payroll adjustments that appear in payroll records dated in or after the year you specified in
Beginning Payroll Year to Convert on the Payroll tab of the Additional Vision Setup dialog box
are converted to Vision withholding codes or contribution codes.. Those codes are then assigned
to employees to whom the corresponding adjustment was assigned in FMS.

Method is set to Amount or Percentage, based on the method assigned at the system level, and
Amount or Percent is set to the correct value for the employee.

Inactive Adjustment Withholding Codes

Any withholding codes or contribution codes that the conversion sets up in Vision with Inactivate
when processing payroll selected are assigned to employees with System selected under
Active. That way, once you have modified and made the code active at the system level, it is
automatically activated for all employees to whom it is assigned.

In some cases, the conversion has to add an employee withholding code or contribution code
created from an FMS adjustment that is no longer active for that employee. This is necessary so
that certain reports work correctly in Vision. In those cases, the employee withholding code is set
up with Inactive in the Active column.

TAG and TNP Adjustments

TAG and TNP adjustments in FMS are converted as other pay types in Vision. If an employee in
FMS is assigned a TAG or TNP adjustment with the Lump Sum Amount calculation method, the
conversion converts the amount of the adjustment for that employee to the appropriate Other Pay
box on the Payroll tab of the Employee Info Center. (If the employee has more than one such
FMS adjustment that is mapped to a single type of other pay, the amounts are combined.)

BNS Adjustments

Vision does not process bonuses using a withholding code or other pay type, so BNS payroll
adjustments are not converted. In Vision, you can’t pay a bonus amount on a regular payroll
check. Because of this, if the conversion encounters that situation when converting FMS payroll
record, it increases the regular pay amount by the amount of the bonus.
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Tax Methods

With some exceptions, tax methods that appear in payroll records dated in or after the year you
specified in Beginning Payroll Year to Convert on the Payroll tab of the Additional Vision Setup
dialog box are converted to Vision withholding codes or contribution codes. Those withholding
and contribution codes are then assigned to employees to whom the corresponding tax method
was assigned in FMS. The exceptions are tax methods for employer FICA and employer
Medicare. These are not converted, regardless of when they were last used in FMS.

The conversion sets values in Filing Status, Exemptions, Additional Amount, and Other
Exemptions in Vision based on the corresponding values in FMS and, for system-assigned
taxes, also based on how Vision calculates the taxes.

Inactive Tax Withholding Codes

Any withholding or contribution codes for taxes that the conversion sets up in Vision with
Inactivate when processing payroll selected are assigned to employees with System selected
under Active. That way, once you have modified and made the code active at the system level, it
is automatically activated for all employees to whom it is assigned.

Payroll Direct Deposit

If Use Direct Deposit for Payroll is selected for an employee on the Payroll Direct Deposit tab in
the Employees dialog box in FMS, the employee’s direct deposit account information from that
tab is converted to Vision.

This item in FMS... Is converted to this in Vision...

Payroll Distribution Basis (% of Payroll Method (Percentage or Amount)
Payroll or Payroll Amount)

Seq Seq

Routing Number Bank ID (The number has nine digits in FMS but only
eight digits in Vision. Vision calculates the ninth digit.)

Bank Name Custom field on the FMS tab

Account Number Account Number

Type (Checking or Savings) Account Type (Checking or Savings)

% of Payroll Payroll Percent

Payroll Amt Payroll Amount

Payroll GL Accounts

No information from the Payroll GL Accounts tab in the Employees dialog box is converted.

Payroll Checks Conversion

If you elect to convert Deltek FMS Payroll Plus information to Deltek Vision Payroll, paid payroll
records dated on or after the first day of the year specified in Beginning Payroll Year to Convert
on the Payroll tab of the Additional Vision Setup dialog box are converted to Vision. Included are
check and direct deposit information, withholding detail, and GL transactions.
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Only payroll records from Payroll Plus for Windows are converted. No information from linked
payroll systems or from the DOS version of Payroll Plus is converted.

Related Migration Decisions
“General Vision Decisions” on page 15

“Payroll Decisions” on page 113

Reviewing the Converted Data
To review the converted payroll information, do either of the following:

= Click Reporting » Payroll on the Vision Applications menu, and print the Payroll Check
Register.

= Click Human Resources » Employee Review on the Vision Applications menu.

Records That Will Be Converted

Which payroll records are converted depends on the conversion setup options you specified and
other factors:

= Only payroll records with the Paid status are converted.

= No payroll records are converted that are dated prior to the first day of the year specified
in Beginning Payroll Year to Convert on the Payroll tab of the Additional Vision Setup
dialog box.

= No payroll records are converted that are dated after the ending date of the accounting
period you select in Convert Periods Through on the Accounting Periods subtab on the
Accounts tab of the Vision Conversion Setup dialog box.

= Cancelled checks for which the cancellation is dated the same as the original check are
not converted.

Regular Hours and Amounts

The conversion combines regular and time-off hours and amounts from FMS when setting regular
hours and amounts in Vision.

Checkbook

The FMS checkbook associated with a payroll record is replaced in Vision by the bank code to
which the checkbook was converted.

If you convert historical payroll records, they are assigned the bank code for the default
checkbook you specified on the General tab of the Vision Conversion Setup dialog box.

Adjustments and Taxes

Most payroll adjustment and tax method detail for employee checks is converted to comparable
detail for the Vision withholding codes and contribution codes to which the adjustments and taxes
were converted.

The exceptions are records for Social Security and Medicare taxes and for TAG, TNP, and BNS
adjustments, which are handled in special ways.

In order for certain reports to print correctly in Vision, all withholding codes and contribution codes
referenced in payroll records must be assigned to the employees in those records. If the
conversion finds that an FMS adjustment referenced in a record is no longer being used for the
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employee, it assigns the corresponding withholding code or contribution code to that employee in
Vision but marks it as inactive so it won't be included in payroll processing.

TAG and TNP Adjustments

The amount for a TAG adjustment is converted to an other pay amount in Vision for the other pay
type to which you mapped the TAG adjustment code on the Payroll tab in the Additional Vision
Setup dialog box.

In FMS, a TNP adjustment results in both an addition to taxable gross wages and a deduction for
the same amount. To duplicate this in Vision, these two amounts are converted to an other pay
amount in Vision for the other pay type to which you mapped the TNP adjustment code and to a
deduction amount for a withholding code set up for the TNP adjustment.

Bonuses

In Vision, you can’t pay a bonus amount on a regular payroll check. Because of this, when the
conversion encounters that situation in an FMS payroll record, it increases the regular pay
amount by the amount of the bonus. No withholding code or other pay type is created in Vision for
bonuses.

Advances

Because Vision doesn'’t support the printing of advance checks, payroll records for advances are
converted as negative withholding records, which in turn result in a positive net pay amount. To
accomplish this, the conversion creates an Advances withholding code in Vision. Advance
repayments in FMS are also converted to withholding records for the Advances withholding code
(a positive withholding amount in this case).

GL Transactions

The conversion creates GL transactions in Vision for all accrual-basis GL entries in FMS for the
converted payroll records. Cash-basis transactions are not converted.

The accounts used are the Vision accounts you mapped to the FMS accounts in the original
transactions. When creating the Vision GL entries for a check, the conversion calculates a net
amount for each Vision account for that check.

Entries to reimbursable expense accounts or direct expense accounts are assigned to the
miscellaneous regular project (Z299). Those to indirect expense accounts are assigned to the
miscellaneous overhead project (ZZZ). If you are using organizations in Vision, the conversion
assigns the entry to the organization to which you mapped the FMS account.

For entries to cash accounts, the bank code assigned is the one to which the FMS checkbook
associated with the cash account was converted.
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Appendix D: How Purchase Order Information Is
Converted

Purchase Order Item Codes Conversion

Item codes in Deltek FMS that have been used in purchase orders that will be converted are
converted to purchasing items in Deltek Vision. Shipping methods, tax methods, and
miscellaneous adjustments used in purchase orders are also converted to purchasing items.

In addition, the conversion creates item categories in Vision for each of the item codes, shipping
methods, tax methods, and miscellaneous adjustments used in FMS purchase orders.

If you do not have the Purchase Order feature set, no FMS item codes, shipping methods, tax
methods, and miscellaneous adjustments are converted.
For More Information

To find out more, see “ltem Codes Conversion” on page 212.

Purchase Orders Conversion: General
Purchase orders in Deltek FMS are converted to Deltek Vision purchase orders.

For FMS purchase orders with unreceived items that are expensed to projects, the conversion
also creates an AP voucher for those items and marks them as fully received on the purchase
order.

Related Migration Decisions

“Accounts Payable Transactions, Employee Expenses, and Purchase Orders to Convert
Decisions” on page 23

“Inactive Vendors Decision” on page 20

Reviewing the Converted Data
To review the converted purchase orders, do either of the following:

= Click Reporting » Purchasing on the Vision Applications menu, and print or view the
Purchase Order Detail report.

= Click Accounting » Accounts Payable » Vendor Review on the Vision Applications
menu, and go to the Purchase Orders tab.

Records That Will Be Converted
Which purchase orders are converted depends on the conversion setup options you specify:

= If you select Only Convert AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or Before on the General tab of the Vision Conversion Setup dialog
box, no purchase orders are converted that are dated prior to the cutoff date you
specified.

= No purchase orders are converted that are dated after the ending date of the accounting
period you select in Convert Periods Through on the Accounting Periods subtab on the
Accounts tab of the Vision Conversion Setup dialog box.
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= If you select Convert Active Vendors Only on the General tab of the Vision Conversion
Setup dialog box, closed purchase orders entered for vendors that are now inactive are
not converted. If there are open purchase orders for an inactive vendor, they and the
vendor are converted automatically.

= If you select Convert Open Purchase Orders Only on the General tab of the Vision
Conversion Setup dialog box, no closed purchase orders are converted.

= Cancelled purchase orders are not converted.

Closed Purchase Orders
When it converts a closed purchase order, the conversion does the following:
= |t creates a purchase order in Vision.

= It adds the purchase order number to the line items in the AP vouchers in Vision with
which the purchase order items were received.

Open Purchase Orders
When it converts an open purchase order, the conversion does the following:
= |t creates a purchase order in Vision.

= For any items received in FMS, it adds the purchase order number to the line items in the
AP vouchers in Vision with which the items were received.

= If the purchase order is a Standard, Blanket, or Drop Ship type, it creates an AP voucher
for any unreceived items that have been expensed to projects and marks those items as
received on the Vision purchase order. Open items that aren’t expensed to projects
remain as open items on the Vision purchase order.

It is necessary to create AP vouchers for expensed items because Vision does not allow you to
expense and bill unreceived items. If the conversion did not create vouchers for them, the Vision
general ledger would not balance. Here are some of the key data items in the AP vouchers
created from purchase orders:

This AP voucher item... Is set to...

Voucher number "P” followed by the purchase order number
Invoice number "P” followed by the purchase order number
Accounting period Vision period in which the order date falls
Transaction date Order date

Invoice date Order date

Payment terms Hold

Work breakdown structure for each | Vision work breakdown structure components, based
line item on your WBS conversion options

GL expense account for each line | The applicable Vision GL expense account that you
item (project cost transaction) mapped to the FMS expense code

GL expense and liability accounts | The Vision GL account that you mapped to the GL
for each line item (GL transaction) | accounts in the original FMS expense transaction
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This AP voucher item... Is set to...

Organization for each line item The organization you mapped to the FMS account
Expense account distribution Each account’s share of the unreceived cost. For a
amounts for each line item (GL partially received item, this would be proportional to the
transaction) account’s share of the total cost

Purchase order for each line item The number of the purchase order from which the
voucher was created

Purchase Order Number

The FMS purchase order number becomes the Vision purchase order number.

The conversion also sets the next purchase order number on the General tab in the Company
Purchasing Configuration form to the number following the last FMS purchase order number.
Vendor

The FMS vendor becomes the Vision vendor.

Purchase Order Type

Standard, Requisition, Commitment, and Drop Ship purchase orders are converted to Standard
purchase orders in Vision. Blanket purchase orders are converted to Vision Blanket purchase
orders.

If any of the converted purchase orders is a requisition, the conversion checks Require
purchase orders to be approved on the General tab in the Purchasing & Inventory Company
Settings form.

Order Date and Required By Date

The FMS order date becomes the Vision order date.

For a Blanket purchase order, the order date also becomes the start date under Blanket Order
on the Agreement tab in the Purchase Orders form, and the required by date in FMS becomes
the ending date for the Blanket purchase order.

The required by date is also converted to the due date for each line item in the Vision purchase
order.
Payment Terms

If the payment terms for the FMS purchase order sets a due date based on the number of days
after the invoice date, the terms for the Vision purchase order is set to that number of days. If the
FMS terms set the due date as a specific day of the month, the terms in Vision are set to Next.

Status

If the purchase order is closed in FMS, it is marked as closed in Vision.

If all unreceived items on the FMS purchase order are expensed to projects, they will all be
marked as received during the conversion and the purchase order in Vision will be marked as
closed.
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Ordered By and Approved By

The employee identified in Ordered By in FMS is assigned as the buyer in Vision. The employee
selected in Approved By in FMS appears as the authorizing employee in Vision.

In addition, each employee that appears in Ordered By on an FMS purchase order is added to
the list of buyers on the Buyer/Approver tab in the Purchasing & Inventory Company Settings
form in Vision. Each employee that appears in Approved By in FMS is added to the list of
approvers on that same Vision tab. The conversion selects Close P.O. for all employees listed as
buyers or approvers, so they can close purchase orders in Vision.

FOB

The conversion creates an FOB code on the Ship tab in the Purchasing & Inventory Company
Settings form in Vision for each of the FOB options in FMS. The FOB selection for each purchase
order is converted to Vision unchanged.

Comment and Notes

If you entered a comment for the purchase order as a whole, it is converted as the description for
the Vision purchase order. If you didn’t enter a comment but did enter notes in FMS, the notes
are converted to the description.

Items Ordered and Adjustments

In most cases, each item ordered and each tax, shipping, or miscellaneous adjustment entered
for a purchase order in FMS is converted to an equivalent line item in the Vision purchase order.
For more information about the conversion of ordered items and adjustments, see “Purchase
Orders Conversion: Items and Adjustments” on page 269.

Purchase Order Address

If the Order To address for the purchase order in FMS is one of the addresses for the vendor,
that address is used as the purchase order address in Vision. If the Order To address in FMS
was not one of the vendor’s addresses, the vendor’s Primary address is used in Vision.

Bill To Address

If the Bill To address for the purchase order in FMS is one of the addresses for your company,
that address is used as the Bill To address in Vision. If the Bill To address in FMS was not one
of your company’s addresses, the company’s Primary address is used in Vision.

Ship To Address

If the Ship To address in FMS is one of the company’s addresses, the Ship To code created in
Vision for that address is assigned to the purchase order. If it is not one of the company
addresses, Ship To is set to Other. In this case, the shipping address and contact information
comes from the employee, contact, or firm associated with the Ship To address in FMS.

Project Expenses

Project expense information entered for purchase orders in FMS is not converted as part of the
purchase order information.

= For closed purchase orders, the project expenses are converted as part of the conversion
process for the AP invoices on which they were received.
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=  For purchase orders with unreceived items expensed to projects, the conversion process
for purchase orders creates an AP voucher in Vision containing those items. As part of
that process, it creates the necessary expense records in Vision.

Purchase Orders Conversion: Items and Adjustments

General Description

In most cases, each item ordered and each tax, shipping, or miscellaneous adjustment entered
for a purchase order in Deltek FMS is converted to an equivalent line item in the Deltek Vision
purchase order.

Possible exceptions to this are items to be closed based on the dollar amount received rather
than number of units received and items that are partially backordered. In these cases, one FMS
line item may be split into two in Vision.

Item Code and Description

The item code (or adjustment) and description are converted to the purchasing item and
description for the line item in Vision. The item code also becomes the item category for the line
item.

Vendor Item Number

The vendor item number isn’t used in Vision, but the conversion puts it into Extra Notes for the
line item in Vision.

Units and Unit Description

For most line items, the units in FMS are converted to Vision without change. (A converted
adjustment line item will have one unit.)

If a line item is split because it is only partially received and its received status is based on the
dollar amount received rather than units, one Vision line item will have the unreceived amount
and the second will have the received amount. If a line item is split because a portion of the units
are backordered, one Vision line item will have the backordered units and the second those not
backordered.

The FMS unit description becomes the unit of measure for the Vision line item.

Unit Cost, Discount, Amount, and Adjustment Amount

The unit cost, discount, amount (units x unit cost), and adjustment amount in an FMS line item
are not converted directly. The Vision unit price for a line item is calculated as the net dollar
amount + units. (The net dollar amount reflects any discount and allocated adjustments.)

Department

If you specify a department in FMS for a line item that isn’'t expensed to a project and you are
converting departments to organizations, the line item in Vision is assigned to the organization to
which the department was converted. If you are converting departments to organizations but the
line item has no department specified, it is assigned to the default organization.

Allocation Method

AP allocation methods are not converted to Vision.
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Track Receiving By

In FMS, you can set up a line item so that its receiving status is determined based on the dollar
amount received rather than the units, but Vision does not have this feature. Because of this, if
such a line item is only partially received, it is split into two line items in Vision. One Vision line
item will be for the unreceived amount and will remain open, and the other will be for the received
amount and be marked fully received.

Units Received

For an expensed line item, the number of units received in Vision is the same as the number of
units ordered because the conversion creates an AP invoice to receive any units not received in
FMS. For the extra line items created because the received status is based on amount received
or because part of the units are backordered, units received will be zero.

For all other line items, the units received in Vision will match the units received in FMS.

Units Backordered

If a line item has backordered units in FMS, the conversion splits it into two line items in Vision.
One Vision line item will have the backordered units and the Backordered receiving status. The
second Vision line item will have the units not backordered.

Status

The conversion uses the FMS line item’s status (Open or Closed) and what has been received, if
anything, to set the receiving status (Partially Received, Fully Received,...) for the line item in
Vision. If nothing has been received, the Vision line item has no receiving status.

Item and Project Expense Comments

If an item code comment exists for an FMS line item, the conversion puts it into Internal Notes
for the line item in Vision.

If a project expense comment exists for an FMS line item, the conversion puts it into Extra Notes
for the line item in Vision.

Work Breakdown Structure

If a line item is not expensed to a project in FMS, it is assigned to the miscellaneous overhead
project (ZZZ) in Vision. If it is expensed, it is assigned to a project and other work breakdown
structure components based on its FMS work breakdown structure and the WBS conversion
options you selected.

Received Items Conversion

If you have received items on a purchase order using the Received Items dialog box in Deltek
FMS, those receiving transactions are converted to Deltek Vision purchase order receiving
records.

The exceptions are received items for purchase orders with associated project expenses. Before
the final conversion, you must convert those receiving records to AP invoices in the Invoices
dialog box in FMS.
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Related Migration Decisions

“Accounts Payable Transactions, Employee Expenses, and Purchase Orders to Convert
Decisions” on page 23

“Inactive Vendors Decision” on page 20

Reviewing the Converted Data
To review the converted receiving information, do either of the following:

= Click Reporting » Purchasing on the Vision Applications menu, and print or view the
Received Purchase Order Items report.

= Click Purchasing » Receiving on the Vision Applications menu.

Records That Will Be Converted

Which items received transactions are converted depends on the conversion setup options you
specify:

= If you selected Only Convert AP Invoices, Employee Expense Sheets, and Purchase
Orders Dated On or Before on the General tab of the Vision Conversion Setup dialog
box, no receiving transactions are converted that are dated prior to the cutoff date you
specified.

= No receiving transaction are converted that are dated after the ending date of the
accounting period you select in Convert Periods Through on the Accounting Periods
subtab on the Accounts tab of the Vision Conversion Setup dialog box.

Transactions That Include More Than One Purchase Order

In Vision, each receiving transaction is for one purchase order, but in FMS, you could receive
items for multiple purchase orders on one receiving transaction. If the conversion encounters an
FMS receiving transaction that includes more than one purchase order, it creates a separate
receiving record in Vision for each purchase order.

Iltems That Are Expensed to Projects

Vision does not support expensing purchase order items to projects. If an FMS receiving
transaction includes items expensed to projects, those are not included in the receiving
transaction in Vision. Instead, when the purchase order is converted, they are received on the AP
voucher the conversion creates for expensed items that haven’t been received on an invoice.

Vision does not support expensing purchase order items to projects. If the purchase order for an
FMS receiving transaction includes items expensed to projects, you must convert those receiving
records to AP invoices in the Invoices dialog box in FMS before the final conversion.

Vendor and Purchase Order

The vendor and purchase order for the receiving transaction in FMS become the vendor and
purchase order for the Vision receiving transaction.

Received On Date

The received on date in FMS becomes the receipt date in Vision.
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Reference and Notes

If you enter reference text or notes for the receiving transaction in FMS, they are converted to the
notes for the Vision receiving transaction.

Units Received

The number of units received for each line item becomes the quantity accepted for the
corresponding line item in the Vision transaction.
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1099 forms, 190, 218, 243
401(k) plans, 258, 260
About Deltek Vision dialog box, 16

Account number structure
converting to organization codes, 45
in FMS, 27, 28
in Vision, 27, 28, 29, 121

Account types
conversion description, 220
expense account ranges for, 31
in FMS, 26
in Vision, 26

Accounting manager, 8
Accounting methods, 112, 178

Accounting periods
conversion options, 124
last converted period, 154

Accounts

account number structure, 27, 28, 29,
121, 220

accounts payable liability accounts, 214

accounts receivable accounts, 105, 150

AP discount account, 180

AP discount accounts, 150

billing income accounts, 108, 150

bonus cost account, 116

budgets for, 131

changing descriptions, 77

combining during conversion, 77

company accounts, 150

consolidation accounts, 26

consultant accrual expense credit
accounts, 107

conversion description, 219

current net income accounts, 150

current year profit and loss accounts, 150

direct expense accounts, 75

employee expense advance credit
accounts, 107

employee expense credit accounts, 106,
107, 150

employee payroll accounts, 264

employee payroll advance accounts, 263,
266

employer contribution expense accounts,
262

employer-paid tax expense accounts, 258

expense account number ranges, 123

expense accounts, 27, 37, 80, 81

expense credit distribution accounts, 106,
150

FICA expense accounts, 258

for billing groups, 205

for checkbooks, 179

for departments, 209

for expense codes, 212

for fee methods, 192

for item codes, 215

for miscellaneous adjustments, 215

for shipping methods, 215

for tax fee methods, 95, 193

for tax methods, 215

for time-off codes, 186

for vendors, 218

income accounts, 27

labor credit accounts, 106

mapping expense codes to, 79, 139

mapping to organizations, 73, 136

mapping to Vision accounts, 73, 136

miscellaneous indirect expense credit
accounts, 107

payroll adjustment accounts, 262

PR-TR Differences accounts, 107

reproduction expense credit accounts,
107

retainage receivable accounts, 105

retained earnings accounts, 150, 219

revenue accounts, 27

salaries payable accounts, 106

shortening account numbers, 30

summary accounts, 26

tax liability accounts, 258

unbilled income accounts, 104

unbilled revenue accounts, 104

unbilled services accounts, 104

unearned income accounts, 104

using separate accounts for principals and
contacts, 182

Accounts payable
balancing, 168
liability accounts, 214
transactions conversion, 20, 69, 119

Accounts receivable
accounts for billing categories, 150
AR comments, 6
balancing, 167
outstanding AR, 112
transactions conversion, 69
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Accounts Receivable Collections module, 6,
69

Accounts Receivable Ledger report, 234
Action dates, 254

Action types, 255

Actions conversion, 6, 69

Activating Vision modules, 163

Activity cutoff date, 69

Additional Vision Setup dialog box
Accounting Company Settings tab, 104,
106, 108, 110, 113, 114, 150
Payroll tab, 115, 151

Add-on billing category, 109, 111
Add-ons, 147

Addresses
billing group invoice, 203
company, 178
contact, 181
converting country portion, 119
employee, 188
firm, 195, 217
project invoice, 198
purchase order, 270
vendor, 243
voucher, 243

Adjust Salary Job Cost process, 67, 130
Adjustment types, 259

Adjustments, miscellaneous
conversion description, 271
linking to expense codes, 153
removing spaces from, 153

Adjustments, payroll
amounts for on payroll checks, 266
bonuses, 116
employee adjustments, 189, 263
other pay types for, 116
removing spaces from, 153

Advances, employee expense, 154
Advances, payroll, 263, 266
After-tax additions, 258

After-tax deductions, 258

Alchemy document management system,
179

Alerts, 205

Allocation methods, 220, 271
Allocation, overhead, 6
Alternate start dates, 189
Annual charge rates, 190

AP Aging report, 157, 166, 168
AP discount accounts, 150, 180
AP transaction numbers, 242
Application administrator, 8
Approval, time record, 153
Approval, time sheet, 153, 184
AR Aged report, 167

AR Aging report, 157, 166, 167
Archive companies, 7, 178, 179
Asset accounting system, 179
ATA adjustments, 258

ATD adjustments, 258
Available hours, 185, 189
Backing up database, 156, 159
Backorders, 272

Balancing
accounts payable data, 168
accounts receivable data, 167
general ledger data, 166
project cost data, 170
purchase order data, 173

Bank codes, 119, 153, 238, 243, 249, 252
Basic conversion level, 5, 34, 69, 116
Basis, fee method, 90, 92, 192

Bill hours, 183, 225

Bill to addresses, 270

Billing

bill hours, 183, 225

billing budgets, 213

billing categories, 108, 111, 150, 234

billing fees, 207

billing messages, 205, 207

billing rate schedules, 89, 144, 145, 147,
193, 194, 195

billing rates, 89, 188

billing reports, 199

billing status, 225, 228, 240, 246, 253

billing terms, 87, 109, 148
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billing types, 202

billing units, 229, 241, 246, 254
by labor category, 52, 53, 86

by labor code, 54

by staff type, 52, 53, 54
converting labor rate exceptions for, 144
default employee billing rates, 89
for taxes, 94

income accounts, 108, 150
invoice formats, 96

Vision expense codes and, 80
WBS levels and, 38

Billing categories, 108, 111, 150, 234
Billing fee history, 183, 203

Billing fees, 203, 207

Billing group managers, 205, 207

Billing groups
billing group 1D, 201
billing group title, 201
billing rate schedules for, 195
conversion description, 200
conversion options, 126
in expense records, 227, 239, 245, 253
in time records, 224
staffing conversion, 132
tax fee methods for, 193

Billing income accounts, 108, 150
Billing messages, 205, 207

Billing rate schedules
expense rate, 195
fee methods, 145, 147
labor rates, 89, 144, 194
tax fee methods, 193

Billing rates, 89, 188

Billing reports, 199

Billing status, 225, 228, 240, 246
Billing statuses, 253

Billing terms, 87, 109, 148

Billing types, 41, 197, 200, 202

Billing units, 229, 241, 254

BNS adjustments, 258, 262, 264, 266
Bonus cost account, 116
Bonuses, 116, 258, 262, 264, 266

Budgets
cost type, 64

department, 47, 64
employee, 63

expense code, 65

general ledger, 131

labor category, 52

labor code, 63
organization, 47

percent of direct hours budget, 188
phase, 63

project, 69, 132

staff type, 63

vendor, 65

Vision labor codes and, 85

Business Management Data Archiving tool,
7

Business Management Only version of FMS,
5

CAF adjustments, 258

Cafeteria deductions, 258

Cafeteria plans, 258, 260

Calculation methods, 259, 260
Canceled transactions, 242
Cash-basis accounting, 112
Categories, billing, 108, 111, 150, 234
Categories, labor, 128, 142

Charge Account Aging report, 157, 166, 168
Charge accounts, 20

Charge payments, 248

Charge rates, annual, 190

Chart of accounts
adding direct expense accounts, 75
conversion description, 219
mapping FMS accounts to organizations,
73, 136
mapping FMS accounts to Vision
accounts, 73, 136

Check dates, 248
Check numbers, 234, 236, 248, 250

Checkbooks
changing checkbook IDs, 153
conversion description, 250
default checkbook, 119
for payroll records, 265
for receipts, 233, 236

Checks
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check types, 250
spoiled checks, 250
stub overruns, 250
voided checks, 250

Classification labels
billing group, 205
client, 196
employee, 188
employee expense, 190
firm, 196
phase, 207
project, 199
vendor, 190, 217

Client implementation team, 8

Clients
client firms, 195
for AR collection actions, 254
for AR invoices, 230
for billing groups, 41, 197, 200, 203
for projects, 198
for receipts, 233

Closed purchase orders, 268
Code Revision tool, 152
Collection actions conversion, 6
Collection notifications, 196
Combined basis, 90, 92

Comments
collection actions converted as, 6
for expense records, 229, 241, 246, 254,
272
for purchase orders, 270, 272
for time records, 182, 203, 226
global comments conversion, 184

Companies
archive, 7, 178, 179
consolidation, 7, 178
elimination, 7, 178
multiple companies, 6, 177

Company accounts, 150
Company name, 178
Completed projects, 70, 88, 198
Completion percentage, 204
Configuration, 162
Consolidation accounts, 7, 26

Consolidation companies, 7, 178

Consultant accrual expense credit accounts,
107

Consultant billing category, 109, 111

Consultants
expense accounts for, 33
expense codes for, 82

Contacts
billing contact, 204
conversion description, 196, 217
using separate accounts for, 182

Contract information, 204

Conversion
billing groups, 200
clients, 195
conversion levels, 5
conversion types, 14, 119
data not converted, 6
fee methods, 192
final conversions, 12
GL accounts, 219
global comments, 184
Info Center data, 5
item codes, 271
loading converted data, 12
miscellaneous adjustments, 271
overview, 5, 11
projects, 196
purchase orders, 271
received items, 153
shipping methods, 271
System Manager control information, 177
tax methods, 271
test conversions, 11, 13
time-off codes, 184
transaction data, 5

Conversion levels, 69
Conversion templates, 98
Coordinator, 8

Copying database, 159
Cost amounts, 132, 153
Cost budgets, 213

Cost rates, 58, 187, 226

Cost types
AR transaction distributions for, 231
budgets for, 64
default for expense codes, 212
in expense records, 228, 240, 246, 253
in time records, 225
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income accounts for, 109
specifying for the AR Transaction Record
report, 111

Cost Types dialog box, 70
Costs, unit, 212
Countries in addresses, 119

Create Mirror Image for Direct Accounts
dialog box, 75

Credit limit, 196

Credit memos
AR, 154, 235

Credit purchases, 238

Current accounting period, 35

Current net income accounts, 150
Current year profit and loss accounts, 150
Custom conversion templates, 98
Custom Format Settings dialog box, 98
Custom invoice formats, 148

Customer Care Connect site, 160

Cutoff dates
for AP transaction conversion, 25
for payroll conversion, 116
for project conversion, 69
for transaction conversion, 35, 154

Data conversion
billing groups, 200
clients, 195
data not converted, 6
fee methods, 192
final conversions, 12
GL accounts, 219
global comments, 184
Info Center data, 5
item codes, 271
loading converted data, 12
miscellaneous adjustments, 271
overview, 5, 11
projects, 196
purchase orders, 271
received items, 153
shipping methods, 271
System Manager control information, 177
tax methods, 271
test conversions, 11
time-off codes, 184
transaction data, 5

Data entry
alerts for, 205
WBS levels and, 38

Database server, 7

Databases
companies and, 6
creating backup copy, 159
installing, 7
submitting for conversion, 160

Dates

accounting period start and end dates,
221

activity cutoff date for project conversion,
69

alternate start date, 189

AR collection action dates, 254

check dates, 248

cutoff date for AP transaction conversion,
25

cutoff date for payroll conversion, 116

cutoff date for transaction conversion, 35,
154

due dates, 180

effective dates, 88, 231, 238, 243, 252

entry dates, 238, 252

invoice dates, 231, 243

order dates, 269

receipt dates, 233, 236

received on date, 273

required by dates, 269

time record dates, 225

Decisions, migration

account number structure, 29

accounts mapping, 73

billing income accounts, 108

checking using preconversion utilities, 154

conversion type, 14

expense codes-to-accounts mapping, 79

expense credit distribution accounts, 106

FMS accounts-to-Vision accounts
mapping, 73

overview, 14

projects to convert, 68

recording in Vision Conversion module,
118

WABS - labor codes, 49

Default Accounts/Organizations dialog box,
75

Default checkbooks, 119
Default codes for Vision labor codes, 85

Default organizations, 73, 78
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Deleted transactions, 242
Delimiters, 41, 55
Deltek Customer Care Connect site, 160

Deltek FMS
DOS version, 24, 34, 69
preparing for migration, 10

Deltek FMS to Deltek Vision Migration
Guide, 1

Deltek Vision
activating modules, 163
configuring, 162
hardware selection, 7
installation, 7
logging on to, 162
Payroll, 119
Resource Planning, 119
setting up security, 163
setting up server side email, 163
setting up the process server, 164
specifying version, 119

Departments
billing group departments, 202
budgets for, 47, 64
chart of accounts conversion and, 29
conversion options, 126

distribution of income and expenses to, 47

employee departments, 188

fixed department allocation, 203

in AR invoice transactions, 232

in expense records, 228, 240, 245, 253
in purchase orders, 271

in time records, 224

mapping to organizations, 135
mapping to Vision labor codes, 141
removing during conversion, 49, 73
tracking time and expenses by, 182

Deposit numbers, 233, 236, 250

Deposits
deposit types, 250

Dialog boxes (FMS)
Additional Vision Setup dialog box

Accounting Company Settings tab, 104,

106, 108, 110, 113, 114, 150

Payroll tab, 115, 151

Cost Types dialog box, 70

Create Mirror Image for Direct Accounts
dialog box, 75

Custom Format Settings dialog box, 98

Default Accounts/Organizations dialog
box, 75

FMS Accounts — Vision Accounts
Mapping dialog box, 74, 136

FMS Billing — Vision Billing Terms dialog
box - Custom Invoice Formats tab, 95,
148

FMS Billing — Vision Billing Terms dialog
box - Fee Methods tab, 90, 147

FMS Billing — Vision Billing Terms dialog
box - Labor Rate Schedules tab, 87,
144

FMS Billing — Vision Billing Terms dialog
box - Tax Methods tab, 94, 145

FMS Codes — Vision Labor Codes dialog
box, 83, 141

FMS Department — Vision Organization
Mapping dialog box, 72, 135

FMS Department — Vision WBS Mapping
dialog box, 72

FMS Expense Codes — Vision Accounts
Mapping dialog box, 79, 139

FMS Projects to Convert dialog box, 68,
133

FMS Staff Types — Vision Labor Category
Mapping dialog box, 85, 142

Pre-Conversion Utilities dialog box, 154

Serial Number dialog box, 10

Update Deltek FMS dialog box, 10

Vision Conversion Setup dialog box -
Accounts tab, 29, 30, 33, 121, 123, 124

Vision Conversion Setup dialog box -
Employees tab, 56, 58, 130

Vision Conversion Setup dialog box - FMS
Miscellaneous BM tab, 61, 62, 65, 67,
132

Vision Conversion Setup dialog box -
General tab, 16, 18, 19, 20, 21, 22, 24,
119

Vision Conversion Setup dialog box - GL
Budgets tab, 59, 131

Vision Conversion Setup dialog box -
Labor Codes tab, 52, 54, 128

Vision Conversion Setup dialog box -
WABS tab, 39, 42, 46, 50, 126

Dialog boxes (Vision)

About Deltek Vision, 16

Direct deposit

employee expenses, 190
payroll, 264
vendor payments, 219

Direct expenses

account number range for, 32
definition, 27

Direct hours budget, 188
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Discounts
in AP payments, 248
in AP transactions, 243
in project receipts, 235
in purchase orders, 271
in vendor payment terms, 119, 180

Document management system, 179
Due dates, 180

ECT adjustments, 258, 260

Effective cost rates, 58, 132, 153

Effective Cost Rates Calculation tool, 153

Effective dates
for AP transactions, 243
for AR invoices, 231
for employee expenses, 238
for GL transactions, 252
for labor billing rates, 88, 89, 195

EIN, 178
Elimination companies, 7, 178
Email, server side, 163

Employee expense advance credit
accounts, 107

Employee expense advances, 154

Employee expense credit accounts, 106,

107, 150

Employee expenses
conversion description, 189
conversion options, 119
partially paid expense sheets, 154

Employee Ledger report, 168

Employees
adding to labor rate tables, 88
creation of vendors for, 219
default billing rates, 89
including on project teams, 132
labor categories for, 52
labor rate exceptions for, 144
organizations for, 45
payroll advances, 263, 266
percent of direct hours budgets, 18
rate information, 18
review information, 189
roles for, 163
staff types, 210
terminated employees, 20, 89

Employer contribution expense accounts,

262

Employer contributions, 258, 260
Employer matching adjustments, 261
Employer’s firm, 181

Entry dates
for employee expenses, 238
for GL transactions, 252

Exceeds available hours warning, 185
Executive sponsor, 8

Expense accounts
account number ranges for, 123
for consultants, 71
in FMS, 27
in Vision, 27, 37, 80
mapping expense codes to, 81
other accounts, 27

Expense billing category, 109, 111
Expense budgets, 65, 213

Expense codes
budgets for, 65
conversion description, 80, 227, 239
expense code types, 80, 82
for subcontractors, 71
in expense records, 245, 252
linking to item codes, 153
mapping to Vision accounts, 79, 139
Vision expense codes, 80

Expense credit distribution accounts, 106,

150
Expense rate exceptions, 195
Expense sheet numbers, 238
Expense sheets, 6, 154, 227

Expenses
employee expenses, 119, 154, 189

entered for receiving transactions, 153,

273
entered with purchase orders, 270
reimbursable consultant expenses, 71
reimbursable expenses, 71
tracking by departments, 182
unbilled, 70
updating project teams from, 61

FAS asset accounting system, 179
Federal EIN, 178
Fee billing category, 109, 111

Fee methods
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conversion options, 147
in AR invoice transactions, 232
tax fee methods, 145, 192

FICA, 256, 264
Final conversions, 12

Finance charges
on AR invoices, 232

Financial reports, 47
Firm types, 181

Firms. See also Clients, Vendors
contact employer’s firm, 181
conversion description, 195

Firm-vendor ID, 217
Fiscal years, 124, 221
Fixed department allocation, 203

FMS Accounts — Vision Accounts Mapping
dialog box, 74, 136

FMS Billing — Vision Billing Terms dialog box
Custom Invoice Formats tab, 95, 148
Fee Methods tab, 90, 147
Labor Rate Schedules tab, 87, 144
Tax Methods tab, 94, 145

FMS Codes — Vision Labor Codes dialog
box, 83, 141

FMS Department — Vision Organization
Mapping dialog box, 72, 135

FMS Department — Vision WBS Mapping
dialog box, 72

FMS Expense Codes — Vision Accounts
Mapping dialog box, 79, 139

FMS Projects to Convert dialog box, 68, 133

FMS Staff Types — Vision Labor Category
Mapping dialog box, 85, 142

FMS, Deltek
DOS version, 24, 34, 69
preparing for migration, 10

FOB codes, 270
Form 1099, 190, 218, 243

Form W-2
current Form W-2 quarter, 154
current Form W-2 year, 116, 154
payroll adjustment line labels for, 262

Formats, invoice, 148

Frequency
job cost, 130
payroll, 130
timesheet, 130

FUTA, 256, 264

General ledger account structure
converting to organization codes, 45

General ledger accounts

account number structure, 27, 28, 29,
121, 220

accounts payable liability accounts, 214

accounts receivable accounts, 105, 150

AP discount account, 180

AP discount accounts, 150

billing income accounts, 108, 150

bonus cost account, 116

budgets for, 131

changing descriptions, 77

combining during conversion, 77

company accounts, 150

consolidation accounts, 26

consultant accrual expense credit
accounts, 107

conversion description, 219

current net income accounts, 150

current year profit and loss accounts, 150

direct expense accounts, 75

employee expense advance credit
accounts, 107

employee expense credit accounts, 106,
107, 150

employee payroll accounts, 264

employee payroll advance accounts, 263,
266

employer contribution expense accounts,
262

employer-paid tax expense accounts, 258

expense account number ranges, 123

expense accounts, 27, 37, 80, 81

expense credit distribution accounts, 106,
150

FICA expense accounts, 258

for billing groups, 205

for checkbooks, 179

for departments, 209

for expense codes, 212

for fee methods, 192

for item codes, 215

for miscellaneous adjustments, 215

for shipping methods, 215

for tax fee methods, 95, 193

for tax methods, 215

for time-off codes, 186
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for vendors, 218 Hourly base billing rates, 188
income accounts, 27
labor credit accounts, 106
mapping expense codes to, 79, 139 Hours budgets, 213
mapping to organizations, 73, 136
mapping to Vision accounts, 73, 136
miscellaneous indirect expense credit Implementation team, 8
accounts, 107
payroll adjustment accounts, 262

Hourly cost rates, 187

Hours per period, 187

Inactive billing groups, 201

PR-TR Differences accounts, 107 Inactive clients, 196
reproduction expense credit accounts, .

107 Inactive contacts, 181
retainage receivable accounts, 105 Inactive departments, 209
retained earnings accounts, 150, 219 ) )
revenue accounts. 27 Inactive employee payroll adjustments, 263
salaries payable accounts, 106 Inactive employee tax methods, 264
shortening account numbers, 30 . i
summary accounts, 26 Inactive payroll adjustments, 259
tax [iabili_ty accounts, 258 Inactive payroll tax methods, 257
unbilled income accounts, 104 .
unbilled revenue accounts, 104 Inactive phases, 207

unbilled services accounts, 104
unearned income accounts, 104 .
using separate accounts for principals and Inactive vendors, 119, 219

contacts, 182 Income accounts, 27, 108, 150

Inactive projects, 70, 88, 198

General ledger beginning year, 34 Info Center data

General ledger budgets, 131 billing groups conversion, 200
choosing to convert, 15
clients conversion, 195
fee methods conversion, 192

General ledger data
balancing, 166

General ledger posting, 154 GL accounts conversion, 219
. global comments conversion, 184
General ledger transactions projects conversion, 196
for AP payments, 249 System Manager control information
for AP transactions, 244 conversion, 177
for AR invoices, 232 time-off codes conversion, 184
for AR receipts, 234 _ _
for employee expenses, 239 Information systems representative, 8
for expense records, 2_29 Invoices
for miscellaneous receipts, 236 addresses, 198, 203
for payroll checks, 266 AP invoices, 119
for time records, 226 invoice dates, 231, 243
GL Trial Balance report, 157, 166 invoice formats, 148
) invoice numbers, 183, 199, 231, 234, 243,
Global comments conversion, 184 248, 255
Global labor codes, 50 invoice templates, 148
Go live date, 13 Item categories, 153
Government contracting information, 205 ltem category types, 216
Hardware selection, 7 ltem codes o
. o conversion description, 271
History, billing fee, 183, 203 in AP transactions, 244
Hold status. 119. 180. 244 Ilnklng to expense codes, 153

Migration Guide 281



Index

Deltek Kwovmore

removing spaces from, 153
vendor item code assignments, 218

Job cost frequency, 130

Job cost rates, 58

Labels, user-defined, 183
Labor billing category, 109, 111
Labor budgets, 63, 213

Labor categories, 128, 142
Labor category tables, 144

Labor codes, FMS
conversion options, 49, 126
in time records, 225
mapping to Vision labor codes, 141
project conversion and, 69

Labor codes, Vision
converting departments to, 126
converting FMS labor codes to, 49, 126
converting phases to, 126, 206
converting staff types to, 128
delimiters, 55
description, 37
levels, 55, 56
mapping FMS codes to, 141
structure, 128

Labor credit accounts, 106

Labor periods, 130

Labor rate exceptions, 144, 194, 195
Labor rate schedules, 144

Labor rate tables, 144

Last names, 181

Legal names, 187

Levels
conversion levels, 69
for labor codes, 55, 56
for organizations, 45

Log files, 156
Logging on to Vision, 162

Managers
billing group, 205, 207
department, 209
phase, 205, 207
project, 198, 205, 207

Markups, unit, 212, 229, 241, 246, 254

Maximum add-on fee amounts, 90, 93, 192
Maximum hours, 185, 188

Maximum payroll adjustment amounts, 261
Maximum payroll tax amounts, 258
Medicare, 256, 264

Messages, billing, 205, 207

Migration decisions

account number structure, 29

accounts mapping, 73

billing income accounts, 108

checking using preconversion utilities, 154

conversion type, 14

expense codes-to-accounts mapping, 79

expense credit distribution accounts, 106

FMS accounts-to-Vision accounts
mapping, 73

overview, 14

projects to convert, 68

recording in Vision Conversion module,
118

WABS - labor codes, 49

Migration guide, 1
Migration planning, 8

Migration process
overview, 1
planning, 8
prepare FMS, 10
prepare Vision, 7

Minimum bill hours increment, 183
Minimum overdue days, 191

Minimum payroll adjustment amounts, 261
Minimum work hours increment, 183

Miscellaneous adjustments
conversion description, 271
in AP transactions, 244
linking to expense codes, 153
removing spaces from, 153

Miscellaneous indirect expense credit
accounts, 107

Modules, activating, 163

Multicompany feature, 6

Multipliers, overtime, 187, 226
Multipliers, unit, 212, 229, 241, 246, 254
Names, 187
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Non-taxable deductions, 258

Notes
for accounts, 221
for AR collection actions, 255
for AR invoice transactions, 232
for item codes, 216
for purchase orders, 270
for receiving transactions, 274

NTD adjustments, 258

Office Earnings report, 170
Office/division administrator, 8
Open purchase orders, 268

Open Purchase Orders report, 173
Order dates, 269

Order to addresses, 270

Organizations
budgets for, 47, 60, 222
conversion background, 45
converting departments to, 29, 126, 135
default organization, 73
distribution of income and expenses to, 47
for AP payments, 249
for AR receipts transactions, 234
for miscellaneous receipts, 236
for vendors, 217
levels, 45
mapping accounts to, 73, 136
reporting by, 44, 47

Original cost rates, 132

Other account type, 26, 27, 74

Other pay types, 116, 258, 260
Outstanding Retainer report, 154, 157
Overdue days, 191

Overhead allocation, 6

Overhead Allocation Assignment tool, 6
Overhead projects, 36, 41, 197, 200

Overtime
hours, 225
multipliers, 187, 226
pay types allowed to have, 183

Partially paid employee expense sheets,
154

Password, 7

Pay period salaries, 187

Pay types, 116, 183, 187
Pay When Paid status, 180, 244

Payment terms conversion, 119, 214, 217,
232, 244, 269

Payment types, 234, 236

Payments
AP, 119
for employee expenses, 241

Payroll
checking dates before conversion, 154
conversion options, 151
payroll adjustments conversion, 153
payroll frequency, 130
tax methods conversion, 153
Vision Payroll, 119, 151

Payroll adjustment accounts, 262

Payroll adjustments
amounts for on payroll checks, 266
bonuses, 116
conversion description, 17
employee adjustments, 189, 263
other pay types for, 116
removing spaces from, 153

Payroll advances, 263, 266
Payroll periods, 187

Payroll taxes
amounts for on payroll checks, 266
conversion description, 17
tax methods, 257, 264
tax types, 257

Percent complete, 204
Percent of direct hours budgets, 18, 188

Periods
accounting, 124
labor, 130
payroll, 187

Personnel management data, 189
Phase List By Client/Project report, 152
Phase List By Project report, 152
Phase managers, 205, 207

Phase schedules, 213

Phased billing types, 202

Phases
budgets for, 63

Migration Guide

283



Index

Know more.
Do more™

Delte

changing phase IDs, 152

conversion options, 126

in expense records, 227, 240, 245, 253
in time records, 224

in Vision, 37

mapping to Vision labor codes, 141
phase IDs, 207

project conversion and, 69

Phone numbers, 178

Planning
configuration plan, 162
migration plan, 8
planning meeting, 9
test plan, 12, 175
training plan, 9
Vision Resource Planning, 47, 52, 119

PO Direct Expense Aging report, 157, 166,
168

Posting status, 220

Posting to the general ledger, 154
Posting types, 220

Pre Vision Conversion report, 153, 158

Preconversion utilities
running, 154
Setup Vision Work Breakdown Structure
utility, 152

Pre-Conversion Utilities dialog box, 154
Premium conversion level, 5, 15, 34, 69, 116
Prepayments, 248

Principals, 182, 198

Prior accounting period, 35

Process server, 164

Project Cost Adjustment options, 82, 83
Project cost data, 170

Project expenses conversion, 153, 270
Project management representative, 8
Project managers, 198, 205, 207

Project Profitability — Combined Cost report,
158, 166, 170

Project Profitability report, 6

Projects
AR collection actions for, 255
billing terms, 148

budgets, 132

completed projects, 70, 88

conversion description, 196

conversion options, 126

in expense records, 227, 239, 245, 253
in time records, 224

inactive projects, 70, 88

invoice formats, 148

miscellaneous overhead project, 258, 272
miscellaneous receipts for, 236

project IDs, 197

project names, 42

project numbers, 41

project teams, 132

project titles, 197

selecting for conversion, 68, 133
status, 70

types of in Vision, 36

Promotional projects, 36

Proposals, 41, 61, 197, 200

PR-TR Differences accounts, 107
Purchase Order List B report, 158, 166, 173
Purchase order numbers, 269

Purchase order types, 269

Purchase orders
balancing, 173
basic PO information conversion, 271
conversion options, 119
item codes conversion, 271
linking items on to expense codes, 153
miscellaneous adjustments conversion,
271
received items conversion, 153
shipping methods conversion, 271
tax methods conversion, 271
vendor conversion and, 20

Purchasing items, 153
Ranges, account number, 123

Rate schedules, billing
conversion options, 144
labor rates, 89

Receipts
applying before conversion, 154
receipt dates, 233, 236
receipt numbers, 233, 235
receipt types, 233

Received items conversion, 153

Received on date, 273
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Recipients, AR collection action, 255

Reconciliation
charge account, 6
check, 6

Recurring transactions, 6

References
for AP transactions, 243
for GL transactions, 252
for receiving transactions, 274

Refunds, 235, 248

Regular hours, 225

Regular projects, 36

Reimbursable consultant expenses, 71
Reimbursable expenses, 27, 32, 71

Reports (FMS)

AP Aging report, 157, 166, 168

AR Aging report, 157, 166, 167

billing reports, 199

Charge Account Aging report, 157, 166,
168

conversion of, 6

financial reports, 47

Form W-2, 116, 154, 262

GL Trial Balance report, 157, 166

Outstanding Retainer report, 154, 157

Phase List By Client/Project report, 152

Phase List By Project report, 152

PO Direct Expense Aging report, 157,
166, 168

Pre Vision Conversion report, 153, 158

Project Profitability — Combined Cost
report, 158, 166, 170

Project Profitability report, 6

Purchase Order List B report, 158, 166,
173

Unapplied Payments/Credit Memos
report, 154, 157

Vision Budget Pre-Conversion Exceptions
report, 62, 158

Reports (Vision)
Accounts Receivable Ledger report, 234
AR Aged report, 167
by organization, 44, 47
Employee Ledger report, 168
Office Earnings report, 170
Open Purchase Orders report, 173
Transaction List reports, 80
Trial Balance report, 166
Voucher Schedule report, 168
WABS levels and, 38

Reproduction expense credit accounts, 107
Required by dates, 269

Required software version
FMS, 10

Resource Planning, Vision, 47, 52, 119

Resource Scheduling and Budgeting (RSB),
6, 85

Retainage, 204, 231, 242, 243
Retained earnings accounts, 150

Retainers
applying before conversion, 154

Revenue accounts, 27

Revenue Generation process, 104, 132
Reviews, employee, 189

Roles, 163

RSB, 6

Sage FAS asset accounting system, 179
Salaries payable accounts, 106
Schedules, 213

Security, 163

Separator characters, 41

Serial Number dialog box, 10

Server side email, 163

Setup Vision Work Breakdown Structure
utility, 152

Ship to addresses, 270

Shipping methods
conversion description, 214, 271
in AP transactions, 244
linking to expense codes, 153
removing spaces from, 153

Source journals, 221, 251
Spoiled checks, 250

Staff types
conversion options, 128
converting labor rate exceptions for, 144
employee staff types, 187
in time records, 225
mapping to labor categories, 142
mapping to Vision labor codes, 141
removing during conversion, 86
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Staffing, 132, 205, 207 Tax treatments, 261
Stand-alone Business Management version Tax types, payroll, 257
of FMS, 5 Taxable addition to gross adjustments, 258,
Standard conversion level, 5, 15, 25, 34, 69, 262, 263, 266
116 Taxable-not paid adjustments, 258, 262,
Standard conversion templates, 98 263, 266
start dates, alternate, 189 Taxes, payroll, 266
Start/end times, 184 Teams
Statuses implementation team, 8
billing status, 225, 228, 240, 246, 253 project teams, 132
labor period status, 57 Technical support, 7

project status, 70

purchase order items status, 272
purchase order status, 269
vendor status, 180

Templates
conversion templates, 98
invoice templates, 148
Stub overruns, 250 Terminated employees, 89
Test conversions, 11, 13

Subcontractors
expense account number ranges for, 33 Test plans, 12
vendor type for, 217 Testing

Submitting accounts payable data, 168
databases for conversion, 160 accounts receivable data, 167
time sheets, 153 general ledger data, 166

project cost data, 170
Summary accounts, 26 purchase order data, 173
Support Web site, 160 .

Time records

SUTA, 256, 264 approving, 153, 224

billing rates for, 89
comments for, 182, 203
cost amounts for, 132, 153

System Manager control information
conversion, 177

TAG adjustments, 116, 258, 262, 263, 266 exceeds available hours warning, 185
tracking by departments, 182

Tasks, 37 unbilled, 70

Tax codes, 145 updating project teams from, 61

Tax credit accounts, 95 Time sheets

approving, 153, 184, 224

Tax fee methods conversion of, 6

convers?on des_cription, 192 submitting, 153, 224
conversion options, 145
in AR invoice transactions, 232 Time-off accumulation, 185
Tax methods, AP Time-off codes
conversion description, 244, 271 accumulation rates, 188
linking to expense codes, 153 conversion description, 184
removing spaces from, 153 employee, 188
Tax methods, payroll Timesheet calendar, 130

conversion description, 17, 257, 264
removing spaces from, 153

Tax rates, 193

Timesheet frequency, 130
TNP adjustments, 116, 258, 262, 263, 266

Tools
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Business Management Data Archiving
tool, 7

Code Revision tool, 152

Effective Cost Rates Calculation tool, 153

Overhead Allocation Assignment tool, 6

Trade name, 178

Training plan, 9
Transaction List reports, 80
Transaction numbers, 230
Transaction types, 230, 243

Transactions conversion
choosing to convert, 15
employee expenses, 239
general ledger transactions, 226, 229,
232, 244, 249, 266
organization assignment, 45
payroll transactions, 151
project conversion and, 69
receipts, 234, 236

Trial Balance report, 166

Unapplied Payments/Credit Memos report,
154, 157

Unbilled time and expense records, 69, 70
Uncollectibles, 235

Unit billing category, 109, 111

Unit costs, 212, 228, 240, 246, 253, 271
Unit descriptions, 212, 216

Unit markups, 212, 229, 241, 246, 254
Unit multipliers, 212, 229, 241, 246, 254
Units received, 274

Update Deltek FMS dialog box, 10

User name, 7

User-defined labels, 183

Utilities, preconversion
running, 154
Setup Vision Work Breakdown Structure
utility, 152

Vendor item numbers, 271

Vendors
budgets for, 65
conversion description, 196
discount information, 119
firm-vendor ID, 217

for AP payments, 248

for AP transactions, 243

for purchase orders, 269

for receiving transactions, 273

Hold status, 119, 180, 244

inactive, 119

including on project teams, 132

Pay When Paid status, 180, 244

payment terms, 119

purchasing information for, 216

vendor item numbers, 271
Vision

activating modules, 163

configuring, 162

hardware selection, 7

installation, 7

logging on to, 162

setting up security, 163

setting up server side email, 163

setting up the process server, 164

specifying version, 119

Vision Budget Pre-Conversion Exceptions
report, 62, 158

Vision Conversion module
functions, 118
unlocking, 10

Vision Conversion Setup dialog box
Accounts tab, 29, 30, 33, 121, 123, 124
Employees tab, 56, 58, 130
FMS Miscellaneous BM tab, 61, 62, 65,
67,132

General tab, 16, 18, 19, 20, 21, 22, 24,
119

GL Budgets tab, 59, 131

Labor Codes tab, 52, 54, 128

WBS tab, 39, 42, 46, 50, 126

Vision labor codes
converting departments to, 126
converting FMS labor codes to, 49, 126
converting phases to, 126
converting staff types to, 128
delimiters, 55
levels, 55, 56
mapping FMS codes to, 141
structure, 128

Vision Payroll, 119, 151

Vision Resource Planning, 47, 52, 119
Voided checks, 250

Voucher numbers, 242

Voucher Schedule report, 168
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W-2 forms
current Form W-2 quarter, 154
current Form W-2 year, 116, 154
payroll adjustment line labels for, 262

WBS1
converting FMS projects and billing
groups to, 126, 196, 200
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